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At its most basic level, PageGate is a communication program that translates inputs to
turn them in to outputs, usually in the form of messages. Put another way, PageGate allows
you to receive and collect data in a variety of formats to deliver as SMS, email, and pages,
among many other formats to your recipients.

Beyond that basic explanation, however, PageGate is a sophisticated messaging
application. The heart of the program is a high throughput messaging engine that has the
ability to support multiple connectors that can send SMS, pages and Email as well as
more complex forms of communication such as GET/POST to both request data from or
push data to an API.

PageGate supports several front-end interfaces (APIls) that can be used alone or in
conjunction with each other. This allows PageGate to receive messages from many
sources simultaneously, and deliver them to recipients such as cell phones, alphanumeric
pagers and email addresses, among many others. These APIs tell PageGate who a
message needs to go to, who or what sent the message, what the message should say
and when the message should be sent.

For example, PageGate's GUI Client APl is a program that can be installed on any
workstation that has UNC/network access to the PageGate server's shared database.
This provides a graphical messaging interface for users on workstations and can be
incredibly useful for dispatching messages.

As another example, PageGate's GetASCIlI API allows the program to monitor a directory
or series of directories on the local system or a network path for text/ASCIl formatted files.
The module also provides a command line executable for other programs to pass
messaging commands to. This module is used by network performance monitoring
programs such as SolarWinds Network Performance Monitor/Orion and Paessler's PRTG
and is also used by many computer automated dispatch platforms as well.

For more information on all of PageGate's APls, have a look at the Accepting Messages
section of the documentation.

Once PageGate knows that a message needs to be delivered, it supports many delivery
protocols for sending messages to many devices and receiving systems. It can send
messages to cell phones, alphanumeric pagers, email addresses, web servers, PIMs and
chat clients, among others.

For more information on how PageGate can deliver messages, have a look at the
Sending Messages section of the manual.

As an example of a simple configuration, PageGate can accept messages from a
dispatcher, who manually enters messages into PageGate's GUI Client application to
send those messages to cell phones, pagers and email addresses.

Chapter 1 Welcome to PageGate version 10
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In a more complex example, PageGate can be simultaneously receiving hundreds of
messages from multiple sources such as email, webpages, monitored serial ports for
alarm systems, manual dispatchers and integration with other applications while also
delivering them through up to sixteen concurrent outbound communication sessions
implementing multiple protocols to multiple sources.

PageGate can be installed to run on a single non-dedicated workstation, or using its
modular architecture, PageGate can actually be installed across a dozen or more
computers for a truly high-performance messaging gateway system.

What's New
Take advantage of the powerful and efficient PageGate version 10!

e SQL Database Module

PageGate now supports using SQL Server and SQL Server Express, allowing you to
integrate PageGate into an existing SQL Server environment or use a dedicated instance
of SQL Server Express! Of course the existing embedded Jet database engine is still
supported.

¢ Replies and two-way messaging with GUI Client

PageGate's GUI Client now supports receiving messages and sending replies to those
messages! This allows your recipients to reply to messages and have those replies go to
instances of the GUI Client. GUI Client users can also move those replies between each
other, so the replies can be handled by the person best suited to do so. Additionally,
workstations can send messages to each other in a chat style conversation.

e Secure Deployment with SQL
Deploying PageGate with an encrypted SQL database connection allows you to
guarantee that any database connection to the server is secure.

e Secure Client Connection to Cloud PageGate Server with SQL
Deploy PageGate to a cloud server with an encrypted SQL connection and you can offer
your personnel the ability to use the PageGate Client securely from anywhere!

e National Weather System Integration
PageGate now supports monitoring the National Weather System's alert, watch and
warning system to automatically notify your recipients with essential information!

e Scheduled and Repeating Messages with PageGate Admin
PageGate Admin now has the ability to schedule messages to go out in the future and can

also schedule repeating messages, making it much easier to create routines to poll data
from APls.
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e Enhanced Internet APl Support

In version 10, we've improved PageGate's ability to bi-directionally communicate with
nearly any web based API. This allows you to both send information to and receive
information from many Internet and intranet sources.

e Enhanced support for cellular hardware and infrastructure

PageGate version 10 has continued to build on previous versions' hardware support and
can use any style of cellular hardware you may need to interact with, from cellular gateways
on virtual machines to cellular modems connected to physical servers.

e Improved global performance

Major work has been done to the core of PageGate for version 10, drastically improving its
efficiency and usage of resources, like memory, CPU, and database. The resultis a
noticeable increase in its operational speed.

e Productivity
Numerous productivity improvements have been made to PG Admin and PG GUI Client,

including a brand new search function!

¢ Improved Data Handling
Speed, and scope improvements have been made to PageGate’s import, export, backup,
logging, and synchronization features.

e Look and Feel
The look and feel of the GUI Client, PG Admin and PG Monitor programs have been
updated to have a more modern appearance.

e Filter Pack

The optional Filter Pack has a number if added capabilities and improvements, allowing
for even more flexibility and support for nearly any data format. This is especially useful
when interacting with internet and intranet APIs!

Release Notes

Changes since 9.0.2
e Option for direct MS SQL Server database support, instead of embedded Jet database

or linked SQL database

¢ Extensive optimizations for more efficient use of processor, database, and memory

resources

¢ Updated look and feel of PG Admin, PG Monitor, and PG Client (added toolbar to PG
Client)

¢ New local message and reply handling added to PG GUI Client

Chapter 1 Welcome to PageGate version 10
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¢ Huge performance improvements made to import and synchronization routines

e Subnet values can be added to BlockedIPs and AllowedIps files for mail server
(DO XK XK XXX/XX)

e Added Database Export All and Import All options in PG Admin

e Added Database backup prompting to PG Admin

e (use No_Admin_Backup_Prompt- REG_SZ = True, to disable on single computer)

¢ In PG Admin added right-click popup 'Open Folder' options for Program, Database, and
Logging

¢ Double-clicking on logs in PG Monitor will open the log in notepad

e Added StripNonAscii setting to TCP and UDP Servers

¢ Added template variables: FilterDebugFile, SubjectFilterDebugFile,
InterfaceFilterDebugFile,

¢ RawlinterfaceFilterDebugFile, ReplyFilter, ReplyFilterDebugFile, Unique, LongUnique,

¢ *note /append switch can be used after a XFilterDebugFile filename

¢ Added template variable: UseFilterDI

e Added Senderlslp setting to TAP IP Server, SNPP Server, TCP Server, and UDP
Server modules

e HTTPGET and HTTPPOST protocols - added HTTPResponse Timeout template setting

e RawTCP protocol - added RawTCPSuccessResponse, RawTCPErrorResponse,
RawTCPResponseTimeout,

¢ ResponsePath, ResponseRecipient

e RawSerial protocol - added RawSerialSuccessResponse, RawSerialErrorResponse,
RawSerialResponseTimeout,

¢ ResponsePath, ResponseRecipient

¢ “** Due to the response timeout now being able to be set for the above protocols, the
default

e timeout value has been lowered.

e Added new template Setting: RawTCPProtocol=ssh

¢ Added new template setting: HttpProtocol=https

e Added new template settings for GSM protocols: GsmUseCpoint, GsmipProtocol=ssh
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¢ In PG GUI Client, the pre-programmed message buttons grow with form resize

¢ Added Interface templates to export/import routines

e Added support for multiple dedicated Carriers for each Connector (separated by |)

e Added WaitForCr to TAP IP Server

¢ Improved UrlEncoding in HTTPGET, HTTPPOST, and AwsSns protocols

e Added ParameterDelimiter template variable

¢ Increased max message size to 16000 characters

e Separated SNPP Advanced screen Password into Username and Password fields

e - Using username <space> password in the password field still works

e Increased valid port numbers for SMTP protocol to > 32768

¢ Clicking on module name in PG monitor brings its monitor window to the front

¢ New replacement webgate.exe CGI module

e Added SmtpFriendlyNames template setting

e Added ArchivelLog feature to SNPP, TAP-IP, TCP and UDP servers

¢ Added Delete as a valid HttpPostType template variable value

¢ Added ResponselincludeRequest template setting

e Added service startup error logging to Windows event logs

¢ Optimized start, stop, restart, and cleanup routines

e Added GetSerial_Ignore_Restart, GetTap_Ignore_Restart registry settings

e Added 0 and -1 as valid values to the Database "Purge After (days)" setting

¢ Added filter pack support to SNPP, TCP, UDP and TAP-IP servers

o Added warning message if a recipient is added that will exceed the recipient license

¢ In PG Admin added 'SQL' object under 'Database’ in the tree - for setting SQL Server
connection strings

¢ Added Tools->Reset Counter to GUI Client

e Added support for headers in HTTPGET protocol

¢ Added right-click 'Scheduled' messages options for carriers, recipients, and groups

e Added logging support in PG Monitor for multiple tcp, udp, tap-ip and snpp server
modules

e Added optionin PG Admin to schedule messages
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e Database synchronization feature now syncs oncall tables, ad-hoc maps, mailboxes and
templates

e Import/Export of groups has now been split into separate groups and display groups
options

¢ Updated order of operations for StripCharacters when processing templates

¢ Added SubjectMaxChars and BodyMaxChars to template settings

¢ Renamed RawTcpProtocol and GsmlpProtocol template settings to TcpProtocol

e Added 'Find' function in PG Admin (ctrl-f)

¢ Improved PG Client startup time

¢ In PG Admin, hovering over a recipient or group now shows its full name

¢ An Upgrade Summary file is written to the database folder with any registry and template
settings

e changes made during the upgrade - SettingsUpgradeReport.txt

o PGFilter:

e - improved debug logging - added many new debug options

¢ - added new MatchFound, MatchNotFound, Lookup, ReadFile, Run, RunFilter and Goto
sections

¢ - added commandline support for debug settings

e - added .dll version (better performance than existing .exe version)

e Changed default SMTP content transfer encoding from quoted-printable to 7bit

¢ Renamed remaining references to 'Dialers' to 'Connectors'

e snppserver.exe and snpp.ini renamed to pgsnppserver.exe and pgsnpp.ini

e tapipserver.exe and tapip.ini renamed to pgtapipserver.exe and pgtapip.ini

¢ ID in recipient table now takes preference over ID in message table, for all non-ad-hoc
messages

¢ Fixed problem where PG Client sometimes didn't get removed from task list

¢ Fixed problem with registration screen showing every time PG Admin is started, on
some systems

¢ Fixed PG Monitor jumpy scrolling at times
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¢ Fixed problem where PG Admin didn't immediately show templates for imported
carriers and recipients

e Fixed SMTP date format

¢ Fixed time zone offset problem when using SMTP and port 25 (may still have issues in
Win XP)

¢ Fixed possible race condition in 'resetting database flags' section of cleanup routine

Purchasing and Pricing

For a quote, please contact NotePage Sales at 781-829-0500 or
sales@notepage.com

To purchase PageGate, you have several options:
¢ Online (with credit cards: MasterCard, Visa, American Express and Discover) at

https://www.notepage.net/purchase.htm

e Fax credit card details (i.e. number, expiration date, security code, name and
billing address) and order information to NotePage, Inc. at 781-829-0419.

e Purchase order, signed and dated, on official letterhead can be faxed to
NotePage, Inc. at 781-829-0419.
We are unfortunately unable to accept purchase orders from outside of the USA.
Obtain W-9 at https://www.notepage.net/purchase-orders.htm

e Check and money order (in US Dollars, drawn from a US bank) payable to:
NotePage, Inc.
P.O. Box 296
Hanover, MA 02339
USA

e For a wire transfer or ACH payment, please contact NotePage Sales at
sales@notepage.com for bank and account details

¢ NotePage Reseller listed at https://www.notepage.net/reseller.htm

For more NotePage Resellers, please contact NotePage Sales Department at
781-829-0500 or sales@notepage.com

When purchasing PageGate, please include the following order information:
1. PageGate Recipient License quantity.

Chapter 1 Welcome to PageGate version 10
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2. Interface(s) & optional Additional Connectors.

3. Mailing address and attention to for the CD.

4. Contact name, email and telephone number.

5. Email address for Registration Key delivery.

6. Software registration information includes these fields:

Name/Department:
Company Name:
Address1:

Address2:

City:

State/Province:

Zip Code/Postal Code:
Country:

A PageGate electronic Registration Key will be emailed within 24 hours of
ordering. A PageGate CD will be sent by regular mail.

For information on pricing for PageGate, please call our Sales Department at 781-829-
0500 xt 1. Alternatively, you can email us at sales@notepage.com or visit our website,
https://www.notepage.net

Upgrade

1. Online (with credit cards: MasterCard, Visa, American Express and Discover) at
https://www.notepage.net/upgrades.htm

2. Fax credit card details (i.e. number, expired date, security code, name and
billing address) and order information to NotePage, Inc. at 781-829-0419.

3. Purchase order, signed and dated, on official letterhead can be faxed to
NotePage, Inc. at 781-829-0419. We are unfortunately unable to accept purchase
orders from outside of the USA. Obtain W-9 at https://www.notepage.net/purchase-
orders.htm

For a quote, please contact NotePage Sales at 781-829-0500 or
sales@notepage.com

4. Check and money order (in US Dollars, drawn from a US bank) payable to:
NotePage, Inc.

P.O. Box 296

Hanover, MA 02339

USA

5. For a wire transfer, please contact NotePage Sales at sales@notepage.com

Chapter 1 Welcome to PageGate version 10
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6. For a NotePage Reseller in your area, please contact NotePage Sales.

Please include the following upgrade information:

1. PageGate Serial Number (PageGate Admin module under Registration).

2. PageGate existing version to current version and PageGate CD (optional).

3. PageGate Pager License: existing quantity to new quantity.

4. Interfaces: GUI Client, Command Line/ASCII, Web (CGI), TAP, TAP2ASCII Module,
Serial, Serial2ASCIl Module, SNPP Server Module, Tap IP Server Module, Touchtone
Receiver Module (DTMF), PageGate Filter Pack, Android SMS Gateway App

5. Additional Connectors.

6. Contact name, email and telephone number.

7. Mailing address and 'attention to' for the optional PageGate CD.

8. Email address for Registration Key delivery.

An upgraded PageGate electronic Registration Key is emailed within 24 hours of
ordering. The optional PageGate CD, if ordered, is sent by regular mail. The
optional PageGate CD is only relevant when upgrading the PageGate version.
Pricing

PageGate's pricing is determined by three things and the option of a service
license agreement or standard support.

e Recipients

Recipients can be cell phones, email addresses, web APIls, pagers, fax machines
and similar. This represents the people, devices, APIs and other destinations for
your messages.

e Interfaces
These represent how you want PageGate to accept messages for delivery.
PageGate's Interfaces are priced separately.

e Connectors

These represent the throughput of the system, the rate at which the program can
deliver messages. PageGate includes 1 Connector. Additional Connectors are a
separate, one-time charge.

There are no monthly or yearly fees for PageGate.

Specific pricing can be found at https://www.notepage.net/purchase.htm

Chapter 1 Welcome to PageGate version 10
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e PageGate Priority Support

Priority support puts your inquiries in a priority queue for a guaranteed 2-hour
response during normal business hours and also provides upgrades to PageGate
free of charge for the duration of the contract.

For more information, see https://www.notepage.net/priority-support.htm

Contact Information

NotePage, Inc.

PO Box 296
Hanover, MA 02339
USA

Sales: sales@notepage.net

Support: Please see the 'Support' section of the documentation
Phone Number: 781-829-0500
Fax Number: 781-829-0419

Websites: www.notepage.net

Resellers

More information at https://www.notepage.net/reseller.htm

For NotePage's Reseller programs please contact NotePage, Inc. at 781-829-
0500 or sales@notepage.com

Evaluation Information

PageGate software defaults into a evaluation mode until purchased and
registered. Enter the provided registration information in the PageGate Admin
module’s Registration screen.

The evaluation version of PageGate allows for two active recipients at any given
time, and the PageGate Server and PageGate will need to be restarted every 3-5
days.

If a less restrictive evaluation would be useful to fully test PageGate, please contact
NotePage Sales at sales@notepage.com or by phone at 781-829-0500 x 1 to
discuss the availability of a thirty-day temporary evaluation key.

This software is not free. Using an unregistered copy of NotePage, Inc.'s software
outside the trial period is considered software piracy and is illegal. The registration

Chapter 1 Welcome to PageGate version 10
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fee allows us to continue developing quality products, notify you of updates, and
provide technical support. PageGate can be tried and tested for an unconditional
trial.

If you like PageGate and want a complete, registered version please contact:
sales@notepage.com

If there are any questions, please contact sales@notepage.com
End User License Agreement (EULA)

END-USER LICENSE AGREEMENT for PageGate

IMPORTANT PLEASE READ THE TERMS AND CONDITIONS OF THIS
LICENSE AGREEMENT CAREFULLY BEFORE CONTINUING WITH THIS
PROGRAM INSTALL:

NotePage, Inc.'s End-User License Agreement ("EULA" or “AGREEMENT”) is a
binding legal agreement between you (“END-USER”) (either an individual or a
single entity) and NotePage, Inc. for the NotePage software product(s) identified
above which may include associated software components, media, printed
materials, and "online" or electronic documentation ("SOFTWARE PRODUCT").
By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree
to be bound by the terms of this EULA. This license agreement represents the
entire agreement concerning the program between you and NotePage, Inc.,
(referred to as "licensor"), and it supersedes any prior proposal, representation, or
understanding between the parties. If you do not agree to the terms of this EULA,
do not install or use the SOFTWARE PRODUCT.

By downloading/installing or using the SOFTWARE PRODUCT, you
(a) acknowledge that you have read and understand this AGREEMENT;
(b) represent that you are 18 years of age or older; and

(c) accept this AGREEMENT and agree that you are legally bound by its terms. If
you do not agree to these terms. Do not download, install or use the SOFTWARE
PRODUCT.

The SOFTWARE PRODUCT is protected by copyright laws and international
copyright treaties, as well as other intellectual property laws and treaties. The
SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE.

Chapter 1 Welcome to PageGate version 10
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The SOFTWARE PRODUCT is licensed as follows:
(a) Installation and Use.

NotePage, Inc. grants you the right to install and use copies of the SOFTWARE
PRODUCT on your computer running a validly licensed copy of the operating
system for which the SOFTWARE PRODUCT was designed [e.g., Windows 95®,
Windows NT®, Windows 98®, Windows ME®, Windows XP®, Windows 2000®,
Windows 2010®)].

(b) Non-Transferable.
The SOFTWARE PRODUCT license is non-transferable.
(c) Proper Licensing.

A single SOFTWARE PRODUCT license is for a single installation, at a single
location, if you wish to run the software at multiple locations and multiple instances
of the server software, you must purchase additional SOFTWARE PRODUCT
license(s) .

(d)Backup Copies.

You may also make copies of the SOFTWARE PRODUCT as may be required by
law and necessary for backup and archival purposes.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.
(@) Maintenance of Copyright Notices.

You must not remove, delete, alter or obscure any copyright notices or trademarks
on any and all copies of the SOFTWARE PRODUCT.

(b) Distribution.

You may not distribute registered copies of the SOFTWARE PRODUCT to third
parties. Evaluation versions are available for download from NotePage, Inc.'s
websites may be freely distributed.

(c) Prohibition on Reverse Engineering, Decompilation, and Disassembly.

You may not reverse engineer, decompile, disassemble, decode or otherwise
attempt to derive or gain access to the source code of the SOFTWARE
PRODUCT, except and only to the extent that such activity is expressly permitted
by applicable law notwithstanding this limitation.

(d) Rental or Assignment.

You may not rent, lease, lend, sublicense, transfer or assign the SOFTWARE
PRODUCT.

(e) Modifications

Chapter 1 Welcome to PageGate version 10
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You may not modify, translate, adapt or otherwise create derivative works or
improvements of the SOFTWARE PRODUCT.

(f) Security or Licensing

You may not remove, disable, circumvent or otherwise create or implement any
workaround to any copy protection, rights management, licensing or security
features in the SOFTWARE PRODUCT.

(9) Support Services.

NotePage, Inc. may provide you with support services related to the SOFTWARE
PRODUCT ("Support Services"). Any supplemental software code provided to you
as part of the Support Services shall be considered part of the SOFTWARE
PRODUCT and subject to the terms and conditions of this EULA.

(h) Compliance with Applicable Laws.

You must comply with all applicable laws regarding use of the SOFTWARE
PRODUCT.

3. TERM AND TERMINATION

Without prejudice to any other rights, NotePage may terminate this EULA if you fail
to comply with the terms and conditions of this EULA. In such event, you must
destroy all copies of the SOFTWARE PRODUCT in your possession.

(@) The term of this agreement commences when you download/install the
SOFTWARE PRODUCT

(b) The END-USER may terminate this agreement by deleting the SOFTWARE
PRODUCT and all copies from all computers.

(c) NotePage may terminate this AGREEMENT at any time without notice if it
ceases to support the SOFTWARE PRODUCT, which NotePage may do at its
sole discretion.

(d) NotePage may terminate this AGREEMENT with or without notice if the END-
USER violates any of the terms and conditions of this AGREEMENT.

(e) NotePage reserves the right to terminate support to any END-USERS that
violate the terms of this AGREEMENT.

(f) Upon Termination
(i) all rights granted to you under this AGREEMENT will also terminate

(ii) the END-USER must cease all use of the SOFTWARE PRODUCT and
delete all copies of the SOFTWARE PRODUCT.

(g) Termination will not limit any of NotePage’s rights or remedies.
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4. COPYRIGHT

All title, including but not limited to copyrights, in and to the SOFTWARE
PRODUCT and any copies thereof are owned by NotePage, Inc. All title and
intellectual property rights in and to the content which may be accessed through
use of the SOFTWARE PRODUCT is the property of the respective content owner
and may be protected by applicable copyright or other intellectual property laws
and treaties. This EULA grants you no rights to use such content. All rights not
expressly granted are reserved by NotePage, Inc.

5. THIRD PARTY COMPONENTS

The SOFTWARE PRODUCT may contain third-party components. NotePage does
not assume and will not have any liability or responsibility to any entity for any third
party components.

6. NO WARRANTIES

NotePage, Inc. expressly disclaims any warranty for the SOFTWARE PRODUCT.
The SOFTWARE PRODUCT is provided "As Is" without any express or implied
warranty of any kind, including but not limited to any warranties of merchantability,
noninfringement, or fitness of a particular purpose. NotePage does not warrant or
assume responsibility for the accuracy or completeness of any information, text,
graphics, links or other items contained within the SOFTWARE PRODUCT.
NotePage, Inc. does not have any liability arising from or related to the END-
USERS use of or inability to use the SOFTWARE PRODUCT. NotePage makes
no warranties respecting any harm that may be caused by the transmission of a
computer virus, worm, time bomb, logic bomb, or other such computer program.
NotePage further expressly disclaims any warranty or representation to Authorized
Users or to any third party.

7. LIMITATION OF LIABILITY

In no event shall NotePage, Inc. be liable for any damages (including, without
limitation, lost profits, business interruption, or lost information) rising out of
'‘Authorized Users' use of or inability to use the SOFTWARE PRODUCT, even if
NotePage, Inc. has been advised of the possibility of such damages. In no event
will NotePage be liable for loss of data or for indirect, special, incidental,
consequential (including lost profit), or other damages based in contract, tort or
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otherwise. NotePage, Inc. shall have no liability with respect to the content of the
SOFTWARE PRODUCT or any part thereof, including but not limited to errors or
omissions contained therein, libel, infringements of rights of publicity, privacy,
trademark rights, business interruption, personal injury, loss of privacy, moral rights
or the disclosure of confidential information. NotePage, Inc. shall not have any
liability for any personal injury, property damage, lost profits, cost of substitute
goods or serves, loss or corruption of data, loss of goodwill, business interruption,
computer failure or malfunction or any other consequential, incidental, indirect,
exemplary, special or punitive damages that results from the use or inability to use
the SOFTWARE PRODUCT.

8. INDEMNIFICATION

The END-USER agrees to indemnify, defend and hold harmless NotePage, Inc.
and its officers, directors, employees, agents, affiliates, service providers,
successors, and assigns from and against any and all losses, damages, liabilities,
deficiencies, claims, actions, judgements, settlements, interest, awards, penalties,
fines, costs or expenses of whatever kind, including reasonable attorney's fees,
arising from or relating to te END-USERS use or misuse of the SOFTWARE
PRODUCT or the END-USERS breach of this AGREEMENT.

9. UPGRADES

NotePage may from time to time in its sole discretion develop and release
upgrades to the SOFTWARE PRODUCT, the upgrades, may include updates,
upgrades, bug fixes, patches and other error corrections and/or new features
(collectively including related documentation). Upgrades may also modify or delete
in their entirety certain features and functionality. NotePage has no obligation to
provide upgrades or to continue to provide or enable any particular features or
functionality. NotePage may charge for upgrades. All Upgrades will be deemed
part of the SOFTWARE PRODUCT and may be subject to all terms and conditions
of this AGREEMENT.

10. REVISIONS TO EULA

NotePage may revise this EULA at any time by posting an updated version,
although we will endeavor to provide you with prior notice of any material changes
to this EULA. Continued use of the SOFTWARE PRODUCT after a change to the
EULA constitutes your binding acceptance of this EULA.
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11. GOVERNING LAW

This Agreement is governed by and construed in accordance with the laws of the
State of Massachusetts. Any legal suit, action or proceedings arising out of or
related to this Agreement and to the SOFTWARE PRODUCT must be instituted
exclusively in the State of Massachusetts.

12. ENTIRE AGREEMENT

The AGREEMENT constitutes the entire AGREEMENT between the END-USER
and NotePage, Inc. with respect to the SOFTWARE PRODUCT and supersedes
all prior or contemporaneous understandings and AGREEMENTS, whether written
or oral, with respect thereto. If any provision of this AGREEMENT is illegal or
unenforceable under applicable law, the remainder of the provision will be
amended to achieve as closely as possible effect of the original term and all other
provisions of this AGREEMENT will continue in full force and effect.iability with
respect to the content of the SOFTWARE PRODUCT or any part thereof, including
but not limited to errors or omissions contained therein, libel, infringements of
rights of publicity, privacy, trademark rights, business interruption, personal injury,
loss of privacy, moral rights or the disclosure of confidential information.

General Features

e Multiple recipients - allows a single message to be sent to more than one recipient
and/or group.

¢ Recipient Groups - messages can be sent to predefined groups of recipients.

e Display Groups - dispatchers using the PageGate GUI Client program can be
configured to only see a subset of recipients and groups

e On-call groups - a schedule can be setup for the recipients in a group, allowing
PageGate to send messages to only the recipients scheduled to receive messages at
that point in time.

e Multiple delivery methods - PageGate can be connected to the internet through a
modem, and a paging terminal by a direct cable connection.

e Message splitting - long messages can be intelligently split into multiple smaller
messages.
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e Settable character limits - the maximum number of characters to be sentin a message
is settable by carrier and individual recipient

e Modular / Scalable - PageGate's front-end Interfaces allows the program to be used
with network computers, email, websites and 3rd party applications.

e Protocols - for message delivery PageGate supports the protocols: SNPP, SMTP,
WCTP, HTTPS, TAP, FAX, GSM, UCP and TONE.

¢ Requeue messages - missed messages can be requeued for re-transmission to the
wireless carrier.

¢ High output - PageGate's intelligent queuing of messages and multiple Connectors
allows for the delivery of a large number of messages.

e Failover - undeliverable text messages can be automatically sent to an alternative
carrier, recipient, group and connection.

¢ Intelligent message queuing - messages for the same carrier are grouped together
and sent during a single communication session.

e Maximum Characters - set the number of characters for each recipient and carrier.
When sending a larger amount of characters the messages will be sequentially
numbered.

¢ Reliapage - will number a message and a recipient can tell if a sequentially numbered
message is missed.

¢ Hold Messages - for recipients and groups to be sent at a later time.

¢ Reports - on recipient, date/time and message can be previewed, saved and printed
for all messages sent and received.

¢ Logs - to help monitor the activity of all of PageGate modules and functions.

¢ Real-time Monitoring - with the PageGate Monitor module of all PageGate's modules

and functions from the paging server, or any workstation connected via TCP/IP.
PageGate is designed to easily integrate with other applications by providing a range of
front-end APIs. Once integrated, your application(s) will be able to send messages to the
recipients and groups that have been configured in the software, and even send
messages through PageGate for recipients that aren't configured in the program's
database with PageGate's Ad-Hoc Messaging feature.
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PageGate supports the following integration methods:

¢ National Weather Service Integration
PageGate can monitor the National Weather Service's alerts, warnings and watches
system to automatically send notifications when severe weather events happen.

e GUIClient

The PageGate GUI Client is a Windows based program that interacts with PageGate's
database. Recipients and groups configured in the PageGate Admin display in the
recipient list, which allows a user to select them to send a message immediately or
schedule a message to go out at a later time.

When using an MSJet database (default), the PageGate Client will need access to the
PageGate server's database directory. You will need to share that folder on the server and
provide all appropriate users and usergroups the read, write and modify permissions.

When using an SQL database, the PageGate Client will need a configuration file that tells
it how to interact with the SQL server.

When using an SQL database hosted on a cloud server, if you enable 'Always Encrypted'
in SQL, GUI Client application can be installed on any computer and given access to your
PageGate server. This makes connecting remote workstations far easier as they can be
given direct access.

e Accepting HTTP Requests

PageGate has an HTTP data receiver (webdata.exe) that can receive input from nearly
any APl or protocol that offers an HTTP return like HTTP GET, HTTP POST and WCTP,
which allows you to receive JSON, XML, HTML, WCTP and similar data submissions via
HTTP/S request.

e AP|Pollin

This method allows PageGate to request information from an API using a webform, HTTP
GET or HTTP POST method. The information collected from the APIs is then fed through
the GetASClIl interface and filter scripts for parsing and, as a result, require the GetASCII
interface and, optionally, filter pack.

e TCP Server Module

This module allows PageGate to run a TCP server/listener, enabling it to accept TCP
packets from any source.

e Syslog/UDP Server Module

This module allows PageGate to run a UDP server/listener, enabling it to accept UDP
packets and function as a Syslog receiver.
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e GetASCIl- Command Line/ASClIl Interface

This interface is capable of monitoring a directory or series of directories on the local hard
drive or across the network for ascii file output and also provides a command line interface
for other applications to use. This module allows many 'off the shelf and custom
applications, such as SolarWinds' Network Performance Monitor, SolarWinds' Orion,
Paessler's PRTG and several CAD programs, among many others, to tell PageGate when
a message needs to be sent.

e Filter Pack

This is a companion module for GetASCIl and allows PageGate to conditionally modify
nearly anything about any part of any message, whether they're received by one of the
interfaces or being sent by one of the connectors.

e GetMail - Email Interface (Includes SMTP server)

This API unlocks the ability to receive email in to PageGate by enabling the receiving
functions of PageGate's mail server engine. This API provides the ability to host your own
messaging domain or sub-domain as well as unlocking an email forwarding feature
associated with your recipients and groups. This APl also allows PageGate to function as
an SMTP/Email receiver for any installation of NotePager Pro, allowing satellite offices to
submit messages for processing with a centralized, master server.

o GetWeb - Webserver and CGl Interface

Also known as the GetWeb Interface, this API allows PageGate to integrate with a web
server to provide a website messaging interface. This allows you to host messaging
websites on your local intranet or, if GetWeb is interfaced with an outward facing web
server, on the internet. Web Developers can also use this web server interface to send
GET/POST requests to notify PageGate when a message needs to be sent, who the
message should go to, who sent the message and what the message should say. This
interface can also be used to enable PageGate to receive notifications from applications
running on different platforms (Unix, Mac, etc.).

e GetSerial - Serial Port (physical or virtual) Interface

Also known as the GetSerial Interface, this APl allows PageGate to monitor a
serial/RS232 port (physical or virtual) for raw data ASCII strings to be parsed in to
outbound messages. When a data string is sent to a monitored serial port, GetSerial
pattern matches sections of the data string to parse information for messaging.

e Serial to ASCII Module

This is a companion module for GetSerial and unlocks the ability to monitor additional
serial/RS232 ports (physical or virtual), up to 16. This module requires the GetAscii API to
function.

e GetTAP - TAP Interface
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Also known as the GetTAP Interface, this APl allows PageGate to monitor a serial port or
answer a modem call to receive TAP transmitted pages. This allows PageGate to function
as a TAP receiver or a TAP terminal for any devices and systems that can transmit that
protocol, such as a Zetron or Motorola paging terminal as well as a few CAD systems.
This also allows PageGate to function as a TAP receiver for any installation of NotePager
Pro, allowing satellite offices to submit messages for processing with a centralized,
master server.

e TAP to ASCIl Module

This is a companion module for GetTAP and unlocks the ability to monitor additional
serial/RS232 ports or modems, up to 16. This module requires the GetAscii API to
function.

e TAP over TCP/IP Server Module
This APl allows you to receive the TAP protocol by TCP/IP instead of by serial or modem
line. This module requires the GetAscii APIto function.

e SNPP Server Module

This APl allows PageGate to function as an SNPP server to receive this protocol from any
source that can send it. Messages received by this APl are output to a directory as a text
file thatis then read in with the GetAscii API. This also allows PageGate to function as an
SNPP receiver for any installation of NotePager Pro, allowing satellite offices to submit
messages for processing with a centralized, master server. This module requires the
GetAscii APIto function.

e TouchTone Server Module (DTMF)
This APl provides the ability to monitor a voice modem to answer calls and receive DTMF
signals and output them as text to a file for the GetAscii APl to process. This module
requires the GetAscii APIto function.

¢ Reqistry Polling
The GetAscii APl can accept messages that are passed to it via the Windows registry.

¢ Direct Database Access
PageGate uses an MSJet database that can be linked to other databases by ODBC
expression.

National Weather Service Integration
Requirements: GetAscii, Filter Pack

The NWS (National Weather Service) provides a live feed of public alerts based on state,
zone and county at their website https://alerts.weather.gov/

PageGate can be configured to routinely poll the NWS for weather alerts in any area of
interest and automatically trigger notifications, alerts and messages based on them.
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To start, we'll need to create a few directories. While they can reside anywhere, you'll need
to create:

\weather\

\weather\posts\

\weathen\ids\

For example, if you're using PageGate's default data location, we would recommend
creating:

c:\PageGateData\Weather\

c:\PageGateData\Weather\posts\

c:\PageGateData\Weather\ids\

Next, we'll need to configure the National Weather Service APlin PageGate:
1) Open PG Admin.

2) Right click Carriers, select 'Add'.

3) Specify the following:

Name: NWS-GetData

Protocol: HTTPGET

Host: The link to the NWS data feed. See note below
Port: 443

Max Chars: 16000

NOTE: The 'Host' is the link to the NWS data feed you're interested in. To find that link, go
to https://alerts.weather.gov/ and scroll to the Zone and County list. When you find the state,
zone or county you're interested in, right click on the link for the specific Zone or County
code and copy it.

After pasting the URL into the 'Host' field, remove the https:/

For example, the link to the NWS data feed for Alameda, CA is
https://alerts.weather.gov/icap/wwaatmget.php?x=CAC001&y=1

We would need this in 'Host' field:
alerts.weather.gov/cap/wwaatmget.php?x=CAC001&y=1

4) Click Apply.
5) Go to Carriers - NWS-GetData - Template
6) In the 'Settings' section of the Template, specify the following:

ResponsePath = The path to the weather folder. Note: Declare \ as \092
Example:
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ResponsePath = C:\092PageGateData\092weather
7) Click Apply.

Next, we'll need to configure a recipient that will allow us to go 'check the weather":
1) Right click Recipients, select 'Add".

2) Specify the following:
Full Name: WeatherCheck
recipient: weathercheck
Carrier: NWS-GetData
ID/PIN: Leave blank

Max Chars: 16000

3) Click Apply.

Now that we have the ability to check the weather, we'll need to configure GetAscii to use
PageGate's NWS Filter, which can be downloaded here:
https://www.notepage.net/support/nwsfilter.zip

You can also find a copy of the script here in the documentation.

Unzip the file in the root \weather\ folder. For example, if you're using the default paths, you
would unzip nwsfilter.zip in to c:\PageGateData\weather\

Next, we'll need to configure the filter for your system:
1) Open nwsfilter.xml in your preferred text editor (NotePad, NotePad++, EditPad, etc)

2) Find all lines that say 'INSERT THE PATH TO YOUR WEATHER FOLDER'. Please
replace that text with the path to your root folder. For example, you'll see this line in the
filter:

INSERT THE PATH TO YOUR WEATHER FOLDER\posts\%InputFileNameBase%-%
Filterindex%.asc

If you're using the default paths, you would use:
c:\PageGateData\weather\posts\%InputFileNameBase %-%Filterindex%.asc

3) Search for YourRecipientOrGroup and replace that with the name of a recipient or
group in PageGate. This is the recipient or group that will receive the weather alerts.

For example, if you want the weather alerts to be sent by email, text, page and APl call at
the same time, you would definitely want to reference a group name.

4) Save and close the filter.
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Now that we have the filter primed and ready, we'll need to tell GetAscii to use it and then
configure GetAscii to start reading the weather data.

1) Back in PG Admin, go to Interfaces - GetAscii - Template

2) Specify the following in the 'Settings' section of the template:
RawlnterfaceFilter = The full path to your nwsfilter.xml file and declare \ as \092*
UseFilterDIl = True

*For Example: c:\\092PageGateData\092weather\092nwsfilter.xml
3) Click Apply.
4) Go to Interfaces - GetAscii - Settings - Advanced Polling - Files

5) Click Add, then specify the following:

Recipient: *

From: Leave Blank

File(s): *.txt

Path: The path to your \weather\ folder.

If you're using the default paths, you would specify c:\PageGateData\weather\
File Type: Standard

6) Click Apply.

7) Click Add, then specify the following:

Recipient: *

From: Leave Blank

File(s): *.asc

Path: The path to your \weather\posts\ folder.

If you're using the default paths, you would specify c:\PageGateData\weather\posts
File Type: Standard

8) Click Apply.
9) Click Apply again.

The final step is to configure a scheduled message to 'check the weather' every few
minutes:

1) Open the PageGate Admin.

2) Right click on the 'WeatherCheck' recipient and select 'Send Message'
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3) Leave 'From' and 'Message' blank.
4) Check 'Repeat message every X minutes'

5) Specify the interval at which PageGate should poll the NWS data feed. Fractions of a
minute will be expressed as seconds. For example, a value of 0.5 will poll every 30
seconds.

6) Click Send.

From that point forward, PageGate will automatically check the weather every X minutes
and will deliver alerts, warnings and watches to the specified recipient or group!

Accepting HTTP Requests: Webdata API

PageGate has an HTTP data receiver (webdata.exe) that can receive input from nearly
any APl or protocol that offers an HTTP/S request like HTTP GET, HTTP POST and
WCTP.

This allows you to receive JSON, XML, HTML, WCTP and similar data submissions via
HTTP/S request. Received data doesn't need to conform to a single standard as it is fully
processed with the GetASCIl interface and, optionally depending on what you want to do
with the received data, Filter Pack.

If you want to receive multiple data formats, the Filter Pack isn't optional and you will need
to implement a filtering system to tell PageGate what to do with each format received.

The APlitself is a CGl executable named ‘webdata.exe’ that must be hosted on a web
server your sending systems can access.

In some cases, this lets you run lIS on the PageGate server for an intranet accessible API.

If you have something that can submit webforms or post information via HTTP/S, like ticket
tracking, records management, monitoring or other types of systems, this provides a way
for them to trigger messages in PageGate.

In other cases, you'll need to host the API's executable on your outward facing web server
to provide an internet accessible URL, then provide a UNC share path to the directory on
the web server where webdata.exe is hosted for PageGate to access.

If you're dealing with an internet or cloud based system, this provides a way for that system
to provide information to your PageGate server.

In more practical terms, the file webdata.exe is located in the PageGate program directory
and MUST be copied to the webserver hosting the API.
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If PageGate is not running on the web server hosting webdata.exe, you'll also need to
share the directory where webdata.exe is hosted on the web server and provide the UNC
filepath to PageGate’s GetASCllinterface.

The Webdata APl is only a receiver. All data received is ultimately processed by GetAscii
and potentially with assistance from the filter pack.

PageGate's Filter Pack opens up quite a few possibilities by allowing you to receive
multiple data types from a single or multiple sources but it also allows you to create
conditional logic for message processing.

As an example, you could configure a filter that changes who should receive an alert or
message based on keywords or keyphrases in the received data. For instance, you could
scan for the word lunch in the body of the message and direct it to the cafeteria group
instead of a general distribution group.

As another example, it is possible receive the WCTP protocol with this APl and you could
configure a filter that directs all replies from specific senders to a specified destination,
like an email distribution list, an SMS to administrators or any number of things.

You could configure a system where messages from a certain phone number or sender ID
will always be copied to certain recipients or groups.

One of the other benefits of the filter is that it can do everything described at the same
time. You aren’t limited in the type, style or number of filters you can apply to your server.

Step 1: Host webdata.exe on your web server

The first thing you'll need to do is host webdata.exe on your web server to provide the
return URL for your APl or WCTP host. The following steps are for IIS but this can be done
with any web server suite.

1) Copy webdata.exe from the PageGate program directory to your server's scripting
directory.

2) Open the IS Admin and select the server object.

3) Open Handler Mappings.

4) Right click CGl-exe, left click Edit Feature Permissions

5) Check Execute.

6) Click OK.
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7) Select the Server object again.
8) Open ISAPIand CGlI Restrictions.
9) Right click in the box and select Add.

10) Specify the following and click OK:
ISAPI or CGI path: Specify the location of webdata.exe

Description: PageGate API Handler

Check 'Allow extension path to execute'

Step 1a: Share the folder webdata.exe is hosted in
If PageGate is not running on the server hosting webdata.exe, you will need to share the
directory where webdata.exe is hosted to allow the GetASCll interface to parse data sent
to the receiver.

Step 2: Configure GetASCIl to process the received data
Each APl and protocol will have a unique structure to the data returned to your server and
you'll need to tell PageGate how to interpret the data and what to do with it in general.

To do that, you'll want to configure an 'Advanced Polling' rule:
1) Open PG Admin.

2) Expand Interfaces - GetAscii - Settings - Advanced Polling
3) Click Files.
4) Click Add.

5) Specify the following and click Apply:
Recipient: *

From: Leave Blank
File(s): *.asc

Path: The path to the folder webdata.exe is stored in on the web server.
Example: \WebServer01\pgscripts\

File Type: Custom
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NOTE: If you will be implementing a filtering system, you will do so at this point. For more
information, please see PageGate's Filter Script documentation.

6) Go to Interfaces - GetAscii - Settings - Advanced Polling - Record
7) Specify the following and click Apply:

Start Pattern: *

Start Offset: 0

End Pattern: ~
End Offset: 0

8) Go to Interfaces - GetAscii - Settings - Advanced Polling - Recipient. This section tells
PageGate where in the data to look for the recipient or group this reply should go to.

9) Select 'Dynamic Recipient' and configure the parameters.

For example, let's say you're working with the WCTP protocol and want to auto-respond to

the person who sent the message. In WCTP, you can key off of senderlD="Value".

As another example, let's say you're receiving an XML form and one of the tags will

determine who needs to receive the reply. You would key off of <XML Tag>Value</XML

Tag>.

Start Pattern: This value determines the first character in the recipient block.

For example, if you're working with WCTP and want to key off of senderlD="Value".
You would use senderlD=" as the Start Pattern.

As another example, if you're working with XML and want to key off of
<XML Tag>Value</XML Tag>. You would use <XML Tag> as the Start Pattern.

Start Offset: The number of characters in the start pattern.

End Pattern: This value determines the last character in the recipient block.

For example, if you're working with WCTP and are using senderID=" as the Start
Pattern, you would use " as the End Pattern.

As another example, if you're working with XML are using <XML Tag> as the Start
Pattern, you would use </XML Tag> as the End Pattern.

End Offset: The negative value of the number of characters in the End Pattern.
Examples: -1, -10, etc
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10) Go to Interfaces - GetAscii - Settings - Advanced Polling - Sender. This section tells
PageGate where in the data to look for the sender value.

11) For most implementations, you can select 'Static Sender' and specify a sender value.
However, if the sender's name will be contained in the data read, you can select
'Dynamic Sender' and parameters are configured similarly to the recipient section.

Start Pattern: This value determines the first character in the sender block.
For example, if you're working with WCTP and want to use the value in

senderlD="Value". You would use senderlD=" as the Start Pattern.

As another example, if you're working with XML and want to key off of
<XML Tag>Value</XML Tag>. You would use <XML Tag> as the Start Pattern.

Start Offset: The number of characters in the start pattern.

End Pattern: This value determines the last character in the sender block.

For example, if you're working with WCTP and are using senderID=" as the Start
Pattern, you would use " as the End Pattern.

As another example, if you're working with XML are using <XML Tag> as the Start
Pattern, you would use </XML Tag> as the End Pattern.

End Offset: The negative value of the number of characters in the End Pattern.

Examples: -1, -10, etc

12) Go to Interfaces - GetAscii - Settings - Advanced Polling - Message. This section tells
PageGate what in the data should be considered the message and also allows for
basic reformatting of messages.

13) Select 'Dynamic Message' and configure the parameters. If you want everything in the
received data to be considered the message, you would use a Start Pattern of * and an
End Pattern of ~.

Start Pattern: This value determines the first character in the message block.

For example, if you're working with WCTP and want to use the value in the
<wctp-Alphanumeric> tag, you would use <wctp-Alphanumeric> as the Start Pattern.

As another example, if you're working with XML and want to key off of
<XML Tag>Value</XML Tag>. You would use <XML Tag> as the Start Pattern.

Start Offset: The number of characters in the start pattern.
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End Pattern: This value determines the last character in the sender block.

For example, if you're working with WCTP and are using <wctp-Alphanumeric> as the
Start Pattern, you would use </wctp-Alphanumeric> as the End Pattern.

As another example, if you're working with XML are using <XML Tag> as the Start
Pattern, you would use </XML Tag> as the End Pattern.

End Offset: The negative value of the number of characters in the End Pattern.
Examples: -1, -10, etc

The lookup table enables PageGate to perform basic search and replace commands.
This allows you to interchange or translate values as needed.

To enable this feature, check Use Lookup Table and click Edit Table.

For more information, please see the lookup table section of the documentation.
Controlling Webdata's HTTP Responses

The HTTP response provided by the Webdata APl can be controlled and customized by
creating a file named 'response.txt' in the same directory on the web server where
'webdata.exe' resides.

If 'response.txt' does not exist, Webdata will provide a default response of:
content-type: text/html

status: 200

<html>

<body>

Y%Filename%

</body>

</html>

However, if your sending system requires a specific response or additional information,
you can provide its template in the 'response.txt' file.

For example, you can use the Webdata APIto host a very basic WCTP receiver by using
this as the response template:

<?xml version="1.0"?7>
<IDOCTYPE wctp-Operation
SYSTEM "http://dtd.wctp.org/wctp-dtd-vir1.dtd">
<wctp-Operation wctpVersion="wctp-dtd-v1r1" wctpToken="11AA">
<wctp-SubmitClientResponse>
<wctp-ClientSuccess
successCode="200"
successText="Message accepted for processing"

trackingNumber="%Fileindex%"
>
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Message accepted for processing
</wctp-ClientSuccess>
</wctp-SubmitClientResponse>
</wctp-Operation>

There are two variables that can be used in the Webdata API's response template.

Value Function

%Filename% | Outputs the name of the file created by submitting data to webdata.exe

Outputs the number of the relative-index kept by Webdata.

(o) H {0)
%oFileindex’e This number resets as data is processed and provides a somewhat

unique value for responses.

Example: Receiving Replies via EMAG WCTP

PageGate can be easily integrated with Verizon's Enterprise Messaging platform
(EMAG), which supports an enterprise WCTP gateway that supports one-way and two-
way messaging.

With one-way implementations, PageGate delivers SMS through the Verizon EMAG
WCTP gateway but no reply is expected and none is monitored for.

With two-way implementations, PageGate delivers SMS through the same gateway but
replies are expected. In order to provide those replies to you, the EMAG WCTP API
requires a reply address; somewhere to route the replies. PageGate's Webdata API
provides the ability to receive those replies and this APl must be hosted on an outward
facing web server as the reply URL provided to the EMAG WCTP APl must be internet
accessible.

You can then configure reply processing in a few ways:

e Static Recipient or Group
This is the most basic form of reply processing. All replies will be delivered to the

specified recipient or group.

¢ Reply processing with GetASCIl API Advanced Polling rules
if you own the GetASCII API, you can feed the reply information through that system for
advanced processing. This allows you to modify message content and who the replies
should go to but does not allow for conditional modification or conditional sending. For
example, you couldn't have the program scan the body of the message for a keyphrase,
then completely change who the message is intended to go to based on it. That would
require the PageGate Filter Pack.
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¢ Reply processing with the GetASCII APl and the PageGate Filter Pack

Reply messages can be fed through PageGate's Filter Pack to allow for conditional
sending. For instance, with the PageGate's filter pack, you can tell PageGate to
conditionally change who receives the message based on what the text in the reply is. As
an example, you could configure a filter system so that any time the word lunch shows up in
a reply message, that reply is sent to the cafeteria group instead of the general replies

group.

You could configure a system where replies from a certain phone number will always be
copied to certain recipients or groups.

You could configure a system where certain keywords or phrases are replaced with other
keywords or phrases. For example, you could translate a code like PD4N in to 4th
Precinct.

You could configure a system to describe every element I've just described all at once.

However, you must own and implement the Filter Pack to have the functionality necessary
to do conditional sending as described.

Step 1: Host webdata.exe on your web server

The first thing you'll need to do is host webdata.exe on your web server so you can provide
the return URL to the EMAG WCTP API. The following steps are for lIS but this can be
done with any web server suite.

1) Copy webdata.exe from the PageGate program directory to your server's scripting
directory.

2) Open the lIS Admin and select the server object.

3) Open Handler Mappings.

4) Right click CGl-exe, left click Edit Feature Permissions

5) Check Execute.

6) Click OK.

7) Select the Server object again.

8) Open ISAPIand CGlI Restrictions.

9) Right click in the box and select Add.

10) Specify the following and click OK:
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ISAPI or CGI path: Specify the location of webdata.exe
Description: PageGate API Handler

Check 'Allow extension path to execute'

Step 1a: Share the folder webdata.exe is hosted in
If PageGate is not running on the server hosting webdata.exe, you will need to share the
directory where webdata.exe is hosted to allow the GetASCll interface to parse data sent
to the receiver.

Step 2: Confiqure the EMAG WCTP API to send replies to Webdata
1) Log in to the EMAG web portal

)
2) Go to Connections - APIs
3) Edit your existing WCTP API connection.

4) Provide the URL to webdata.exe in the Return URL field.
Example: https://yourlPhere/pgscripts/webdata.exe

5) Apply the changes.

Static Recipient or Group

These are the steps on how to configure PageGate to deliver EMAG WCTP replies to a
static recipient or group.

Step 1: Configure GetASCIl to process the received data
WCTP has a unique structure to the data returned to your server and you'll need to tell
PageGate how to interpret the data and what to do with it in general.

To do that, you'll want to configure an 'Advanced Polling' rule for PageGate's GetASCII
interface:
1) Open PG Admin.

2) Expand Interfaces - GetAscii - Settings - Advanced Polling
3) Click Files.
4) Click Add.

5) Specify the following and click Apply:

Recipient: *

From: Leave Blank
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File(s): *.asc

Path: The path to the folder webdata.exe is stored in on the web server.
Example: \WebServer01\pgscripts\ or c:\inetpub\pgscripts\

File Type: Custom

NOTE: If you will be implementing a filter, you will do so at this point. For more information,
please see PageGate's Filter Script documentation.

6) Click Apply, then Apply again.
7) Go to Interfaces - GetAscii - Settings - Advanced Polling - Record

8) Specify the following and click Apply:
Start Pattern: *

Start Offset: 0

End Pattern: ~
End Offset: 0

9) Go to Interfaces - GetAscii - Settings - Advanced Polling - Recipient.

10) Select 'Static Recipient and specify the recipient or group the replies should go to.

11) Go to Interfaces - GetAscii - Settings - Advanced Polling - Sender. This section tells
PageGate where in the data to look for the sender value.

12) Select 'Static Sender' and specify a sender value.

13) Go to Interfaces - GetAscii - Settings - Advanced Polling - Message. This section tells
PageGate what in the data should be considered the message and also allows for
basic reformatting of messages.

14) Select 'Dynamic Message' and configure the parameters. If you want everything in the
received data to be considered the message, you would use a Start Pattern of * and an
End Pattern of ~.

Start Pattern: <wctp-Alphanumeric>

Start Offset: 19

End Pattern: </wctp-Alphanumeric>
End Offset: -20
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The lookup table enables PageGate to perform basic search and replace commands.
This allows you to interchange or translate values as needed.

To enable this feature, check Use Lookup Table and click Edit Table.

For more information, please see the lookup table section of the documentation.
Processing replies with GetAscii Advanced Polling

This is an example of how EMAG WCTP reply messages can be processed with the
GetASCIIAPI.

Step 1: Confiqure GetASCIl to process the received data
1) Open PG Admin.

2) Expand Interfaces - GetAscii - Settings - Advanced Polling
3) Click Files.
4) Click Add.

5) Specify the following and click Apply:
Recipient: *

From: Leave Blank
File(s): *.asc

Path: The path to the folder webdata.exe is stored in
on the web server.
Example: \WebServer01\pgscripts\

File Type: Custom

NOTE: If you will be implementing a filtering system, you will do so at this point. For more
information, please see PageGate's Filter Script documentation.

6) Go to Interfaces - GetAscii - Settings - Advanced Polling - Record

7) Specify the following and click Apply:

Start Pattern: *
Start Offset: 0
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End Pattern: ~
End Offset: 0

8) Go to Interfaces - GetAscii - Settings - Advanced Polling - Recipient. This section tells
PageGate where in the data to look for the recipient or group this reply should go to.

9) Select'Dynamic Recipient' and configure the parameters.

Start Pattern: This value determines the first character in the

recipient block.

Since we're working with WCTP, you could key off of
senderlD="Value" to auto-respond to the person that sent the
message.

You would use senderlD=" as the Start Pattern.
Start Offset: The number of characters in the start pattern: 10

End Pattern: This value determines the last character in the
recipient block.

Since we're working with WCTP and are using senderID=" as
the Start Pattern, you would use " as the End Pattern.

End Offset: The negative value of the number of characters in
the End Pattern: -1

10) Go to Interfaces - GetAscii - Settings - Advanced Polling - Sender. This section tells
PageGate where in the data to look for the sender value.

11) Select 'Static Sender' and specify a sender value.

12) Go to Interfaces - GetAscii - Settings - Advanced Polling - Message. This section tells
PageGate what in the data should be considered the message and also allows for
basic reformatting of messages.

13) Select 'Dynamic Message' and configure the parameters. If you want everything in the
received data to be considered the message, you would use a Start Pattern of * and an
End Pattern of ~ with both Offsets set to 0.

Start Pattern: <wctp-Alphanumeric>
Start Offset: 19

End Pattern: </wctp-Alphanumeric>
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End Offset: -20

The lookup table enables PageGate to perform basic search and replace commands.
This allows you to interchange or translate values as needed.

To enable this feature, check Use Lookup Table and click Edit Table.

For more information, please see the lookup table section of the documentation.
Processing replies with a Filter Pack

Note: PageGate's filter pack supports RegEx expressions, which can allow you to
implement an incredibly intricate system.

To say that there are many things you can do with a properly coded filter pack would be an
understatement. The Filter Pack allows you to modify and conditionally modify any part of
what it interacts with. It can reassign who a message is delivered to based on words or
phrases in a reply, it can modify the body of the message, it can modify the subject line, it
can insert pre-determined text and many other things.

For instance, with the filter pack, you can tell PageGate to conditionally change who
receives the message based on what the text in the reply is. As an example, you could
configure a filter system so that any time the word lunch shows up in a reply message, that
reply is sent to the cafeteria group instead of the general replies group.

You could configure a system where replies from a certain phone number will always be
copied to certain recipients or groups.

You could configure a system where certain keywords or phrases are replaced with other
keywords or phrases. For example, you could translate a code like PD4N in to 4th
Precinct.

You could configure a system to describe every element I've just described all at once, it's
just a matter of coding your filter pack to perform the actions you want.

Step 1: Confiqure GetASCII to process the received data
WCTP has a unique structure to the data returned to your server and you'll need to tell
PageGate how to interpret the data and what to do with it in general.

To do that, you'll want to configure an 'Advanced Polling' rule for PageGate's GetASCII
interface:
1) Open PG Admin.

2) Expand Interfaces - GetAscii - Settings - Advanced Polling
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3) Click Files.
4) Click Add.

5) Specify the following and click Apply:
Recipient: *

From: Leave Blank
File(s): *.asc

Path: The path to the folder webdata.exe is stored in
on the web server.
Example: \WebServer01\pgscripts\ or c:

\inetpub\pgscripts\

File Type: Custom

6) Click Apply, then Apply again.

NOTE: Since you will be implementing a filtering system, you will do so at this point. For
more information, please see PageGate's Filter Script documentation.

API Polling

With the HTTPGET and HTTPPOST protocols, you can poll information from any Web or
REST API that supports the GET or POST methods. That information can then be fed
through a filter pack to turnitin to a message to your recipients and groups.

For instance, if you have a web resource that provides XML content, you can configure
PageGate to poll for that XML content, then feed it through a filter pack to turn it in to a
readable text message.

As an example, you can poll the Spillman CAD API for information to dispatch for first
responders.

As another example, you can poll the National Weather Service for information on the
weather in your local area, then send that weather information out as an SMS to your
recipients and groups.
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Example: Spillman XML API
Note: This requires the GetASCII APl and the Filter Pack.

In this example, we're using a Powershell script to automatically poll the Spillman XML API
for information in real time, then parsing the collected data with PageGate's GetAscii
interface and a filtering system.

One key component of this implementation is understanding what you want done with the
data you get from CAD. Do you want every notification or call type to go to every district?
Should only certain agency codes receive messages? Understanding the answers to
questions like these is key to knowing whether you need to implement a filtering system.

Step 1: Create the script to poll the Spillman XML API

1) In Windows, create a new directory for the script to reside in.
Example: C:\PageGateData\sp-pg-ps\

2) Open your preferred text editor (Notepad, Wordpad, EditPad, NotePad++, etc)

3) Copy and paste the Spillman AP1Poller in to your new, blank document.

4) Modify $WorkingDir to reflect the path you created in step 1.
Example: $WorkingDir = "C:\PageGateData\sp-pg-ps\"

5) Modify $RequestUri to reflect the IP address and port of your Spillman XML API host.
Example: $RequestUri = "127.0.0.1:4081/DataExchange/REST"

6) Modify $APIRequest to reflect the information you want from Spillman. This API
Request will directly determine what information is requested from CAD.

The default request information from the CAD Active Call table and asks for Law, Fire and

EMS call types but NOT Miscellaneous call types.

Default Request:

<?xml version="1.0" encoding="UTF-8"?>

<PublicSafetyEnvelope version="1.0">

<From/>

<To/>

<Creation/>

<PublicSafety id="">

<Query>

<CADActiveCallTable>

<CallTypeLawFireEMS search_type="not_equal_to">m</CallTypeLawFireEMS>
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<CADMasterCallCommentsTable childField="LongTermCalllD"
parentField="LongTermCallD" />

</CADActiveCallTable>

</Query>

</PublicSafety>

</PublicSafetyEnvelope>

7) Modify $LogFile to reflect the path you created in step 1.
Example: $LogFile = "c:\PageGateData\sp-pg-ps\log.txt"

8) Save the file as pollspillman.ps1 in the directory you created in step 1.
Example: c:\PageGateData\sp-pg-ps\pollspillman.ps1

Step 2: Create an Eveng Log source for the script

1) Run Powershell as administrator.
2) Type the following and hit enter:
New-EventLog -LogName Application -Source "SpillmanXmlApiRequester"

3) Close Powershell.

Step 3: Create a Windows Service for the script

1) There are a few service manager utilities you could use but we recommend using
NSSM (https://nssm.cc/download). Unzip the nssm-verzion.zip file in to your script's
directory.

Example: c:\PageGateData\sp-pg-ps\nssm-2.24\

2) Open your preferred text editor (Notepad, Wordpad, EditPad, NotePad++, etc)

3) Copy and paste the Spillman to PageGate Service Installation Script in to your new,

blank document.

4) Modify $NssmPath to reflect the directory you unzipped NSSM to.
Example: $NssmPath = "c:\\PageGateData\sp-pg-ps\nssm-2.24\win64\"

5) Modify $PsPath to point to the pollspillman.ps1 script you created above.
Example: $PsPath = "c:\PageGateData\sp-pg-ps\pollspillman.ps1"

6) Save the file as install.ps1 in the directory the script resides in.
Example: c:\PageGateData\sp-pg-ps\

7) Run Powershell as administrator.

8) Change directory in to the folder the script resides in.
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Example: c:\PageGateData\sp-pg-ps\

9) Type the following and hit enter:
Ainstall.ps1

10) Close Powershell.

11) Open the Services list in Windows.

12) Go in to the properties of the Spillman-PageGate-PowerScript service.
13) Select the 'Log On' tab

14) Specify a service account with permission to run powershell scripts. A normal user
account is usually sufficient but this user must have logged in to Windows and run
Microsoft Edge or the Internet Explorer at least once.

15) Start the Spillman-PageGate-PowerScript service.

NOTE: To remove the script, use the Spillman to PageGate service removal script.

Step 4: Configure GetAscii

This part of the configuration will be determined by what you want to do with the data

retrieved from Spillman's API.

e Basic Implementation
In the most basic configuration, PageGate will match the value in <AgencyCode> to its

recipients and groups list, allowing any call to that agency to go through regardless of
incident type or nature code used.

¢ Implementation with filtering
With PageGate's filter pack, you have the ability to determine what dispatches should

trigger outbound messages by keying off of any data returned by the API.

Examples of what you can do with filtering:

¢ Specify which notification types an agency should receive

e Determine whether additional assets should be messaged based on address and
notification type

e Restrict certain notification types to only go to specific agencies or assets
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Spillman API Poller

Please contact NotePage Tech Support at 781-829-0500 x 2 or support@notepage.com
for access to the Spillman APl poller and its' related files
Implementing GetAscii for Spillman

Without filtering, PageGate will monitor all received information from the APl and dispatch
any message addressed to an agency code that exists as a recipient or group in
PageGate.

1) In Windows, create a directory for GetAscii to reference.
Example: c:\PageGateData\ASCIN
2) Run PG Admin.
3) Go to Interfaces - GetAscii - Settings
4) Set 'Polling Directory’ to the directory the script resides within. Example: c:
\PageGatedata\ASCIN
5) Check 'Enabled' and click Apply.
6) Select 'Yes'
7) Go to Interfaces - GetAscii - Settings - Advanced Polling - Files
8) Click Add
9) Specify the following and click Apply, then click Apply again.
Recipient: *
From: CAD
File(s): *.asc
Path: The path to your script.
Example: C:\PageGateData\sp-pg-ps\
File Type: Custom

10) Go to Interfaces - GetAscii - Settings - Advanced Polling - Record
11) Specify the following and click Apply

Start Pattern: *

Start Offset: 0

End Pattern: ~
End Offset: 0
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12) Go to Interfaces - GetAscii - Settings - Advanced Polling - Recipient
13) Select 'Dynamic Recipient', specify the following and click Apply
Start Pattern: <AgencyCode>
Start Offset: 12

End Pattern: </AgencyCode>
End Offset: -13

14) Go to Interfaces - GetAscii - Settings - Advanced Polling - Sender
15) Select 'Static Sender’, enter the name 'CAD' and click Apply
16) Go to Interfaces - GetAscii - Settings - Advanced Polling - Message
17) Specify the following and click Apply

Start Pattern: *

Start Offset: 0

End Pattern: ~
End Offset: 0
Implementing GetAscii and Filtering with Spillman

PageGate's filtering system allows you to do nearly anything you want with processed

traffic. In our example filter pack for Spillman, we provide examples for how to:

¢ Only allow an agency to be messaged for specific nature codes.

¢ Allow an agency to receive all nature codes.

e Determine whether additional assets should be messaged based on address and
notification type

¢ Restrict certain notification types to only go to specific agencies or assets

Step 1: Configure GetAscii

1) In Windows, create a directory for GetAscii to reference.
Example: c:\PageGateData\ASCIN

2) Run PG Admin.

3) Go to Interfaces - GetAscii - Settings
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4) Set 'Polling Directory’ to the directory the script resides within. Example: c:
\PageGatedata\ASCIN
5) Check 'Enabled' and click Apply.
6) Select 'Yes'
7) Go to Interfaces - GetAscii - Settings - Advanced Polling - Files
8) Click Add
9) Specify the following and click Apply, then click Apply again.
Recipient: *
From: CAD
File(s): *.asc
Path: The path to your script.
Example: C:\PageGateData\sp-pg-ps\
File Type: Standard

Step 2: Configure your filter(s)

PageGate's filtering system allows you to do nearly anything you want with processed

traffic. In our example filter pack for Spillman, we provide examples for how to:

¢ Only allow an agency to be messaged for specific nature codes.

¢ Allow an agency to receive all nature codes.

e Determine whether additional assets should be messaged based on address and
notification type

¢ Restrict certain notification types to only go to specific agencies or assets

Step 3: Implement your filter

1) In PG Admin, go to Interfaces - GetAscii - Template

2) Specify the following in the 'Settings' section:
RawlnterfaceFilter = The path to and file name of your script.
Example:

RawinterfaceFilter = c:\PageGateData\sp-pg-ps\pdfilter.xmi
3) Click Apply.
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Example Filter Pack for Spillman

<DebugFile>
<Active>
True
</Active>
<Name>
debug.txt
</Name>
</DebugFile>

<Filter>
<Comment>
Check to see if processed data is original CAD output
</Comment>
<Search>
<Section>
Recipient
</Section>
<Type>
Literal
</Type>
<Text>
fromcad
</Text>
</Search>
<Replace>
<Section>
Flag
</Section>
<Scope>
Section
</Scope>
<Text>
True
</Text>
</Replace>
</Filter>

<Filter>
<Comment>
abort if not original CAD output
</Comment>
<Search>
<Section>
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Flag
</Section>
<Type>
Literal
</Type>
<Text>
False
</Text>
</Search>
<Replace>
<Section>
Flag
</Section>
<Scope>
Section
</Scope>
<Text>
True
</Text>
</Replace>
<Abort>True</Abort>
</Filter>

<Filter>
<Comment>
set recipient to an invalid name so if there aren't any matches, the file won't
be
accepted by PageGate
</Comment>
<Search>
<Section>
Message
</Section>
<Type>
RegEx
</Type>
<Text>

</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
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<Scope>
Section
</Scope>
<Text>
nobody
</Text>
</Replace>
</Filter>
<Filter>
<Comment>

In this example, we want to restrict what notification types will trigger a
message to an agency. In this example, if the incident nature is AIRCRAFT EMERGE or
AIRCRAFT HIJACK or ARSON or BOMB THREAT or DROWNING or ESCAPE
PRISONER or EXPLOSION or FIRE CHEM SPILL or FIRE FUEL SPILL or FIRE
WILDLAND or FIRE STRUCTURE or GAS LEAK INSIDE or GAS LEAK OUTSID or
GUNSHOT WOUND or MUTUAL AID OUT or PURSUIT or RAILROAD INCIDE or
RESCUE or SCHOOL LOCKDOWN or SEARCH or SMOKE INVESTIGA or
UNATTENDED DEAT or WEATHER INCIDEN, the filter will dispatch the message to the
recipient or group referenced in the 'Text' section in the <Replace> statement.

</Comment>

<Search>

<Section>

Message
</Section>
<Type>

RegEx
</Type>
<Text>

(?s).*<IncidentNature>(AIRCRAFT EMERGE|AIRCRAFT HJACK|ARSON|BOMB
THREAT|DROWNINGIESCAPE PRISONER|EXPLOSION|FIRE CHEM SPILL|FIRE FUEL
SPILL|FIRE WILDLAND|FIRE STRUCTURE|GAS LEAK INSIDE|GAS LEAK OUTSID|
GUNSHOT WOUND|MUTUAL AID OUT|PURSUIT|RAILROAD INCIDE|IRESCUE]
SCHOOL LOCKDOWN|SEARCH|SMOKE INVESTIGA|UNATTENDED DEAT]|
WEATHER INCIDEN)<VIncidentNature>

</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
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Section
</Scope>
<Text>
ExampleRecipientOrGroup
</Text>
</Replace>
<WriteFile>
THE PATH TO YOUR SCRIPT'S FOLDER\%InputFileNameBase %-%
Filterindex%%InputFileNameExtension%
</WriteFile>
</Filter>

<Filter>
<Comment>
In this example, we want to make sure the "Search and Rescue" team is
ALWAYS messaged in addition to the original agency dispatched any time the call type is
'SEARCH' is used.
</Comment>
<Search>
<Section>
Message
</Section>
<Type>
RegEx
</Type>
<Text>

(?s).*<IncidentNature>SEARCH<VIncidentNature>

</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
YourSearchAndRescueRecipientOrGroup
</Text>
</Replace>
<WriteFile>
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THE PATH TO YOUR SCRIPT'S FOLDER\%InputFileNameBase%-%
Filterindex% %InputFileNameExtension%
</WriteFile>
</Filter>

<Filter>
<Comment>
In this example, we want to make sure the "Search and Rescue" team is
ALWAYS messaged in addition to the original agency dispatched any time the call type is
'RESCUE' is used.
</Comment>
<Search>
<Section>
Message
</Section>
<Type>
RegEx
</Type>
<Text>

(?s).*<IncidentNature>RESCUE<VIncidentNature>

</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
YourSearchAndRescueRecipientOrGroup
</Text>
</Replace>
<WriteFile>

THE PATH TO YOUR SCRIPT'S FOLDER\%InputFileNameBase %-%
Filterindex% %InputFileNameExtension%
</WriteFile>
</Filter>

<Filter>
<Comment>
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In this example, we're scanning the address for a specific value. If it finds
that value, the agency referenced should be messaged in addition to the original agency
dispatched. This can be used to dispatch additional resources when an event takes place
at a school, hospital or other specifically addressed location.

</Comment>

<Search>

<Section>

Message
</Section>
<Type>

RegEx
</Type>
<Text>

(?s).*<RespondToAddress>An Example Address<VRespondToAddress>

</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
ExampleRecipientOrGroup
</Text>
</Replace>
<WriteFile>
THE PATH TO YOUR SCRIPT'S FOLDER\%InputFileNameBase%-%
Filterindex%%InputFileNameExtension%
</WriteFile>
</Filter>

<Filter>
<Comment>
set recipient back to aninvalid name in case the above filter changed it
</Comment>
<Search>

<Section>
Message

</Section>

<Type>
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RegEx
</T ype>
<Text>

</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
nobody
</Text>
</Replace>
</Filter>

<Filter>
<Comment>
In this example, the specified agency should receive all call types.
</Comment>
<Search>
<Section>
Message
</Section>
<Type>
RegEx
</Type>
<Text>
<AgencyCode>ExampleAgencyCode</AgencyCode>
</Text>
</Search>

<Replace>

<Section>
Recipient

</Section>

<Scope>
Section

</Scope>

<Text>
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ExampleAgencyCode
</Text>
</Replace>

<Continue>
False
</Continue>
</Filter>

TCP Server Module

This interface allows PageGate to function as a TCP server to receive TCP packets from
a variety of sources. Messages received by this APl are output to a directory as a text file
that is then read in by the GetASCII API.

Step 1: Create a directory for the TCP Server

1) In Windows, create a new directory for the TCP Server. This can be any folder
accessible to PageGate, whether on the local hard drive or by UNC path to a network
resource. However, if PageGate will need to reference a network resource, the services
relevant to these processes will need permission to access it. For more information, see
the services section of the documentation. We recommend creating a directory called
TCP as a sub-directory of PageGate's database directory (By default, c:
\PageGateData\TCP\).

2) In Windows, browse in to the PageGate program directory.

3) Move the pgtcpserver.exe and pgtcp.ini files to the folder you created in step 1.

Step 2: Configure the TCP Server's settings

1) The first thing we'll need to do is modify the pgtcp.ini file. Open the file in notepad.

To give you a little more information, this INI file controls the behavior of the TCP Server. If
you are running the evaluation version, it will stop itself every 3-5 days, and/or after 500
messages, whichever comes first.

2) Configure the port the TCP server should listen to. By default, the port is set to 5002.

3) Change the OutputFolder= value to the directory you created in step 1. By default, C:
\PageGateData\TCP\

4) Change the LogFolder= value to your logging directory. If you are unsure of what this
folder is, open the PageGate Admin and go to the Program - Settings section. By defaul,
C:\PageGateData\Logs\
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5) Next, we'll need to set the end of record delimiter but let's go in to what that means first.
When the TCP Server is receiving information, it doesn't really know what in the data is
important; it's just receiving TCP packets of data. The end of record delimiter tells the TCP
server that the expressed series of characters denotes a break in the data stream.

For example, the TCP server could receive a series of 5 packets:
a) This is

b)a

c) test message #

d) This is a new

€) message

If you set EndOfRecordDelimiter = #, that tells the TCP server that everything before every
# received is a data block to be parsed.

Put another way, the end of record delimiter tells the TCP server how to break down the
information it's receiving in to processable chunks.

It's the "over" of a CB radio conversation.
5) Below that, there are RequiredText and RequiredTextOperator values that can be set.

RequiredText specifies text that must appear for a data block to be processed and you
may specify multiple values by separating each with a | (pipe).

The RequiredTextOperator specifies whether you're using OR or AND logic.

For example, let's say you specify the following:
RequiredText=alarm|notification
RequiredTextOperator=AND

That tells the TCP server that both the words alarm AND notification need to appear in a
received data block for that data block to be treated as a message to send.

As another example:
RequiredText=alarm|alert
RequiredTextOperator=OR

That tells the TCP server that either the words alarm or alert need to appear in a received
data block for that data block to be treated as a message to send.

6) Next we have EndOfRecordTimeout, whose value is expressed in milliseconds.

If data is received by the TCP server, but the EndOfRecordDelimiter isn't received within
the time specified, the data will be accepted for processing anyway.
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By default, this is set to 3000 milliseconds or 3 seconds.

7) RejectOnTimeout determines whether timeouts should post a rejection notice or not. By
default, this is set to true.

8) AcceptResponse determines what the TCP server will echo to the sending system upon
acceptance of a data block.

9) RejectResponse determines what the TCP server will echo to the sending system upon
rejection of a data block.

10) Last, we have two optional settings: StaticRecipient and StaticSender

StaticRecipient allows you to specify the name of a specific recipient or group in
PageGate that ALL traffic from the TCP server should be passed through.

StaticSender allows you to hard code a sender's name that should be associated with
ALL traffic from the TCP server.

11) Save the .ini file and close notepad.

Step 3: Run the TCP Server

1) Open a command prompt with elevated permission.

2) Change directory to the TCP Server's program directory. By default, c:
\PageGateData\TCP\

3) Type the following and hit enter:
pgtcpserver /install

4) Exit the command prompt.
5) Open the Services listin Windows.
6) Go in to the Properties of the PageGate TCP Server service.

7) Change the Startup Type to Automatic and Start the Service.

Step 4: Configure the GetASCII APIto process the TCP Server's messages

1) Go to Interfaces - GetASCII - Settings.
2) Set the 'Polling Directory' to the output folder. By default, C:\PageGateData\TCP\
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3) Check Enabled.

4) Click Apply.

5) Go to Program - Settings.

6) In the 'Run on this server' section, check GetASCI
7) Click Apply.

8) If prompted for credentials, leave them blank and click Apply again.

Note: If you are already using the GetASCIl module, you can use the Advanced Polling
Files section to specify the TCP Server's output folder as a secondary polling location. The
File(s) value will need to be set to *.asc and it is a Standard file type.

UDP Server Module

This interface allows PageGate to function as a UDP server to receive UDP packets from
a variety of sources. Messages received by this API are output to a directory as a text file
that is then read in by the GetASCII API.

Step 1: Create a directory for the UDP Server

1) In Windows, create a new directory for the UDP Server. This can be any folder
accessible to PageGate, whether on the local hard drive or by UNC path to a network
resource. However, if PageGate will need to reference a network resource, the services
relevant to these processes will need permission to access it. For more information, see
the services section of the documentation. We recommend creating a directory called
UDP as a sub-directory of PageGate's database directory (By default, c:
\PageGateData\UDP\).

2) In Windows, browse in to the PageGate program directory.

3) Move the pgudpserver.exe and pgudp.ini files to the folder you created in step 1.

Step 2: Configure the UDP Server's settings

1) The first thing we'll need to do is modify the pgudp.ini file. Open the file in notepad.
To give you a little more information, this INI file controls the behavior of the UDP Server. If
you are running the evaluation version, it will stop itself every 3-5 days, and/or after 500

messages, whichever comes first.

2) Configure the port the UDP server should listen to. By default, the port is set to 5002.
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3) Change the OutputFolder= value to the directory you created in step 1. By default, C:
\PageGateData\UDP\

4) Change the LogFolder= value to your logging directory. If you are unsure of what this
folder is, open the PageGate Admin and go to the Program - Settings section. By defaul,
C:\PageGateData\Logs\

5) Next, we'll need to set the end of record delimiter but let's go in to what that means first.
When the UDP Server is receiving information, it doesn't really know what in the data is
important; it's just receiving UDP packets of data. The end of record delimiter tells the
UDP server that the expressed series of characters denotes a break in the data stream.

For example, the UDP server could receive a series of 5 packets:
a) This is

b)a

c) test message #

d) This is a new

€) message

If you set EndOfRecordDelimiter = #, that tells the UDP server that everything before every
# received is a data block to be parsed.

Put another way, the end of record delimiter tells the UDP server how to break down the
information it's receiving in to processable chunks.

It's the "over" of a CB radio conversation.
5) Below that, there are RequiredText and RequiredTextOperator values that can be set.

RequiredText specifies text that must appear for a data block to be processed and you
may specify multiple values by separating each with a | (pipe).

The RequiredTextOperator specifies whether you're using OR or AND logic.
For example, let's say you specify the following:
RequiredText=alarm|notification

RequiredTextOperator=AND

That tells the UDP server that both the words alarm AND notification need to appearin a
received data block for that data block to be treated as a message to send.

As another example:
RequiredText=alarmjalert
RequiredTextOperator=OR
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That tells the UDP server that either the words alarm or alert need to appear in a received
data block for that data block to be treated as a message to send.

6) Next we have EndOfRecordTimeout, whose value is expressed in milliseconds. This
value tells the UDP server how long to wait before timeout after receiving data, to accept a
data record.

By default, this is set to 3000 milliseconds or 3 seconds.

7) RejectOnTimeout determines whether timeouts should post a rejection notice or not. By
default, this is set to true.

8) AcceptResponse determines what the UDP server will echo to the sending system
upon acceptance of a data block.

9) RejectResponse determines what the UDP server will echo to the sending system upon
rejection of a data block.

10) Last, we have two optional settins: StaticRecipient and StaticSender

StaticRecipient allows you to specify the name of a specific recipient or group in
PageGate that ALL traffic from the UDP server should be passed through.

StaticSender allows you to hard code a sender's name that should be associated with
ALL traffic from the UDP server.

11) Save the .ini file and close notepad.

Step 3: Run the UDP Server

1) Open a command prompt with elevated permission.

2) Change directory to the UDP Server's program directory. By default, c:
\PageGateData\UDP\

3) Type the following and hit enter:
pgudpserver /install

4) Exit the command prompt.
5) Open the Services listin Windows.

6) Go in to the Properties of the PageGate UDP Server service.
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7) Change the Startup Type to Automatic and Start the Service.

Step 4: Configure the GetASCII API to process the UDP Server's messages

1) Go to Interfaces - GetASCII - Settings.

2) Set the 'Polling Directory' to the output folder. By default, C:\PageGateData\UDP\
3) Check Enabled.

4) Click Apply.

5) Go to Program - Settings.

6) In the 'Run on this server' section, check GetASCI

7) Click Apply.

8) If prompted for credentials, leave them blank and click Apply again.

Note: If you are already using the GetASCIl module, you can use the Advanced Polling
Files section to specify the UDP Server's output folder as a secondary polling location.
The File(s) value will need to be setto *.asc and itis a Standard file type.

GetAscii Integration

The GetAscii API, also known as the Command Line/ASCIl interface, is capable of
monitoring a directory or series of directories on the local hard drive or across the network
for ascii file output and also provides a command line interface for other applications to
use. This module allows many 'off the shelf and custom applications, such as SolarWinds'
Network Performance Monitor, SolarWinds' Orion, Paessler's PRTG and several CAD
programs, among many others, to tell PageGate when a message needs to be sent.

GetAscii can accept messages from other applications in the following ways:
e Command Line

e ASCIl TextXML/HTML/JSON File

e Reqistry Polling

Click here for more information at the GetAscii section of the documentation.

You may also want to review the sections on:

e How to see if the GetAscii module is running
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e How to get a list of current PageGate Recipients and Groups

Command Line Integration

PageGate includes two executable files that can be run to pass messages into its
message queue: sendpage.exe and sendpage32.exe.

Sendpage.exe is a 16-bit program, and sendpage32 is a 32-bit program. Depending on
how the programs are to be called, you may need to use one or the other.

To use the executables, run them and provide the recipient, sender, and message
information as parameters on the command line.

Example:
sendpage32 Joe Brian Testing 123

That example would send a message to Joe from Brian with the message Testing 123.

These executables can be hosted in any directory, whether it is local to the PageGate
Server or a network directory. If you need to call the command line executables from
another location, please reference that path before the file name. For example, you would
use this as an example command to a network instance of the command line executable:

\\servername\directory\sendpage32.exe Joe Brian Testing 123
or you would use this command to a local instance of the command line executable:
c:\PageGateData\ASCI\sendpage32.exe Joe Brian Testing 123

Any time a command is issued to a command line executable, the CLE outputs a file in the
same directory that the GetAscii module will read in for data parsing.

Detailed information about the use of the sendpage programs can be found in the
GetAscii section (under Interfaces) of the documentation.
Text File Integration

GetAscii can extract message information from plaintext formatted ascii files, whether the
content in the file is HTML, XML, JSON or other form of plaintext.

GetAscii's basic polling module looks for text files with a predefined file format in a single
location. GetAscii also supports an advanced polling module, which enable GetAscii to
read files from multiple folders and from files that aren't in a standard format. GetAscii can
even 'watch' files for additions or changes, then extract message data from them.

Detailed information about the use of the GetAscii text file interface can be found in the
GetAscii section (under Interfaces) of the documentation.
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Registry Polling Integration

The GetAscii interface can accept messages that are passed to it via the Windows
registry. Messages written to a predefined location in the registry will be picked up by the
GetAscii interface. The application to be integrated with PageGate MUST be running on
the same computer as the GetAscii module to use this integration method.

To integrate using this method:
1) Open the Windows Registry Editor.

2) Browse to
HKEY_LOCAL_MACHINE\Software\Wow6432Node\NotePage\Transfer\Messages\
Note: In versions of Windows prior to Windows Vista and Windows Server 2008, the path

is HKEY_LOCAL_MACHINE\Software\NotePage\Transfer\Messages\

3) Create a new Key.

4) The name of the new key should be unique so it doesn't get overwritten by the next
message.

Under the new key, the following values should be created:

Name Type Value Description
Ready Dword 0 ﬁ;.)eciﬁes whether this message is ready to be read
To swing | Cusom o ahout receive s meseage.
From String Custom 'Ir:: Se;;rg.spemﬁes the Sender value for this
Message  String Custom ;'eri.entry specifies the text of the message to be

After all the values are written, set the 'Ready' value to one (1). This signals PageGate that
the entry is complete and can be read in. These new entries are automatically removed by
the GetAscii interface after they are read in.

How to see if GetAscii is active

Read the PageGate database file (pagegate.mdb)
The current location of the PageGate database can be read from the registry:
HKEY_LOCAL_MACHINE\Software\NotePage\TransfenDBDir
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Iltis in a format compatible with MS Access 2000. In the 'Control' table, the 'getascii_state'
field will be True if the GetAscii module is running.

Read the reqistry
The registry value HKEY_LOCAL_MACHINE\Software\NotePage\Transfer\Running will
have a value of 1 when GetAscii is running

Use the OpenEvent API call

When GetAscii starts, it creates a Windows event named 'NotePagelsRunning'. This
event is destroyed when GetAscii stops. The API call
OpenEvent(0,0,"NotePagelsRunning") will return a non-zero result if the GetAscii interface
iS running.

How to get a list of Recipients and Groups

Read the PageGate database file (pagegate.mdb)
The current location of the PageGate database can be read from the registry:
HKEY_LOCAL_MACHINE\Software\NotePage\TransfenDBDir

ltis in a format compatible with MS Access 2000. The 'Users' table has an entry for each
valid PageGate recipient and group.

Read the registry

The GetAscii interface keeps an up-to-date list of all the PageGate recipients and groups
in the Windows registry:
HKEY_LOCAL_MACHINE\Software\NotePage\Transfer\Recipients
HKEY_LOCAL_MACHINE\Software\NotePage\Transfer\Groups

Filter Pack

The filter pack is a scripting system that allows you to modify any input in to or output from
any of PageGate's interfaces based on nearly any criteria of your choosing.

Things you can do with the filtering system:
e Conditionally modify who a message is intended to go to based on key words or key

phrases.
e Allfire, rescue and accident calls should be dispatched but non-emergency calls

should not be.

¢ Only alarms with "CRITICAL" in them should be delivered.
Exam

oles: e Messages with the keyphrase "HAZARD" should go to a high priority group

instead of the normal distribution list.
¢ Replies with the word 'subscribe’ should perform one action but replies with the

word 'unsubscribe' should perform another.
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e Modify the contents or structure of data to turn it in to something more user-friendly and
readable.
¢ Pull content from an API (like the National Weather Service, a Ticket Tracking

Exam  System like Jira or ServiceNow, etc)

ples: e Parse XML, HTML, JSON or any other form of delimited text in to readable

message content

e Trigger a Powershell or other script.

¢ This allows you to have PageGate trigger other applications or processes by
tying them to a conditional filter in PageGate. Powershell is incredibly powerful
and with the right script, you could have PageGate execute functions that would
modify another application's database, perform network or domain lookup
functions or anything else made available by Powershell.

Descr
iption:

This is certainly not a comprehensive list of things you could do and, effectively, this filter
allows you to modify any input fed in to or output delivered from PageGate based on nearly
any selection criteria of your choosing.

Over the course of this documentation, we'll be going over how to configure, code and
implement PageGate's filtering system.

First, the filter scripts require the file 'pdfilter.exe’ to reside in the PageGate program
directory and will need to reference an XML file containing the script, which can reside in
any directory the PageGate server has access to (whether that's on the local hard drive or
on a network share via UNC path). You should receive all necessary files for the filtering
system upon purchase but if you do not have them, please contact our sales and
registration department at 781-829-0500 x 1 or by email at sales@notepage.com.

Second, it's important to understand the chain of events that triggers the script to run.

For more detailed information, please see: How to Implement the Script

As an important note, due to the way this script is programmed, certain characters are
treated as command characters instead of literal text characters. The following characters
represent certain command functions in the script:
Chara Function

cter

~ as first character means start of sectionffile, ~ as last character means end of
sectionffile. For example, ~123~ would only find 123 and not 01234 or 1237, etc.
~123 would find 12340 but would not find 01234. 123~ would find 0123 but would

not find 01234.
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? | Single character wildcard.
* | Multiple character wildcard.

IMPORTANT
ASCll value prefix (Ex: \013 for a carriage return, \010 for a line feed). The \ must
be followed by a three digit code to indicate the character to be output.

This character is used when you want to represent a character as represented by
its ASCII Decimal value. For example, since the filter directly references the
character ~ in its function, if you want to use the ~ character in your text, you'll need
to represent it with its ASCIl value. The ASCIl value of ~is: \126

Note: PageGate's filter script supports RegEx expressions, which can allow you to
implement an incredibly intricate system.
How to Implement the Script

Step 1: Copy the filter's executable in to the PageGate program directory
The file 'pdfilter.exe’ must reside in the PageGate program folder. If you do not have a
copy of this file, please contact our sales and registration department at
sales@notepage.com or by phone at 781-829-0500.

Step 2: Determine what you want filtered
Filter scripts are called through PageGate's template system and can be broken down in
to two categories: Inbound and Outbound

Inbound filters can trigger on and modify content passed to the program. These filters are
applied to the program's input interfaces and on a global level to effect all input interfaces.

Outbound filters can trigger on and modify messages delivered by the program. These
filters can be applied to a recipient, carrier, connector and on a global level.

You can have a system reference multiple filters for different purposes at the same time.

For example, you could configure an inbound filter to strip XML and JSON formatting from
received data as well as a global outbound filter that inserted a custom header before
every message. You could then make exceptions to that global rule by configuring unique
filters for a carrier, recipient or connector.

You could also configure an SMS reply processing system that filtered reply messages
containing certain keywords to specific recipients and groups while also implementing an
outbound filter to customize the contents or formatting of messages delivered to them.

You could do everything described all at once. It really is just a matter of determining what
you want to do, then implementing an appropriate solution.

Step 3: Write the filter
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Each filter exists as an XML file in a directory of your choosing; this directory just needs to

be accessible to the PageGate server, whether that's on the local hard drive or via UNC to
a network path. The XML file containing your filter may also be called anything you like, you
can give the file any name as long as its extension is .xml

Steps for writing filters can be found here.

Step 4: Reference the filter

After writing a filter, you'll need to add reference it in the 'Settings' section of a template in

PG Admin.

Inbound/Interface Filters

Value

Description

Example

InterfaceFil
ter

This applies a filter to processed data. This
allows the interfaces to apply the initial layer
of data sorting and collection and then
applies the filter to the result.

GetAscii
Standard polling: Filter is applied against

temp file with recipient, sender and message

Advanced polling: Filter is applied against
temp file with recipient, sender and message,
and after lookup substitution

GetMail

Filter is applied against temp file with
recipient, sender and message, after they
have been extracted from the email, and
decoding has taken place

GetSerial

Filter is applied against temp file with
recipient, sender and message, and after
lookup substitution

GetTap
Filter is applied against each message that is

received. The file processed by PGFilter will
have Id as first line, second line blank, and
message on remaining lines.

GetWeb

InterfaceFilter = c:
\PageGateData\Filters\yourfilter
Xxml
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Filter is applied against temp file with
recipient, sender and message

This can be used on an interface or global
level. If used in an interface, it applies the filter
to that interface. If used on a global level, it
applies the filter to all input from all interfaces.

RawiInterfa
ceFilter

This applies a filter to raw, unprocessed data.
This applies the filter before the interface has
a chance to read the data. The specific
behavior varies depending on the interface in
question.

GetAscii
Standard polling: Filter is applied against the

raw text file before GetAscii tries to process it

Advanced polling: Filter is applied against
each record that is found, before it is
processed any further (record pattern
matching done first)

GetMail

Filter is applied against the raw file received
from the PageGate mail server process. All
headers are intact and no decoding has
taken place yet. Envelope values for recipient
and sender are not available for modification
in the raw mail file (because they are read
from the envelope).

GetSerial

Filter is applied against each record found
before itis processed any further (record
pattern matching is done first)

GetTap
Filter is applied against each message that is

received.

GetWeb
Filter is applied against raw text file created
by webgate.exe CGIl program

RawinterfaceFilter = c:
\PageGateData\Filters\yourfilter
Xxml

Chapter 2 How PageGate Accepts Messages

64



How PageGate Accepts Messages 2

This can be used on an interface or global
level. If used in aninterface, it applies the filter
to that interface. If used on a global level, it

applies the filter to all input from all interfaces.

Outbound Filters
Value Description Example

This applies a filter to outbound messages.
This can be applied on a recipient, carrier,
connector or global level.

If used in a recipient template, all messages

delivered to that recipient will be processed ConnectorFilter = c:

Filter |through the filter. \PageGateData\Filters\yourfilten
If used in a carrier template, all messages xml

delivered through that carrier will be
processed through the filter.
If used in the program template, it applies to

all output from the program.

This applies a filter to the messages
delivered by a connector. This filter can only
modify the contents of a message and cannot
modify the recipient or sender information.

Filter = c:
Connector ,
Fiter | This can be applied on a connector or global \PalgeGateData\FlIters\yourﬁlter
XM
level.

If used in the program template, it applies to

all connectors in the program.

This applies a filter to the subject line of any
outbound email. This value is only referenced
by the SMTP protocol and is not referenced

by other protocols. SubjectFilter = c:

\PageGateData\Filters\yourfilter
xml

SubjectFilt
er This can be applied on a recipient, carrier,

connector or global level.

If used in a recipient template, all
SMTP/email messages delivered to that
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recipient will have their subject lines
processed through the filter.

If used in a recipient template, all
SMTP/email messages delivered to through
that SMTP/email carrier will have their subject]
lines processed through the filter.

If used in the program template, all
SMTP/email traffic sent from the system will
have its subject line processed through the
filter.

Hierarchy
An Interface (and Global) template can have both a RawlnterfaceFilter and an

InterfaceFilter. Both filters will run in that order if they are both set.

Connectors will run any outbound filter according to which template has the highest priority.
In order, they are:

1) Recipient
2) Carrier

3) Connector
4) Global

After implementing a filter script, it is highly recommend that you go through a debugging
process to verify what you've configured. See Debugging the Script for more information.
Debugging the Script

To debug the filter script, you'll first need to set the Debug tag to true.

By setting Debug to True, that puts the script in to debugging mode. When in debugging
mode, the script will display a window that shows the result of every component of your
filter. It will display whether the filter performed its functions successfully or if there was an
error and, if there was an error, what the error was related to. For example, "Match not
found" in the event that your search criteria couldn't be found.

This makes tracking down errors in the script much easier than it otherwise would be.

If you're using preproc.bat, rename it to preprocv.bat

If you're using pstproc.bat, rename it to pstprocv.bat

The vin the file name stands for Verbose, so you're effectively putting the scriptinto a
mode that will display far more information on the screen.
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The Filter Script

Filters can be simple or complex depending on what you want to do. The most basic filters
are search and replace functions, where you remove specific patterns like XML tags from
text or replace short-codes with more verbose information. The more advanced filters can
conditionally modify who receives a message, what the message says and execute
functions via batch file or Powershell script, among other things.

The filters themselves are written in XML and, to start, you may want to look at the
complete filter script template. That will give you a general overview of each section and all
of the possible values you could use in them.

To break things down, there is one major section, Filter, that determines what each section
of the script will do. Additionally, there are two conditional sections, InputFile and
OutputFile, plus an optional debugging mode:

o Filter

The Filter section determines what you want to do with the data read as input. A single
filter script may reference multiple individual <Filter> sections to perform multiple tasks
within the same data set. It's also important to note that the filter system supports the use
of Regex, allowing for a high level of customization and control.

e InputFile

Most scripts will not need this parameter. When using the filter system in conjunction with
the GetAscii interface or a FILE protocol carrier, the InputFile section determines which
file(s) you want the filter to scan.

e OutputFile

Most scripts will not need this parameter. When using the filter system in conjunction with
the GetAscii interface or a FILE protocol carrier, the OutputFile section determines what
you want to name the files output by the filter's modifications.

e Debug

The Debug section determines whether you want a debug level review of the filter to
appear before the filter completes its actions. This is incredibly useful when first
configuring a script and we recommend that this flag be enabled until the filter is ready to
put in to production.

For most scripts, you'll want to start with the Filter section.
The Complete Filter Script Template

Note: The InputFile and OutputFile sections are not required for most scripts. For more
information, please see The Filter Script.

<InputFile>
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<Name>
(Parameter), static input filename
</Name>
<Delete>
True, (False) - deletes the Input File, even if <Abort> is used
</Delete>
</InputFile>
<OutputFile> - not used if the .dll version of the filter is running the script
<Name>
(InputFile), static output filename
</Name>
</OutputFile>
<Debug>
<Console>
<Active>
True, (False)
</Active>
</Console>
<File>
<Active>
True, (False)
</Active>
<Name>
debug log filename
</Name>
<Append>
True, (False) - appends to existing file instead of recreating it
</Append>
</File>
<LogInputFile>
True, (False)
</LoglnputFile>
<LogOutputFile>
True, (False)
</LogOutputFile>
</Debug>
<Filter>*
<Comment>
optional comment text that will be shown in debug output
</Comment>
<FilterName>
If you are using the <Goto> tag for looping, then the filter you want
to jump back to must have a name
</FilterName>
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<Lookup> - if the Lookup section is included, no other sections are processed (i.e.
<MatchFound> and <MatchNotFound> are not run
<Variable>
(All), Recipient, Sender, Message, Temp1-10
</Variable>
<CaseSensitive>
True, (False)
</CaseSensitive>
<SpaceSensitive>
True, (False) - If False, leading and trailing spaces are ignored
(otherwise they need to match exactly)
</SpaceSensitive>
<List>
A list of comma separated values - one per line
or a filename that contains the list
If the text in the <Variable> text matches the first value of a pair in the
list,
the second value in the pair is substituted for it
Multiple values can be included in the first value by separating them
with | symbols
Values can be quoted - if so use two quotes in a row ("") to include
a single quote in the value's text
if no match is found, and the last pair in the list have a * for it's first
value, then this will be used as a default value
Comments: any line of text with a pound sign (#) as the very first

character
(no leading spaces or tabs) will be considered a comment,
and ignored.
</List>
</Lookup>
<Search>
<Type>
(Literal), RegEx, GreaterThan, LessThan - for GreaterThan and
LessThan, <Variable> is GreatherThan/LessThan <Text> </Type>
<Variable>
(All), Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Text>*
search text, True, False
must be quoted to retain beginning and/or ending whitespace
</Text>
</Search>

<MatchFound> - if you don't include a <Search> section,
<Replace> - multiple Replace sections are allowed
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<Type>
(Literal), RegEx, And, Or - And/Or sets Flag equal to Flag
And/Or <Text>
</Type>
<Variable>
(All), Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Scope>
(Match), Entire - replace only the matched text, or the entire
variable's contents
</Scope>
<ReplaceAll>
True, (False) - replaces all matches in the variable
</ReplaceAll>
<Text>*
replacement text, True, False
must be quoted to retain beginning and/or ending whitespace

<[Text>
</Replace>
<WriteFile>
<Name>*
if match found, filename to save to - most macros are valid
</Name>
<Variable>
(All), Recipient, Sender, Message, Temp1-10
</Variable>
</WriteFile>
<Run>
<Command>*
run this command (no spaces in folders or filenames)
</Command>
<Async>
(True), False - if true, the filter continues immediately, if false it
waits for
the program it started to finish
</Async>
<Show> - true give the program a window to run in, false hides the
program
True, (False)
</Show>
</Run>
<RunFilter>

<SettingsFile>*
path and name of new filter settings file
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</SettingsFile>
<Variable>
(), All, Recipient, Sender, Message, Temp1-10
name of the variable that holds the text to be sent to the filter
*if Variable is used (and not empty), the InputFile value is
ignored
</Variable>
<InputFile>
path and name of input file - ignored if Variable section is set
</InputFile>
<DebugFile>
path and name of debug file
</DebugFile>
<AppendDebug>
True, (False)
</AppendDebug>
<UseDII>
True, False - if pdfilter.dll is running, then default value is True,
otherwise itis False
</UseDII>
</RunFilter>
<ReadFile>
<Name>*
if match found, filename to read - most macros are valid
</Name>
<Variable>
(All), Recipient, Sender, Message, Temp1-10
</Variable>
<Delete>
True, (False) - delete the file after reading it
</Delete>
</ReadFile>
<Goto>
Name of filter to jump to - *** be careful not to make infinite loops
</Goto>
<Abort>
True, (False) - exit without writing to the Output File (which is the Input
File by default)
</Abort>
<Continue>
(True), False - whether or not to continue processing the next filter
block
</Continue>
<MatchFound>
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<MatchNotFound> - this section is always run if there is no <Search> section
<Replace> - multiple Replace sections are allowed
<Type>
(Literal), And, Or - And/Or sets Flag to Flag And/Or
replacement Text
</Type>
<Variable>
(All), Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Text>*
replacement text, True, False
must be quoted to retain beginning and/or ending whitespace

</Text>
</Replace>
<WriteFile>
<Name>*
if match found, filename to save to - most macros are valid
</Name>
<Variable>
(All), Recipient, Sender, Message, Temp1-10
</Variable>
</WriteFile>
<Run>
<Command>*
run this command (no spaces in folders or filenames)
</Command>
<Async>
(True), False - if true, the filter continues immediately, if false it
waits for
the program it started to finish
</Async>
<Show> - true give the program a window to run in, false hides the
program
True, (False)
</Show>
</Run>
<RunFilter>

<SettingsFile>*
path and name of new filter settings file
</SettingsFile>
<Variable>
(), All, Recipient, Sender, Message, Temp1-10
name of the variable that holds the text to be sent to the filter
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*if Variable is used (and not empty), the InputFile value is
ignored
</Variable>
<InputFile>
path and name of input file - ignored if Variable section is set
</InputFile>
<DebugFile>
path and name of debug file
</DebugFile>
<AppendDebug>
True, (False)
</AppendDebug>
<UseDII>
True, False - if pdfilter.dll is running, then default value is True,
otherwise itis False
</UseDII>
</RunFilter>
<ReadFile>
<Name>*
if match found, filename to read - most macros are valid
</Name>
<Variable>
(All), Recipient, Sender, Message, Temp1-10
</Variable>
<Delete>
True, (False) - delete the file after reading it
</Delete>
</ReadFile>
<Goto>
Name of filter to jump back to - be careful not to make infinite loops
</Goto>
<Abort>
True, (False) - exit without writing to the Output File (which is the Input
File by default)

</Abort>
<Continue>
(True), False - whether or not to continue processing the next filter

block

</Continue>

<MatchNotFound>

</Filter>
<Filter>...
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Notes:

Sections with * are required
Values in () are default values if section is not present

The first commandline parameter is the name of the InputFile to be processed
If an <InputFile><Name> section is used, its value overrides the commandline

parameter value

The default settings file name is pdfilter.xml
The settings file name can be set by using settingsfile= as a parameter on
the commandline. The input file name would then be the next parameter

The debug file name can be set by using debugfile= as a parameter on
the commandline. The input file name would then be the next parameter

By default, when writing debug info to a file, the file is recreated each time
Using the commandline parameter debugappend=true will append to the file

instead

* WARNING *** don't leave debugappend set for long periods, because the file
will keep growing forever

OutputFile, ReadFile, WriteFile support variables (in addition to the normal ones):
Y%InputFilePathAndName%
%InputFilePath%
Y%InputFileName%
%InputFileNameBase %
Y%InputFileNameExtension%
%Filterindex%

Section values for Recipient, Sender, Message, and All really just mean:
Recipient: first line of text,
Sender: second line of text,
Message: third and remaining lines of text
All: the entire contents of the file

Literal search text special characters:
~ as first character means the start of the variable's contents
~ as last character means the end of variable's contents
? matches a single character
* matches anything (including nothing)
\ following 3 digits are a decimal character value
the ~, ?, *, and \ characters must use \ with decimal equivalent to be used

literally

Chapter 2 How PageGate Accepts Messages

74



How PageGate Accepts Messages 2

RegEx replacement:
Backreferences are allowed in replacement text (i.e. \1\2\3 ...)
\r, \n, and \### (3 digits) literals are supported for inserting CR, LF, and
ASCII

Literal search text variables
%Recipient% - the current value for Recipient
%Sender% - the current value for Sender
%Message% - the current value for Message
%All% - the current value for All of the text
%Temp1-10% - the current value for that Temp variable
\ following 3 digits are a decimal character value

Literal replacement text variables:

%Recipient% - the current value for Recipient

%Sender% - the current value for Sender

%Message% - the current value for Message

%All% - the current value for All of the text

%Match% - the actual text that matched the search text (Literal or RegEx
match types)

%Group1-10% - RegEx group backreferences obtained from a RegEx
search

%Temp1-10% - the current value for that Temp variable

%InputFileName% - the name of the input file being processed

%Year%, %Month%, %Day%, %MHour%, %Hour%, %Minute%, %Second
%, %MSecond%, %AMPM%

%Unique % - unique number - guaranteed unique to the computer - pretty
unique otherwise

\ following 3 digits are a decimal character value

Functions:
Format is %FunctionName(input-value)% - it will be replaced with the
function's output value
%DateTimeToUnixTime()%

The default value of the Temp1-10 variables are an empty string
The default value of the Flag variable is false

Comments: The <Comment> section can be used in each <Filter> and it will b
output
in the debug log, or any line of text with a pound sign (#) as the very first
character (no leading spaces or tabs) will be considered a comment, and
ignored,
and also not logged
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The Recipient, Sender, Message and ALL variables are dynamically linked
together. So, for
example, if you change the Sender, the first line of All will also be updated.
Changing
All will update the Recipient, Sender and Message parts

When the order of things matter:
<Filter> block are executed in the order they appear (unless <Goto> is used)
In a <Filter> block:
<Search> (if it exists) runs first and determines if the <MatchFound>
or <MatchNotFound> block is run
<Replace> <WriteFile> <Run> <RunFilter> <ReadFile> <GoTo>
<Abort> <Continue> run in that order
There can be multiple <Replace> <WriteFile> <Run> <RunFilter>
<ReadFile> blocks and they will run
in the order they appear - i.e. all <Replace> blocks will run,
then all <WriteFile> blocks, etc.

RegEx uses a Pearl compatible implementation syntax
good reference: http://www.regular-expressions.info/tutorialcnt.html

Breaking changes

<Section></Section> is renamed to <Variable></Variable>

In the <Replace> section the <All></All> tag has been renamed to
<ReplaceAll></ReplaceAll>

In the <Replace> <Scope> section the value: 'Section' is renamed to 'Entire’

All exiting <Replace> section have to be surrounded with <MatchFound></MatchFound>
tags

Recipient, Sender, Message and All are new dynamically linked together

Bare Filter Template - for easier cuttting/pasting
* in sections with multiple value options, the firstin the list is the default value

<InputFile>
<Name>
Parameter
</Name>
<Delete>
False, True
</Delete>
</InputFile>
<OutputFile>
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<Name>
InputFile
</Name>
</OutputFile>
<Debug>
<Console>
<Active>
False, True
</Active>
</Console>
<File>
<Active>
False, True
</Active>
<Name>

</Name>
<Append>
False, True
</Append>
</File>
<LoglnputFile>
False, True
</LoglnputFile>
<LogOutputFile>
False, True
</LogOutputFile>
</Debug>
<Filter>
<Comment>

</Comment>
<FilterName>

</FilterName>
<Lookup>
<Variable>
All, Recipient, Sender, Message, Temp1-10
</Variable>
<CaseSensitive>
False, True
</CaseSensitive>
<SpaceSensitive>
False, True
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</SpaceSensitive>
<List>

</List>
</Lookup>
<Search>
<Type>
Literal, RegEx, GreaterThan, LessThan
</Type>
<Variable>

All, Recipient, Sender, Message, Temp1-10, Flag

</VVariable>
<Text>

</Text>
</Search>
<MatchFound>
<Replace>
<Type>
Literal, RegEx, And, Or
</Type>
<Variable>

All, Recipient, Sender, Message, Temp1-10, Flag

</Variable>
<Scope>

Match, Entire
</Scope>
<ReplaceAll>

False, True
</ReplaceAll>
<Text>

</Text>
</Replace>
<WriteFile>

<Name>

</Name>
<Variable>

All, Recipient, Sender, Message, Temp1-10, Flag

</Variable>
</WriteFile>
<Run>
<Command>
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</Command>
<Async>
True, False
</Async>
<Show>
False, True
</Show>
</Run>
<RunFilter>
<SettingsFile>

</SettingsFile>
<Variable>
, All, Recipient, Sender, Message, Temp1-10
</Variable>
<InputFile>

</InputFile>
<DebugFile>

</DebugFile>
<AppendDebug>
False, True
</AppendDebug>
<UseDlI>
True, False
</UseDII>
</RunFilter>
<ReadFile>
<Name>

</Name>
<Variable>
All, Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Delete>
False, True
</Delete>
</ReadFile>
<Goto>

</Goto>
<Abort>
False, True
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</Abort>
<Continue>
True, False
</Continue>
<MatchFound>
<MatchNotFound>
<Replace>
<Type>
Literal, And, Or
</Type>
<Variable>
All, Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Text>
</Text>
</Replace>
<WriteFile>
<Name>
</Name>
<Variable>
All
</Variable>
</WriteFile>
<Run>
<Command>
</Command>
<Async>
True, False
</Async>
<Show>
False, True
</Show>
</Run>
<RunFilter>

<SettingsFile>

</SettingsFile>
<Variable>
, All, Recipient, Sender, Message, Temp1-10
</Variable>
<InputFile>
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</InputFile>
<DebugFile>

</DebugFile>
<AppendDebug>
False, True
</AppendDebug>
<UseDII>
True, False
</UseDlII>
</RunFilter>
<ReadFile>
<Name>

</Name>
<Variable>
All, Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Delete>
False, True
</Delete>
</ReadFile>
<Goto>

</Goto>
<Abort>
False, True
</Abort>
<Continue>
True, False
</Continue>
<MatchNotFound>
</Filter>

Filter

The Filter section determines what you want to do with the data read as input. A single
filter script may reference multiple individual <Filter> sections to perform multiple tasks
within the same data set. You can also find filter statement examples here and complete
script examples here.

<Filter>
<Search>
See Search section
</Search>
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<Replace>

See Replace section.

</Replace>
<Continue>

See Values and Description

</Continue>

<Abort>
See Values and Description
</Abort>
</Filter>
Flag Values and Description

Search

Please review the Search section for a detailed explanation of this tag and
its components.

Replace

Please review the Replace section for a detailed explanation of this tag and
its components.

Continue

This tag determines whether or not you want the script to continue to the
next action if it finds a match. This tag can be set to a value of True or
False.

For example, let's say we're searching for the text 345 within the input file's
data. Let's also say that no match for 345 can be found in the input data.

If Continue is set to True, the filter will move to the next specified <Filter>
section. If Continue is set to False, the script willimmediately terminate
upon not finding a match.

Abort

If the search section finds a match and Abort has a value of True, the script
is aborted. Basically, the input data is left unchanged and no more filter
blocks are processed. It just abruptly ends the filter processing and quits
out without saving anything.

As an important note, due to the way this script is programmed, certain characters are
treated as command characters instead of literal text characters. The following characters
represent certain command functions in the script:

Chara
cter

Function

~ as first character means start of sectionffile, ~ as last character means end of
section/file. For example, ~123~ would only find 123 and not 01234 or 1237, etc.
~123 would find 12340 but would not find 01234. 123~ would find 0123 but would
not find 01234.

? | Single character wildcard.

Multiple character wildcard.

IMPORTANT
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ASClIvalue prefix (Ex: \013 for a carriage return, \010 for a line feed). The \ must
be followed by a three digit code to indicate the character to be output.

This character is used when you want to represent a character as represented by
its ASCIl Decimal value. For example, since the filter directly references the

character ~ in its function, if you want to use the ~ character in your text, you'll need
to represent it with its ascii value. The ascii value of ~ is \126.

Search

The Search section determines what you want the filter to look for.

<Search>
<Section>

See Values and Description

</Section>
<Type>

See Values and Description

</T ype>
<Text>

See Values and Description

</Text>
</Search>

Flag

Values and Description

This tag determines where the filter should look for the data specified in thel
Text tag (see below).

Value
s

Explanation

All

All tells the filter to search the entire data set read from the input file.

Recipi
ent

Recipient tells the filter to search only in the first line of the file.

Sende
Section r

Sender tells the filter to search only in the second line of the file.

Messa
ge

Message tells the filter to search only in the third and following lines of
the file.

Temp

Temp is a string variable that can be passed strings of characters to
hold, then use its value to search on later. Temp does not support
boolean operators. For example, you can have certain information
stored in the Temp value, then both search on and output that Temp
value in successive Filter tags. See Example 1 and Example 3.

Flag

Flag is a boolean value that can only hold a true or false statement,
However, you can run "And" or "Or" statements against it for
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| | advanced logic chains. See Example 1 and Example 3.
Values: Literal or RegEx
Type This tag determines whether you want to use literal text or a RegEx statement
in the Text tag.
If the Type tag is set to Literal, this tells the filter to search on the text entered in
to the Text tag. For example, you could enter the literal text Fire Department if
you wanted the filter to key off of the literal text "Fire Department" (without the|
quotes).
This tag supports the following boolean parameters:
* - Multiple Character Wildcard
For example, fire* would find fire, firewood, fireplace, fireman and similar.
? - Single Character Wildcard
For example, fire? would fine fires, fired but would not find fire.
Text
(Literal)| ~ as first character means start of section/file
~ as last character means end of section/file
For example, ~12345~ would only read 12345. Without the ~ before and after
the string, the filter would recognize 12345 in 0123456.
This tag also supports the following variables:
%Recipient% - the current value for Recipient
%Sender% - the current value for Sender
%Message% - the current value for Message
%All% - the current value for All of the text
%Temp% - the current value for the Temp variable
\ - following 3 digits are a decimal character value. See Below.
The PageGate Filter script supports RegEx expressions. RegEx uses a Pear
Text compatible implementation syntax and a good reference guide for the
(Regex)| language can be found here:
http://www.regular-expressions.info/tutorialcnt.html

As an important note, due to the way this script is programmed, certain characters are
treated as command characters instead of literal text characters. The following characters
represent certain command functions in the script:

Chara
cter

Function

~ as first character means start of section/file, ~ as last character means end of
sectionffile. For example, ~123~ would only find 123 and not 01234 or 1237, etc.
~123 would find 12340 but would not find 01234. 123~ would find 0123 but would
not find 01234.
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? | Single character wildcard.
* | Multiple character wildcard.

IMPORTANT
ASCll value prefix (Ex: \013 for a carriage return, \010 for a line feed). The \ must
be followed by a three digit code to indicate the character to be output.

This character is used when you want to represent a character as represented by
its ASCII Decimal value. For example, since the filter directly references the
character ~ in its function, if you want to use the ~ character in your text, you'll need
to represent it with its ascii value. The ascii value of ~ is \126.

Replace

The Replace section determines what you want to do with the data found in the Search
section.

<Replace>
<Section>
See Values and Description
</Section>
<Type>
See Values and Description
</Type>
<Scope>
See Values and Description
</Scope>
<All>
See Values and Description
</All>
<Text>
replacement text goes here
must be quoted to retain beginning and/or ending whitespace
See Values and Description
</Text>
</Replace>

Flag Values and Description
Values: All, Recipient, Sender, Message, Temp, Flag

This tag determines which section the filter perform the replacement within.

Secti| |value Explanation
on All tells the filter to replace any instance of the searched text within the
All . .
entire data set read from the input file.
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Recipi
ent
Sende
r
Mess| Message tells the filter to replace values only in the third and following

age | lines of the file.
Temp is a string variable that can be passed strings of characters to
hold, then use its value to search on later. Temp does not support
Temp| boolean operators. For example, you can have certain information storedj
in the Temp value, then both search on and output that Temp value in
successive Filter tags.
Flag is a boolean value that can only hold a true or false statement.
Flag | However, you canrun"And" or "Or" statements against it for advanced
logic chains.

Recipient tells the filter to replace values only in the first line of the file.

Sender tells the filter to replace values only in the second line of the file.

Values: Literal, RegEx, And, Or

This tag determines whether you want to use literal text or a RegEx statement in
the Text tag. This tag can also be used as a situational boolean operator to
determine how to proceed.

Type
The boolean values (Or & And) modify the Flag value. So, for example, you could
have the filter search for a value and set it as the Flag, then have the replace filter
use "Or" to indicate that the Flag value may be more than one thing. You could
also use the And operator to tell the filter that the Flag value must contain multiple
variables to be matched. See Example 1 and Example 3.
Sceop Values: Match or Section
All | Values: True or False
If the Type tag is set to Literal, this tells the filter to search on the text entered in to
the Text tag. For example, you could enter the literal text Fire Department if you
wanted the filter to key off of the literal text "Fire Department" (without the quotes).
This tag supports the following boolean parameters:
Text| *-Multiple Character Wildcard
(Liter| For example, fire* would find fire, firewood, fireplace, fireman and similar.
al)

? - Single Character Wildcard
For example, fire? would fine fires, fired but would not find fire.

~ as first character means start of section/file
~ as last character means end of sectionffile
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For example, ~12345~ would only read 12345. Without the ~ before and after the
string, the filter would recognize 12345 in 0123456.

Text
(Reg

ex)

The PageGate Filter script supports RegEx expressions. RegEx uses a Pearl
compatible implementation syntax and a good reference guide for the language
can be found here: http://www.regular-expressions.info/tutorialcnt.html

As an important note, due to the way this script is programmed, certain characters are
treated as command characters instead of literal text characters. The following characters
represent certain command functions in the script:

Chara
cter

Function

~ as first character means start of section/file, ~ as last character means end of
sectionffile. For example, ~123~ would only find 123 and not 01234 or 1237, etc.
~123 would find 12340 but would not find 01234. 123~ would find 0123 but would
not find 01234.

Single character wildcard.

Multiple character wildcard.

IMPORTANT
ASClIvalue prefix (Ex: \013 for a carriage return, \010 for a line feed). The \ must
be followed by a three digit code to indicate the character to be output.

This character is used when you want to represent a character as represented by
its ASCII Decimal value. For example, since the filter directly references the
character ~ in its function, if you want to use the ~ character in your text, you'll need
to represent it with its ascii value. The ascii value of ~is \126.

Filter Statement Examples

To better demonstrate how some of the flags function, here are a few examples of
complete filter statements and an explanation of what they do.

Here is an example of a Literal Text Replacement Command.

Here is an example of an Abort Command.

Abort Command

This Filter statement tells the script to terminate if the Flag variable is set to False:

<Filter>
<Search>
<Section>
Flag
</Section>
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<Type>
Literal
</Type>
<Text>
False
</Text>
</Search>
<Replace>
<Section>
Flag
</Section>
<Scope>
Section
</Scope>
<Type>
And
</Type>
<Text>
False
</Text>
<All>
False
</All>
</Replace>
<Continue>
False
</Continue>

</Filter>
Literal Text Replacement Command

This Filter statement tells the script to replace one piece of literal text with another. More
specifically, this statement tells the script to search for the literal text Boiler Room and
replace it with boiler_tech_group.

<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
Boiler Room
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</Text>

</Search>
<Replace>

<Section>
Temp
</Section>
<Scope>
Section
</Scope>
<Type>
Literal
</Type>
<Text>
boiler_tech_group
</Text>
<All>
False
</All>

</Replace>

</Filter>
InputFile

The InputFile section determines which file(s) you want the filter to scan.

<InputFile>
<Name>
See Values and Description
</Name>
<Delete>
See Values and Description
</Delete>
</InputFile>
Flag Values and Description

Values: Parameter or Static Input File Name

This tag determines the name(s) of the file(s) that you want the filter to modify.
Just to note, the value Parameter is literal and not figurative. To use this value,
you'll want to use the text Parameter, including the capital P. When the filter is

Name | engaged by the pstproc.bat file, it is fed the file name being used by the filter.
The Parameter value tells the filter that it should simply accept the file name as
it was passed by the batch file.
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Alternatively, you can specify a static file for input. For example, c:
\PageGateData\Filter\winsck9000.log would tell the filter to only read from a
specific file named winsck9000.log. As another example, you could specify c:
\PageGateData\Filter\*.log and that would tell the filter to read all log files
placed in the directory.

Values: True or False

This tag determines whether you want the filter to delete the input file when it
has finished processing it.
If you do, set this tag to True. If you do not, set this tag to False.

Delete

As an important note, due to the way this script is programmed, certain characters are
treated as command characters instead of literal text characters. The following characters
represent certain command functions in the script:
Chara Function

cter

~ as first character means start of section/file, ~ as last character means end of
sectionffile. For example, ~123~ would only find 123 and not 01234 or 1237, etc.
~123 would find 12340 but would not find 01234. 123~ would find 0123 but would
not find 01234.

? | Single character wildcard.

Multiple character wildcard.

IMPORTANT
ASCll value prefix (Ex: \013 for a carriage return, \010 for a line feed). The \ must
be followed by a three digit code to indicate the character to be output.

This character is used when you want to represent a character as represented by
its ASCII Decimal value. For example, since the filter directly references the
character ~ in its function, if you want to use the ~ character in your text, you'll need
to represent it with its ascii value. The ascii value of ~ is \126.

OutputFile

The OutputFile section determines what you want to name the files output by the filter's
modifications. This section is defined as follows:

<OutputFile>
<Name>
See Values and Description
</Name>
</OutputFile>
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Flag

Values and Description

Name

Values: InputFile or Static Input File Name

This tag determines the names of the files that you want the filter to output after
it has modified the data read from the input file.

The value InputFile (this is case sensitive) tells the filter that the file output
should mirror the original input file's name. So, for example, if the file read was
named example.txt, then the file output would also be called example.txt

Alternatively, you can specify a static naming convention for the output files.
This value also supports the following variables:

%InputFileName%

%InputFileNameBase%

%InputFileNameExtension%

%InputFilePathAndName%

%InputFilePath%

So, for example, you could specify this as the value: c:\PageGateData\ASCI\%
InputFileNameBase%.asc

That would tell the filter that it should use the original name of the file read but
the output file should have the extension .asc instead of the extension on the
original file.

As an important note, due to the way this script is programmed, certain characters are
treated as command characters instead of literal text characters. The following characters
represent certain command functions in the script:

Chara
cter

Function

~ as first character means start of section/file, ~ as last character means end of
sectionffile. For example, ~123~ would only find 123 and not 01234 or 1237, etc.
~123 would find 12340 but would not find 01234. 123~ would find 0123 but would
not find 01234.

Single character wildcard.

Multiple character wildcard.

IMPORTANT
ASClIvalue prefix (Ex: \013 for a carriage return, \010 for a line feed). The \ must
be followed by a three digit code to indicate the character to be output.

This character is used when you want to represent a character as represented by
its ASCII Decimal value. For example, since the filter directly references the
character ~ in its function, if you want to use the ~ character in your text, you'll need
to represent it with its ascii value. The ascii value of ~is \126.
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Debug

The Debug section determines whether you want a debug level review of the filter to
appear before the filter completes its actions. This is incredibly useful when first
configuring a script and we recommend that this flag be enabled until the filter is ready to
put in to production. This section is defined as follows:

<Debug>
See Values and Description
</Debug>

Flag Values and Description
Values: True or False

Debug | This tag determines whether you want to review the debug level information for
the filter before it completes its actions. Set this flag to True to review the
debugging information, set this flag to False if you do not.

Please see Debugging the Script for more information.
Complete Script Examples

Due to the complex nature of the Filter script, we've created a few examples of how scripts
can be implemented. This is by no means a complete list of everything that the script can
do and is intended to be a set of examples to guide you through the possibilities the script
offers.

Example 1
In this example, we've configured the filter script to search the message read from the

input file for the text BIOHAZARD and replace it with bio_hazard. We're then inserting the
static text WARNING! EXTREME HAZARD DETECTED: before the matched search
string.

Example 2
In this example, we've configured the filter to scan through XML tags for the text Technical

or Network in the <AlertType> tag, then pull in information from the <Incident> and
<Description> tags. This collated data is then being passed to a statically named group in
PageGate: techsupervisors.

Example 3
In this example, we've configured the filter to scan for certain keywords and key phrases. If

it finds them, messages containing that text should not be allowed to go through and
should instead be filtered.

Example 4
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In this example, we've configured the filter script for a dispatching agency that needs all
fire, rescue and accident calls dispatched but does not want non-emergency calls
dispatched. To do this, the script reads in the entire input file and looks for certain flags
like FIRE,DISPATCHED or RESCUE,DISPATCHED or ACCID,DISPATCHED.

If it finds any of those three strings, the script then begins massaging and reformatting the
data to remove unwanted information and to determine who the message should go to and
what the message should say.

In this particular example, all fire and rescue calls need to be delineated from each other
so that the fire calls go to the fire department and the rescue calls go to the rescue
department but all accident calls should go to both fire and rescue departments.

Example 5
In this example, we're using an HTTPGET carrier to poll data from the National Weather
service to have it delivered as an SMS.

Example 6
This example is designed to work with an SMS Replies system and is configured to look

for the words 'subscribe' and 'unsubscribe' in the body of reply messages. If it finds
'subscribe’, it reconfigures the message to go to the recipient or group in PageGate
named 'subscribe’'. If it finds 'unsubscribe’, it reconfigures the message to go to the
recipient or group named 'unsubscribe’'.

Example 7
This example is designed to work with an SMS Replies system and is configured so that

any time someone replies to a message with 'unsubscribe' or 'subscribe’, those replies
execute a batch file or script contained within a batch file. This can be especially useful if
you're using an SQL environment and have PageGate's database linked to it with ODBC
expressions. In theory, you could code a script to be executed that would automatically
remove an entry from the users table of the database any time the 'unsubscribe' script was
executed.

Example 8
This example is designed to work with an SMS Replies system. This script is configured

with a list of 'allowed' phone numbers and is also configured to scan the sender value of all
replies. If the sender's phone number isn't in the 'allowed' list, the message is filtered as
spam.

Example 1

In this example, we've configured the filter script to search the message read from the
input file for the text 'BIOHAZARD'. [fit is found then the script will replace the current
Recipient with 'bio_hazard' to indicate that all messages containing the word BIOHAZARD
should go to the bio_hazard group. We're then inserting the static text WWARNING!
EXTREME HAZARD DETECTED:' before the matched search string.
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Note: Lines prefaced with # are comment lines for description purposes. The filter ignore
any lines that begin with #

This section of the filter configures the script to look for a static file named Example.txtin
the same directory as the script and, when the script completes, it will not delete the
original file and will output to a static file named Output.txt to the directory in which the
script resides.

<InputFile>
<Name>
Example.txt
</Name>
<Delete>
False
</Delete>
</InputFile>

<OutputFile>
<Name>
Output.txt
</Name>
</OutputFile>

<Debug>
False
</Debug>

# This section of the filter configures the script to search
# for BIOHAZARD and if found, replaces the Recipient
# with bio_hazard.
<Filter>
<Search>
<Section>
Message
</Section>
<Type>
Literal
</Type>
<Text>
BIOHAZARD
</Text>
</Search>
<Replace>
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<Section>
Recipient
</Section>
<Type>
Literal
</Type>
<Scope>
Section
</Scope>
<Text>
bio_hazard
</Text>
</Replace>
<Continue>
True
</Continue>
</Filter>

# This section of the filter configures the script to insert
# WARNING! EXTREME HAZARD DETECTED: before the BIOHAZARD text
<Filter>
<Search>
<Section>
Message
</Section>
<Type>
Literal
</Type>
<Text>
BIOHAZARD
</Text>
</Search>
<Replace>
<Section>
Message
</Section>
<Type>
Literal
</Type>
<Scope>
Match
</Scope>
<Text>
WARNING! EXTREME HAZARD DETECTED: %Match%
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<[Text>
</Replace>
</Filter>
Original Content

This is an example of the input file for filter example 1. This is what it looks like before the

filter engages.

supervisors
AlarmMonitor
BIOHAZARD ROOM 354

Another example:

it_alerts
AlarmMonitor

BIOHAZARD RULES IN EFFECT FOR WING 2
Filtered Content

When the data from example 1 is put through the example 1 filter, this is the output:

bio_hazard
AlarmMonitor
WARNING! EXTREME HAZARD DETECTED: BIOHAZARD ROOM 354

or like this:

bio_hazard
AlarmMonitor
WARNING! EXTREME HAZARD DETECTED: BIOHAZARD RULES IN EFFECT FOR

WING 2
Example 2

In this example, we've configured the filter to scan through an XML file for the text
"Technical' or 'Network' in the <AlertType> tag. It will then temporarily store the information
from the <Incident> and <Description> tags in the Temp variable. This collected data is
then being passed to a statically named group in PageGate: techsupervisors.

Note: Lines prefaced with # are comment lines for description purposes. The filter ignore
any lines that begin with #

<InputFile>
<Name>
Parameter
</Name>
<Delete>
True
</Delete>
</InputFile>
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<Debug>
False
</Debug>

<OutputFile>
<Name>
c:\PageGateData\ASCI\%InputFileNameBase%.asc
</Name>
</OutputFile>

# This section of the Filters tells the script to look for
# any lines that have<AlertType>Technical</AlertType> and
# set the Flag variable to True if it is found
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
<AlertType>Technical</AlertType>
</Text>
</Search>
<Replace>
<Section>
Flag
</Section>
<Scope>
Section
</Scope>
<Type>
Or
</Type>
<Text>
True
</Text>
</Replace>
</Filter>

# This section of the Filters tells the script to look for any
# lines that have the<AlertType>Network</AlertType> and
# set the Flag variable to True if it is found
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<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
<AlertType>Network</AlertType>
</Text>
</Search>
<Replace>
<Section>
Flag
</Section>
<Scope>
Section
</Scope>
<Type>
Or
</Type>
<Text>
True
</Text>
</Replace>
</Filter>

# This Filter section tells the script to abort if no instances of
# the two search strings can be found:
<Filter>
<Search>
<Section>
Flag
</Section>
<Type>
Literal
</Type>
<Text>
False
</Text>
</Search>
<Replace>
<Section>
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Flag
</Section>
<Scope>

Section
</Scope>
<Type>

And
</Type>
<Text>

False
<[Text>

</Replace>
<Continue>
False
</Continue>
</Filter>

# This section of the filter tells the script to grab data
# contained in the <Incident> tag.

<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
<Incident>*</Incident>
</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
<Scope>
Section
</Scope>
<Type>
Literal
</Type>
<Text>
%Match%
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</Text>
</Replace>
</Filter>

# This section of the filter tells the script to grab data from

# the <Description> tag

<Filter>
<Search>

<Section>
All

</Section>

<Type>
Literal

</Type>

<Text>

<Description>*</Description>

</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
<Scope>
Section
</Scope>
<Type>
Literal
</Type>
<Text>
%Temp% %Match%
</Text>
</Replace>
</Filter>

# This section of the filter removes the tag
# <Incident> from the message.

<Filter>
<Search>
<Section>
Temp
</Section>
<Type>
Literal

Chapter 2 How PageGate Accepts Messages

100



How PageGate Accepts Messages

</Type>
<Text>
<Incident>
</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
<Scope>
Match
</Scope>
<Type>
Literal
</Type>
<Text>

<[Text>
</Replace>
</Filter>

# This section of the filter removes the tag
# </Incident> from the message.

<Filter>
<Search>
<Section>
Temp
</Section>
<Type>
Literal
</Type>
<Text>
</Incident>
</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
<Scope>
Match
</Scope>
<Type>
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Literal
</T ype>
<Text>

</Text>
</Replace>
</Filter>

# This section of the filter removes the tag
# <Description> from the message.

<Filter>
<Search>
<Section>
Temp
</Section>
<Type>
Literal
</Type>
<Text>
<Description>
</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
<Scope>
Match
</Scope>
<Type>
Literal
</Type>
<Text>

<[Text>
</Replace>

</Filter>

# This section of the filter removes the tag
# </Description> from the message.

<Filter>
<Search>
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<Section>
Temp
</Section>
<Type>
Literal
</Type>
<Text>
<Incident>
</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
<Scope>
Match
</Scope>
<Type>
Literal
</Type>
<Text>

</Text>
</Replace>
</Filter>

# This Filter tells the script to output the file in the standard
# PageGate GetASClI file format for direct processing:

<Filter>
<Search>
<Section>
Flag
</Section>
<Type>
Literal
</Type>
<Text>
True
</Text>
</Search>
<Replace>
<Section>
All
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</Section>
<Scope>
Section
</Scope>
<Type>
Literal
</Type>
<Text>
TechSupervisors\013\010CAD\013\010%Temp%
</Text>
</Replace>
</Filter>

Original Content

This is example XML content to be processed by filter example 2. This is what it looks like

before the filter engages.

<XML>

<AlertType>Technical</AlertType>

<Requester>Station 3</Requester>

<Assets>PC01, PC02</Assets>

<Category>Desktop Support</Category>

<Incident>Replace Computers</Incident>

<Description>Workstations 01 and 02 should be replaced on Thursday</Description>
</XML>

Another example:

<XML>

<AlertType>Network</AlertType>

<Requester>Admin Group</Requester>
<Assets>Router</Assets>

<Category>Network Support</Category>

<Incident>DNS Failure</Incident>

<Description>DNS failures detected in node 2</Description>

</XML>
Filtered Content

When the data from filter example 2 is processed by filter example 2, this is the output

content:

techsupervisors
CAD
Replace Computers, Workstations 01 and 02 should be replaced on Thursday

Another example:
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techsupervisors

CAD

DNS Failure, DNS failures detected in node 2
Example 3

In this example, we're scanning for keywords and keyphrases that indicate a message
shouldn't be sent. If the filter finds any of the keywords or keyphrases, it will filter those
messages from going through. For this example, we've configured the filter to look for the
key phrases "Return from Alarm" and "Alarm Acknowledged" as well as potential partial
matches.

<InputFile>
<Name>

Parameter
</Name>
<Delete>

True
</Delete>
</InputFile>

<Debug>
True
</Debug>

<OutputFile>

<Name>
c:\PageGateData\output\%InputFileNameBase%.asc

</Name>

</OutputFile>

<Filter>
<Comment>look for Return From Alarm</Comment>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
Return From Alarm
</Text>
</Search>
<Replace>
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<Text>
</Text>
</Replace>
<Abort>
True
</Abort>
</Filter>

<Filter>

<Comment>look for Partial Phrases of Return From Alarm</Comment>

<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
Retu*
</Text>
</Search>
<Replace>
<Text>
</Text>
</Replace>
<Abort>
True
</Abort>
</Filter>

<Filter>

<Comment>look for Alarm Block Acknowledged</Comment>

<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>

Alarm Block Acknowledged

</Text>
</Search>
<Replace>
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<Text>
</Text>
</Replace>
<Abort>
True
</Abort>
</Filter>

<Filter>
<Comment>look for Partial "Alarm Block Acknowledged" phrases</Comment>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
Block
</Text>
</Search>
<Replace>
<Text>
</Text>
</Replace>
<Abort>
True
</Abort>
</Filter>
Example 4

Example 3

In this example, we've configured the filter script for a dispatching agency that needs all
fire, rescue and accident calls dispatched but does not want non-emergency calls
dispatched. To do this, the script reads in the entire input file and looks for certain
keywords like FIRE,DISPATCHED or RESCUE,DISPATCHED or ACCID,DISPATCHED.

If it finds any of those three strings, the script then reformats the data, removes unwanted
information, and determines who the message should be sent to.

In this particular example, all fire and rescue calls need to be separated from each other

so that the fire calls go to the fire department and the rescue calls go to the rescue
department, but all accident calls should go to both fire and rescue departments.
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Note: Lines prefaced with # are comment lines for description purposes. The filter ignore
any lines that begin with #

This section of the filter configures the script to accept whatever file name is passed by the
preproc.bat file, to delete the input file when it's finished and to output the reformatted data
to the c:\\PageGateData\ASCIN folder with a file name mirroring the original file but with a
.asc extension instead of the original file's extension.

<InputFile>
<Name>
Parameter
</Name>
<Delete>
True
</Delete>
</InputFile>

<Debug>
False
</Debug>

<OutputFile>
<Name>
c:\PageGateData\ASCI\%InputFileNameBase%.asc
</Name>
</OutputFile>

# The next three sections of the Filters tells the script to look for any lines that have

# the text ,FIRE,DISPATCHED| or ,RESCUE,DISPATCHED| or ACCID,DISPATCHED|in
the input file

# and sets the temporary Flag variable to True if any are found

# look for lines with station FIRE,DISPATCHED identifier
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
,FIRE,DISPATCHED|
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</Text>
</Search>
<Replace>
<Section>
Flag
</Section>
<Scope>
Section
</Scope>
<Type>
Or
</Type>
<Text>
True
</Text>
</Replace>
</Filter>

# look for lines with station RESCUE ,DISPATCHED identifier
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
,RESCUE,DISPATCHED|
</Text>
</Search>
<Replace>
<Section>
Flag
</Section>
<Scope>
Section
</Scope>
<Type>
Or
</Type>
<Text>
True
</Text>
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</Replace>
</Filter>

# look for lines with station ACCID,DISPATCHED identifier
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
,ACCID,DISPATCHED|
</Text>
</Search>
<Replace>
<Section>
Flag
</Section>
<Scope>
Section
</Scope>
<Type>
Or
</Type>
<Text>
True
</Text>
</Replace>
</Filter>

# This section test the value of the Flag variable

# and aborts out of the script if it is not set to True

# Note that the values in the <Replace> section really
# don't matter because the scriptis aborting

# abort if FIRE/RESCUE/ACCID DISPATCHED not found

<Filter>
<Search>
<Section>
Flag
</Section>
<Type>
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Literal
</Type>
<Text>

False
</Text>

</Search>
<Replace>
<Section>

Flag
</Section>
<Scope>

Section
</Scope>
<Type>

And
</Type>
<Text>

False
</Text>

</Replace>
<Continue>
False
</Continue>
</Filter>

# Now that the filter has determined that there is relevant data
# in the message file, these filter statements will search for
# department names and store what is found in the Temp variable

# look for lines with station F-BAY identifier
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
[F-BAY
</Text>
</Search>
<Replace>
<Section>
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Temp
</Section>
<Scope>

Section
</Scope>
<Type>

Literal
</Type>
<Text>

F-BAY
</Text>

</Replace>
</Filter>

# look for lines with station F-STU identifier
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
/[F-STU
</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
<Scope>
Section
</Scope>
<Type>
Literal
</Type>
<Text>
F-STU
</Text>
</Replace>
</Filter>

# This Filter section tells the script to abort if no
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# acceptable station is found within the data
# (the Temp variable is still blank)
<Filter>
<Search>
<Section>
Temp
</Section>
<Type>
Literal
</Type>
<Text>

</Text>
</Search>
<Replace>
<Section>
Flag
</Section>
<Scope>
Section
</Scope>
<Type>
And
</Type>
<Text>
False
</Text>
</Replace>
<Continue>
False
</Continue>
</Filter>

# This Filter section tells the script to grab a portion of the data read for modification:
# It grabs everything between the first character of the line and ,DISPATCHED| keyword
# and removes everything else
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>

Chapter 2 How PageGate Accepts Messages



How PageGate Accepts Messages

<Text>
* DISPATCHED|
</Text>
</Search>
<Replace>
<Section>
All
</Section>
<Scope>
Section
</Scope>
<Type>
Literal
</Type>
<Text>
%Match%
</Text>
</Replace>
</Filter>

# This Filter flag takes the data read by the previous statement and modifies it:
# It gets rid of extra stuff between date/time and address and replaces it with
# a carriage return and line feed
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
(Eastern Daylight Time)*/%Temp%,F,
</Text>
</Search>
<Replace>
<Section>
All
</Section>
<Scope>
Match
</Scope>
<Type>
Literal
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</Type>
<Text>
\013\010
</Text>
</Replace>
</Filter>

# The next two filter sections separate the rescue calls from the fire calls
# so that they go to two different agencies/organizations/units.
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
FIRE
</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
<Scope>
Section
</Scope>
<Type>
Literal
</Type>
<Text>
%Temp%-FIRE
</Text>
</Replace>
</Filter>

<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal

Chapter 2 How PageGate Accepts Messages



How PageGate Accepts Messages

</Type>
<Text>
RESCUE
</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
<Scope>
Section
</Scope>
<Type>
Literal
</Type>
<Text>
%Temp%-RESCUE
</Text>
</Replace>
</Filter>

# The next three Filter sections remove the text , DISPATCHED| from the message
# and replaces it with more readable text

# getrid of DISPATCHED on RESCUE
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
,RESCUE,DISPATCHED)|
</Text>
</Search>
<Replace>
<Section>
All
</Section>
<Scope>
Match
</Scope>
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<Type>
Literal

</Type>

<Text>
\013\010RESCUE

</Text>

</Replace>
</Filter>

# getrid of DISPATCHED on FIRE
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
,FIRE,DISPATCHED|
</Text>
</Search>
<Replace>
<Section>
All
</Section>
<Scope>
Match
</Scope>
<Type>
Literal
</Type>
<Text>
\013\010FIRE
</Text>
</Replace>
</Filter>

# getrid of DISPATCHED on ACCID
<Filter>
<Search>
<Section>
All
</Section>
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<Type>
Literal
</Type>
<Text>
,ACCID,DISPATCHED|
</Text>
</Search>
<Replace>
<Section>
All
</Section>
<Scope>
Match
</Scope>
<Type>
Literal
</Type>
<Text>
\013\010ACCID
</Text>
</Replace>
</Filter>

# This Filter section tells the script to output the file in the standard

# PageGate GetASClI file format for direct processing:

# convert to standard .asc format
<Filter>
<Search>
<Section>
Flag
</Section>
<Type>
Literal
</Type>
<Text>
True
</Text>
</Search>
<Replace>
<Section>
All
</Section>
<Scope>
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Section
</Scope>
<Type>

Literal
</Type>
<Text>

%Temp%\013\010CAD\013\010Dispatch % Temp%\013\010%All%
</Text>

</Replace>
</Filter>
Original Content

This is example content to be processed by filter example 3. This is what it looks like

before the filter engages.

2018-08-23 14:07:30.307 (Eastern Daylight Time) CISCOUNITSTAT|[T=1]
V=6233M070737305319|[T=4[V=02|[T=0]V=U,00/F-BAY,P,PRIMARY STREET/CROSS
STREET,INJ ACCID,DISPATCHED||

Filtered Content

When the data from filter example 4 is processed by filter example 4, this is the output

content:

F-BAY

DISPATCH

P,PRIMARY STREET/CROSS STREET,INJ ACCID
Example 5

This filter script is designed to work with the National Weather service's XML content,
which is generated by polling their web API.

<Debug>
<Console>
<Active>True</Active>
</Console>
<File>
<Active>True</Active>
<Name>weatherfilter.txt</Name>
<Append>False</Append>
</File>
<LoglnputFile>True</LoglnputFile>
<LogOutputFile>True</LogOutputFile>
</Debug>

<Filter>

<Comment>Delete if no severe weather alerts</Comment>
<Search>
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<Type>Literal</Type>
<Variable>All</VVariable>
<Text><title>There are no active watches, warnings or
advisories</title></Text>
</Search>
<MatchFound>
<Replace>
<Type>Literal</Type>
<Variable>All</VVariable>
<Scope>Entire</Scope>

<Text></Text>
</Replace>
</MatchFound>
</Filter>
<Filter>

<Comment>Check to see if this is the raw weather data or the ascii formatted data. If the
latter, skip to Process.</Comment>
<Search>
<Type>Literal</Type>
<Variable>Sender</Variable>
<Text>WeatherSend</Text>
</Search>
<MatchFound>
<Goto>Process</Goto>
</MatchFound>
</Filter>

<Filter>
<Comment>Turn each entry block in to a separate file.</Comment>
<FilterName>EntryLoop</FilterName>
<Search>
<Type>Regex</Type>
<Variable>All</VVariable>
<Text>(?7s)(<entry>.*?<Ventry>)</Text>
</Search>
<MatchFound>
<Replace>
<Variable>Temp8</Variable>
<Scope>Entire</Scope>
<Text>YourRecipientOrGroup\013\010WeatherSend\013\010%
Group1%</Text>
</Replace>
<WriteFile>
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<Variable>Temp8</Variable>
<Name>INSERT THE PATH TO YOUR WEATHER FOLDER\posts\
%InputFileNameBase %-%Filterindex%.asc</Name>
</WriteFile>
</MatchFound>
<MatchNotFound>
<Replace>
<Variable>All</Variable>
<Scope>Entire</Scope>
<Text></Text>
</Replace>
<Goto>Finished</Goto>
</MatchNotFound>
</Filter>

<Filter>
<Comment>Get rid of the entry block processed, then loop back until there are no more
entry blocks</Comment>
<Search>
<Type>Regex</Type>
<Variable>All</VVariable>
<Text>(7s)<entry>.*?<Ventry></Text>
</Search>
<MatchFound>
<Replace>
<Variable>All</Variable>
<Scope>Match</Scope>
<Text></Text>
</Replace>
<Goto>EntryLoop</Goto>
</MatchFound>
<MatchNotFound>
<Goto>Finished</Goto>
</MatchNotFound>
</Filter>

<Filter>
<FilterName>Process</FilterName>
<Comment>Grab cap:effective and put it in Temp4</Comment>
<Search>
<Type>Regex</Type>
<Variable>All</Variable>
<Text><cap:effective>(.*)?<Vcap:effective></Text>
</Search>
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<MatchFound>
<Replace>
<Variable>Temp4</Variable>
<Scope>Entire</Scope>
<Text>%Group1%</Text>

</Replace>
</MatchFound>
</Filter>
<Filter>
<Comment>Grab cap:expires and putitin Temp5, then put the final ID in
Temp6</Comment>
<Search>
<Type>Regex</Type>
<Variable>All</Variable>
<Text><cap:expires>(.*)?<Vcap:expires></Text>
</Search>
<MatchFound>
<Replace>
<Variable>Temp5</Variable>
<Scope>Entire</Scope>
<Text>%Group1%</Text>
</Replace>
<Replace>
<Variable>Temp6</Variable>
<Scope>Entire</Scope>
<Text>%Temp4%%Temp5%</Text>
</Replace>
</MatchFound>
</Filter>
<Filter>

<Comment> Turn Temp6 in to a valid file name and putitin Temp?7. It will be used
to read/write the requestld files</Comment>
<Search>
<Type>RegEx</Type>
<Variable>Temp6</Variable>
<Text>["a-zA-Z0-9\-]</Text>
</Search>
<MatchFound>
<Replace>
<Type>RegEx</Type>
<Variable>Temp7</Variable>
<Scope>Entire</Scope>
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<Text>%Group1%</Text>
<ReplaceAll>True</ReplaceAll>
</Replace>
</MatchFound>
</Filter>

<Filter>
<Comment>Pull in the ID from the file</Comment>
<MatchNotFound>
<ReadFile>
<Variable>Temp9</Variable>
<Name>INSERT THE PATH TO YOUR WEATHER FOLDER\ids\%
Temp7%.asc</Name>

</ReadFile>

</MatchNotFound>
</Filter>
<Filter>

<Comment>Check to see if the ID already exists. If it does, delete everything. If it
doesn't, write the ID file</Comment>
<Search>
<Type>Literal</Type>
<Variable>Temp9</Variable>
<Text>%Temp7%</Text>
</Search>
<MatchFound>
<Replace>
<Variable>All</Variable>
<Scope>Entire</Scope>
<Text></Text>
</Replace>
<Goto>Finished</Goto>
</MatchFound>
<MatchNotFound>
<WriteFile>
<Variable>Temp7</Variable>
<Name>INSERT THE PATH TO YOUR WEATHER FOLDER\ids\%
Temp7%.asc</Name>

</WriteFile>
</MatchNotFound>
</Filter>
<Filter>

<Comment>Remove from cap:event to cap:certainty</Comment>
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<Search>
<Type>Regex</Type>
<Variable>All</VVariable>
<Text>(7s)<cap:event>.*?<Vlcap:certainty></Text>
</Search>
<MatchFound>
<Replace>
<Type>Regex</Type>
<ReplaceAll>True</ReplaceAll>
<Variable>All</Variable>
<Scope>Match</Scope>
<Text></Text>
</Replace>
</MatchFound>
</Filter>

<Filter>
<Comment>Remove from entry to author</Comment>
<Search>
<Type>Regex</Type>
<Variable>All</VVariable>
<Text>(7?s)<entry>.*?<Vauthor></Text>
</Search>
<MatchFound>
<Replace>
<Type>Regex</Type>
<ReplaceAll>True</ReplaceAll>
<Variable>All</Variable>
<Scope>Match</Scope>
<Text></Text>
</Replace>
</MatchFound>
</Filter>

<Filter>
<Comment>Replace cap:areaDesc with LOCATION</Comment>
<Search>
<Type>Literal</Type>
<Variable>All</Variable>
<Text><cap:areaDesc></Text>
</Search>
<MatchFound>
<Replace>
<ReplaceAll>True</ReplaceAll>
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<Variable>All</Variable>

<Scope>Match</Scope>
<Text>\013\010LOCATION:\032</Text>
</Replace>
</MatchFound>
</Filter>
<Filter>
<Comment>Remove the XML tags from the link</Comment>
<Search>
<Type>Regex</Type>
<Variable>All</Variable>
<Text><link href="(.*)"V></Text>
</Search>
<MatchFound>
<Replace>
<Variable>All</Variable>
<Scope>Match</Scope>
<Text>%Group1%</Text>
</Replace>
</MatchFound>
</Filter>
<Filter>
<Comment>Remove from cap:polygon to cap:entry</Comment>
<Search>
<Type>Regex</Type>
<Variable>All</VVariable>
<Text>(7?s)<cap:polygon>.*?<Ventry></Text>
</Search>
<MatchFound>
<Replace>
<Type>Regex</Type>
<ReplaceAll>True</ReplaceAll>
<Variable>All</Variable>
<Scope>Match</Scope>
<Text></Text>
</Replace>
</MatchFound>
</Filter>
<Filter>
<Comment>Remove the summary</Comment>
<Search>
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<Type>Regex</Type>
<Variable>All</Variable>
<Text><summary>.*<\/summary></Text>

</Search>
<MatchFound>
<Replace>
<Variable>All</Variable>
<Scope>Match</Scope>
<Text></Text>
</Replace>
</MatchFound>
</Filter>
<Filter>
<Comment>Remove the opening title tag</Comment>
<Search>
<Type>Regex</Type>
<Variable>All</Variable>
<Text><title></Text>
</Search>
<MatchFound>
<Replace>
<Type>Regex</Type>
<Variable>All</Variable>
<ReplaceAll>True</ReplaceAll>
<Scope>Match</Scope>
<Text></Text>
</Replace>
</MatchFound>
</Filter>
<Filter>
<Comment>Remove the closing title tag</Comment>
<Search>
<Type>Regex</Type>
<Variable>All</Variable>
<Text><\ftitle></Text>
</Search>
<MatchFound>
<Replace>
<Type>Regex</Type>

<Variable>All</Variable>
<ReplaceAll>True</ReplaceAll>
<Scope>Match</Scope>
<Text></Text>
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</Replace>
</MatchFound>
</Filter>
<Filter>
<Comment>Remove the closing cap:areaDesc tag</Comment>
<Search>
<Type>Regex</Type>
<Variable>All</Variable>
<Text><Vcap:areaDesc></Text>
</Search>
<MatchFound>
<Replace>
<Type>Regex</Type>
<Variable>All</Variable>
<ReplaceAll>True</ReplaceAll>
<Scope>Match</Scope>
<Text></Text>
</Replace>
</MatchFound>
</Filter>
<Filter>
<Comment>Clean up the text, part 1</Comment>
<Search>
<Type>Literal</Type>
<Variable>All</Variable>
<Text>\013\010\013\010</Text>
</Search>
<MatchFound>
<Replace>
<ReplaceAll>True</ReplaceAll>
<Variable>All</Variable>
<Scope>Match</Scope>
<Text>\013\010</Text>
</Replace>
</MatchFound>
</Filter>
<Filter>

<Comment>Processing completed</Comment>
<FilterName>Finished</FilterName>
<MatchNotFound>
</MatchNotFound>
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</Filter>
Example 6

Example 5

This filter script is designed to work with an SMS Replies system and is configured to look
for the words 'subscribe' and 'unsubscribe' in the body of reply messages. If it finds
'subscribe’, it reconfigures the message to go to the recipient or group in PageGate
named 'subscribe’. If it finds 'unsubscribe’, it reconfigures the message to go to the
recipient or group named 'unsubscribe’'.

Note: The <InputFile> and <OutputFile> sections are not icluded, so the script will use the
filename passed in by PageGate, and write the script's results back to the same filename
when done.

Note: Lines prefaced with # are comment lines for description purposes. The filter ignore
any lines that begin with #

# look for 'unsubscribe' in message text (all lower case)
# if found, route the message to 'unsubscribe' recipient
<Filter>
<Search>
<Section>
Message
</Section>
<Type>
Literal
</Type>
<Text>
unsubscribe
</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
unsubscribe-recipient-or-group-here
</Text>
</Replace>
<Continue>
False
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</Continue>
</Filter>

# look for 'Unsubscribe' in message text (begins with capital)
# if found, route the message to 'unsubscribe' recipient
<Filter>
<Search>
<Section>
Message
</Section>
<Type>
Literal
</Type>
<Text>
Unsubscribe
</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
unsubscribe-recipient-or-group-here
</Text>
</Replace>
<Continue>
False
</Continue>
</Filter>

# look for 'subscribe' in message text (all lower case)
# if found, route the message to 'subscribe' recipient
<Filter>
<Search>
<Section>
Message
</Section>
<Type>
Literal
</Type>
<Text>

129 Chapter 2 How PageGate Accepts Messages



How PageGate Accepts Messages

subscribe
</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
subscribe-recipient-or-group-here
</Text>
</Replace>
<Continue>
False
</Continue>
</Filter>

# look for 'Subscribe' in message text (begins with capital)
# if found, route the message to 'subscribe' recipient
<Filter>
<Search>
<Section>
Message
</Section>
<Type>
Literal
</Type>
<Text>
Subscribe
</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
subscribe-recipient-or-group-here
</Text>
</Replace>
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<Continue>
False
</Continue>
</Filter>

Example 7

This filter script is designed to work with an SMS Replies system and is configured so that
any time someone replies to a message with 'unsubscribe’ or 'subscribe’, those replies will
be sent to an 'unsubscribe' or 'subscribe’ recipient in PageGate that will execute a batch
file or script contained within a batch file.

To do so, there's a bit of preparation you'll need to do to tell PageGate what script to run.
It's also important to note that this batch file can be used to execute powershell
commands.

Step 1: Create a directory for your batch file
1) Create a directory for the batch file(s) to reside in. This will also be the output folder for
the carrier we'll create in Step 2. For example, c:\PageGateData\unsubscribe\

Step 2: Create a FILE Carrier

1) Open PG Admin.

2) Right click Carriers, select Add.

3) Give the carrier a name, something straightforward like BATCH.

4) Set Protocol to: FILE

5) Set File Path to the directory you created in Step 1 above. By default, c:

\PageGateData\unsubscribe\

Step 3: Create a recipient named 'unsubscribe' and tie it to the FILE carrier
Right click Recipients, select Add.

1)
2) Name the recipient: unsubscribe

3) Set Carrier to the FILE carrier you created in step 2. By default, BATCH.
4) Click Apply.

Step 4: Place and edit the appropriate script files
1) Open the directory you created in step 1 above. By default, c:

\PageGateData\unsubscribe\
2) Copy pstproc.bat from the PageGate program directory in to that folder.
3) Edit pstproc.bat to execute the desired effect.
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Step 5: Configure the SMS Replies Filter System
# look for 'unsubscribe' in message text
# if found, route the message to 'unsubscribe' recipient
<Filter>
<Search>
<Section>
Message
</Section>
<Type>
Literal
</Type>
<Text>
unsubscribe
</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
unsubscribe-recipient
</Text>
</Replace>
<Continue>
False
</Continue>
</Filter>

# look for 'Unsubscribe' in message text
# if found, route the message to 'unsubscribe' recipient
<Filter>
<Search>
<Section>
Message
</Section>
<Type>
Literal
</Type>
<Text>
Unsubscribe
</Text>
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</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
unsubscribe-recipient
</Text>
</Replace>
<Continue>
False
</Continue>
</Filter>

# look for 'subscribe' in message text
# if found, route the message to 'subscribe' recipient
<Filter>
<Search>
<Section>
Message
</Section>
<Type>
Literal
</Type>
<Text>
subscribe
</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
subscribe-recipient
</Text>
</Replace>
<Continue>
False
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</Continue>
</Filter>

# look for 'Subscribe' in message text
# if found, route the message to 'subscribe' recipient

<Filter>
<Search>
<Section>
Message
</Section>
<Type>
Literal
</Type>
<Text>
Subscribe
</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
subscribe-recipient
</Text>
</Replace>
<Continue>
False
</Continue>
</Filter>
Example 8

This example is designed to work with an SMS Replies system. This script is configured
with a list of 'allowed' phone numbers and is also configured to scan the sender value of all
replies. If the sender's phone number isn't in the 'allowed' list, the message is filtered as
spam.

<Filter>

<Comment>

This filter is scanning the sender value for a series of phone numbers. In this example,
we're using a simple Regex string to create an 'or' statement. So, we're scanning for the
first number or the second number or the third number and so on.

</Comment>
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<Search>
<Section>
Sender
</Section>
<Type>
Regex
</Type>
<Text>
(phonenumber1|phonenumber2|phonenumber3|phonenumber4|etc)
</Text>
</Search>

<Replace>
<Comment>
If the filter finds any of the specified phone numbers, it assigns the intended delivery group
or recipient.
</Comment>
<Section>
Recipient
</Section>
<Scope>
Section
</Scope>
<Text>
name of messaging group or recipient
</Text>
</Replace>
<Continue>
False
</Continue>
</Filter>

GetMail Integration

The GetMail APl allows you to receive SMTP/Email traffic and translate it into outbound
messages in a different format. For example, you could email a message to PageGate to
deliver as a message to cell phones, other email addresses, pagers, web APls, etc.
Enabling GetMail allows you to have all traffic to a recipient or group forwarded to the
specified email address as well as allowing PageGate to host a POP accessible mailbox
on the PageGate server for that recipient or group.

PageGate has a fully functional mail server engine as a core part of the program but
without the GetMail module, you only ever access the outbound functions of this mail
server. The GetMail module unlocks the receiving portion of our mail server engine.

GetMail can receive email/SMTP messages in one of two ways:
e Sub-domain hosting
e POP Mailbox
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The best method of email integration is to have PageGate host a sub-domain off of your
existing domain. To do this, you'll want to talk to your mail server administrator and ask
them to create this sub-domain for you, then redirect the MX record for that sub-domain to
the internal IP address of the PageGate server. For example, let's say that you have an
email domain of whatever.com (and that your email addresses are
something@whatever.com). You could have messaging.whatever.com created and
redirected to PageGate's IP. As soon as you do, every recipient and group in the program
becomes a valid email address.

So, let's say that we have a recipient called sales and we have GetMail configured to use
messaging.whatever.com. You could send an email to sales@messaging.whatever.com
and that email would come in to PageGate, then get processed as an outbound message
for the recipient named sales.

POP is a relatively antiquated method of receiving email, many modern mail servers don't
support it. However, if your mail server does still support POP mailboxes, you can
configure GetMail to periodically check those email addresses, then read in any email
waiting in the mailbox and deliver that traffic to a recipient or group of your specification.

With the ubiquity of email, more and more modern applications are integrating the ability
to send email. If your application has the ability to send email, it can easily be integrated
with PageGate by using PageGate's email interface. It is worth noting that this interface
can be used to integrate applications running on different platforms (Unix, Mac, etc.). For
more information, please refer to the GetMail section of this manual for more details.

GetWeb Integration

The GetWeb API provides a CGI executable that can be hosted on a web server and a
series of pre-formatted templates to publish a messaging website or series of messaging
websites. Web Developers can use this web server interface to send messages to
PageGate from their webpages (HTML, ASP, JavaScript, etc.). This means that you can
host messaging websites on your local intranet or, if GetWeb is interfaced with an outward
facing web server, on the internet.

GetWeb's CGl executable can be used with either a POST or GET method.

The POST method can be used by creating a form on your webpage and pointing to the
webgate.exe program in the FORM ACTION statement.

The GET method is more popular with scripting languages such as JavaScript and Java.
It allows the GetWeb CGl to be called with a command similar to one that could be entered
into a browser's URL field.

The GetWeb interface can be used to enable PageGate to be integrated with applications
running on different platforms (Unix, Mac, etc.). Please refer to the GetWeb section of this
manual for more details.
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You can also find examples of Linux and Powershell scripts that can be used with GetWeb
in our documentation here.

GetSerial Integration

The GetSerial APl allows PageGate to monitor a serial/RS232 port, virtual or physical, for
raw data text strings to be parsed in to outbound messages.

When a data string is sent to monitored a serial port, GetSerial pattern matches sections
of the data string to parse information for messaging. For more information, please see
the GetSerial portion of the documentation.

GetTAP Integration

The GetTAP API allows PageGate to monitor a serial port or answer a modem call to
receive TAP transmitted pages.

This allows PageGate to function as a TAP receiver or a TAP terminal for any devices and
systems that can transmit that protocol, such as a Zetron terminal. For more information,
please see the GetTAP portion of the documentation.

If you need to monitor more than just one serial port or phone line for incoming TAP
messages, you can do so with PageGate's TAP2Ascii module. For more information,
please contact our Sales Department at 781-829-0500 xt1 or at sales@notepage.com

SNPP Server Integration

The SNPP API allows PageGate to function as an SNPP server to receive this protocol
from a variety of sources. Messages received by this APl are output to a directory as a text
file that is then read in with the GetASCII API. As a result, this APl requires the GetASCII
APl to function.

To configure the PageGate SNPP server:

1) Create a directory where the SNPP Server and its files will reside. We recommend
creating the following directory: C:\PageGateData\SNPP\

2) In Windows, browse in to the PageGate installation directory.

3) Move the snppserver.exe, pininfo.txt and snpp.ini files to the folder you created in step
1.

4) The first thing we'll need to do is modify the snpp.ini file. Open the file in notepad.
To give you a little more information, this .ini file controls the behavior of the PageGate
SNPP Server. If you are running the evaluation version of the PageGate SNPP Server, it

will stop itself every 3-5 days, and/or after 500 messages, whichever comes first.

3) Change the OutputFolder= value to the directory you created in step 1.
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4) Change the LogFolder= value to your PageGate Logging directory. If you are unsure of
what this folder is, open the PageGate Admin and go to the Program - Settings section.

5) Save the snpp.ini file and close notepad.

1) Open pininfo.txt in notepad.

2) This file tells the SNPP server what range of numbers can be passed to the server. The
format of the entries defined in this text file are:
"Starting PIN", "Ending PIN", "recipient type"

If you would like ID numbers in a range to be recognized as the recipient's name (not using
ad-hoc, but using numeric recipient names in PageGate), use the text "PG_Recipient" as
shown below:

"0001","9999", "PG_Recipient"

if you would like ID numbers in a range to be passed through PageGate as intact ID's to
another source in an ad-hoc range, use the name of a Recipient in PageGate whose type
is Ad-Hoc.

"0000001","4999999" "adhoc1"

To set the SNPP Server to run as a Windows Service, do the following:
1) Open a command prompt.
2) Change directory to the SNPP Server's program directory.

3) Type the following and hit enter:
snppserver /install

4) Exit the command prompt.

5) Open the Services listin Windows.

6) Go in to the Properties of the PageGate SNPP Server service.
7) Change the Startup Type to Automatic and Start the Service.

Once this has been done, the final step is to configure the GetASCIl module to read the
data from the SNPP server. To do so:

1) Open the PageGate Admin.

2) Go to Interfaces - GetASCII - Settings.
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3) In the Polling Directory, specify the PageGate SNPP Server's output folder.
4) Put a check in Enabled.

5) Click Apply.

Note: If you are already using the GetASCIl module, you can use the Advanced Polling
Files section to specify the SNPP Server's output folder as a secondary polling location.
The File(s) value will need to be setto *.asc

TouchTone Receiver Integration

This module provides the ability to monitor a voice modem to answer calls and receive
DTMF signals and output them as text to a file.

To configure the PageGate Touch Tone Receiver:

1) Create a directory where the SNPP Server and its files will reside. For example, the
directory:

C:\TouchTone\

2) In Windows, browse in to the PageGate installation directory.

3) Move the pggttone.ini and pgttreceiver.exe files to the folder you created in step 1.

4) The first thing we'll need to do is modify the pggttone.ini file. Open the file in notepad.

To give you a little more information, this .ini file controls the behavior of the PageGate
Touch Tone Receiver. If you are running the evaluation version, it will stop itself every 3-5
days, and/or after 500 messages, whichever comes first.

3) Change RunStyle=Application to RunStyle=Service

4) Change SwitchStyle=False to SwitchStyle=True

5) Set the DataFolder= value to your GetASCIl polling directory. If you do not have
GetASCll enabled, please see the GetASCIl section of the documentation.

Note: If you are already using the GetASCIl module, you can use the Advanced Polling
Files section to specify the SNPP Server's output folder as a secondary polling location.
The File(s) value will need to be setto *.asc

6) Set the ComPort= value to match the COM port of your modem.
Note: Only modems that have the 'voice' capability can receive DTMF signals. Modems
that do not have that ability cannot interpret them and cannot be used for this purpose.
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7) For the Initialization and Connection strings, please use the settings relevant to your
modem as detailed in the file.

8) Save the file and close notepad.
9) Open a command prompt.
10) Change directory to the directory you created in step 1.

11) Type the following and hit enter:
pgttreceiver /install

12) Exit the command prompt.
13) Open the Services listin Windows.
14) Go in to the Properties of the PageGate TouchTone service.

15) Change the Startup Type to Automatic and Start the Service.
Direct Database Access

Developers that are familiar with database access can directly integrate with PageGate's
database.

Note: Please consider other integration methods first. Writing improperly formatted lines
to the database will interfere with PageGate's stability. Empty fields MUST be expressed
as blank string values and CANNOT be left null. Each field value must exactly match the
expected format.

This is probably the most efficient way to add messages to the message queue, but may
not be an option in all programming environments. Another downside to this method is
that it may be version specific (if the database structure changes in a future version of
PageGate, the integration may stop working).

PageGate uses a Jet 4.0 database as it's back end. This is a MS Access 2000
compatible database. If you have the ability to write to MS Access 2000 databases, then
you can write to the PageGate's database directly. New messages can be added to the
PageGate's message queue by adding a new record to the 'messages' table in the
'pagegate.mdb' database.

Click here for field descriptions and values in the Messaqges table

Click here for field descriptions and values in the Users and Groups table
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The Messages Table

The field definitions, descriptions and values for the 'Messages' table.
Warning: Empty fields should be represented as blank string values. NULL values will not
be properly be parsed.

Label Field Value
Type
This field must match the name of a Recipient or Group within the
user Text .
PageGate Admin.
pin Text Must be set to a zero length string (""). This field value CANNOT be

left Null.
message | Memo | This field is the text of the message to be sent

. Must be set to a zero length string (""). This field value CANNOT be
carrier | Text

left Null.
date_time This field specifies the date and time to send this message. By
_requeste, Date .
d default, set the current date and time.
date_time Date | Leave unset
_sent
frm Text | This field specifies the name of the Sender of the message.
sent Bocr)]lea Setto False
error Bo?1lea Setto False

ascii file| Text Must be set to a zero length string (""). This field value CANNOT be

left Null.
mail file | Text Must be set to a zero length string (""). This field value CANNOT be
- left Null.
lock Bo<r)]lea Setto False

scheduled Bocr)]lea Setto False

reliapage  Numeri

: Setto 0
_index C
repeat_int Numeri Setto 0
erval C
repeat_st This value should be set to the same value as the
Date ,
op date_time_requested field.
This field provides a unique identifier that can be referenced when
station Numeri | performing reports to identify the source of the message. Values 0

through 9 are system reserved and cannot be used. Set this field
value to 10 =
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message_| Auto
- Leave unset

id Number
retries Nur:erl Setto 0

This value should be set to the 30 seconds before the

date_time_requested field.

REQUIRED VALUE

This field must be a unique number (long integer). The best way to

transactio Numeri | handle this is to edit the control database record, read the current

n C value of the 'unique' field, increment it, and then write this value back

to the control table. The transaction number can be reused after
approximately 1 hour.

dialer N“r:e” Setto 0

lasty try | Date

If security is enabled within PageGate, this is the name of the user

crza;oel"_n Text | who created the message. Otherwise, set the field value to a zero
length string (""). This field value CANNOT be left Null.
creator m Text This is the machine name of the computer that created the message.
achine This field value CANNOT be left Null.
org;)r::lr?[re Text | Setthis field value to the same value as the user field.
Iastg;etmpl Text | Setthis field value to the same value as the user field.

This field is not used but must be set to a zero length string (""). This
field value CANNOT be left Null.

archived Bocr)]lea Setto False.

server Text

priority Nur:erl Set this field value to 0.

The Users and Groups Table

Field definitions, descriptions and values for the 'Users' table in the database.

Warning: Empty fields should be represented as blank string values. NULL values will not
be properly be parsed.

Label Field Description and Potential Values

Type
The internal database name of a recipient or group and is the value
referenced by the GetASCII, GetWeb, GetTAP and GetSerial
interfaces.
For instance, this field name is the value referenced by network
monitoring utilities, CAD dispatching, ticket tracking systems and
similar.

user Text
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The recipient or group's display name in the PageGate GUI Client and
in any messaging websites this recipient or group appears on.

The ID to message. This will vary widely based on what type of
messages this recipient will receive. It could be a 10 or 11 digit ID for
SMS, it could be an email address, it could be a custom ID string or it
could be something else entirely.

When this recipient is messaged through SMTP based carriers, this
is the email address that will be messaged. This field overrides what
may be in the ID field but only for delivery via the SMTP protocol,
otherwise the ID field is respected.

ful_name| Text

id Text

EmailTo | Text It is possible to tie a recipient to a non-SMTP method of delivery, like

cellular hardware or an SMS delivery service (AWSSNS, Twilio, etc),
then configure a failover scenario where that non-SMTP method of
delivery fails over to SMTP. When that happens, this field's delivery
value will be used instead of the id value.
This value must exactly match the name of a carrier as it exists in the

carrier Text | 'carrier' field of the Carriers table in the database; which is also the
name displayed in the 'Carriers' section of PG Admin.
The maximum number of characters this recipient should have the

.| ability to receive. This value may be higher than the carrier's 'Max
Numeri , - L .
maxchars c Chars' value. If the recipient value is higher than the carrier value,

PageGate will break up long messages in to multiple data blocks
based on the carrier value.
0 for False. -1 for True.

This field should be set to False for recipients.
Boolea
on_call

If a group should have an on-call schedule, set this field to True.
Schedules are configured in PG Admin or by modifying values in the
table 'oncalltable' of the database.
rellapage Numert| g1 ihis field to 0.
_index C
If you own the GetMail interface and would like a copy of all messages
sent to this recipient or group forwarded to an email address, specify

forward Text that email address in this field.

If you do not own the GetMail interface, leave this field as a blank
string value.

.. 0 for False. -1 for True.
ascii_serv Boolea

ce : If GetAscii is part if your license, set to True. Otherwise, set to False.

gui_servic|Boolea | 0 for False. -1 for True.
e n
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mail_servi Boolea
ce n

serial_ser|Boolea
vice n

tap_servic Boolea
e n

web_servi|Boolea
ce n

ad_hoc Boolea

multi_pag|Boolea

e n
. Boolea
email_only
Boolea
group

display_gr Boolea
oup n

template | Text

If the PageGate GUI Client is part if your license, set to True.
Otherwise, set to False.
0 for False. -1 for True.

If GetMail is part if your license, set to True. Otherwise, set to False.
0 for False. -1 for True.

If GetSerial is part if your license, set to True. Otherwise, set to False.
0 for False. -1 for True.

If GetTAP is part if your license, set to True. Otherwise, set to False.
0 for False. -1 for True.

If GetWeb is part if your license, set to True. Otherwise, set to False.
0 for False. -1 for True.

This field should be set to False for groups.

If this recipient is an ad-hoc recipient, set to True. Otherwise, set to
False.
0 for False. -1 for True.

This field should be set to False for recipients.

If this group is tied to the multi-page GetWeb template, set this to
True. Otherwise, set to False.
0 for False. -1 for True.

This field should be set to False for groups.

If this recipient should only exist as a mailbox for use with GetMail, set
to True. Otherwise, set to False.
0 for False. -1 for True.

This field should be set to False for recipients.

If this entry should be a group, set to True. Otherwise, set to False.
0 for False. -1 for True.

This field should be set to False for recipients and groups.

If this entry should be a display group, set to True. Otherwise, set to
False.

Set to a blank string value.
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text1 - text
10

image1 -
imageb

custom

group_list

GLFullNa
me

Failover

extral -
extra4

hold

Text

Text

Boolea

Boolea

Boolea
n

Text

Text

Boolea

Text fields that are referenced by GetWeb's basic templates and
values that may be called on by PageGate's template system. In most
cases, leave these as blank string values.

Text fields that are referenced by GetWeb's basic templates and
values that may be called on by PageGate's template system. In most
cases, leave these as blank string values.

0 for False. -1 for True.

This field should be set to False for recipients.

If this group is tied to a custom web template, set to True. Otherwise,
set to False.

0 for False. -1 for True.
This field should be set to False for recipients.

If this group is tied to a web template and the members of this group
should display on the website it generates, set to True. Otherwise, set
to False.

0 for False. -1 for True.

This field should be set to False for recipients.

If this group_list is true, setting this field to True will configure the
website to reference the value in the full_name field instead of the

recipient field.

In all other cases, set to False.
This field may only be set for recipients and has no effect on groups.

The value of this field must exactly match the name of a recipient or
group as it appears in the user field.

If messages to this recipient fail, they will be redirected to the
specified value.

Otherwise, leave this field as a blank string value.
Text fields that are referenced by the PageGate GUI Client and values
that may be called on by PageGate's template system.

In most cases, leave these as blank string values.

O for False. -1 for True.

This field should be set to False for groups.
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If this recipient should have a hold placed on their messages during
specified dates and times, set to True and configure the values in
hold_start and hold_stop.

In all other cases, set to False.

If hold is set to True, enter the current date and what time the
message hold should begin. If hold is set to False, enter the current
date and time. The field value won't be referenced if hold is False but
this field can't be left blank.

Date/Ti Date values should be expressed as m/dd/yyyy and Time values
hold_start me should be expressed as HH:MM:SS AM/PM.

Example: 7/16/2020 8:35:00 PM

The only part of the field that will remain relevant is the time value
specified. PageGate will automatically update the date value to the
current date if hold is True.

If hold is set to True, enter the current date and what time the
message hold should end. If hold is set to False, enter the current date
and time. The field value won't be referenced if hold is False but this
field can't be left blank.

Date/Ti Date values should be expressed as m/dd/yyyy and Time values
hold_stop me should be expressed as HH:MM:SS AM/PM.

Example: 7/16/2020 7:35:00 AM

The only part of the field that will remain relevant is the time value

specified. PageGate will automatically update the date value to the

current date if hold is True.

This field specifies the name of an administrator or administrative

group that should have creator/control rights to this recipient or group.

If you aren't using the security system, leave this field as a blank string
creator | Text |value.

Otherwise, match this value to the name of an administrator or
administrative group in your PageGate security list.
Set to 100 for groups.
L Numeri . L
priority . Can be setto 1 - 32000 for recipients and reflects that recipient's

priority in messaging. Recipients with values closer to 1 are sorted
higher in the delivery order while recipients with values closer to
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32000 are sorted lower. For more information, see Prioritizing
Messages.

PageGate has the ability to send messages in a variety of formats to a variety of sources.
Among other methods, you can:

e Send SMS/text messages to phones

e Send pages to pagers

e Send Email
e Make APl calls to Web API, REST API, or web form
e Use XMPP chat clients

e Send faxes
e Send RAW data via TCP or Serial

e Trigger scripts, including Powershell

Since reliability is incredibly important, PageGate has a failover system that allows you to
automatically fail over from one method of communication to another in the event of failure.

For more information on how to configure a fail over, have a look at the Failover Scenarios
section of the documentation.

SMS (text message) Delivery Methods

Sending SMS is relatively easy and it can be done in a few ways, some of which are
hardware based and some of which are internet based.

Typically speaking, hardware methods of SMS delivery tend to be more reliable as they do
not rely on an internet connection but SMS delivery services and carrier enterprise
systems can be incredibly reliable methods of delivery.

e Carrier Public Gateways

Most carriers support an email-to-SMS system as a free, public service and PageGate
supports the ability to send SMTP/Email messages . We try to keep an up to date listing of
known carrier domains on our support site.

However, due to the nature of email delivery, this method can be somewhat unreliable and
delayed. While this is a viable method of SMS delivery, we don't recommend using it as
the primary method.

For more information, see the Carrier Public Gateways section of the documentation.

e Cellular Hardware
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On the hardware side of things, there are cellular modems and gateways. These devices
have an interface PageGate can use to send and receive SMS just like a cell phone does.

Cellular modems are easier to use with physical systems as they connect by USB and/or
RS-232.

Cellular gateways are easier to use in virtual environments as they can be reached via
TCP by Telnet or SSH.

For more information, including make and model recommendations, have a look at the
Using Cellular Hardware section of the documentation.

e General SMS delivery services

SMS delivery services are companies that provide a messaging APIfor you to deliver
traffic through and you typically license your SMS services through them, though not every
SMS delivery service is intended for use in every environment.

For a list of known SMS delivery services, have a look at the Message Aggregators
section of our integration page.

General messaging services are designed to be accessible to anyone and are incredibly
easy to register and configure for the end user, though they are typically intended for lower
volume environments. These services include Amazon Web Services SNS, Twilio,
MessageBird and similar.

Some companies provide SMS services as an integrated part of a telephony or VOIP
solution and PageGate can easily trigger messages through their API. These services
include APIDaze, Teli and similar.

High volume messaging services are designed for implementations that will need to send
100,000+ messages per month. Contracts are negotiated with the high volume service
and PageGate uses their APl to trigger messages. These services include Bandwidth,
Teli, Infobip and similar.

For more information, have a look at the General SMS Delivery Services section of the
documentation.

e Public Safety delivery services

Some SMS delivery services are designed to work with public safety dispatching to
provide mapping, geopositional and other key data to first responders. These services
include Active911, | Am Responding, CodeMessaging and similar.

For more information, have a look at the Public Safety Delivery Services section of the
documentation.
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e Medical Industry delivery services

Some SMS delivery services are designed to work with hospitals, clinics and other
medical services to provide HIPAA compliant secure messaging. These services include
TigerConnect, QligSOFT, Voalte and similar.

For more information, have a look at the Medical Industry Delivery Services section of the
documentation.

e Carrier Enterprise Systems

The major North American carriers each have their own respective enterprise messaging
platforms. Verizon has EMAG (Enterprise Messaging Access Gateway), AT&T has
FirstNet, Sprint has EMG (Enterprise Messaging Gateway), and so on.

Note for Public Safety: Verizon offers free access to dispatch related public safety
organizations if you ONLY message Verizon phones through EMAG. Enabling inter-carrier
operability requires a paid contract.

PageGate supports the protocols necessary to use these platforms to send your SMS.

For more information, see the Carrier Enterprise Systems section of the documentation.
Carrier Public Gateways

Most carriers support an email-to-SMS system as a free, public service and PageGate
supports the ability to send SMTP/Email messages. We try to keep an up to date listing of
known carrier domains on our support site.

However, due to the nature of email delivery, this method can be somewhat unreliable and
delayed. While this is a viable method of SMS delivery, we don't recommend using it as
the primary method due to the potential delays and missed messages inherent to it.

PageGate has the ability to send SMTP/Email messages in one of two ways:

e Direct

Direct delivery configures PageGate to use its own mail server engine to directly negotiate
with the outside world.

To configure this method of delivery, you will need to open port 25 and add the public IP
address of your PageGate server to the SPF record for your email domain.

¢ Relayed
Relayed delivery configures PageGate to pass all of its traffic through an SMTP server.

To configure this method of delivery, you will need to knowyour SMTP server address,
port to connect on and required authentication credentials.
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Technically, direct delivery is more efficient and reliable because it removes at least one
hop in the delivery sequence and also means that PageGate isn't reliant on another mail
server for delivery. However, when you use direct delivery for SMTP/Email, you'll need
abide by all of the rules required of a mail server because the program will be functioning
as a mail server to deliver SMTP/Email on behalf of your email domain.

Due to some of the complications involved in configuring PageGate for direct delivery, it
may be more practical to configure PageGate to relay its SMTP/Email traffic through your
SMTP/Email server. However, doing so makes PageGate reliant on that mail server for
message delivery.

Step 1: Configure the Carrier as a delivery method
1) Run PG Admin.

2) Right click Carriers, select Add

3) Specify the following and click Apply:
Carrier: The name of the carrier.
Protocol: SMTP
Host: The domain (part after the @) of the carrier host. For a list of known hosts, please
see the SMTP Delivery section of our site.
Port: When relaying SMTP, specify the port required by your SMTP server. When using
direct SMTP, set the port to 25.
Max Chars: 160
4) Go to Carriers - YourNewCarrier - Advanced
5) Specify the following:
When relaying SMTP, select the 'Deliver through outgoing mail server' option and enter
your SMTP server address in the 'Relay Server' field.
For example, if you use Office365, you would use smtp.office365.com as the relay
server address.
Specify the required username and password.

When using direct SMTP, select 'Deliver directly to destination server'.

6) Click Apply
7) Go to Carriers - YourNewCarrier - Template

8) Specify the following in the 'Settings' section:
From = The value from the username field
EXAMPLE:

From = CAD@notepage.com
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9) Click Apply.

Step 2: Create Recipients tied to the Carrier
1) Right click Recipients, select Add.

2) Specify the following:
Full Name: The name of the recipient
Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.
Type: Normal
Carrier: The recipient's cell phone carrier
Failover: See Failover Scenarios
ID/PIN: 10 digit cell phone number
Correct Incorrect

7818290500 1781829500
Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.

3) Click Apply.
Cellular Hardware

Cellular hardware is the one of the most reliable and efficient method of delivering SMS.
By using cellular hardware, you're removing PageGate's reliance on your internet
connection to deliver your messages which means that your internet connection could go
down and your messages would still be delivered. It's also important to note that allowing
PageGate to interact with cellular hardware is the a method of configuring a two-way
messaging system with SMS.

SMS capable cellular hardware comes in two varieties: cellular gateway/router and cellular
modem.

Cellular Gateways/Routers
Cellular routers and gateways can be accessed via TCP by Telnet or SSH. You don't have
to connect these devices to a PC, they just need to be connected to your network and
configured appropriately to receive messaging commands.

Good examples of cellular routers/gateways are:
e Multitech's MTR-LNA7

e Airlink's GX450, RV50, RV55 and LX40
e Microhard IP4nGii
e Cisco Series 800, 900
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e Cradlepoint AER1600/1650 Series, AER31x0, AER2100, AER2200 Series, COR
IBR200, COR IBR600B/C Series, COR IBR900 Series, COR IBR1100 Series, COR
IBR1700, MBR1400, MBR1200B, ARC CBA850, ARC CBA750B*, IBR300, IBR6x0,
IBR11x0

For information on how to configure TCP accessible cellular hardware, have a look at the
Creating a GSM-AT-IP Carrier steps.

Cellular Modems
A cellular modem connects to a PC by USB or RS232 and provides a COM port in the
operating system.
If PageGate is running in a virtual environment, you can also connect a cellular modem to a
COM port virtualizer that provides the COM port to the virtual machine. This grants
PageGate access to the cellular modem, which allows it to send and receive text
messages just like a cell phone does.

Good examples of cellular modem are:
e Multitech's MTC-LNA4

¢ Microhard's IPANG

e AirPrime 73xx and 75xx

e Skyus-DS

¢ BlueOcean GSM and GPRS series

e Duxbury 120 and 180

e Siemens MTC45MC, MTC45TC, TC35, TC65

e \Wavecom Fastrack GSM Modems

For information on how to configure RS232 or USB connected cellular hardware, have a
look at the Creating a GSM-AT Carrier steps.
General SMS Delivery Services

For a list of known SMS delivery services, have a look at the Message Aggregators
section of our integration page.

SMS delivery services are companies that provide a messaging API for you to deliver
traffic through and you typically license your SMS services through them, though not every
SMS delivery service is intended for use in every environment.

Most SMS delivery services offer at least one AP| that PageGate can use to send
messages and some services offer multiple methods that can be used for failover and

Chapter 3 How to Send Messages 152


https://www.notepage.net/how-to-integrate-pagegate.htm
https://www.notepage.net/how-to-integrate-pagegate.htm

How to Send Messages 3

redundancy. PageGate supports the following delivery methods for internet or local
network SMS delivery services:

e HTTP POST and HTTP GET

These methods are used to interact with Web and REST APIs, whether those are internet
or local network based. Any SMS service or application that can accept a web form,
POST or GET methods can be used for messaging with this protocol.

Typically speaking, there will be a few variables needed to set things up; things like
account number, APl key and authentication credentials

Examples:

e AWS SNS

e Twilio

e MessageBird
e APl Daze

e Teln

e Voximplant

e SMTP
Some delivery services offer the ability to email messages in to their platform can can be
used for messaging with this protocol.

Services that support this delivery method will have an email domain you'll deliver your
traffic through. For configuration steps, please see the Creating a Relayed SMTP Carrier
section.

If your SMS delivery service supports multiple APl hosts or delivery methods, you can
configure them for failover and redundancy. For more information, see the Failover
Scenarios section of the documentation.

For a list of known SMS delivery services, have a look at the Message Aggregators
section of our integration page.
Configuring AWS SNS

Step 1: Create an Amazon Web Services Account

1) Go to https://aws.amazon.com/
2) Click an AWS Create Account
3) Enter the email address and password.

153 Chapter 3 How to Send Messages


https://www.notepage.net/how-to-integrate-pagegate.htm
https://www.notepage.net/how-to-integrate-pagegate.htm
https://aws.amazon.com/

How to Send Messages 3

4) Enter payment information (required by Amazon)

5) Choose your support plan.

Step 2: Create an Access Key for PageGate to use

Creating an access key can be done by providing PageGate access to the root account

and password or you can tie the AWS SNS permissions to a specific user account..

If you want PageGate to use the root account, you would do the following:

1) Log in to your AWS account.

2) In the upper right hand corner, click on your account's name and select 'My Security
Credentials'

3) Click 'Create new Access Key'

4) Copy the 'Access Key ID' and 'Secret Access Key' values as we'll need both in

PageGate.

If you want to grant the ability to use AWS SNS to an existing account, you would do the

following:

1) Log in to your AWS account.

2) In the upper right hand corner, click on your account's name and select 'My Security
Credentials'

3) On the left hand side, click 'Users'

4) Select the user in question.

5) Click 'Add Permissions'

6) Select 'Attach existing policies directly'

7) In the 'Filter policies' field, enter: SNS

8) Check '"AmazonSNSFullAccess'

9) Click Next.

10) Click 'Add Permissions'

11) Select the 'Security Credentials' tab for that user.

12) Click 'Create Access Key'

13) Copy the 'Access Key ID' and 'Secret Access Key' values as we'll need both in

PageGate.
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Step 3: Configure AWS SNS in PageGate

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following:

Carrier: AWSSNS

Protocol: AwsSns

Host: Please see Amazon's SNS documentation

https://docs.aws.amazon.com/sns/latest/dg/sns-supported-regions-countries.html

The 'Endpoint' value is what you will use in the this field.
Examples:
sns.us-east-1.amazonaws.com
sns.us-west-2.amazonaws.com
Max Chars: 160
4) Click Apply to add the new delivery method.
5) Go to Carriers - AWSSNS - Advanced
6) Enter the Access Key ID value in the Username field.
7) Enter the Secret Access Key value in the Password field.
8) Click Apply.

Step 4: Create Recipients tied to the AWSSNS method of delivery

1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: AWSSNS

Failover: See Failover Scenarios

ID/PIN: cell phone number, including country code.

NOTE: For messaging in North America, it is imperative that you provide the 1 in front of
the phone number. AWS SNS treats the first character of the phone number as the
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country code and you can unintentionally send international SMS if you do not provide the
1.

Correct Incorrect
17818290500 781829500

Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.

3) Click Apply.
Configuring Twilio

Step 1: Create a Twilio Account

1) Go to https://www.twilio.com/
2) Click Sign Up
3) Create your Twilio Account

Step 2: Create an Access Key for PageGate to use

1) Log in to your Twilio account.

2) On the left hand side, click Settings, then APIKeys.

3) Click 'Create new APIKey'

4) In'Friendly Name', enter: PageGate

5) Leave 'Key Type' set to: Standard

6) Click 'Create APIKey'

7) Copy the SID and SECRET values as we'll need both for PageGate.

Step 3: Configure Twilio in PageGate
1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following:
Carrier: Twilio
Protocol: HTTPPOST
Host: api.twilio.com/2010-04-01/Accounts/YourAccountSID/Messages
NOTE: Your account SID is part of the host address.
Port: 443
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Max Chars: 160

4) Click Apply to add the new delivery method.

5) Go to Carriers - Twilio - Advanced

6) Enter the SID in'Username’.

7) Enter the SECRET value in'Password'.

8) Click Apply.

9) Go to Carriers - Twilio - Template

10) Specify the following in the 'Text' section and click Apply:

|To|%Recipientld%|

|[From|The Phone Number of your Twilio Account in international format. Example:
+17818290500]|

|Body|%Message%|

Step 4: Create Recipients tied to the Twilio method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: Twilio

Failover: See Failover Scenarios

ID/PIN: cell phone number, including country code.
Correct Incorrect
17818290500 781829500
Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.

3) Click Apply.
Configuring MessageBird

Step 1: Create a MessageBird Account

1) Go to https://messagebird.com/en/

2) Click Sign Up
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3) Create your MessageBird Account
4) In'Select an interface' section, select REST APls

5) In'Select a product to try first' section, select SMS API

7) In'Get your free test credits', enter your cell phone number for confirmation.

)
)
)
6) In'Select a use case', select Send SMS
)
8) Enter your verification code.

)

9) Click 'Skip'

Step 2: Create an Access Key for PageGate to use

1) Log in to your MessageBird account.

2) On the right side, under Your API Keys, click Manage APIKeys.

3) On the left side, click APlaccess

4) Click 'Show Key' next to the account you want PageGate to use.
)

5) Copy the Key.

Step 3: Configure MessageBird in PageGate

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following:

Carrier: MessageBird

Protocol: HTTPPOST

Host: rest messagebird.com/messages

Port: 443

Max Chars: 160
4) Click Apply to add the new delivery method.
5) Go to Carriers - MessageBird - Template
6) Specify the following in the 'Settings' section:
HttpSuccessResponse = "status":"sent"
7) Specify the following in the "Text' section:
|Authorization|AccessKey PasteYourAccessKeyHere|

[recipients|%Recipientld%|
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loriginator|%Sender%|
lbody|%Message%|

8) Click Apply

Step 4: Create Recipients tied to the MessageBird method of delivery
1) Right click Recipients, select Add.

2) Specify the following:

Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: MessageBird

Failover: See Failover Scenarios

ID/PIN: cell phone number, including country code.
Correct Incorrect
17818290500 781829500
Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.

3) Click Apply.
Configuring APl Daze
Step 1: Configure APIDaze in PageGate

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following:
Carrier: APIDaze
Protocol: HTTPPOST
Host: api4.apidaze.io/yourAPlkey/sms/send?api_secret=yoursecretAPIcode

NOTE: Paste your API code in to the 'yoursecretAPIcode' section
Port: 443
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Max Chars: 160
4) Click Apply to add the new delivery method.
5) Go to Carriers - APl Daze - Template
6) Specify the following in the 'Text' section:
|Content-Typelapplication/x-www-form-urlencoded]|
\013\010
from=YourAPIDazeNumber&to=%Recipientld%&body=%Message%

7) Click Apply

Step 4: Create Recipients tied to the API Daze method of delivery
1) Right click Recipients, select Add.

2) Specify the following:
Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: APIDaze

Failover: See Failover Scenarios
ID/PIN: 10 digit cell phone number

Correct Incorrect
7818290500 1781829500
Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.

3) Click Apply.
Configuring Telnyx
Step 1: Create a Telnyx Account

1) Go to https://www.telnyx.com/
2) Click Sign Up
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3) Create your Telnyx Account

Step 2: Create an Access Key for PageGate to use

1) Follow the Telnyx portal setup guide:

https://developers.telnyx.com/docs/v2/messaging/quickstarts/portal-setup

2) Follow the Telnyx development environment setup guide to generate your APl key:

https://developers.telnyx.com/docs/v2/messaqging/quickstarts/dev-env-setup

Step 3: Configure Telnyx in PageGate

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following:
Carrier: Telnyx
Protocol: HTTPPOST
Host: api.telnyx.com/v2/messages
Port: 443
Max Chars: 160
4) Click Apply to add the new delivery method.
5) Go to Carriers - Telnyx - Template
6) Specify the following in the 'Settings' section :
HttpPostType = HeadBody
7) Specify the following in the "Text' section and click Apply:

|To|%Recipientld%|

|[From|A TN authorized to send SMS in your Telnyx Account in international format.
Example: +17818290500|

|Body|%Message%|

Note: Information on the 'From' parameter can be found in Telnyx's documentation:
https://developers.telnyx.com/docs/v2/messaging/featuresi/traffic-type

Step 4: Create Recipients tied to the Telnyx method of delivery
1) Right click Recipients, select Add.
2) Specify the following:
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Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: Twilio

Failover: See Failover Scenarios

ID/PIN: cell phone number, including country code.

Correct Incorrect
781829500,
+17818290500 17818290500

Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.

3) Click Apply.
Configuring Mobile-Text-Alerts
Step 1: Create a Mobile-Text-Alerts Account

1) Go to https://mobile-text-alerts.com/sms/api

2) Go through the account creation and registration process to receive your APl key.

Step 2: Configure Mobile-Text-Alerts in PageGate

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following:

Carrier: Mobile-Text-Alerts

Protocol: HTTPGET

Host: mobile-text-alerts.com/rest/

Port: 80

Max Chars: 160
4) Click Apply to add the new delivery method.
5) Go to Carriers - Mobile-Text-Alerts - Template
6) Specify the following in the 'Text' section:

lkey|Enter your API Key|
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[request|send_message|
Imessage|%Message %|

[number|%Recipientld%|
7) Click Apply
Step 3: Create Recipients tied to the Mobile-Text-Alerts method of delivery

1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: Mobile-Text-Alerts

Failover: See Failover Scenarios

ID/PIN: Cell phone number with no spaces or dashes

Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.

3) Click Apply.
Configuring Voximplant

Step 1: Create a Voximplant Account

1) Go to https://voximplant.com/capabilities/sms
2) Click Sign Up
3) Create your Voximplant Account.

Step 2: Find your APl Access Key and Password for PageGate to use

1) Log in to your Voximplant account.
2) In the upper right hand corner of the page, click on the dropdown arrow next to your
profile icon.
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3) Select APlaccess
4) Click 'Show Key' next to the account you want PageGate to use.
5) Copy the Key.

Step 3: Configure Voximplant in PageGate

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following:
Carrier: Voximplant
Protocol: HTTPGET
Host: api.voximplant.com/platform_api/A2PSendSms
Port: 443
Max Chars: 6000
4) Click Apply to add the new delivery method.
5) Go to Carriers - Voximplant - Template
6) Specify the following in the "Text' section:
laccount_id|Enter Your Account ID Here)|
|src_number|Your Voximplant Phone Number|
|dst_numbers|%Recipientld%|
text|%Message%]|

7) Click Apply

8) Go to Carriers - Voximplant - Advanced

9) Enter your Account ID in the Username field.
10) Enter your API Key in to the Password field.
11) Click Apply.

Step 4: Create Recipients tied to the Voximplant method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient
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Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: Voximplant

Failover: See Failover Scenarios
ID/PIN: The 10 digit cell phone number

Correct Incorrect
7818290500 1781829500
Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.

3) Click Apply.
Public Safety Delivery Services

Some SMS delivery services are designed specifically to work with public safety
dispatching to provide mapping, geopositional and other key data to first responders.

To use one of these services, you'll take output from a CAD system and pass various data
points like call type, address, crossroads and cross-streets to the service. When the
service receives that data, they then put it through a field parser to understand what data
exists in which field. As a result, these services usually require data to be passed ina
consistently structured order.

Typically speaking, the delivery service will work with you to configure their parser but once
the parser is configured, it's important that those field positions remain where they are.

Examples:
o Active911

e | Am Responding

e Chief Messaging

e CodeMessaging

e eDispatches
e FireTextResponse

e Rover
e The Fire Horn

e Who's Responding

Chapter 3 How to Send Messages



How to Send Messages 3

If your SMS delivery service supports multiple APls, hosts or delivery methods, you can
configure them for failover and redundancy. For more information, see the Failover
Scenarios section of the documentation.

For a list of known SMS delivery services, have a look at the Message Aggregators
section of our integration page.
Configuring Active911

Active911 supports receiving messages by SNPP and SMTP. As a result, we can
configure PageGate to use the better and more direct SNPP method first and fail over to

SMTP if something goes wrong.

Special Notes:
e Port 444 will need to be open for SNPP traffic.

¢ To configure the SMTP failover, you will need to know your SMTP server address, port to

connect on and required authentication credentials.

Step 1: Configure Active911-PRIMARY as a delivery method

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:

Carrier: Active911-PRIMARY

Protocol: SNPP

Host: snpp.active911.xcom

Port: 444

Max Chars: 6000
4) Go to Carriers - Active911-PRIMARY - Advanced
5) Set Priority to: 1
6) Click Apply

Step 2: Configure Active911-BACKUP as a delivery method
1) Right click Carriers, select Add
2) Specify the following:
Carrier: Active911-BACKUP
Protocol: SMTP
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Host: alert.active911.com

Port: Specify the port required by your
SMTP server.

Max Chars: 6000

3) Go to Carriers - Active911-BACKUP - Advanced
4) Specify the following:

Select the 'Deliver through outgoing mail
server' option and enter your SMTP server

address in the 'Relay Server' field.

For example, if you use Office365, you would
use smtp.office365.com as the relay server

address.
Specify the required username and password.

Set 'Priority’ to: 1
5) Click Apply
6) Go to Carriers - Active911-BACKUP - Template
7) Specify the following in the 'Settings' section:
From = The value from the username field
EXAMPLE:
From = CAD@notepage.com
8) Click Apply.

Step 3: Configure the failover
1) Go to Carriers - Active911-PRIMARY - Advanced
2) Click the dropdown arrow next to 'Failover' and select: Active911-BACKUP
3) Click Apply

Step 4: Create Recipients tied to the Active911 method of delivery
1) Right click Recipients, select Add.
2) Specify the following:
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Full Name: Describe the agency being messaged
Recipient: This field is auto-populated and may need to be edited. When integrating

with a CAD system, this field will need to reflect CAD's name.

For example, if CAD is going to dispatch 'Palentine Fire District 2' by calling on the
name pfd2, that is the value you would use in this field.

Type: Normal

Carrier: Active911-PRIMARY

Failover: See Failover Scenarios

ID/PIN: The Active911 messaging ID. Typically speaking, Active911 will give you an
email address per group you want to send to. The prefix of the email address, the part
before the @, is what you'll use in the ID/PIN field.

For example, if your Active911 ID is 491-x3aAkdbn@alert.active911.com, you would
use 491-x3aAkdbn in the ID/PIN field.
Max Chars: 6000

3) Click Apply.
Configuring | Am Responding
| Am Responding supports receiving messages by SMTP/Email and has been

investigating the possibility of bringing SNPP services online.

PageGate has the ability to send SMTP/Email messages in one of two ways:

e Direct
Direct delivery configures PageGate to use its own mail server engine to directly negotiate
with the outside world.

To configure this method of delivery, you will need to open port 25 and add the public IP

address of your PageGate server to the SPF record for your email domain.

¢ Relayed
Relayed delivery configures PageGate to pass all of its traffic through an SMTP server.
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To configure this method of delivery, you will need to knowyour SMTP server address,

port to connect on and required authentication credentials.

Technically, direct delivery is more efficient and reliable because it removes at least one
hop in the delivery sequence and also means that PageGate isn't reliant on another mail
server for delivery. However, when you use direct delivery for SMTP/Email, you'll need
abide by all of the rules required of a mail server because the program will be functioning
as a mail server to deliver SMTP/Email on behalf of your email domain.

Due to some of the complications involved in configuring PageGate for direct delivery, it
may be more practical to configure PageGate to relay its SMTP/Email traffic through your
SMTP/Email server. However, doing so makes PageGate reliant on that mail server for
message delivery.

Step 1: Configure IAmResponding as a delivery method
1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:

Carrier: IAmResponding
Protocol: SMTP
Host: iaralerts.com

Port: When relaying SMTP, specify the port required by your SMTP server.

When using direct SMTP, set the port to 25.
Max Chars: 6000
4) Go to Carriers - IAmResponding - Advanced
5) Specify the following:

When relaying SMTP, select the 'Deliver through outgoing mail server' option and enter
your SMTP server address in the 'Relay Server' field.

For example, if you use Office365, you would use smtp.office365.com as the relay
server address.

Specify the required username and password.

When using direct SMTP, select 'Deliver directly to destination server'.
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Set 'Priority’ to: 1
6) Click Apply
7) Go to Carriers - IAmResponding - Template
8) Specify the following in the 'Settings' section:
From = The value from the username field
EXAMPLE:
From = CAD@notepage.com
9) Click Apply.

Step 2: Create Recipients tied to the IAmResponding method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: Describe the agency being messaged

Recipient: This field is auto-populated and may need to be edited. When integrating
with a CAD system, this field will need to reflect CAD's name.

For example, if CAD is going to dispatch 'Palentine Fire District 2' by calling on the
name pfd2, that is the value you would use in this field.

Type: Normal

Carrier: IAmResponding

Failover: See Failover Scenarios

ID/PIN: The IAR messaging ID. Typically speaking, IAR will give you an email address
per group you want to send to. The prefix of the email address, the part before the @, is
what you'll use in the ID/PIN field.

For example, if your IAR ID is 4912anh@iaralerts.com, you would use 4912anh in the
ID/PIN field.
Max Chars: 6000

3) Click Apply.

Configuring Chief Messaging

Chief Messaging supports receiving messages by SNPP and SMTP. As a result, we can

configure PageGate to use the better and more direct SNPP method first and fail over to

SMTP if something goes wrong.
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Special Notes:
e Port 444 will need to be open for SNPP traffic.

3

¢ To configure the SMTP failover, you will need to know your SMTP server address, port to

connect on and required authentication credentials.

Step 1: Configure ChiefMessaging-PRIMARY as a delivery method

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:
Carrier: ChiefMessaging-PRIMARY
Protocol: SNPP
Host: snpp.chiefcadpage.com
Port: 444
Max Chars: 6000
4) Go to Carriers - ChiefMessaging-PRIMARY - Advanced
5) Set Priority to: 1
6) Click Apply

Step 2: Configure ChiefMessaging-BACKUP as a delivery method
1) Right click Carriers, select Add
2) Specify the following:
Carrier: ChiefMessaging-BACKUP
Protocol: SMTP

Host: alert.active911.com

Port: Specify the port required by your

SMTP server.

Max Chars: 6000
3) Go to Carriers - ChiefMessaging-BACKUP - Advanced
4) Specify the following:

Select the 'Deliver through outgoing mail server' option and enter your SMTP server

address in the 'Relay Server' field.
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For example, if you use Office365, you would use smtp.office365.com as the relay

server address.
Specify the required username and password.

Set 'Priority’ to: 1
5) Click Apply
6) Go to Carriers - ChiefMessaging-BACKUP - Template
7) Specify the following in the 'Settings' section:
From = The value from the username field
EXAMPLE:
From = CAD@notepage.com
8) Click Apply.

Step 3: Configure the failover
1) Go to Carriers - ChiefMessaging-PRIMARY - Advanced
2) Click the dropdown arrow next to 'Failover' and select: ChiefMessaging-BACKUP
3) Click Apply

Step 4: Create Recipients tied to the Chief Messaging method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: Describe the agency being messaged
Recipient: This field is auto-populated and may need to be edited. When integrating

with a CAD system, this field will need to reflect CAD's name.

For example, if CAD is going to dispatch 'Palentine Fire District 2' by calling on the
name pfd2, that is the value you would use in this field.

Type: Normal

Carrier: ChiefMessaging-PRIMARY

Failover: See Failover Scenarios

ID/PIN: The Chief Messaging messaging ID.
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Typically speaking, Chief Messaging will give you an email address per group you want
to send to. The prefix of the email address, the part before the @, is what you'll use in
the ID/PIN field.

As an example, if your Chief Messaging address is uxW900@chiefcadpage.com, you
would use uxW900 in the ID/PIN field.
Max Chars: 6000
3) Click Apply.
Configuring CodeMessaging
CodeMessaging supports receiving messages by WCTP, SNPP and SMTP. As a result,
we can configure PageGate to use the better and more direct WCTP method first, fail over
to SNPP if something goes wrong and then have a final last-ditch attempt to deliver it as
SMTP/Email.

Special Notes:
e Port 443 will need to be open for WCTP.
e Port 444 will need to be open for SNPP.

¢ To configure the SMTP failover, you will need to know your SMTP server address, port to

connect on and required authentication credentials.

Step 1: Configure CodeMessaging-PRIMARY as a delivery method
1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:
Carrier: CodeMessaging-PRIMARY
Protocol: WCTP
Host: www.codepassport.net/codepassport.asp?wci=getWCTP
Port: 443
Max Chars: 1000
4) Go to Carriers - CodeMessaging-PRIMARY - Advanced
5) Specify the following:

Priority: 1

Chapter 3 How to Send Messages



How to Send Messages 3
Username: Contact CodeMessaging to obtain this information.

Password: Contact CodeMessaging to obtain this information.
6) Click Apply

Step 2: Configure CodeMessaging-SECONDARY as a delivery method

1) Right click Carriers, select Add
2) Specify the following:

Carrier: CodeMessaging-SECONDARY

Protocol: SNPP

Host: snpp.c-msg.net

Port: 444

Max Chars: 1000
3) Go to Carriers - CodeMessaging-SECONDARY - Advanced
4) Specify the following:

Priority: 1
Password: Enter the CodeMessaging username and password values separated by a
single space.

EXAMPLE:
username password
NPSupport PasswordGoesHere

Contact CodeMessaging to obtain your authentication credentials.

5) Click Apply

Step 3: Configure CodeMessaging-FINAL as a delivery method
1) Right click Carriers, select Add
2) Specify the following:

Carrier: CodeMessaging-FINAL

Protocol: SMTP

Host: c-msg.net

Port: Specify the port required by your
SMTP server.

Max Chars: 1000
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3) Go to Carriers - CodeMessaging-FINAL - Advanced
4) Specify the following:

Select the 'Deliver through outgoing mail
server' option and enter your SMTP server

address in the 'Relay Server' field.

For example, if you use Office365, you would
use smtp.office365.com as the relay server

address.
Specify the required username and password.

Set 'Priority’ to: 1
5) Click Apply
6) Go to Carriers - CodeMessaging-FINAL - Template
7) Specify the following in the 'Settings' section:
From = The value from the username field
EXAMPLE:
From = CAD@notepage.com
8) Click Apply.

Step 3: Configure the failover system

1) Go to Carriers - CodeMessaging-PRIMARY - Advanced
2) Click the dropdown arrow next to 'Failover' and select: CodeMessaging-BACKUP

4) Go to Carriers - CodeMessaging-SECONDARY - Advanced

5) Click the dropdown arrow next to 'Failover' and select: CodeMessaging-FINAL

)
)
3) Click Apply
)
)

Step 4: Create Recipients tied to the CodeMessaging method of delivery

1) Right click Recipients, select Add.
2) Specify the following:
Full Name: Describe the agency being messaged
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Recipient: This field is auto-populated and may need to be edited. When integrating

with a CAD system, this field will need to reflect CAD's name.

For example, if CAD is going to dispatch 'Palentine Fire District 2' by calling on the
name pfd2, that is the value you would use in this field.

Type: Normal

Carrier: CodeMessaging-PRIMARY

Failover: See Failover Scenarios

ID/PIN: The CodeMessaging messaging ID. Typically speaking, CodeMessaging will
give you an email address per group you want to send to. The prefix of the email
address, the part before the @, is what you'll use in the ID/PIN field.

For example, if your CodeMessaging ID is x3aAkdbn@c-msg.net, you would use
x3aAkdbn in the ID/PIN field.

Max Chars: 1000
3) Click Apply.

Configuring eDispatches

eDispatches supports receiving messages by SMTP/Email.

PageGate has the ability to send SMTP/Email messages in one of two ways:

e Direct
Direct delivery configures PageGate to use its own mail server engine to directly negotiate
with the outside world.

To configure this method of delivery, you will need to open port 25 and add the public IP

address of your Page Gate server to the SPF record for your email domain.

e Relayed
Relayed delivery configures PageGate to pass all of its traffic through an SMTP server.

To configure this method of delivery, you will need to knowyour SMTP server address,

port to connect on and required authentication credentials.

Technically, direct delivery is more efficient and reliable because it removes at least one
hop in the delivery sequence and also means that PageGate isn't reliant on another mail

Chapter 3 How to Send Messages 176



How to Send Messages 3

server for delivery. However, when you use direct delivery for SMTP/Email, you'll need
abide by all of the rules required of a mail server because the program will be functioning
as a mail server to deliver SMTP/Email on behalf of your email domain.

Due to some of the complications involved in configuring PageGate for direct delivery, it
may be more practical to configure PageGate to relay its SMTP/Email traffic through your
SMTP/Email server. However, doing so makes PageGate reliant on that mail server for
message delivery.

Step 1: Configure eDispatches as a delivery method
1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:

Carrier: eDispatches
Protocol: SMTP
Host: edispnoc.com

Port: When relaying SMTP, specify the port required by your SMTP server.

When using direct SMTP, set the port to 25.
Max Chars: 6000

4) Go to Carriers - eDispatches - Advanced
5) Specify the following:

When relaying SMTP, select the 'Deliver through outgoing mail server' option and enter
your SMTP server address in the 'Relay Server' field.

For example, if you use Office365, you would use smtp.office365.com as the relay
server address.

Specify the required username and password.

When using direct SMTP, select 'Deliver directly to destination server'.

Set 'Priority’ to: 1
6) Click Apply
7) Go to Carriers - eDispatches - Template

8) Specify the following in the 'Settings' section:
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From = The value from the username field
EXAMPLE:
From = CAD@notepage.com

9) Click Apply.

Step 2: Create Recipients tied to the eDispatches method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: Describe the agency being messaged

Recipient: This field is auto-populated and may need to be edited. When integrating
with a CAD system, this field will need to reflect CAD's name.

For example, if CAD is going to dispatch 'Palentine Fire District 2' by calling on the
name pfd2, that is the value you would use in this field.

Type: Normal
Carrier: eDispatches

Failover: See Failover Scenarios

ID/PIN: The eDispatches messaging ID.

Typically speaking, eDispatches will give you an email address per group you want to
send to. The prefix of the email address, the part before the @, is what you'll use in the
ID/PIN field.

For example, if the eDispatches email address is 4912anh@edispnoc.com, you would
use 4912anhin the ID/PIN field.
Max Chars: 6000

3) Click Apply.

Configuring FireTextResponse

FireTextResponse supports receiving messages by SMTP/Email.

PageGate has the ability to send SMTP/Email messages in one of two ways:

e Direct
Direct delivery configures PageGate to use its own mail server engine to directly negotiate
with the outside world.
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To configure this method of delivery, you will need to open port 25 and add the public IP

address of your Page Gate server to the SPF record for your email domain.

¢ Relayed
Relayed delivery configures PageGate to pass all of its traffic through an SMTP server.

To configure this method of delivery, you will need to knowyour SMTP server address,

port to connect on and required authentication credentials.

Technically, direct delivery is more efficient and reliable because it removes at least one
hop in the delivery sequence and also means that PageGate isn't reliant on another mail
server for delivery. However, when you use direct delivery for SMTP/Email, you'll need
abide by all of the rules required of a mail server because the program will be functioning
as a mail server to deliver SMTP/Email on behalf of your email domain.

Due to some of the complications involved in configuring PageGate for direct delivery, it
may be more practical to configure PageGate to relay its SMTP/Email traffic through your
SMTP/Email server. However, doing so makes PageGate reliant on that mail server for
message delivery.

Step 1: Configure FireTextResponse as a delivery method
1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:

Carrier: FireTextResponse
Protocol: SMTP
Host: ftralerts.com or ftralerts.net

Port: When relaying SMTP, specify the port required by your SMTP server.

When using direct SMTP, set the port to 25.

Max Chars: 6000
4) Go to Carriers - FireTextResponse - Advanced
5) Specify the following:

When relaying SMTP, select the 'Deliver through outgoing mail server' option and enter
your SMTP server address in the 'Relay Server field.

For example, if you use Office365, you would use smtp.office365.com as the relay
server address.
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Specify the required username and password.

When using direct SMTP, select 'Deliver directly to destination server'.

Set 'Priority’ to: 1
6) Click Apply
7) Go to Carriers - FireTextResponse - Template
8) Specify the following in the 'Settings' section:
From = The value from the username field
EXAMPLE:
From = CAD@notepage.com
9) Click Apply.

Step 2: Create Recipients tied to the FireTextResponse method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: Describe the agency being messaged

Recipient: This field is auto-populated and may need to be edited. When integrating
with a CAD system, this field will need to reflect CAD's name.

For example, if CAD is going to dispatch 'Palentine Fire District 2' by calling on the
name pfd2, that is the value you would use in this field.

Type: Normal
Carrier: FireTextResponse

Failover: See Failover Scenarios

ID/PIN: The FireTextResponse messaging ID.
Typically speaking, FireTextResponse will give you an email address per group you

want to send to. The prefix of the email address, the part before the @, is what you'll use
in the ID/PIN field.

For example, if the email address is 4912anh@ftralerts.com, you would use 4912anh in
the ID/PIN field.
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Max Chars: 6000
3) Click Apply.
Configuring Rover
Rover supports receiving messages by WCTP and SMTP. This allows you to configure

WCTP as a primary method of delivery with a failover method of SMTP/email.

Special Notes:
e Port 443 will need to be open for WCTP.

¢ To configure the SMTP failover, you will need to know your SMTP server address, port to

connect on and required authentication credentials.

Step 1: Configure Rover-PRIMARY as a delivery method
1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:

Carrier: Rover
Protocol: WCTP
Host: websvc.spotteddogtech.com/Rover WCTP
Port: 443
Max Chars: 6000
4) Go to Carriers - Rover - Advanced
5) Specify the following:
Priority: 1
6) Click Apply

Step 2: Configure Rover-SECONDARY as a delivery method
1) Right click Carriers, select Add
2) Specify the following:
Carrier: Rover-SECONDARY
Protocol: SMTP

Host: rover.spotteddogtech.com

Port: Specify the port required by your SMTP server.
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Max Chars: 6000
3) Go to Carriers - Rover-SECONDARY - Advanced
4) Specify the following:
Select the 'Deliver through outgoing mail server' option and enter your SMTP server

address in the 'Relay Server field.

For example, if you use Office365, you would use smtp.office365.com as the relay

server address.
Specify the required username and password.

Set 'Priority’ to: 1
5) Click Apply
6) Go to Carriers - Rover-SECONDARY - Template
7) Specify the following in the 'Settings' section:
From = The value from the username field
EXAMPLE:
From = CAD@notepage.com
8) Click Apply.

Step 3: Configure the failover
1) Go to Carriers - Rover-PRIMARY - Advanced
2) Click the dropdown arrow next to 'Failover' and select: Rover-SECONDARY
3) Click Apply

Step 4: Create Recipients tied to the Rover method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: Describe the agency being messaged
Recipient: This field is auto-populated and may need to be edited. When integrating

with a CAD system, this field will need to reflect CAD's name.
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For example, if CAD is going to dispatch 'Palentine Fire District 2' by calling on the
name pfd2, that is the value you would use in this field.

Type: Normal

Carrier: Rover

Failover: See Failover Scenarios

ID/PIN: Enter the Rover ID. Example: Value@rover.spotteddogtech.com
Max Chars: 6000

3) Click Apply.

Configuring The Fire Horn

The Fire Horn provides a CGI URL for clients to submit messages to and they can use
PageGate's HTTPGET protocol to do so.

Step 1: Configure FireHorn as a delivery method

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:
Carrier: Rover
Protocol: HTTPGET
Host: thfirehorn.com/api/software_relay/text_message/YourSiteKeyHere/
NOTE: You will need your Fire Horn site key as part of the host address.
Port: 443
Max Chars: 6000
4) Go to Carriers - FireHorn - Template
5) Specify the following in the "Text' section:
Imessage|%Message %|
6) Click Apply
Step 2: Create Recipients tied to the FireHorn method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: Describe the agency being messaged

Recipient: This field is auto-populated and may need to be edited. When integrating
with a CAD system, this field will need to reflect CAD's name.
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For example, if CAD is going to dispatch 'Palentine Fire District 2' by calling on the
name pfd2, that is the value you would use in this field.

Type: Normal

Carrier: FireHorn

Failover: See Failover Scenarios

ID/PIN: Enter the FireHorn ID

Max Chars: 6000
3) Click Apply.

Configuring Who's Responding

Who's Responding supports receiving messages by SNPP and SMTP. As a result, we
can configure PageGate to use the better and more direct SNPP method first and fail over

to SMTP if something goes wrong.

Special Notes:
e Port 444 will need to be open for SNPP traffic.

¢ To configure the SMTP failover, you will need to know your SMTP server address, port to

connect on and required authentication credentials.

Step 1: Configure WhosResponding-PRIMARY as a delivery method

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:

Carrier: WhosResponding-PRIMARY

Protocol: SNPP

Host: ds1.whosresponding.com

Port: 444

Max Chars: 6000
4) Go to Carriers - WhosResponding-PRIMARY - Advanced
5) Set Priority to: 1
6) Click Apply

Step 2: Configure WhosResponding-BACKUP as a delivery method
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1) Right click Carriers, select Add
2) Specify the following:
Carrier: WhosResponding-BACKUP
Protocol: SMTP
Host: ds1.whosresponding.com
Port: Specify the port required by your SMTP server.
Max Chars: 6000
3) Go to Carriers - WhosResponding-BACKUP - Advanced
4) Specify the following:
Select the 'Deliver through outgoing mail server' option and enter your SMTP server
address in the 'Relay Server' field.

For example, if you use Office365, you would use smtp.office365.com as the relay
server address.

Specify the required username and password.

Set 'Priority’ to: 1
5) Click Apply
6) Go to Carriers - WhosResponding-BACKUP - Template
7) Specify the following in the 'Settings' section:
From = The value from the username field
EXAMPLE:
From = CAD@notepage.com
8) Click Apply.

Step 3: Configure the failover
1) Go to Carriers - WhosResponding-PRIMARY - Advanced
2) Click the dropdown arrow next to 'Failover' and select: WhosResponding-BACKUP
3) Click Apply

Step 4: Create Recipients tied to the WhosResponding method of delivery
1) Right click Recipients, select Add.
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2) Specify the following:
Full Name: Describe the agency being messaged
Recipient: This field is auto-populated and may need to be edited. When integrating

with a CAD system, this field will need to reflect CAD's name.

For example, if CAD is going to dispatch 'Palentine Fire District 2' by calling on the
name pfd2, that is the value you would use in this field.

Type: Normal

Carrier: WhosResponding-PRIMARY

Failover: See Failover Scenarios

ID/PIN: The Who's Responding messaging ID.

Typically speaking, Who's Responding will give you an email address per group you
want to send to. The prefix of the email address, the part before the @, is what you'll use
in the ID/PIN field.

Max Chars: 6000
3) Click Apply.
Medical Industry Delivery Services

Standard SMS/text messaging is not secure, not HIPAA compliant and should never be
used to transmit messages with PHI. Some SMS delivery services are designed to work
with hospitals, clinics and other medical services to provide HIPAA compliant secure
messaging.

In most cases, these services have two methods of operating and some even support
both:

¢ A secure server that hosts all messages

With this method, the SMS service hosts a secure messaging server that they provide you
and your users access to. When you send a message, the message is created on the
secure server and a notification with login link is sent to the end user's phone. The end
user must then log in to the secure server to retrieve their message.

¢ A secure app on the end-user's device

With this method, the SMS service provides a secure messaging app that is installed on
the end user's devices. When you send a message, you initiate the message through the
service's secure server and they provide the message to the secure app on the device.
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For more information, have a look at our article on how secure messaging works.

Examples: TigerConnect, QligSOFT, DocHalo
Configuring TigerConnect

TigerConnect supports receiving messages by WCTP, an HTTPS method of delivery..

Step 1: Configure TigerConnect as a delivery method

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:

Carrier: TigerConnect

Protocol: WCTP

Host: wctp.tigertext. me/wctp

Port: 443

Max Chars: 160
4) Go to Carriers - TigerConnect - Advanced
5) Specify the following:

Priority: 1

Username: Enter the TigerConnect UserID.

Password: Enter the TigerConnect password.
6) Click Apply

Step 2: Create Recipients tied to the TigerConnect method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: TigerConnect

Failover: See Failover Scenarios

ID/PIN: 10 digit cell phone or pager number

Correct Incorrect
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7818290500 1781829500
Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.
3) Click Apply.

Configuring QliqSOFT
QligSOFT supports receiving messages by POST method to their secure API.

Step 1: Configure QligSOFT in PageGate

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following:
Carrier: QliqSOFT
Protocol: HTTPPOST
Host: webprod.qligsoft.com/secure_messages/send
Port: 443
Max Chars: 160
4) Click Apply to add the new delivery method.
5) Go to Carriers - QligSOFT - Template
6) Specify the following in the 'Text' section:

lapi_keylyour-QligSOF T-web-AP-key|

to]%Recipientld%|

[from|%Sender%|

text|%Message%]|

NOTE: You will need your QligSOFT web APl key. Information on how to generate that API
key can be found in the QliqSOFT documentation:
https://webprod.qgligsoft.com/qligCONNECT_CloudApiGuide.pdf

7) Click Apply

Step 4: Create Recipients tied to the QligSOFT method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.
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Type: Normal

Carrier: QliqSOFT

Failover: See Failover Scenarios
ID/PIN: 10 digit cell phone number

Correct Incorrect
7818290500 1781829500
Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.
3) Click Apply.

Configuring DocHalo

DocHalo supports receiving messages by WCTP, an HTTPS method of delivery..

Step 1: Configure DocHalo as a delivery method
1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:

Carrier: DocHalo

Protocol: WCTP

Host: wctp.halospectrum.com/message

Port: 443

Max Chars: 160
4) Go to Carriers - DocHalo - Advanced
5) Specify the following:

Priority: 1

Username: Enter the DocHalo UserID.

Password: Enter the DocHalo password.
6) Click Apply

Step 2: Create Recipients tied to the DocHalo method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient
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Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: DocHalo

Failover: See Failover Scenarios

ID/PIN: The 8 or 12 digit DocHalo HDID
Examples: DH123456 or DHO001020A3B

Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.

3) Click Apply.

Configuring Voalte
Voalte supports receiving messages by WCTP, an HTTPS method of delivery..

Step 1: Configure Voalte as a delivery method
1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:
Carrier: Voalte
Protocol: WCTP
Host: cws01.voalte.net/wctp
Port: 50100
Max Chars: 6000
4) Go to Carriers - Voalte - Advanced
5) Specify the following:
Priority: 1
6) Click Apply
7) Go to Carriers - Voalte - Template
8) Specify the following in the 'Settings' section:
StripNonPrintable = True
From = Your whitelisted Voalte Sender ID
9) Click Apply.
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Step 2: Create Recipients tied to the Voalte method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal
Carrier: Voalte
Failover: See Failover Scenarios

ID/PIN: Voalte Conact ID

Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.

3) Click Apply.

Configuring Zinc

ServiceMax's Zinc supports receiving messages by POST method to their secure API.

For this configuration, you will need to know the Message Bot Identification Token and
information on both using their APl and determining the token can be found in the Zinc
documentation: https://community.servicemax.com/t5/Zinc-Help-Articles/Zinc-How-to-Use-
Messaging-APVba-p/17738

Step 1: Configure Zinc in PageGate

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following:
Carrier: Zinc
Protocol: HTTPPOST
Host: api.zincit.io/hooks/v1/:id/message

NOTE: The :id portion of the URL is determined by the Message Bot Identification
Token. Please see Zinc's documentation for more information.

Port: 443
Max Chars: 6000
4) Click Apply to add the new delivery method.

5) Go to Carriers - Zinc - Template
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6) Specify the following in the 'Text' section:

lapi_key|your-Zinc-web-APl-key|
to]%Recipientld%|
[from|%Sender%|
text|%Message%]|

NOTE: You will need your Zinc web APl key. Please see Zinc's documentation for more
information.

7) Click Apply

Step 4: Create Recipients tied to the Zinc method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: QliqSOFT

Failover: See Failover Scenarios
ID/PIN: 10 digit cell phone number

Correct Incorrect
7818290500 1781829500
Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.
3) Click Apply.

Configuring Spok Mobile

Spok Mobile supports receiving messages by WCTP, an HTTPS method of delivery.

Step 1: Configure SpokMobile as a delivery method
1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:

Carrier: SpokMobile
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Protocol: WCTP

Host: wctp.usamobility.net/wctp
Port: 443

Max Chars: 160

Step 2: Create Recipients tied to the SpokMobile method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: SpokMobile

Failover: See Failover Scenarios

ID/PIN: 10 digit cell phone or pager number
Correct Incorrect
7818290500 1781829500
Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.
3) Click Apply.

Carrier Enterprise Systems

The major North American carriers each have their own respective enterprise messaging
platforms and these gateways are ultimately faster and more reliable than the free, public
SMTP-to-SMS system. These platforms also typically provide multiple APIs, allowing
PageGate to use all of them in a failover capacity.

Access to these gateways is usually not provided free of charge and will require a contract
of some variety with the carrier.

e Verizon Enterprise Messaging Access Gateway (EMAG)
e AT&T FirstNet

e Sprint Enterprise Messaging Gateway (EMG)

Configuring EMAG

To register on Verizon's EMAG platform, you'll need to contact your Verizon
representative, who will provide an intake form.
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In the registration process, you'll need to specify whether your EMAG account has the
ability to send to all cell phones, also called inter-carrier operability, or just Verizon cell
phones.

Note for Public Safety: Verizon offers free access to dispatch related public safety
organizations if you ONLY message Verizon phones through EMAG. Enabling inter-carrier
operability requires a paid contract.

On the intake form, you're interested in the WCTP, SNPP and SMTP APlIs. With all three,
we can configure a failover system where the program will use the best method of delivery
(WCTP) first, then fail over to the second best (SNPP) and if that fails, it makes a last ditch
attempt to send it out via email (SMTP).

For the WCTP and SNPP APIs, you'll need to provide the public IP address your
PageGate server resides behind. You'll also be asked to create a username and
password that are unique to each APl and we'll need those credentials for PageGate's
configuration.

For the SMTP API, you'll need to specify whether you have a cloud based solution, like
Office 365, or a traditional SMTP server and provide your email domain and server IP
information.

It's important to note that EMAG ties your API credentials to your public IP address. If your
public IP address changes, you'll definitely want to update that with EMAG and, if possible,
communicate the shift ahead of time

Special Notes:
e Port 443 will need to be open for WCTP.
e Port 444 will need to be open for SNPP.

¢ To configure the SMTP failover, you will need to know your SMTP server address, port to

connect on and required authentication credentials.

Step 1: Configure EMAG-PRIMARY as a delivery method
1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following and click Apply:
Carrier: EMAG-PRIMARY
Protocol: WCTP
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Host: wctp.emag.vzw.com/wctp/wctp
Port: 443
Max Chars: 160
4) Go to Carriers - EMAG-PRIMARY - Advanced
5) Specify the following:
Priority: See Prioritizing Messages
Username: The EMAG WCTP APl Username

Password: The EMAG WCTP API|Password
6) Click Apply

7) Go to Carriers - EMAG-PRIMARY - Template

8) Specify the following in the 'Settings' section:
StripNonPrintable = True

9) Click Apply.

Step 2: Configure EMAG-SECONDARY as a delivery method
1) Right click Carriers, select Add
2) Specify the following:
Carrier: EMAG-SECONDARY
Protocol: SNPP

Host: snpp.emag.vzw.com

Port: 444

Max Chars: 160
3) Go to Carriers - EMAG-SECONDARY - Advanced
4) Specify the following:

Priority: See Prioritizing Messages

Password: Enter the EMAG SNPP username and password values separated by a
single space.

EXAMPLE:
username password
NPSupport PasswordGoesHere

5) Click Apply
Step 3: Configure EMAG-FINAL as a delivery method
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1) Right click Carriers, select Add
2) Specify the following:
Carrier: EMAG-FINAL
Protocol: SMTP
Host: vzvmg.biz
Port: Specify the port required by your SMTP server.
Max Chars: 160
3) Go to Carriers - EMAG-FINAL - Advanced
4) Specify the following:
Select the 'Deliver through outgoing mail server' option and enter your SMTP server

address in the 'Relay Server' field.

For example, if you use Office365, you would use smtp.office365.com as the relay

server address.
Specify the required username and password.

Priority: See Prioritizing Messages
5) Click Apply
6) Go to Carriers - EMAG-FINAL - Template
7) Specify the following in the 'Settings' section:

From = The value from the username field
EXAMPLE:
From = CAD@notepage.com

8) Click Apply.

Step 4: Configure the failover system
Go to Carriers - EMAG-PRIMARY - Advanced

1)

2) Click the dropdown arrow next to 'Failover' and select: EMAG-SECONDARY
3) Click Apply

4) Go to Carriers - EMAG-SECONDARY - Advanced

5) Click the dropdown arrow next to 'Failover' and select: EMAG-FINAL
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6) Click Apply
Step 4: Create Recipients tied to the EMAG-PRIMARY method of delivery

1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: EMAG-PRIMARY
Failover: See Failover Scenarios
ID/PIN: 10 digit cell phone number

Correct Incorrect
7818290500 1781829500
Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.
3) Click Apply.

Configuring FirstNet

To begin the process of registering on FirstNet, you'll want to contact your AT&T
representative or go to https://www.firstnet.com/signup

During this registration process, you'll need to let your Firstnet representative know that
you'll need access to the Firstnet Messaging Portal (https://messaging.firstnet.com/).

FirstNet supports receiving messages by SNPP and SMTP. With all both, we can
configure a failover system where the program will use the best method of delivery (SNPP)
first, then fail over to the second best (SMTP).

To use the SNPP gateways, you will need login access to the AT&T FirstNet Admin or
Business Notification Center web portals.

Once there, on the left hand side, go to Administration and you should see a 'Generate
Credentials' option. You will need both the username and the password for PageGate.

Special Notes:
e Port 444 will need to be open for SNPP.

¢ To configure the SMTP failover, you will need to know your SMTP server address, port to

connect on and required authentication credentials.
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Step 1: Configure FirstNet-PRIMARY as a delivery method

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following:

Carrier: FirstNet-PRIMARY

Protocol: SNPP

Host: snpp firstnet.com

Port: 444

Max Chars: 999
4) Click Apply.
5) Go to Carriers - FirstNet-PRIMARY - Advanced

6) Enter your FirstNet SNPP API username and password in to the Username and

Password fields

Username: Your FirstNet APl Username

Password: Your FirstNet APl Password
7) Click Apply.

Step 2: Configure FirstNet-FINAL as a delivery method
1) Right click Carriers, select Add
2) Specify the following:
Carrier: FirstNet-FINAL
Protocol: SMTP

Carrier Domain: 1Twaysms firstnet.com
Port: Specify the port required by your SMTP server.
Max Chars: 1000
3) Go to Carriers - FirstNet-FINAL - Advanced
4) Specify the following:
Select the 'Deliver through outgoing mail server' option and enter your SMTP server
address in the 'Relay Server' field.
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For example, if you use Office365, you would use smtp.office365.com as the relay

server address.
Specify the required username and password.

Priority: See Prioritizing Messages
5) Click Apply
6) Go to Carriers - FirstNet-FINAL - Template
7) Specify the following in the 'Settings' section:

From = The value from the username field
EXAMPLE:
From = CAD@notepage.com

8) Click Apply.

Step 4: Configure the failover system
1) Go to Carriers - FirstNet-PRIMARY - Advanced
2) Click the dropdown arrow next to 'Failover' and select: FirstNet-FINAL
3) Click Apply

Step 4: Create Recipients tied to the FirstNet-PRIMARY method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: FirstNet-PRIMARY
Failover: See Failover Scenarios
ID/PIN: 10 digit cell phone number

Correct Incorrect
7818290500 1781829500

Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.
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3) Click Apply.
Configuring EMG

To begin the process of registering on Sprint's EMG, you'll want to contact your Sprint
representative or go to https://emg.sprint.com

EMG supports receiving messages by SNPP and SMTP. With all both, we can configure a
failover system where the program will use the best method of delivery (SNPP) first and if
that fails, it makes a last ditch attempt to send it out via email (SMTP).

Special Notes:
e Port 444 will need to be open for SNPP.

¢ To configure the SMTP failover, you will need to know your SMTP server address, port to

connect on and required authentication credentials.

Step 1: Configure Sprint-PRIMARY as a delivery method

1) Run PG Admin.
2) Right click Carriers, select Add
3) Specify the following:

Carrier: Sprint-PRIMARY

Protocol: SNPP

Host: snpp.messaging.sprint.com

Port: 444

Max Chars: 160
4) Click Apply.

Step 2: Configure Sprint-FINAL as a delivery method
1) Right click Carriers, select Add
2) Specify the following:
Carrier: Sprint-FINAL
Protocol: SMTP

Host: messaging.sprintpcs.com

Port: Specify the port required by your SMTP server.
Max Chars: 160

3) Go to Carriers - Sprint-FINAL - Advanced

4) Specify the following:
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Select the 'Deliver through outgoing mail server' option and enter your SMTP server

address in the 'Relay Server' field.

For example, if you use Office365, you would use smtp.office365.com as the relay

server address.
Specify the required username and password.

Priority: See Prioritizing Messages
5) Click Apply
6) Go to Carriers - Sprint-FINAL - Template
7) Specify the following in the 'Settings' section:

From = The value from the username field
EXAMPLE:
From = CAD@notepage.com

8) Click Apply.

Step 3: Configure the failover system
1) Go to Carriers - Sprint-PRIMARY - Advanced
2) Click the dropdown arrow next to 'Failover' and select: Sprint-FINAL
3) Click Apply

Step 4: Create Recipients tied to the Sprint-PRIMARY method of delivery
1) Right click Recipients, select Add.
2) Specify the following:

Full Name: The name of the recipient

Recipient: This field will automatically populate but can be edited and may ONLY
contain alphanumeric characters, underscores and dashes.

Type: Normal

Carrier: Sprint-PRIMARY

Failover: See Failover Scenarios

ID/PIN: 10 digit cell phone number

Correct Incorrect
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7818290500 1781829500
Max Chars: Specify the number of characters you want the ability to send to this
recipient. If this value is higher than the carrier's "Max Chars" value, PageGate will
break up long messages in to multiple blocks.
3) Click Apply.

Prioritizing Messages

PageGate allows you to prioritize your traffic by setting a priority value at both a carrier and
recipient level and the 'Priority’ field can be found in the Advanced sub-section of every
carrier and recipient.

The scale of priority is 1 (the most important) to 32000 (the least important). By default, all
carriers and recipients start with a priority value of 100.

Entries that share a priority value are treated equally. Entries with lower values are treated
as more important, entries with higher values are treated as less important.

Carrier level priority determines the order in which carriers should have their messages
queued.
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For example, let's say that you use | Am Responding and Active911's message
aggregation service and that you also deliver regular email, SMS and pages through
PageGate. If you set the priority value for | Am Responding and Active911 to something
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lower than the priority value for the other carriers, PageGate will always schedule the | Am
Responding and Active911 messages to go out before anything else.

Carrier priority values are determined in a carrier's Advanced sub-section.

Recipient level priority determines the order in which recipients should receive their
messages.
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For example, let's say that you had a list of 100 recipients and that we had 10 recipients
who needed to receive their traffic before anyone else. If you set the priority value for those
recipients to something lower than the priority value for the other recipients, PageGate will
always schedule their messages first. To give a slightly more practical example, let's say
that you have a dispatch supervisor or fire marshal or IT director that needed to be notified
before anyone else in the system. You could edit the value of that recipient's Priority field to
be lower than the other recipients and that would ensure that they always received their
messages first.

Recipient priority values are determined in a recipient's Advanced sub-section.
How to send Pages

PageGate can be configured to deliver messages to pagers with modem, serial or
internet methods of delivery. Pagers receive their service through a local paging

transmitter or from carriers like USA Mobility and American Messaging and this
determines what you'll need to configure in PageGate.

Chapter 3 How to Send Messages



How to Send Messages 3

On-site paging transmitters, like those made by Zetron, Glenayre and Motorola, support
receiving messages via modem or serial line by the TAP protocol and PageGate supports
TAP delivery by either method. For more information on how to configure either a modem
or serial TAP carrier, have a look at the Creating a TAP Carrier section of the
documentation.

Pagers hosted through a paging company can be messaged with any protocols the carrier
supports.

For example, American Messaging and USA Mobility support the SNPP, WCTP, SMTP
and TAP protocols. SNPP and WCTP are more efficient and reliable than SMTP and
should be implemented where possible. If you're looking for a method of delivery that isn't
reliant on your internet connection, most pager companies also still support dial-in TAP
terminals.

PageGate also supports sending TAP by TCP/IP as well.

Click here for a list of known SNPP hosts.

Click here for steps to create SNPP carriers.

Click here for a list of known WCTP hosts.

Click here for steps to create WCTP carriers.

Click here for a list of known SMTP addresses.

Click here for steps to create SMTP carries.

Click here for a list of known TAP terminals.

Click here for steps to create TAP carriers.
How to send Emaiil

SMTP is the protocol used to send email of all varieties, including those delivered as
SMS; nearly every US and Canadian carrier supports text messaging to their phones
using a public access SMTP/Email gateway.

PageGate has a full mail server engine as a core part of the program and this gives you
the ability to send SMTP/Email messages in one of two ways: Direct and Relayed

To explain the difference between the two, direct delivery allows PageGate to use its own
mail server engine to directly negotiate with the receiving mail servers. Relayed delivery
configures PageGate to pass all of its traffic through a verified SMTP server for delivery,
like an email client.

Chapter 3 How to Send Messages 204


http://notepage.net/snpp.htm
http://notepage.net/wctp.htm
http://notepage.net/smtp.htm
http://www.notepage.net/tap-phone-numbers.htm

205

How to Send Messages 3

Technically, direct delivery is more efficient and reliable because it removes at least one
hop in the delivery sequence and also means that PageGate isn't reliant on another mail
server for delivery. However, when you have PageGate use direct delivery for
SMTP/Email, it has to abide by all of the rules required of a mail server because the
program will be functioning as a mail server to deliver SMTP/Email on behalf of your email
domain. This is incredibly important to note because, in an effort to combat spam, all
major US and Canadian carriers pay respect to SPF records.

SPF stands for "Sender Policy Framework" and is a record of public IP addresses that
are allowed to deliver email on behalf of your email domain. This record is published by
whoever owns and operates the email domain. If the PageGate server's public IP address
is not part of your email domain's SPF record, the major carriers will filter your messages
as potential spam for failing the SPF validation check. If you continue to send traffic that
fails SPF validation checks, the receiving servers will eventually blacklist your site from
sending any traffic to them.

To check to see if port 25 is open, run the Port Scan in the Program - Tools section of the
PageGate Admin.

To verify that your site can perform the necessary MX lookups and to discover what your
SPF record is, run DNS Lookup in the Program - Tools section of the PageGate admin.

Due to some of the complications involved in configuring PageGate for direct delivery, it is
usually more practical to configure PageGate to relay its SMTP/Email traffic through your
company or ISP's SMTP/Email server. However, doing so makes PageGate reliant on that
mail server for message delivery.

For information on how to configure a "Relayed Delivery" SMTP carrier, click here.

For information on how to configure a "Direct Delivery" SMTP carrier, click here.

Using webforms, Web APIs and REST APIs

PageGate supports the ability to use HTTP GET and POST methods which can be used
to submit web forms, request information from websites and/or WEB APIs and interact
with REST APls.

The website, web form or APl you interact with will directly determine what you need to
configure in PageGate.

GET and POST are conceptually similar to each other but perform their functions in
completely different ways. The GET method carries parameters in the URL string and the
POST method carries parameters in the request body. GET can be used to interact with
WEB APIs and POST is used to interact with webforms and REST APIs and both can be
used to request information from and submit information to them.
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e HTTPGET

As an example, ViaNett (vianett.com) is an SMS delivery service in Europe that provides a
Web APIto send SMS. This is a sample HTTP GET request to send a message via their
Web API:

https://smsc.vianett.no/v3/send?
username=UsernameValue&password=PasswordValue&msgid=1234&tel=4711111111
&msg=Hello+World&pricegroup=300&campaignid=12345

As you can see, all variables are declared as part of the URL. If you need to reference
JSON, XML or something similar, you'll want to use the POST method.

e HTTPPOST
Web APIs, REST APIs and webforms all have different requirements for the headers and
contents they need to see.

Web forms you interact with, whether it be PHP, CGl or something else, will have certain
parameters that determine whether you're requesting or submitting data and you'll need to
know each required parameter and the value that should be passed in it.

Some APIs want the body in JSON format, others want XML, others will accept both and
leave it to the end user to determine which they want to use.

It's important to gather as much information as you can about what APl or webform you're
interacting with and their documentation will typically provide required variables and how
they need to be implemented.

Templates for HTTP GET Carriers

Templates for HTTP GET carriers tell PageGate what variables and data to declare in the
URL passed to the API.

All variables are declared in the 'Text' section of the template as follows:
|<name1>|<value1>|

|<name2>|<value2>|

etc.

Each value you specify will need to correspond to a variable that the receiving API will
recognize. For example, let's say we wanted to send a message to an APl that looked for
to, from, subject and text as variables. We would need to format the text template as
follows:

to|%Recipientld%|
[from|%Sender%|
|subject|%Subject%|
text|%Message%]|
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NOTE: | a pipe character.

The following parameters can be specified in the 'Settings' section of an HTTP GET
carrier
Possi
. ble .
Variable Value Description
s
Example: BodyMaxChars =200
BodyMaxCh | Numeri
ars c This parameter limits the length of the %Message% macro and
does not override the carrier "Max Chars" setting.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate

File
path program directory to use this parameter.
toﬁ?end Example: Filter = c:\\PageGateData\Filters\yourcarrierfilter.xml
Filter
n?r::e This parameter calls on PageGate's filtering system when
Oﬂt © sending and receiving SMS through this carrier. This allows for
) liter the sorting and modification of both outbound messages and
o run replies and is an integral part of two-way messaging.
File
th
tgaand Example: FilterDebugFile = c:
FilterDebug | file \PageGateData\Filters\outboundfilter1.log
File n?[:e When using a filter, you can use this variable to output this
I(:)g tz specific filter's log to the specific location and file name.
write
Example: From = CAD
E Text This parameter overrides the value passed to PageGate by the
rom © input modules/APls. By specifying this variable, you're telling
PageGate to use a single, standardized sender's name for all
traffic controlled by this template.
Com NOTE: This parameter's routine only engages when receiving a
200 class response from the web server.
mand
HitpErrorRe Sstn "9 | This variable tells PageGate to scan for the specified keywords
sponse D °€  lor keyphrases in responses to a GET requests made by this
ip?iso(;r carrier. If those keywords or keyphrases are found, the message

is treated as failed or rejected, depending on what you specify.
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HttpProtocol

HttpRespon
seTimeout

HttpSucces
sResponse

HTTP
S
HTTP

Millise
conds

Com
mand
String
See
Descr
iption

This variable is both case and punctuation sensitive and
PageGate will look for an exact match to what you enter.

Multiple search terms may be used and must be separated by a
pipe.

For example, this would only scan for the word failed:
HttpErrorResponse = failed

This would scan for the word failed in the <Reply> tag:
HttpErrorResponse = <Reply>failed</Reply>

This would scan for the word reject or the word failed in the
<Reply> tag:
HttpErrorResponse = reject|<Reply>failed</Reply>

This would scan for the word failed OR the word reject OR the
phrase object not found:
HttpErrorResponse = failed|reject|object not found

Any response from the web server that includes the search
term(s) will be treated as a failure.

Example: HttpProtocol = HTTPS

This parameter forces the use of HTTPS regardless of the port
used to connect.

Example: HitpResponseTimeout = 1000

This variable forces PageGate to wait for the specified number
of milliseconds (1000 = 1 second) for a response to the HTTP
communication request.

NOTE: This parameter's routine only engages when receiving a
200 class response from the web server.

This variable tells PageGate to scan for the specified keywords
or keyphrases in responses to a GET requests made by this
carrier. If those keywords or keyphrases are found, the message
is treated as failed or rejected, depending on what you specify.

This variable is both case and punctuation sensitive and
PageGate will look for an exact match to what you enter.
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Multiple search terms may be used and must be separated by a
pipe.

For example, this would only scan for the word success:
HitpSuccessResponse = success

This would scan for the word Acknowledged in the <Reply> tag:
HttpSuccessResponse = <Reply>Acknowledged</Reply>

This would scan for the word hijinks or the word Acknowledged
in the <Reply> tag:
HitpSuccessResponse =hijinks|<Reply>Acknowledged</Reply>

This would scan for the word success OR the word hijinks OR
the word actualization:
HttpSuccessResponse = success|hijinks|actualization

Any response from the web server that includes the search
term(s) will be treated as a success.

Example: InterMessageDelay = 1000

InterMessag | Millise | This variable inserts a pause, in milliseconds, in between each
eDelay conds | message thatis delivered. It could be possible for PageGate to
send a large number of data requests too quickly and this
prevents that from happening.

Example: ParameterDelimiter = !

Message templates for HTTP GET carriers usually involve
See | parameter + variable pairs that are declared in this format:

ParameterD :
. Descr | [parameter|variable|
elimiter -
iption

ParameterDelimiter allows you to change the 'wrapping'
character from a pipe (|) to something else, like an exclamation
mark (!).
Example: ResponseincludeRequest = True

Responseln | 16

cludezeque False @ Setting this parameter to true tells PageGate to include the

original request sent to the APl when recording responses.
Example: ResponsePath = c:\\PageGateData\APIResponses\

ResponseP | File

ath Path This parameter allows you to specify the folder that responses

should be written to. If APl responses do not need to be tracked,
this parameter is not required.
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Example: ResponseRecipient = groupname

Recipi When the HTTP GET or POST transaction completes, the

ResponseR | ent
ecipient specified recipient or group will receive any responses from the
Group | receiving APliweb host. For more information, please see the

Two Way Messaging section of the documentation.

Example: StripAlpha = True

True | Setting this value to true will remove any alphabetical character

StripAlpha False | from messages delivered through this carrier. For example, if
you tried to send the message 'Alert on node 127.0.0.1', the only
thing delivered would be '127.0.0.1"

See Example: StripCharacters = |\~
Strlpigrr;arac descrip | This parameter will remove all instance of any character(s)

tion |entered. In the above example, that would strip out all pipes (),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True

i i | True
StripNonPri Settings this value to true will remove any non-printable ASCII

ntable False | characters, like carriage retums, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.
To =7818290500
To Text | This variable overrides the ID/PIN or Email values. By specifying

this variable, you're telling PageGate to send all traffic processed
by this template to the specified ID or Email address instead.
Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

True

UseFilterDI Example: UseFilterDIl = True
False

Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.

Templates for HTTP POST Carriers

Templates for HTTP POST carriers tell PageGate how to interact and how to structure
data passed to a web form, Web APlor REST API.

It's important to gather as much information as you can about what APl or webform you're
interacting with and their documentation will typically provide required variables and how
they need to be implemented.
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Conceptually, the 'Settings' section of a POST carrier template tells PageGate if the API
requires any special interaction and the "Text' section determines what variables to
declare and how to structure the message body.

These values can be used in the 'Settings' section of an HTTP POST carrier:

Possi
Variable ble Description
Value
s
Example: BodyMaxChars = 200
BodyMaxC Numeric
hars This parameter limits the length of the %Message% macro and
does not override the carrier "Max Chars" setting.
Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
File program directory to use this parameter.
path to
and file | Example: Filter = c:\\PageGateData\Filters\yourcarrierfilter.xml
Filter name

ofthe | This parameter calls on PageGate's filtering system when
filter to | sending and receiving SMS through this carrier. This allows for
run the sorting and modification of both outbound messages and
replies and is an integral part of two-way messaging.

File
pathto | Example: FilterDebugFile = c:
and file | \PageGateData\Filters\outboundfilter1.log

FilterDebu
. name
gFile ofthe | When using a filter, you can use this variable to output this
logto | specific filter's log to the specific location and file name.
write
Example: From = CAD
From Text This parameter overrides the value passed to PageGate by the
input modules/APls. By specifying this variable, you're telling
PageGate to use a single, standardized sender's name for all
traffic controlled by this template.
C NOTE: This parameter's routine only engages when receiving a
omm
and 200 class response from the web server.

HttpErrorR | String
esponse See

Descri

ption

This variable tells PageGate to scan for the specified keywords
or keyphrases in responses to a POST requests made by this
carrier. If those keywords or keyphrases are found, the message
is treated as failed or rejected, depending on what you specify.
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HttpPostTy
pe

HttpProtoc
ol

HttpRespo
nseTimeou
t

HttpSucce
ssRespons
e

HeadB
ody
UrlHea
dBody

HTTP
S
HTTP

Millise
conds

Comm
and
String

This variable is both case and punctuation sensitive and
PageGate will look for an exact match to what you enter.

Multiple search terms may be used and must be separated by a
pipe.

For example, this would only scan for the word failed:
HttpErrorResponse = failed

This would scan for the word failed in the <Reply> tag:
HttpErrorResponse = <Reply>failed</Reply>

This would scan for the word reject or the word failed in the
<Reply> tag:
HttpErrorResponse = reject|<Reply>failed</Reply>

This would scan for the word failed OR the word reject OR the
phrase object not found:
HttpErrorResponse = failed|reject|object not found

Any response from the web server that includes the search
term(s) will be treated as a failure.

HttpPostType = HeadBody configures an HTTP POST carrier to
provide header information followed by structured data, usually
JSON or XML, in the body.

HttpPostType = UrIHeadBody configures an HTTP POST carrier
to pass parameters in the URL, more like the POST method.
This is not a typical use of HTTP POST but is used/required by
some APls.

Example: HitpProtocol = HTTPS

This parameter forces the use of HTTPS or HTTP regardless of
the port used to connect.

Example: HttpResponseTimeout = 1000

This variable forces PageGate to wait for the specified number
of milliseconds (1000 = 1 second) for a response to the HTTP
communication request.

NOTE: This parameter's routine only engages when receiving a
200 class response from the web server.
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See
Descri
ption

InterMessa | Millise

geDelay | conds
Parameter See .
. Descri
Delimiter .
ption
Responsel | Tre
ncludeReq
uest False

This variable tells PageGate to scan for the specified keywords

or keyphrases in responses to a POST requests made by this
carrier. If those keywords or keyphrases are found, the message
is treated as failed or rejected, depending on what you specify.

This variable is both case and punctuation sensitive and
PageGate will look for an exact match to what you enter.

Multiple search terms may be used and must be separated by a
pipe.

For example, this would only scan for the word success:
HttpSuccessResponse = success

This would scan for the word Acknowledged in the <Reply> tag:
HttpSuccessResponse = <Reply>Acknowledged</Reply>

This would scan for the word hijinks or the word Acknowledged in
the <Reply> tag:
HttpSuccessResponse =hijinks|<Reply>Acknowledged</Reply>

This would scan for the word success OR the word hijinks OR the
word actualization:
HttpSuccessResponse = success|hijinks|actualization

Any response from the web server that includes the search
term(s) will be treated as a success.

Example: InterMessageDelay = 1000

This variable inserts a pause, in milliseconds, in between each
message thatis delivered. It could be possible for PageGate to
send a large number of data requests too quickly and this
prevents that from happening.

Example: ParameterDelimiter = !

Message templates for HTTP POST carriers usually involve
parameter + variable pairs that are declared in this format:
|[parameter|variable|

ParameterDelimiter allows you to change the 'wrapping' character
from a pipe (|) to something else, like an exclamation mark (!).

Example: ResponselncludeRequest = True
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Response File
Path Path
Recipi
Response ent
Recipient
Group
True
StripAlpha
False
See
StripChara descripti
cters
on
StripNonPr | True
intable False
To Text
UseFilterDI | True
| False

Setting this parameter to true tells PageGate to include the
original request sent to the APl when recording responses.

Example: ResponsePath = c:\\PageGateData\APIResponses\

This parameter allows you to specify the folder that responses
should be written to. If APl responses do not need to be tracked,
this parameter is not required.

Example: ResponseRecipient = groupname

When the HTTP POST transaction completes, the specified
recipient or group will receive any responses from the receiving
APliweb host. For more information, please see the Two Way
Messaging section of the documentation.

Example: StripAlpha = True

Setting this value to true will remove any alphabetical character
from messages delivered through this carrier. For example, if you
tried to send the message 'Alert on node 127.0.0.1', the only
thing delivered would be '127.0.0.1'

Example: StripCharacters = |\~

This parameter will remove all instance of any character(s)
entered. In the above example, that would strip out all pipes (|),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True

Settings this value to true will remove any non-printable ASCII
characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.

Example: To = 7818290500

This variable overrides the ID/PIN or Email values. By specifying
this variable, you're telling PageGate to send all traffic processed
by this template to the specified ID or Email address instead.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: UseFilterDIl = True
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Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.

This is how to use the 'Text' section of an HTTP POST carrier:
Each value you specify will need to correspond to a variable that the receiving APl will
recognize. For example, let's say we wanted to send a message using Twilio's API. We
know they're looking that looked for to, from and body as variables. We would need to
format the text template as follows:

to|%Recipientld%|
[from|%Sender%|
lbody|%Message%|

NOTE: |is a pipe character and is found on most keyboards above the backslash
character, \.

Some APIs, like MessageBird, require an authentication variable in the body of the POST
and those are declared like any other variable.

Example:
|Authorization|]AccessKey PasteYourAccessKeyHere|

[recipients|%Recipientld%|
loriginator|%Sender%|

lbody|%Message%|

Miscellaneous Methods

Outside of SMS, email and paging, PageGate has the ability to communicate in other
methods to a variety of sources and devices. PageGate's miscellaneous delivery methods
are:

e XMPP (Extensible Messaging and Presence Protocol)
This protocol allows PageGate to communicate with an XMPP server/chat system such as
Jabber. Click here to access the steps to create an XMPP carrier.

e FAX
This protocol allows PageGate to use a faxmodem to deliver messages to destination Fax
machines. Click here to access the steps to create a FAX carrier.

e FAXSrv
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This protocol allows PageGate to pass facsimile messages to either a local or network
available Microsoft fax server. Click here to access the steps to create a FAXSrv carrier.

e RawSerial
This protocol allows PageGate to deliver messages as raw data strings over a serial port.
Click here to access the steps to create a RawSerial carrier.

e RawTCP
This protocol allows PageGate to deliver messages by Raw TCP to a host IP. Click here
to access the steps to create a RawTCP carrier.

e File

This protocol allows PageGate to output a message as an ascii formatted file to a
specified directory. This is incredibly useful when implementing the PageGate Filter Pack
as it allows you to put messages through for secondary processing. This protocol also, just
as an example, allows you to keep a hard record of messages that are sent from the
program by keeping a copy of every message sent as a file in the specified directory.
Click here to access the steps to create a File carrier.

e TONE/Touch Tone/DTMF (Dual Tone Multi-Frequency)
This protocol allows PageGate to use a dial-up modem to deliver touch tones to older

numeric-only pagers and similar equipment. Click here to access the steps to create a
TONE carrier.

e UCP (Universal Computer Protocol)

A delivery protocol for analog modem, or direct serial communications to a wireless
provider. Click here to access the steps to create a UCP carrier.

PageGate is designed to be a highly modular application that can send messages to cell
phones, pagers, email addresses or any combination of the three. This design also allows
PageGate's modules to be run across multiple computers and platforms. The following
installation information covers installation of PageGate on a single computer.

When you run PageGate's installation file, you'll be prompted to perform one of four
installations:
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age Gate...

Install PageG ate Server

Install PageGate GUI Client

Installers for additional administrative workstations

Inztall Additional PG Admin

Inztall Additional PG Momtor

Exit

The Install PageGate Server option should only be run on the system that will be hosting
the database and functioning as the PageGate server. If you want to grant a workstation
access to the PageGate Admin, you should use the "Install Additional PG Admin" option.

The PageGate Server installation will install the following components:

e PageGate Server
This is the control module for PageGate. It is constantly running in the background

whenever the PageGate application is running. It monitors, starts, and stops the other
PageGate modules.

e PageGate Scheduler
This module processes all messages sent by PageGate. It manages scheduled and

repeating messages, in addition to scheduling the delivery of each message by a
Connector.

e PageGate Connectors
The Connectors are responsible for the actual delivery of the messages.

o PageGate Interfaces
These modules (GetAscii, GetMail, GetWeb, GetTAP, GetSerial and GUI) accept
messages from various sources, into the PageGate application.
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e PageGate Add-ons

Additional server processes than can be run to accept messages into the PageGate
Server: SNPP Server Add-on, Touch-Tone Receiver Add-on (require the GetAscii
interface for operation)

The PageGate GUI Client installation will install the following components:
e PageGate Client
A Windows based program installed on workstations on the same network as the

PageGate server. This program provides a graphical user interface to send and schedule

messages.

The Additional PG Admin installation will install the following components:

e PageGate Admin

The administration program is used to setup, control, and maintain the PageGate
application.

The Additional PG Monitor installation will install the following components:

e PageGate Monitor

The monitoring application allows for real-time monitoring of the PageGate application
from the local machine, or from any other workstation that is connected to the PageGate
server via TCP/IP.

PageGate Server

The PageGate Server is the main processing portion of PageGate. All messages,
modules, and interfaces are contained within and run by the PageGate Server. This
installation should only be performed on the system intended to host the PageGate Server
and its data.

Minimum system requirements:
Operating System: Windows 7, Windows 8, Windows 10, Server 2012, Server 2016,

Server 2019, Server 2022
Processor: 1.0 Ghz Processor or better.
Memory: 1GB RAM

Storage: 100 MB of free disk space (for application and database)
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Communications: PageGate supports internet, hardware and TCP based
communications. Please review the How PageGate Sends Messages section of the
documentation to understand what is required to deliver your traffic.

Please reference the Installation Steps section of the manual for information on how to
install the program.

Installation Steps

e Downloaded installation file

The classic installation method. Download an executable, run it and go through the

installation steps.

e Promptless Automatic installation

A more advanced installation method for deploying the PageGate server via command

line parameters passed to the installation.

e Upgrading from a previous version

Have a previous version? These steps will guide you through the process to upgrade
your existing installation to version 10.
Installation by Download

1) Open a web browser.

2) Go to our website: https://www.notepage.net

3) In the center of the page, click on the Download button under the PageGate section.
4) When prompted, you want to save the file.

5) Save the pgsetup.exe file somewhere easy to reference, like the Desktop.

6) After the file has been downloaded, right click on it and select "Run As Administrator".
7) When prompted, select the Install PageGate Server option.

8) Click Next.

9) Select whether or not you want to view the ReadMe File and/or Release Notes, then
click on Next.
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10) Please read the End User License Agreement (EULA), then select "l accept the
agreement" and click on Next.

11) In the next step, you will be prompted for the PageGate Server installation directory. By
default, the installation directory is C:\Program Files(x86)\NotePage\PageGate\
The installation directory can be changed to any local path. Click Next to proceed.

12) In the next step, changes to the program group PageGate will appear under in the start
menu can be made. Click Next to proceed.

13) Select whether you want to create a Desktop Icon for PageGate and click on Next.
14) Click Install to begin installing the PageGate Server.
15) Click Finish to finalize the installation.

Be sure to make a copy of the installation file and store it somewhere safe. You will need it
again if you ever need to reinstall PageGate, or want to install the Additional PageGate
Administrator, Additional PageGate Monitor, or GUI Client on a workstation.

Promptless Automatic Installation

Any part of PageGate can be installed unattended. This helps network administrators to
automate the program's installation.

1) Start the PageGate setup program as usual (see above).

2) When the list of installation options screen is shown, exit the installation.
3) Browse in to the c:\Users\<your_user>\AppData\Local\Temp\ directory.
4) Copy the 'PGSetup’ folder to another location.

5) Use the following command line syntax to run a promptless install.
PageGate Server Installation File: pgssetup.exe

Command line options:
Installs without prompts. Does display progress screens, will prompt for.

Isilent :
reboot if necessary.
. Installs without prompts, display screens and will reboot without
Iverysilent .
prompting, if necessary.
/norestart This flag prevents the installation from rebooting, even if necessary.

/dir ="x:\dirname" |This flag overrides the default installation directory.
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Igroup="folder

name" This flag overrides the default Windows Start Menu group name.

. This flag will prevent the installation from creating the desktop icons for
/noicons

the program.

The <path> option should be replace with the path to where you copied the 'PGSetup’
folder in step #2 above.

Here is an example of a promptless install of the PageGate server if the PGSetup folder
was copied to C:\

C:\PGSetup\pgssetup.exe /silent /dir="c:\PageGate"

That command line would install the PageGate server to c:\\PageGate\ without prompting
for information, would display the progress screens and would prompt to reboot the

system if necessary.
Optional Registry Settings

Note: Folders that are set must be created and given sufficient rights before the program
is run.

Location: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NotePage\PageGate\

Name sz Description

Prog_Di Strin| This value specifies the directory in which the program was resides. The
r g | path specified in this field must end in a backslash, \.
DB Dir Strin| This value specifies the directory in which the database resides. The path
- g |specified in this field must end in a backslash, \.
Strin| This value specifies the directory in which the logs reside. The path
g |specified in this field must end in a backslash, \.
Archive Strin| This value specifies the directory in which archived information should
_Dir | g |reside. The path specified in this field must end in a backslash, \.
If a database password has been set on the PageGate database, the
DB_Pa Strin| password for the database can be specified here. Due to the nature of the
ssword | g | security involved, the value is encrypted, so it must be copied from a
system with the password already set.

Log_Dir

Upgrading to version 10

Make sure you have a v10 registration key. Previous version
registration keys will not work with version 10.

1) Make a backup of the PageGate database (pagegate.mdb). By default, this file is
located in the c:\\PageGateData\Database\ directory.
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2) If you're using PageGate's GetMail Module, please backup the PageGate Mailboxes
sub-directory of the PageGate Program directory.

3) If you're using PageGate's GetWeb interface, please backup the web

templates/webpages.

a) On the computer running the PageGate Server, open the PageGate Admin.

b) Go to the Interfaces - GetWeb - Settings section.

c) Make a note of the Web Pages Directory.

d) Browse to the directory indicated in step c.

e) In this directory, there will be a sub-directory called Templates.

f) To backup your webpage templates, you could copy the Templates folder to a CD,
make a copy on a network location, make a copy in a different folder on the current
system, the methods of backing up can vary widely.

4) Shut down every part of PageGate. Make sure that none of the PageGate processes or
applications, even the PageGate Client on the workstations, are running.

5) To verify that everything has been shut down, run the Task Manager in Windows by
pressing Ctrl+Alt+Del on your keyboard or by right clicking on the task bar and
selecting "Task Manager".

6) Once the task manager comes up, browse through the Applications or Processes tab.
There should be nothing the begins with PG in either list. If you see something that
begins with PG that’s still in the list, please highlight it and click on End Task.

7) Download the latest PageGate installation file from our website
(https://www.notepage.net - Click the download button under the PageGate section and
save the pgsetup.exe file to your desktop).

8) Right click on the pgsetup.exe, left click on "Run As Administrator".

9) When it asks which installation you wish to run, the only option you want to select is
Install PageGate Server.

10) Unless you need to change the installation directory, you can really just click next
through the entire routine until it finishes.

11) Now that we have version 10 installed, right click the shortcut for 'PageGate Admin'
and select "Run As Administrator"”.

12) The Admin will prompt you for the version 10 Registration Key. Please enter it, then
click Apply.

13) Go to the Program - Settings section.
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14) Once in the Settings, you should see a section that says "Run PageGate As". If you
are using Windows Server 2016 or 2019, select 'PG Service'. For other operating
systems, select 'Windows Service'.

15) Click Apply.
When you click on Apply, you will be prompted for a username and password. In most
cases, you can leave both values blank and click 'Apply' again.
To explain, if the default System Account in Windows is enabled, you can leave the
credentials blank. If the default system account is disabled, you will need to provide an
account name and password that has the "Log on as Service" security policy.
Click here for more information.

16) Open the Services listin Windows. You can do this by either going in to the Services
section of the Administrative Tools in the Control Panel or by running services.msc in
the Run command.

17) Browse to the PageGate Service.
18) Right click on the PageGate service, tell it to start.

To upgrade the PageGate Client to v10, please refer to this portion of the manual.

To upgrade the Additional PageGate Admin to v10, please refer to this portion of the
manual.

To upgrade the Additional PageGate Monitor to v10, please refer to this portion of the
manual.
Windows Server 2016 and 2019 Core

These are the steps to install the PageGate Server in Windows Server 2016 and 2019
Core (no GUI).

1) Configure networking: sconfig (this is optional)

2) Run powershell: powershell

3) Download PageGate setup program: invoke-webrequest
https://www.notepage.net/download/pgsetup.exe -outfile pgsetup.exe

4) Return to command prompt: exit

5

6

7

Run PageGate setup: pgsetup
select the Install PageGate Server option.

)
)
)
) Click Next.
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8) Select whether or not you want to view the ReadMe File and/or Release Notes, then
click on Next.

9) Please read the End User License Agreement (EULA), then select "l accept the
agreement" and click on Next.

10) In the next step, you will be prompted for the PageGate Server installation directory. By
default, the installation directory is C:\Program Files(x86)\NotePage\PageGate\

The installation directory can be changed to any local path. Click Next to proceed.

11) In the next step, changes to the program group PageGate will appear under in the start
menu can be made. Click Next to proceed.

12) Click Next.

13) Click Install to begin installing the PageGate Server.

14) Click Finish to finalize the installation.

PageGate GUI Client

The PageGate GUI Client is a Windows based program that can be installed on
workstations on the same network as the PageGate server. This program provides a
graphical user interface that shows a list of recipients available to message and grants the
ability to immediately send or schedule messages.
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The PageGate Client can be installed on the server but is intended to be run from
workstation computers.

Note: If you have the GUI Client installed on the PageGate server, do not have the

workstations reference the PageGate Server's GUI Client program folder. Each
workstation requires its own installation of the GUI Client.

Minimum system requirements to run the PageGate GUI Client:

Operating System: Windows 7, Windows 8, Windows 10, Server 2012,
Server 2016, Server 2019, Server 2022

Processor: 1.0 Ghz Processor or better.

Memory: 1GB RAM

Storage: 100 MB of free disk space (for application and database)
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Please reference the Installation Steps section of the manual for information
on how to install the program.

Pre-installation

There are a few things you should verify before installing the PageGate GUI Client:
1) The PageGate Server must be installed and operational before the PageGate GUI
Clientis installed.

2) The PageGate Server's database directory must be shared on the network and the
workstation must have sufficient network permissions to the database (pagegate.mdb).
The workstation must have read, write, and change permissions to this file.

3) If you plan to use the spell-checking feature, Microsoft Office 2000 or newer must be
installed on the workstation.
4) If application or database passwords have been defined in the PG Admin program,

they will be needed to access the application and the PageGate database.

Installation Steps

e Downloaded installation file

The classic installation method. Download an executable, run it and go through the

installation steps.

e Promptless Automatic installation

A more advanced installation method for deploying the PageGate Client to multiple

workstations at once.

e Upgrading from a previous version

Have a previous version? These steps will guide you through the process to upgrade
your existing installation to version 10.
Installation by Download

1) Open a web browser.

2) Go to our website: https://www.notepage.net
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3) In the center of the page, click on the Download button under the PageGate section.

4) When prompted, save the file somewhere convenient to reference, like the Desktop.

5) After the file has been downloaded, right click on it and select "Run As Administrator"

6) If prompted by the User Accounts Control, allows the installation to proceed.

7) When prompted, select Install PageGate GUI Client.

8) Click Next.

9) Select whether or not you want to view the ReadMe File and/or Release Notes, then
click on Next.

10) Please read the End User License Agreement (EULA), then select "l accept the
agreement" and click on Next.

11) In the next step, you will be prompted for the PageGate Client installation directory. By
default, the installation directory is C:\Program Files (x86)\NotePage\PageGate Client.
Once you've specified the installation path, click on Next to proceed.

12) In the next step, changes to the program group in the Start Menu the PageGate Client
will appear under can be made. Click Next to proceed.

13) Select whether you want to create a Desktop Icon for the PageGate Client and click on
Next.

14) Click Install to begin installing the PageGate Client.

15) Click Finish to finalize the installation.

Be sure to make a copy of the installation file and store it somewhere safe. You will need it
again if you ever need to reinstall PageGate, or want to install the Additional PageGate
Administrator, Additional PageGate Monitor, or GUI Client on a workstation.

Promptless Automatic Installation

Any part of PageGate can be installed unattended. This helps network administrators to
automate the program'’s installation.

1) Start the PageGate setup program as usual (see above).

2) When the list of installation options screen is shown, exit the installation.
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3) Browse in to the c:\Users\<your_user>\AppData\Local\Temp\ directory.
4) Copy the 'PGSetup’ folder to another location.

5) Use the following command line syntax to run a promptless install.
Installation executable for the GUI Client: pgcsetup.exe

Command line options:
Installs without prompts. Does display progress screens, will prompt for

Isilent _
reboot if necessary.
. Installs without prompts, display screens and will reboot without
Iverysilent S
prompting, if necessary.
/norestart This flag prevents the installation from rebooting, even if necessary.

[dir ="x\dirname" |This flag overrides the default installation directory.

i]gar;lgf folder This flag overrides the default Windows Start Menu group name.
, This flag will prevent the installation from creating the desktop icons for
/noicons

the program.
Here is an example of a promptless install of the PageGate server if the PGSetup folder

was copied to C:\
C:\PGSetup\pgcsetup.exe /silent /dir="c:\PageGate Client\"

That command line would install the PageGate server to c:\\PageGate Client\ without
prompting for information, would display the progress screens and would prompt to reboot

the system if necessary.
Optional Registry Settings

Client Reqistry Settings

Note: Folders that are set must be created and given sufficient rights before the program
is run.

Location: HKEY_CURRENT_USER\SOF TWARE\NotePage\NotePagerNet\

Name Type Description

By default settings in the Current User portion of the registry are used.
If every user on the workstation should use the standardized, rather

Dword than logon specific, settings, then the Local Machine portion of the
registry can be forced to be used instead by setting LockSettings to 1,
which is a 'true’ value.

LockSettin
S
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This value specifies the directory in which the database resides. The
path specified in this field must end in a backslash, \.

If a database password has been set on the PageGate database, the
password for the database can be specified here. Due to the nature of
the security involved, the value is encrypted, so it must be copied from
a system with the password already set.

This value specifies a static sender's name that this copy of the Client
will use when sending messages.

Note: Values lower than 10 are system reserved and should never be
used.

Clients with the same Station value will be able to reference each
others' message histories and be able to run reports on the same.

DB_Dir |String

DB_Passw

ord String

Sender |String

Station |String

Upgrading from a previous version

Make sure you DO NOT have the PageGate Client running. The update cannot be applied
if the PG Client is running.

1) Open a web browser.

2) Go to our website: https://www.notepage.net

3) In the center of the page, click on the Download button under the PageGate section.
4) When prompted, you want to save the file.

5) Save the pgsetup.exe file somewhere easy to reference, like the Desktop.

6) After the file has been downloaded, right click on it and select "Run As Administrator".
7) When prompted, select: Install PageGate GUI Client

8) Click Next.

9) Select whether or not you want to view the ReadMe File and/or Release Notes, then
click Next.

10) Please read the End User License Agreement (EULA), then select "l accept the
agreement" and click Next.

11) Click Install to begin installing the version 10 PageGate GUI Client.

12) Click Finish to finalize the installation.
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Additional PG Admin

Do not install this on the PageGate Server. The Additional PageGate Admin
is only intended for workstations.

The Additional PageGate Admin is a program that allows a workstation the
capability to modify PageGate's settings, such as the ability to add, modify, or
remove recipients and carriers. The workstation intended to run the Additional
PageGate Admin must have network access to the PageGate Server's database.
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Minimum system requirements to run the PageGate Admin

Operating System: Windows 7, Windows 8, Windows 10, Server 2012,
Server 2016, Server 2019, Server 2022

Processor: 1.0 Ghz Processor or better.

Memory: 1GB RAM

Storage: 100 MB of free disk space (for application and database)

Please reference the Installation Steps section of the manual for information
on how to install the program.
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Pre-installation

There are a few things that should be verified and setup before the installation of PG
Admin:

1) Do not install this on the PageGate Server. The Additional PageGate Admin program

is intended only for workstations.

2) Be sure your hardware meets the minimum specs for PageGate Admin.

3) Be sure the computer is configured for your network. The PageGate Admin must
access the PageGate database through your LAN (Local Area Network).

4) Be sure that you have sufficient permissions (if applicable) to install new programs on
the chosen computer.

5) In some cases, you will be asked to restart your computer after the installation of the
PageGate Admin. If so, this must be done before the PageGate Admin is run. Be sure
that you install the PageGate Admin at a time when this can be done.

6) Always be sure to have a complete backup of your system before installing any new
software! The installation of the PageGate Admin is not and exception to this rule.

Installation Steps

e Downloaded installation file

The classic installation method. Download an executable, run it and go through the

installation steps.

e Promptless Automatic installation

A more advanced installation method for deploying the PageGate Admin to multiple

workstations at once.

e Upgrading to version 10 from a previous version

Have a previous version (4 - 9)? These steps will guide you through the process to
upgrade your existing installation to version 10.
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Installation by Download

1) Open a web browser.

2) Go to our website: https://www.notepage.net

3) Inthe center of the page, click on the Download button under the PageGate section.
4) When prompted, you want to save the file.

5) Save the pgsetup.exe file somewhere easy to reference, like the Desktop.

6) After the file has been downloaded, right click on it and select "Run As Administrator”.
7) When prompted, select: Install Additional PG Admin

8) Click Next.

9) Select whether or not you want to view the ReadMe File and/or Release Notes, then
click on Next.

10) Please read the End User License Agreement (EULA), then select "l accept the
agreement" and click on Next.

11) In the next step, you will be prompted for the PageGate Admin installation directory. By
default, the installation directory is C:\Program Files(x86)\NotePage\PageGate Admin\
The installation directory can be changed to any local path. Click Next to proceed.

12) In the next step, changes to the program group for the PageGate Admin will appear
under in the start menu can be made. Click Next to proceed.

13) Select whether you want to create a Desktop Icon for the PageGate Admin and click
on Next.

14) Click Install to begin installing the PageGate Admin.
15) Click Finish to finalize the installation.

Promptless Automatic Installation

Any part of PageGate can be installed unattended. This helps network administrators to
automate the program's installation.

1) Start the PageGate setup program as usual (see above).

2) When the list of installation options screen is shown, exit the installation.
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3) Browse in to the c:\Users\<your_user>\AppData\Local\Temp\ directory.
4) Copy the 'PGSetup’ folder to another location.

5) Use the following command line syntax to run a promptless install.
PageGate Server Installation File: pgasetup.exe

Command line options:
Installs without prompts. Does display progress screens, will prompt for

Isilent _
reboot if necessary.
. Installs without prompts, display screens and will reboot without
Iverysilent S
prompting, if necessary.
/norestart This flag prevents the installation from rebooting, even if necessary.

[dir ="x\dirname" |This flag overrides the default installation directory.

/group="folder

name" This flag overrides the default Windows Start Menu group name.

, This flag will prevent the installation from creating the desktop icons for
/noicons
the program.

The <path> option should be the 'PGSetup' folder in step #4 above.

Here is an example of a promptless install of the PageGate Admin if the PGSetup folder
was copied to C:\

C:\PGSetup\pgasetup.exe /silent /dir="c:\PageGate Admin\"

That command line would install the PageGate server to c:\\PageGate Admin\ without
prompting for information, would display the progress screens and would prompt to reboot

the system if necessary.
Optional Registry Settings

Note: Folders that are set must be created and given sufficient rights before the program
is run.

Location: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NotePage\PageGate\

N2m Type Description

PrOg—Strin This value specifies the directory in which the program was resides. The
Dir 9 path specified in this field must end in a backslash, \.

DB This value specifies the directory in which the database resides. The path

Dir_ String specified in this field must end in a backslash, \.
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Log Strin This value specifies the directory in which the logs reside. The path specified
Dir 9 in this field mustend ina backslash, \.
Archiv., . | This value specifies the directory in which archived information should

e_DirStrlng reside. The path specified in this field must end in a backslash, \.

If a database password has been set on the PageGate database, the

DB_P . password for the database can be specified here. Due to the nature of the
assw String Y : . .
ord security involved, the value is encrypted, so it must be copied from a system

with the password already set.

Upgrading from a previous version

Make sure you DO NOT have the PageGate Admin running. The update cannot be applied
of the PG Adminis running.

1) Open a web browser.

2) Go to our website: https://www.notepage.net

3) Inthe center of the page, click on the Download button under the PageGate section.
4) When prompted, you want to save the file.

5) Save the pgsetup.exe file somewhere easy to reference, like the Desktop.

6) After the file has been downloaded, right click on it and select "Run As Administrator".
7) When prompted, select: Install Additional PG Admin

8) Click Next.

9) Select whether or not you want to view the ReadMe File and/or Release Notes, then
click Next.

10) Please read the End User License Agreement (EULA), then select "l accept the
agreement" and click Next.

11) Click Install to begin installing the version 10 PageGate PG Admin.

12) Click Finish to finalize the installation.

Additional PG Monitor

Do not install this on the PageGate Server. The Additional PageGate
Monitor program is only intended for workstations.
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The Additional PageGate Monitor is a program that allows a workstation to view
what's happening in PageGate as it happens. It shows which modules are running,
how many messages have been processed, how many of the processed
messages are good, how many of the processed messages are bad, and also
gives the detailed log of the precise transactions between PageGate, its modules
and the messaging hosts PageGate contacts.

M - O X
File View Tools Help
Good  Bad

Server Ijl
Sched [
Gethsei [ 1
Getdal [ 0
GetSerial Ijl Ijl
GetTap Ijl Ijl
Getweb [ ][ 0
Cient [ o[ 1
Connectars Ijl Ijl
Pending Ijl

iShaw All Connectors

L

Minimum requirements to run the PageGate Monitor

Operating System: Windows 7, Windows 8, Windows 10, Server 2012,
Server 2016, Server 2019, Server 2022

Processor: 1.0 Ghz Processor or better.

Memory: 1GB RAM

Storage: 100 MB of free disk space (for application and database)
Please reference the Windows 8, 10, Server 2008, Server 2012, Server
2016 and Server 2019 portion of the manual to install on those operating

systems.
Installation Steps

¢ Installation by download
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The classic installation method. Download an executable, run it and go through the

installation steps.

e Promptless Automatic installation

A more advanced installation method for deploying the PageGate Monitor to multiple

workstations at once.

e Upgrading from a previous version

Have a previous version? These steps will guide you through the process to upgrade

your existing installation to version 10.

Installation by Download

1) Open a web browser.

2) Go to our website: https://www.notepage.net

3) In the center of the page, click on the Download button under the PageGate section.
4) When prompted, you want to save the file.

5) Save the pgsetup.exe file somewhere easy to reference, like the Desktop.

6) After the file has been downloaded, right click on it and select "Run As Administrator".
7) When prompted, select: Install Additional PG Monitor

8) Click Next.

9) Select whether or not you want to view the ReadMe File and/or Release Notes, then
click on Next.

10) Please read the End User License Agreement (EULA), then select "l accept the
agreement" and click on Next.

11) In the next step, you will be prompted for the installation directory. By default, the
installation directory is C:\Program Files(x86)\NotePage\PageGate Monitor\
The installation directory can be changed to any local path. Click Next to proceed.

12) In the next step, changes to the program group PageGate will appear under in the start

menu can be made. Click Next to proceed.
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13) Select whether you want to create a Desktop Icon for the PageGate Monitor and click
on Next.

14) Click Install to begin installing the PageGate Monitor.

15) Click Finish to finalize the installation.
Promptless Automatic Installation

Any part of PageGate can be installed unattended. This helps network administrators to
automate the program's installation.

1) Start the PageGate setup program as usual (see above).

2) When the list of installation options screen is shown, exit the installation.
3) Browse in to the c:\Users\<your_user>\AppData\Local\Temp\ directory.
4) Copy the 'PGSetup’ folder to another location.

5) Use the following command line syntax to run a promptless install.
PageGate Server Installation File: pgmsetup.exe

Command line options:
Installs without prompts. Does display progress screens, will prompt for.

Isilent ,
reboot if necessary.
. Installs without prompts, display screens and will reboot without
Iverysilent S
prompting, if necessary.
/norestart This flag prevents the installation from rebooting, even if necessary.

[dir ="x\dirname" |This flag overrides the default installation directory.

/group="folder

name” This flag overrides the default Windows Start Menu group name.

. This flag will prevent the installation from creating the desktop icons for
/noicons

the program.
The <path> option should be the 'PGSetup' folder in step #4 above.

Here is an example of a promptless install of the PageGate Monitor if the PGSetup folder
was copied to C:\

C:\PGSetup\pgmsetup.exe /silent /dir="c:\PageGate Monitor\"
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That command line would install the PageGate server to c:\\PageGate Monitor\ without
prompting for information, would display the progress screens and would prompt to reboot

the system if necessary.
Optional Registry Settings

Location: HKEY_LOCAL_MACHINE\SOFTWARE\NotePage\PageGate\

Description

Name Typ
e

Dwor This key specifies the port number that PageGate uses to send updates via

PGM_| d, UDP. This setting MUST match the setting used by the PageGate Server,

Port |Deci| referenced in the Logging section of the documentation. Use a value of
mal | 10101 decimal, unless the server value has been changed.

NPP_ Strin| If the PageGate Monitor's NotePager Pro Alerts have been enabled, this key

Serr1de g | specifies the Sender information for these alerts.

Upgrading from a previous version

Make sure you do not have the PageGate Monitor running. The update cannot be applied
of the PG Monitor is running.

1) Open a web browser.

2) Go to our website: https://www.notepage.net

3) Inthe center of the page, click on the Download button under the PageGate section.
4) When prompted, you want to save the file.

5) Save the pgsetup.exe file somewhere easy to reference, like the Desktop.

6) After the file has been downloaded, right click on it and select "Run As Administrator".
7) When prompted, select: Install Additional PG Monitor

8) Click Next.

9) Select whether or not you want to view the ReadMe File and/or Release Notes, then
click Next.

10) Please read the End User License Agreement (EULA), then select "l accept the
agreement" and click Next.

11) In the next step, you will be prompted for the installation directory. Specify the existing
PageGate Monitor program directory, then click Next to proceed.
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12) In the next step, changes to the program group PageGate will appear under in the start
menu can be made. Click Next to proceed.

13) Select whether you want to create a Desktop Icon for the PageGate Monitor and click
Next.

14) Click Install to begin installing the PageGate Monitor.
15) Click Finish to finalize the installation.

To run PageGate for the first time, you'll need to choose your database style, configure
PageGate's input interfaces, configure delivery methods, then configure recipients and
groups.

Logically speaking, PageGate breaks down in to two halves: input and output. So, you'll
need to tell the program how you'll be passing messages in and then how to deliver those
messages and who they're going to.

Step 1: Choose your database style
PageGate currently supports two different database styles: SQL and MSJet. PageGate's
default installation uses the MSJet database format but you can quite easily configure the
program to use SQL instead.

e Click here for steps to use an MSJet database (default installation)

e Click here for steps to use an SQL database

Step 2: Confiqure PageGate to run as a System Service
PageGate can be configured to run in three different styles: Application, Windows Service
and PG Service. We strongly recommend using the Windows Service or PG Service run
styles.

e Click here for steps to change PageGate's run style to a Windows Service or PG
Service.

Step 3: Confiqure PageGate's input interface(s)
After getting the program installed and the basic database created, you'll need to tell
PageGate how you're going to be passing messages into the system.

For more information on that, have a look at the "How PageGate Accepts Messages" or
the "Interfaces" section of the documentation.

Step 4: Configure your delivery methods
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Once you have the input interfaces configured, you're ready to start passing messages in
to the program for delivery. So, the next step is to tell the program how you're going to be
delivering messages.

Message delivery is largely controlled by the type of messages you want to send. Are you
sending to cell phones? Email addresses? Making APl calls in to a ticket tracking or chat
system?

For more detailed information, have a look at the "How PageGate Sends Messages" or
"Carriers" section of the documentation.

Step 5: Confiqure your recipients and groups
Now that PageGate knows how messages are going to come in and how to deliver them,
you'll need to configure recipients and groups to tell it who the messages are going to.

For more detailed information, have a look at the "Recipients" and "Groups" section of the
documentation.

Standard Setup (MSJet)
1) Go through the steps to install the PageGate Server.

2) From your Start Menu or Desktop, right click on the shortcut for the PageGate Admin
and select "Run as Administrator”

3) You should then be presented with the default setup screen.
U

Frogram Directory |E:HPngram Files [#8E]%M otePagehPagel ateh

D atabase Directory |C:\Pagel atel atah[atabaset

Log Directony |E:HPageG ateDatahLogsh

Archive Directary |\ PageG ateD atavdichivel

[

Backup Directory |E:HPageG ateD atahDatabasze'Backuph

Run on this gerver:

W Scheduler v Getbsci v Gethdail
[ GetSenal [ GetTap v Getw'eb
W Connectarl [ Connector? [ Cornector3 [ Connectard
[ Connectars [ Connector [ Connector? [ Connectard
[ Connectard [ Connector1D [ Comnector!! | Connectarl2
[ Connectarl3 [ Connector14 [ Connector!s [ ConnectarlB

Apply Lt

You can leave the values at their defaults or specify custom locations. Click Apply to
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proceed.

4) If it asks you to create the Database, Archive, Log and Backup directories or database,
say yes and it will create them for you.

The database directory does not exist. Do you want to create it

Yes Mo

The log directary does not exist. Do you want to create it

Yes Mo

The archive directory does not exist. Do you want to create it

Yes Mo

The backup directory does not exist. Do you want to create it

Yes Mo

The database does not appear to exist. Do you want to create it?

Yes Mo

You can now begin configuring the interfaces, output methods and recipients and groups.

We also recommend switching PageGate's run style to PG Service or Windows service.

SQL Setup

PageGate currently supports using SQL Express and SQL Server 2017 and 2019
deployed both on local networks and on cloud based servers.
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When using an SQL database hosted on a cloud server, if you enable 'Always Encrypted'

in SQL, the PageGate Admin and GUI Client applications can be installed on any
computer and given access to your PageGate server. This makes connecting remote
workstations far easier as they can be given direct access.

These steps go over how to configure PageGate to use an SQL database.

Step 1: Create the SQL Database

1) Run Microsoft SQL Server Management Studio

|.’J-; Microsoft QL Server Management Studic (Administrator)

File Edit View Tools Window Help
5 - | 3 - -2 e | o2 New Query

| | Execute

i

Object Explorer > X
Connect~ ¥ *¥ ¢ -

=W -] SOL\SOLEXPRESS (SOL Server 15.0.2001

Catabases

Security

Server Objects

Replication

PolyBase

Management

XEvent Profiler

2) Right click Database, select 'New Database'

o
MDY

Object Explorer * 1 X
Connect~ ¥ ™ VI
= @ SCL\SOLEXPRESS (SOL Server 15.0.2000
Databascy
Security MNew Database...
Server O Attach...
Replicati Restore Database...
PolyBasg ] ]
Manages Restore Files and Filegroups...
[¥] XEventP Deploy Data-tier Application...

Import Data-tier Application...

Start PowerShell

Reports b

Refresh
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B mew Database — O >
- T s - @
& Options
# Filegroups Database name: |pagegate| |
Owner: |'C':|Efau|1> |
Database files:
Logical Mame  File Type  Filegroup Initial Size (MB)  Autogrowth / Maxsize Pa
pagegate ROWS... PRIMARY 8 By 64 MB, Unlimited .| C:
pagegate_log  LOG Mot Applicable 8 By 64 MB. Unlimited .| C:
Connechion
Server:
SOLVSQLEXPRESS
Connection:
SQLAdministrator
ﬁ View connection properties
Progress
Ready <
Add Remave
Cancel

Step 2: Create the Admin and User accounts for the SQL Server
Note: You can skip this step if all relevant users already exist as SQL Logins.

1) Expand the 'Security' section.
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2) Right click Logins and select 'New Login'.

= Security
Server Mew Login...
Creder Filter ,
Audits|
Canver Start PowerShell
Server Obj Reports ,
Replicatic
PolyBase Refresh

3) When using a domain controller/domain network, select 'Windows authentication'
B Login- Mew — O X

EE ey IT Script ~ ) Help
& General

& Server Roles
& User Mapping Login name: || Search...
& Securables
& Status

(@) Windows authentication
(") 5GL Server authentication

() Mapped to cerfficate

() Mapped to asymmetric key

Connechon [J Map ta Credential o o
n
Server: Mapped Credentials Credertial Provider
SOLVSQLEXPRESS
Connection:
SQLAdministrator
ﬁ View connection properties
i Remowve
Ready Defautt database: master "
Defautt language: <default> ~
Cancel

When using a workgroup network, select 'SQL Server authentication'.
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B Login - New - O X
Szlzn:ral I Scipt ~ 9 Help
& Server Roles
& User Mapping Login name: | | Search...
& Securables
& Status (") Windows authertication
(®) SOL Server authentication
Password: | |
Confirm password: | |
Enforce password policy
Enforce password expiration
User must change password at next login
(") Mapped to cerdificate
(") Mapped to asymmetric key
Co = [] Map to Credential W Add
nneckon
Server Mapped Credentials Credential Provider
SALNSALEXPRESS
Connection:
SO\ Administrator
ﬁ View connection properties
Progress Remove
Ready Default database: master >
Default language: <default> ™~
Canco
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4) When using 'Windows authentication', set 'Login name' to a domain account.

B Login - New — O X
- T o - @
& Server Roles
& User Mapping Login name: SALveremy Search...
& Securables
F Status (® Windows authentication
(") 5QL Server authentication
(") Mapped to cerfficate
(") Mapped to asymmetric key
= - [ Map to Credential v Add
nnechon
Server Mapped Credertials Credential Provider
SOLVSQLEXPRESS
Connection:
SQLAdministrator
ﬁ View connection properties
Progress Remove
Ready Default database: master >
Default language: <default> >
Cancel

When using 'SQL Server authentication’, specify the username and password you
would like to use.
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B Login- MNew — O by
5;"::“:@' LT Scipt ~ @ Helo
& Server Roles
& User Mapping Login name: |.Jen=,-m1.I | Search...
& Securables
K Status (") Windows authentication
(®) SOL Server authentication
Passward: |--oo-oo- |
Corfirm passwaord: |uuuu |
Enforce password policy
Enforce password expiration
User must change password at next login
(") Mapped to cerdificate
(") Mapped to asymmetric key
Con n [] Map to Credential o Add
Server Mapped Credentials Credential Provider
SALNSALEXPRESS
Connection:
SO\ Administrator
ﬁ View connection properties
Progress Remove
Ready Default database: master i
Defautt language: <defautt> b
Canco

5) Click OK to add the new login.

Step 3: Create the SQL Admin and User accounts for the PageGate database
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1) Go to Databases - pagegate - Security - Users.
Object Explorer > 0 x
Connect~ ¥ ¥ O

= @ SQUL\SQLEXPRESS (SQL Server 15.0.200(

8

Systern Databases

Database Snapshots
= E pageqgate

Database Diagrams
Tables

Views

External Resources
Synonyms
Prograrmrmability
Service Broker

O EEEEE BB

Storage

Security
Users
Roles
Schemas
Asymmetric Keys
Certificates
Symmetric Keys
Always Encrypted Keys
Database Audit Specifice
Security Policies

2) Right click Users and select 'New User'.

= Security H
H Mew User...

Sch Filter 3
Asy .

Cert Policies »
Sy Facets

Alw Start Powershell

Diats

Sec Reports 3

Security

Refresh
Server Objects res
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6) When using a domain network, set 'User type' to 'Windows authentication'.

5

@ Database User - New — O >
Sotsos IT Script + &) Help
& General
& Owned Schemas
& Membership User type:
& Securables Windows user =
& BEdended Properties
User name:
| SQLNAdministrator
Login name:
| SO Administrator |
Default schema:
Connechion
Server:
SOLVSQLEXPRESS
Connection:
SQLAdministrator
ﬁ View connection properties
Progress
Ready
Cancel

When using a workgroup network, set 'User type' to 'SQL user with login'.
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W Database User - New — | x
— st - Q1
& Owned Schemas
& Membership User type:
& Securables SCIL user with login bl
& Extended Properties
User name:
| SQLAdministrator |
Login name:
| SQLNAdministrator |
Default schema:
Connection
Server:
SALNSALEXPRESS
Connection:
SO\ Administrator
ﬁ View connection properties
Progress
Ready
Canco

7) Set the username and login name to the account required.
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8) Select'Membership' on the left hand side.

@ Database User - New — O

Sotioos IT Script + &) Help

& General

& Owned Schemas

B Membership Database role membership:

F# Securables Role Members

& Edended Properties [] db_accessadmin
[] db_backupoperator
db_datareader
db_datawriter
7]} db_ddladmin
|:| db_denydatareader
[ db_denydatawriter
[ db_owner
[] db_securtyadmin

Connechion

Server:
SOLVSQLEXPRESS

Connection:
SQLAdministrator

ﬁ View connection properties

Progress
Ready

Cancel

9) Your administrative accounts will need the db_datareader, db_datawriter and
db_ddladmin memberships. Your non-administrative accounts will need the
db_datareader and db_datawriter memberships.

10) Click OK.

Step 4: Configure SQL Server to use encrypted connection
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1) Open the SQL Server Configuration Manager

& Sql Server Configuration Manager — O >
File Action View Help
|3
‘@ S0L Server Configuration Manager (Local) ltems
B SQL Server Services Bl SOL Server Services

_E_ S5CL Server Metwork Configuration (32bit) -E- SQL Server Network Configuration (
&L 50L Native Client 11.0 Configuration (32bit) " SQL Native Client 11.0 Configuratio
_E_ S0L Server Metwork Configuration = ' ) o
= . . . . _E_ S0L Server Metwork Configuration
£ QL Native Client 11.0 Configuration 24 501 Native Client 11.0 Configuration
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2) Expand SQL Server Network Configuration

E Sgl Server Configuration Manager — O

File Action View Help

L I ERCRESE 7

‘@ S0L Server Configuration Manager (Local) Protocol Mame Status
H SL Server Services ) _ _ W Shared Memory  Enabled
_E_ S0L Server Metwork Configuration (32bit) = Named Pipes Dicabled
.. 5CL Mative Client 11,0 Configuration (32bit) = TCP/IP g Enabled

/ nable

v _E_ S0L Server Metwork Configuration
= Protocols for SOLEXPRESS
.. S0L Mative Client 11.0 Cenfiguration

3) Right click Protocols for SQL (SQLEXPRESS, MSSQLSERVER, etc) and select

'Properties’.
w E_ SC0L Server Metwork Configuration || ?
E’F Protocols for SCL Open
£ SOL Native Client 11, S

View »
Refresh
Export List...
Properties
Help
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4) Set'Force Encryption' to yes.
Protocols for SOLEXPRESS Properties ? >

Flags  Certificate  Advanced

Bl General
Force Encryption Yes -
Hide Instance Mo

Force Encryption
Turn on or off encryption for selected server instance

Cancel Apply Help

5) Click OK.

Step 5: Install PageGate and configure the basic settings

1) Go through the steps to install the PageGate Server.

2) From your Start Menu or Desktop, right click on the shortcut for the PageGate Admin
and select "Run as Administrator"

3) You should then be presented with the default setup screen. You can leave the values
at their defaults or specify custom locations. Click Apply.

4) When it asks if you would like to create the Database, Archive and Log directories, say
Yes.

5) You should then see a message indicating that a new database has been created and
that PageGate must be restarted. Click OK.
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6) Right click on the shortcut for the PageGate Admin and select "Run as Administrator”.

PG Admin

— O

X

- ] Databaze
o Scheduler
gy Interfaces
*T Connectors
- & Cariers
T .
T Recipients
M4 Groups

PageGate

Thiz iz & partialy dizabled evaluation version af aur praduct. [t will anly

allow bwo recipients to be active and will stop itzelf every three to five days.

MatePage., Ine. Phane [781] 823-06500
PO Box 296 Faw [781) 582-1869
Hanower, Ma 023339 zales@notepage. com

wi, notepage. com

Copyright 1337-2022 Matepage. Ihc.

10.0.0[=ql)
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7) Go to Database - SQL Server

B D PageGate Database SOL Server Connection Sting
H-[=] Program

E@ [atabaze

b Seflings

@ S0L Server

3 Status

Ci@ Taoolz

----- =2 Pazsword Protect

F- & Synchronization

[EI---LH Scheduler

[H-4ifp Intertaces

[;|---=F’T Cannectars

[

[

o Earn.erls Archive SOL Server Connection String
T Recipients
15 Groups
- Bl Dizplay-groups
& Logging

7 Reports
-3 Flegistration

-4 Help

=
i}

=N ghe: Al Pagelate programs and services should
be stopped before making changes to this setting.

Inzert Samples
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8) Click Insert Samples

D atabaze SAL Server Connection String
QCBLC;
Diriver=S0L Server;

Server=tcpPUT-SAL-SERVER-IP-ADDRESS-HERE 1433;
D atabase=pagegate:;

Archive SEL Server Connection String
QDEC;
Diriver=SGL Server:

ServerstcpPUT-SOL-SERVER-IP-ADDRESS-HERE 1433;
Database=pagegate_archive;

==l ate: All Fagelate programs and zervices should
be stopped before making changes to thiz zetting.

[nzert Samples Apply

9) Replace 'PUT-SQL-SERVER-IP-ADDRESS-HERE' with the IP address or machine
name of the SQL Server.
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D atabaze SOL Server Connection String

QCDELC;

Driver=50L Server;
Server=tep:127.0.0.1.1433;
[ atabaze=pageqgate;

Archive SGL Server Connection String

QCELC;

Driver=S0L Server;
Serer=stcp:127.0.0.1.1433;

D atabaze=pageqate_archive;

==k|ote; All FageGate programs and services should
be stopped before making changes to thiz zetting.

Inzert Samples Apply

10) Replace the Database name with the value you assigned in SQL. If your SQL
database names are 'pagegate’ and 'pagegate_archive', no changes are required.

11) Click Apply, then click OK on the next prompt.
12) Right click on the shortcut for 'PG Admin' and select 'Run as Administrator'.

13) When asked if you want to create the database, click Yes.

Create Database?

The database structure does not appear to exist (if it does, then this
could be a permissions problem). Do you want to create it?

You can now begin configuring the interfaces, output methods and recipients and groups.

We also recommend switching PageGate's run style to PG Service or Windows service.
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Switching PageGate's Run Style
1) Launch PG Admin with 'Run as Administrator'.

PG Admin - O

E-[7=] Program
3| Database
[% Scheduler
-;5} Interfaces
‘-FT Connectors

; § Carriers
I + Recipients @age ga te
Hi Groups
o Bl Dizplay-groups

-

t/_’ Logaing Werzion 10.0

5 Reports

""" % Registration Thiz iz a partialy dizabled evaluation verzion of our product. [t will only

[ @ Help allows bewo recipients to be active and will stop itzell every three to five daps.
MoteFage, Inc. Phone [781) 823-0500
PO Box 296 Fawx [781) 582-1869
Hanower, ka 02335 zalez(@notepage. com

Wi, natepage. com

Copynght 1997-2022 Motepage. Inc.

100000 (=)
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2) Go to Program - Settings.

Frogram Directory |I::'~.F'r|:|gram Files [=36]%M otePage\Fagei ates,

D atabaze Directary |I::HPageGateDataHDatabase"«

Log Directary |I::"'.F'agel3 atel atahLogsh

Archive Directary |I::"'.F'agel3 atelrataharchive’,

Backup Directory | C:\Pagel atelata\D atahaszeB ackup’

ER{ER NI

Run PagelGate as:

¢ Application
" windows Service
" PG Service

Run on this server:

W Scheduler W Getisci
[ GetSerial [ GetTap
W Conrector] [ Coneechor?
[ Conrectors [ Coneectors

v Gethdail
v Get'eh
[ Conrectord [ Coneectord
[ Conrectar? [ Coneectord

[ Conrectard | Connectorl] [ Connectorll [ Conrectar 2
[ Conrectar!3 | Connectorld [ ConnectorlS [ Conrectarl B

3) In the "Run PageGate as" section, select either Windows Service or PG Service and

click Apply.

Pragram Directary |I::"'.F'r|:|gram Files #8614 otePage'Fagel ateh,
D atabaze Directony |\ PageGateD atatD atabaseh

Log Directary |I::"'.F'agel3 atelr atatLogsh,

Archive Directory | C:\PageGateD atadrchive

Backup Directary |I:: “Pagel ateD ata\D atabazehB ackuph,

ER{ER NI

Run Pagelzate as:

" Application
& Windows Service
" PG Service

Run on this server:

W Scheduler W Getbsci v Gethdail
[ GetSenal [ GetTap v Getweb
W Corkectar] [ Coneector?2 [ Coneecterd [ Connectord
[ Corkectors [ Corkectors [ Coneecter? [ Connector
[ Corkectord [ Corkector!D [ Coneectarll [ Connectar] 2
[ Conkector13 [ Corkectorld [ Connectarls [ Connectar] B

Apply
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4) When prompted for credentials, leave them blank and click Apply.

U

Leave these fieldz blank to uze the built in Suztem
Account, Othenwize, provide a user account and
pazzward that haz the necceszary rights for Pagel ate
to operate [pleaze refer to the help file).

Account |

Paszwiard |

Cancel

Apply

5) When "Switching Run Styles" goes away, right click on the 'PageGate' at the top of the

left hand menu tree.

PG Admin

Pagela

-[=] Proan I} Start Server

- Bl Datat
-k Sche
-igkp |nterf: _
T Conrw Exit

é Carriers

S -
-1, Recipients

Stop Server
Start Monitor

Yergion 10.0

74 Loggin
E \,; qaing

MotePage, Inc.
PO Box 296
Hanower, A 02339

Copyright 1997-2022 Matepage, Inc.

10.0.0 [jet)

Page(ate

H-- U Reports Thiz iz a partialy dizabled evaluation verzion of our product. [t will only
Y Fegistration allow bwo recipients to be active and will stop itself every three tao five days.
P @ Help

Phone [781] 823-0500
Faw [F21] 5321869
zales(@notepage. com
v NOkepage. com

6) Select'Start Server'.
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Starting and Stopping PageGate

After PageGate is started, icon of a smartphone will appear in the Windows
system tray on the bottom right-hand corner of the screen (next to the clock). This
icon is used to stop PageGate, start the PG Admin program, or start the PG
Monitor program. Clicking on the pager with the left mouse button will display a
menu with these options.

If PageGate is running as an application, the first menu option is the Restore
function and will simply remove the pager icon from the system tray, and open a
window on your desktop. Use the minimize button to return the icon to the system
tray and remove the PageGate window. Quitting the PageGate window by using
the 'X' control or by using the 'Quit PageGate' button will stop the entire PageGate
Server application.

If PageGate is running as a Windows System service, the first menu option will be
‘Start' instead of 'Restore’. This option will start the PageGate system service ifitis
not already running.

The second menu item is 'PG Admin'. Choosing this item will start PageGate's
Administration program (if it is not already running).

The third menu item is 'PG Monitor'. Choosing this item will start PageGate's real-
time monitoring program.

If PageGate is running as an Application, the last option is 'Quit'. Selecting 'Quit'
will stop the entire PageGate application. f PG Admin or PG Monitor are running,
they will need to be exited individually.

If PageGate is running as a Windows System service, the last option is 'Stop'. This
will stop the PageGate Server service from running. If the PG Admin or PG Monitor
programs are running, they will need to be quit out of individually.

If PageGate has been setup to run as Windows Service, it will start automatically
each time the computer is restarted. Otherwise, you must start PageGate manually
from the Windows start menu. (or add it to the computer's startup group).

Monitoring PageGate

Please see the "Keeping an eye on PageGate" section of the documentation.
Example Configuration using the PageGate GUI Client

Step 1: Install PageGate

1) Go to the system that's going to host the database and program for PageGate (I'll refer

to it as the PageGate Server).
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2) Browse to our website, https://www.notepage.net

3) Click the Download button under the PageGate section.

)
)

4) Save the pgsetup.exe file somewhere convenient, like the Desktop.

5) Once the file is downloaded, right click on it and select "Run as Administrator"

6) You should then be presented with four installation options. Select: Install PageGate
Server

7) Click next until the installation finishes.

8) From your Start Menu or Desktop, right click on the shortcut for the PageGate Admin
and select "Run as Administrator"

9) You should then be presented with the default setup screen. Click Apply.

10) When it asks if you would like to create the Database, Archive and Log directories,
say Yes.

11) You should then see a message indicating that a new database has been created and
that PageGate must be restarted. Click OK.

12) Right click on the shortcut for the PageGate Admin and select "Run as Administrator".

13) Go to the Program - Settings section of the Admin.

14) Under 'Run PageGate As', select: Windows Service

15) Click Apply.

16) You should then be prompted for credentials. Leave both boxes blank and click Apply.

17) When "Switching Run Styles" goes away, open the Windows Service list.

18) Find and start the PageGate service.

Step 2: Confiqure PageGate to send messages

Now that we have PageGate installed and the server engine running, all that remains is to
configure the program to send messages.

Click here for information on how to configure PageGate to send messages.

Step 3: Share the PageGate server's database

To get the PageGate GUI Client installed and functioning on workstations, there's a
little networking setup that has to be done in advance on the server. All you'll need
to do is share the PageGate Database directory (on the PageGate Server) on the
network and make a note of the UNC/Networking path to the shared folder.
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Step 4: Install PageGate's GUI Client

Once you have the PageGate Server's database shared, here's how to install the

PageGate Client on a workstation:
1) Go to a system that's going to run the PageGate Client.

2) Browse to our website, https://www.notepage.net

3) Click the Download button under the PageGate section.

)

)
4) Save the pgsetup.exe file somewhere convenient, like the Desktop.
5) Once the file is downloaded, right click on it and select "Run as Administrator"
)

6) You should then be presented with four installation options. Select: Install PageGate

GUI Client
7) Click Next until the installation finishes.

5

8) When you run the Client for the first time, it's going to ask you for the server's database

path. This is the network path to the PageGate Server's network shared database
directory (example: \\servername\directory\)
9) Click Apply.
The PageGate Administrator (PG Admin) is used for configuring and controlling all
aspects of the PageGate Server. The PageGate Admin takes an object-oriented
approach to administering the server; most of its functions and settings can be

accessed by manipulating the objects in its object-tree. Many of the functions of PG
Admin are only accessible by right-clicking on these objects.
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PaaceGate
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The Admin is automatically installed on the PageGate Server. Workstations that
need to administrate your PageGate server(s) should have the Workstation PG
Admin installed on them.

When running PG Admin for the first time, you will need to use the 'Run as
Administrator' option.

To run PG Admin, there should be a shortcut on the desktop and in the start menu.
If the PageGate server is running, you can also click on the PageGate icon in your
system tray and select 'PG Admin'.

Program

The Program section contains settings and information that relate to the global operations
of the PageGate Server.
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PageGate

- D FageGate
El - Program
- [E] Settings

------ E Template
4 Global Log

I = SecLnity

:i, Toolz

e Settings
This section contains the PageGate server's configuration, including which APlIs to run and
whether PageGate should run as an application or Windows service.

¢ Global Log
This section contains the global log of activity recorded by the

PageGate server, including server start and stop events as well
as a record of traffic processed.

e Template
This section contains the PageGate server's global template.

e Security
This section contains the PageGate server's security settings, users and their
permissions.

e Tools
This section contains a series of tools to test internet and hardware functionality.

Right clicking on PageGate will bring up a context menu
with four options.

o Start Server
Selecting this option will start the PageGate server, if
it's stopped.

gelate
e Stop Server

=

l

I
Selecting this option will stop the PageGate server, if : Sched

l

l

I

Interfa

T Canne

E Carrier Open Folder
o Start Monitor T feen Bt

Selecting this option will launch the PageGate Monitor

application.

Stop Server

FI

= =

% Datab Start Server
<

it's started.

Start Monitor

e Exit
Selecting this option will close the PageGate Admin.
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DAananllAata
Program Settings’

Pragram Directary |E:'\F'ru:ugram Filez [«86]%M oteFage\Fagel ate®,
D atabaze Directory |C:\PageGateDatatDatabase

Lag Directary |E:'\F'agel3 atel atahLogsh
Archive Directary |E:HPageGateData'\.ﬁ.rchive'\

I Y Y Y

Backup Directary |E:'\F'agel3 atel atahD atabase'B ackuph

Fun PageGate as:

{* Application
" windows Service
" PG Service

Fiun on this server:

v Scheduler v Gethsci v Gethdai
[ GetSerial [ GetTap v Gefs'eh
v Connector] [ Connector2 | Commectar3 | Conmectord
[ Connectors [ Connectors | Conmectar? | Conmectard
[ Connectord [ Connector10 | Cormector!! [ Connectar] 2
[ Connector!3 [ Connector!4 | Cornmector!® [ Connectarl &

This section can be broken down in to three parts:

¢ \Where to store the database, logs and archives.
Pragram Directary |E:'\F'r|:|gram Filez [86)NMoteFagehFagel ate’,

D atabase Directory |C:\Pagel ateD atatDatabaset

Lag Directary |E: WPageliatel atahlogzh,

Archive Directary |E: "PagelGateD ataharchivel

I Y Y Y

Backup Directary |E:'\F'ageGateData'\Database'\Backup"\
Setting Function

Progra
m The Program Directory MUST point to the directory where PageGate is
Director| installed and should not be modified after the installation.
y
Databa | This directory specifies the PageGate Server's database location. The
se | database contains ALL pertinent information for the PageGate Server and
Director, must be shared on the network for the GUI Client and Additional Admin to
y reference.
Log

Director This directory specifies where PageGate should keep its log and security log

files.
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Dananl(Catna

Arcﬂi%tsua <o

: When the option for PageGate to archive messages is enabled, all archived
Director , . o
files will be stored in this directory.

Backup
Director| This directories tells PageGate where to keep backup information.

y

e Which run style to use (Application, Windows Service or PG Service)

Fiun PageGate as:

i+ Application
" windows Service
" PG Service

We strongly recommend running PageGate as a Windows Service or PG
Service.

The 'Windows Service' run style tells PageGate to create a service for each
component of the program.

The 'PG service' run style tells PageGate to create a single, master service that alll
elements of the program are run from.

Server 2016, 2019 and 2022: Use the 'PG Service' run style.

Desktop and Previous Server Versions: Use the 'Windows Service' or 'PG
Service' run styles.

e \Which which Interfaces to use for input and how many Connectors to use for output
Run an thiz server:

v Scheduler [ Gettsci [ Gettail
[ GetSeral [ GetTap [ Getw'eb
¥ Connectorl [ Conkector? [ Comeector3 [ Connectard
[ Connectors [ Conkector [ Comeector? [ Connectar
[ Connectord [ Coneector10 [ Comeector!! [ Connectar! 2
[ Connectorl3 [ Connector14 [ Comeector!S [ Connectarl B

Please see the Interfaces and Connectors sections for more information.
Run Styles

PageGate can be configured to run in three different styles: Application, Windows Service
and PG Service.

We strongly recommend using the Windows Service or PG Service run styles.

Application
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Irﬁt@gﬁj@ %Gate is started and stopped just like any other program and can be
automatically run at startup by putting a shortcut to it in the Windows "Startup" group. The
disadvantage to this run style, is that if the computer is configured to show a login screen
at startup, PageGate cannot automatically start until someone logs onto the computer.

Windows Service or PG Service
The 'Windows Service' run style tells PageGate to create a service for each
component of the program.

The 'PG service' run style tells PageGate to create a single, master service that alll
elements of the program are run from.

Server 2016, 2019 and 2022: Use the 'PG Service' run style.

Desktop and Previous Server Versions: Use the 'Windows Service' or 'PG
Service' run styles.

1) Right click on the shortcut for the PageGate Admin and select "Run as Administrator".

)

2) Go to the Program - Settings section of the Admin.

3) Under 'Run PageGate As', select: Windows Service or PG Service

4) Click Apply.

5) You should then be prompted for credentials. "See notes below.

6) When "Switching Run Styles" goes away, open the Windows Service list.
)

7) Find and start the PageGate service.

"Windows Credentials and PageGate
This is where things might get a little complicated because this part has more to do with
how your network and/or domain are configured than anything native to PageGate; you're
interacting with the Windows System Services. Having said that, you can typically use the
Windows System Account to run PageGate's services. To do so, when you're prompted
for credentials in step 5, leave the username and password fields blank and click on Apply
again.

If leaving the username and password fields blank returns an "Invalid account or
password" error, that means that the Windows System Account has been disabled and
you must provide an appropriate username and password that has the "Create service"
and "Log on as service" policies.

However, the Windows System Account typically has no network privileges and cannot
access cross-network information.
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Iif o@g%%ignponent of the PageGate server referencing a network resource, like a
file path by GetASCIl or GetWeb APls, the corresponding service must have sufficient
rights to access those resources (in addition to the 'run as service' right).

In our experience, the easiest thing to do when you want to run PageGate as a service but
need to have an interface or connector reference a network path is to have the system
services created with the Windows System Account. Then, after the services exist, go into
the properties of the service that corresponds to the APl or Connector and assign the
service account under the Log On tab of the service.

When using the PG Service run style, you will only have a single, master PageGate service
that will need a service account assigned to it.
Global Log

If logging is enabled, this window displays a summary of the events generated by
PageGate, including all messages scheduled and sent.

Refresh Open Clipboard Find Purge
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Df\ nf‘n
agecuoalc
Reffesh Displays the most current entries in the global log.
Print Sends a copy of everything listed in the Global Log to a printer.
. Copies the contents of the Global Log to the Windows Clipboard, allowing
Clipboard . : .
it to be pasted into another application.
Find Deletes the entirety of the Global Log.
Purge Allows you to search for a variable (such as a carrier or recipient name).
Security

The security section of the PageGate Admin allows you to configure the program's security
system, which can be used to restrict access to both PG Admin and the GUI Client.

ElD Pagelate
=-[=] Pragrar
----- Settings

..... [Z] Template
..... -u" Global LDEI

E-

E_. it

e Settings allows you to enable or disable security restrictions to the Admin or GUI Client.

e Users allows you to create and manage the list of users who have access to the
programs and what level of control they have.

¢ Log displays which user has performed what action(s) at any given date and time. It
records each instance of security permissions being used.

Settings

Note: ltis entirely possible lock yourself out of the PageGate Admin if you enable
the PG Admin security before configuring any security users. Please configure at
least one master administrative user before enabling any security in the program.
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PageGate

[ Enable PG Admin Security

[~ Enable GUI Client Securty

_borb|

*warning: do nat enable admin security without creating at l2ast
one Lzer with administrator rightz

Enable PG Admin
Security

Enable GUI Client
Security

Users

Restricts access to the PG Admin to ONLY those users given
rights in the Users section.

If this option is not enabled, all users will be able to access all
functions of the PG Admin.
Restricts access to the GUI Client to ONLY those users given
rights in the Users section.

If this option is not enabled, all users will be able to access all
functions of the GUI Client.

The users portion of the Security Settings allows you to create and maintain a list of
users that have permission to access certain portions of either the PageGate

Admin or the GUI Client.

D Users hod

|1zername

Add

Edit

Delete

Cloze

*changes to curment uzer won't take full effect until next login
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PageGate
A d% IS allows you to create a new security user profile. Click here for more
information.

Edit This allows you to edit an existing security user profile.
Delete | This allows you to remove an existing security profile.

Close | This closes the Users dialog.

Adding a Security User

D Mew User ot
|lzermame | Right=

[ Adrninistrator
[~ Usze'Windows Login Credentialz [ Interfaces
Fazzword | [ Connectors

[ Carriers
Aliaz | ﬂ [~ Al Recipients

[ Dwn Recipients
Digplay-group | ﬂ [ Al Groups

[ Dwn Groups
Sender |;=g|_,:,ginNamEﬁg [ Al Dizplay-groups

[ Dwn Dizplay-groups
Station 110 [~ FReparts

[ Client Adminigtrator
Fresetz File | [ Client

Cancel Apply

When creating a user to have security rights, there are several settings that need to
be considered:
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geGate
J Tis field is where you assign a unique login name to a user. When

Username | a user attempts to access a security enabled PG Admin or GUI
Client, they will be prompted for this username.

When this option is checked, both the GUI Client and PG Admin

DA
I d

Use
. will allow a user logged into windows with this name to access the
Windows ) . i
. program. For example, if you create a user named "Johnny" and a
Login o : : " o
. workstation is currently logged in as the Windows user "Johnny", it
Credentials

will grant access to the program.

This field is where you assign a unique password to a user. When
Password | a user attempts to access a security enabled PG Admin or GUI
Client, they will be prompted for this password.

Alias This field allows you to set a security alias for this user.

This field over-rides the Display-group setting in the settings of the
GUI Client for this specific user. For more information, please refer
to the GUI Client Settings section of the help file.

This field over-rides the Sender setting in the GUI Client for this
Sender | specific user. For more information, please refer to the GUI Client
Settings section of the help file.

This field over-rides the Station Number of the GUI Client for this
Station specific user. For more information, please refer to the GUI Client
Settings section of the help file.
This field over-rides the Preset Msgs File setting in the settings of
Presets File the GUI Client for this specific user. For more information, please
refer to the GUI Client Settings section of the help file.

Display-
group

The following rights can be assigned to a user:
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DA

a

Administrato
r

Interfaces
Connectors

Carriers

All
Recipients

Own
Recipients

All Groups

Own Groups

All Display-
Groups

Own
Display-
Groups

Reports

Client
Administrato
r

Client

Logging In

geGate
J “is will make this user an administrator capable of adding, editing

and removing all recipients, carriers, groups and display groups as
well. This also grants this user the ability to administrate the
Interfaces, Connectors and other global program values.

Grants this user permission to access and modify settings in the
Interfaces section of the Admin.

Grants this user permission to access and modify settings in the
Connectors section of the Admin.

Grants this user permission to access and modify settings in the
Carriers section of the Admin.

Grants this user permission to access and modify settings for all
recipients in the Recipients section of the Admin.

Grants this user permission to access and modify settings in the
Recipients section but only for those recipients that this user, or
this user's alias, has been marked Manager.

Grants this user permission to access and modify settings for all
groups in the Groups section of the Admin.

Grants this user permission to access and modify settings in the
Groups section but only for those groups that this user, or this
user's alias, has been marked Manager.

Grants this user permission to access and modify settings for all
display groups in the Display Groups section of the Admin.

Grants this user permission to access and modify settings in the
Display Groups section but only for those display groups that this
user, or this user's alias, has been marked Manager.

Grants this user permission to access the Reports section of the
Admin.

This will make this user an administrator for the PageGate GUI
Client but will not grant them access to the Admin or its functions.

Grants this user permission to access and run the PageGate GUI
Client.

6

Note: Not every user is granted administrative privileges. If certain functions are
unavailable, the user you have logged in with may not have permission to access to

them.
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PageGate

[ PG Admin Login X

Usemame | administrator

Paszword |

Exit | Login

When logging in to the PageGate Admin or PageGate Client, you will receive the login
prompt (shown above). Simply type in the username and password that has been
assigned, then click Login.

Tools

ED FageGate
=-=] Program
b Settings

£ Global Log

F-==3 Secunty

5+ B8
- File Wersions

Z3: Senal Port Scan
b g TCP Part Scan
L@ DNS Lookup

e File Versions provides a quick reference for the specific file version information for your
installed copy of PageGate.

e Serial Port Scan runs a port scan to determine if you have any available COM ports in
the operating system.

e TCP Port Scan runs a test on a range of TCP and UDP ports related to message
delivery and will report if they are open or not.

e DNS Lookup performs a series of DNS lookups, including A, MX and SPF record
querying.

File Versions

Clicking on "File Versions" will display the following

dialog:
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5. File Version Information »
File Hame Yersion Modified -
chilkatax-9.5.0-win32 dil 95080 104282019 11:3210 AM T
clasze dl 220 NMA22013 63317 A —
clazswps.dil T1A2/2013 6:33:17 AM
filewerzioninfo. exe 1.m 2/21/20191216:08 P
flp32=20.0c4 21.20 MA22013 63317 aM

Frnjr1 0. dll 220 MA22013 63317 aM
jEtoomp. exe 4,0,1532.0 111222013 623318 AM
nprrdil E000 TA2/20136:33:18 aM
pageqate. exe 10.00 342022 10:30:55 AM
pgadmin. exe 10.00 342022 11:50:55 AM
pgconnector] . exe 10.00 342022 10:31:04 AM
paconnector] 0.exe 10.00 222022 103703 Ak
paconnector] 1.exe 10.00 242172022 103706 Abd
paconnector] 2. exe 10.00 20212022 103709 Abd
paconnector] 3.exe 10.00 222022103712 Ak
poconnector] 4.exe 10.00 27212022 103715 Ak
paconnector] Bexe 10.00 27212022 103718 Ak
paconnector] B.exe 10.00 2P 2022 103721 Ak
paconnecton?, exe 10.00 342022 10:31:08 Abd
paconnectord. exe 10.00 A42022 103117 Ak
pacannectord. exe 10.00 I42022 103113 AW
pgconnectorh. exe 10.00 20212022 10:37:33 AM
pagconnectors, exe 10.00 20212022 103757 AM
poconnector?. exe 10.00 20212022 10:37: 29 AM
pgconnectord. exe 10.00 20212022 10:37:43 AM
poconnectord. exe 10.00 22022103746 4M
il [

Detailz Clipboard Cloze

This is a list of every file, and its specific build
version, in the PageGate program directory

Serial Port Scan

O} [EF [EVEV SV EFEFE]
O} [EF [EVEV SV EFEFE]

Scan

The serial port scan tool allows PageGate to scan
available communication (COM) ports. Any COM
port found to have a modem present will have a
check placed next to it when the scan completes.
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s Cate

PageGate uses many internet based protocols. This Port Scan tool allows PageGate to
determine whether the ports to use these protocols are available or closed.

Corr
esp

P ondi
or

t| "9
Prot
ocol

SMT
P/E

mail
SMT
P/E

4 mail
with
SSL/
STA
RTL

S

SMT
P/E

5 | mail
with
7 |STA
RTT
LS

WC
TP

(=2}

(o]

POP

SNP
P

a s b PAhO=_2 =200

DNS

w

DNS Lookup

DNS Lookup provides a utility that will attempt to perform a series of DNS lookups,
including A, MX and SPF, on the domain specified.
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Tﬁsag%%%k%sing when configuring PageGate to send SMTP/Email.
DNS Server [gg88

Diamain |yurdamain, com

Lookup | Clipboard

Database

The Database section is where any database related settings and functions, like how
much information to store in the database or synchronizing multiple PageGate servers, are
configured.

ElD FPageGate
-] Program
ElLi_[_l D atabase

|| Settings
[ SOL Server
3 Status

Ci& Tools

----- =3 Paggword Protect

- Synchronization

e Settings
This section controls message retention and archiving options.

e Status
This section displays relevant information about the database, including file size.

e Tools

This section allows you to import and export recipients as well as rebuild the database in
the event of corruption.
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e Password Protect

This section allows you to password protect the PageGate databases.

e Synchronization

This section allows you to configure multiple PageGate servers to synchronize their data

with each other.

Right clicking on Database will provide a context menu that
provides two options:

e Open Folder
Selecting this option will open a Windows File Explorer

pointed to the PageGate database directory.

 Zip

This will create a compressed file named pagegate.mdb.zip
output in the PageGate database directory and is useful in the
event that you need to email your database to Tech Support
or for backup purposes.

E|D PageGate

-[=] Program

> O

L Scheduler Open Fol
vﬁ;‘v Interfaces Zip

*T Connectar.
. B Cariers

der

Settings
Purge After [daps]  |3p

Frompt for backup lm

[ Include meszages in backup

Hecipient Extra Field Labels

Fieldl Label |I:|:|mment1

Field2 Label |I:|:|mment2

Field3 Label |I:|:|mment3

Fieldd Label | Comment4

[ Move meszages to archive

Mowve After [dayz] [0

Setting Function

Purge After
(days)

Chapter 6 PageGate Admin: How to Configure PageGate

This field sets the number of days that PageGate will keep old
messages in the messages table. After X days, where X is the number
you enter, PageGate will purge old messages from the database.
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PageGate
Run Iyur o I\Vlgssages are normally purged from the database during the midnight
Nowg cleanup routine. Messages can be manually purged from the database
by clicking this button.
This field may be set to: Never, daily, weekly, monthly, quarterly, Bi-
Prompt for annually and yearly
Backup If enabled, PG Admin will prompt users to back up the database at the
specified time interval.
mglglslfees If enabled, this option includes the 'Messages' table of the database in
. 9 the backup routine.
in backup
Field 1,2, | Four extra pieces of information can be stored with each recipient and
3,and 4 group. This is where you can set the labels that are shown with each
Label piece of information.
me'\gg;/ees Checking this option will allow PageGate to move "purged" messages
9 to the Archive Directory.
to archive
Move After | This determines the number of days that messages are moved to the
(days) Archive Directory.
Status

D atabaze File Size (Kb] |51z

Carrier Records |-|7
Recipient Recards |-|7
Group Recaords IDi
Dizplay-group Fecords IDi
Meszage Records |-|7
Local Messages IDi
Scheduled Meszages |-|7
Pending Messages IDi
Refresh
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etting Function

Database File Size
(Kb)

Carrier Records | Displays the current number of carrier records in the database.

Displays the current file size of the database in kilobytes.

Recipient Records | Displays the current number of recipient records in the database.

Group Records Displays the current number of group records in the database.

Display-group Displays the current number of Display-group records in the
Records database.

Message Records | Displays the current number of messages in the messages table.

Displays the current number of messages waiting to be processed

Pending Messages | . o messages table.

Tools

This section allows you to import and export information as well as rebuild the database in
the event of corruption.

ElD FPageGate
H-[=] Pragram
Elﬂ Databaze
----- Settings
----- |El_| SOL Server
----- B Status

B

& Export

& |mport

& Rebuild Databasze
----- =3 Paggword Protect
- Synchionization

e Export
This option is used for exporting information from PageGate ina CSV format.

e Import
This option is used for pulling information in to PageGate from a CSV format.

e File Formats

This section goes over the specific format of PageGate's export files and the required

structure for importing. These file structures are also used by PageGate's Synchronization
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e Rebuild Database

This option is used for repairing databases that may have errors in them.
Export

This section allows you to export information from the PageGate database.

Eﬂ Databasze

----- Settings
----- [::[_l SCL Server
----- ﬂf Status
E-=F Tools

----- =3 Secunty

----- -.ff Connectors

----- § Carriers

----- f: Recipientz

..... 5 Groups

----- Mg Display Groups
----- E| Templatesz

----- nf-: Mezzages

----- Y. Advanced Asci Poling
----- [ On-Call Schedule
----- 12, AdHoc Map

----- =7 Mailboxes

----- + Lookup Table
-5 Pinlnfo
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enu ltem
All
Settings
Security
Connectors
Carriers
Recipients
Groups
Display Groups
Templates

Messages

Advanced ASCI
Polling

On-Call Schedule
Ad-Hoc Map
Mailboxes
Lookup Table

Pininfo
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Function

This exports everything at once to a specified directory.

Exports the existing global settings for PageGate, including
registration and Program Settings.

Exports the existing Security Settings and Users.

Exports the existing Connectors settings.
Exports all carriers and their settings.
Exports all recipients

Exports all groups and group members

Exports all display groups and display group members

Exports all Templates (global, interface, connector, carrier and
recipient)

Exports the messages table of the database.

Exports the Advanced Polling settings for the GetASCII module.

Exports the existing schedule of messages to send to on-call
groups.

Exports the range of PIN numbers set for use by the ad-hoc
function.

Exports the mail settings set for each recipient or group.

Exports the Lookup Table settings used by the GetASCIlI and
GetSerial interfaces.

Exports a list of all recipient names and ID/PIN values.
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This section allows you to import information in to PageGate's database.

Menu Item
All
Settings
Security
Connectors
Carriers
Recipients
Groups
Display Groups
Templates

Messages

E‘D FPageGate

E-[=] Program
I__—_lﬂ Database
----- Settings
----- Bl 50L Server
----- 3 Status
[—:IC}'& Tools
[+1-=g% Export
..... @ &l
----- Settings

..... =3 Secuity

..... #1 Connectors

----- ﬁ Carriers

----- + Recipients

----- g Groups

..... HI Dizplay Groups

----- E Templates

..... 7 Messages

----- Y. Advanced Ascil Polling
----- [.ﬂ On-Call Schedule

----- T2, AdHoc Map

----- =9 Mailboxes

----- + Lookup Table

e + Recipients [simplified)

Function

This will import all items from the specified folder.

Imports the global settings for PageGate, including registration and
Program Settings.

Imports the Security Settings and Users.

Imports the Connector settings.

Imports a list of Carriers and their respective settings.
Imports a list of Recipients

Imports a list of groups and group members.

Imports a list of display groups and display group members.
Imports all templates from the specified folder.

Imports messages from the specified import file.
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A%\%Sgﬁggéal Imports the Advanced Polling settings for the GetASCIl module.
On-Call Schedule | Imports a schedule to send messages to on-call groups.
Ad-Hoc Map Imports a range of IDs for use with PageGate's ad-hoc feature.
Mailboxes gr:cp))ggs information about the mail settings for each recipient or
Lookup Table Icr;neg[grésri ;T?nlt_grc;:ggsTable settings used with the GetASCIl and
gierﬁipﬁ:ﬁgzjs) A simplified form of the Recipients and Groups import file.

File Formats
PageGate uses a standardized Comma Separated Values (CSV) file format for exporting
and importing. If you want to import information into PageGate, we would recommend

creating some sample or dummy data and then performing an export.

Each export file contains the specific structure and format required to import, including
version information and field names. PageGate also uses the .csv extension on its'
exported data to make opening it in programs like Excel much easier. Field labels are

contained on line 2 of the file.

To import information into PageGate, please follow the guideline shown in the export files.
Rebuild Database

This option will compact and rebuild the PageGate
database. When you click on the Rebuild Database
option, you will receive the following prompt:

WARMING

All PageGate programs must be shut down before the database can be
rebuilt. You should also make a backup of the database before
proceeding. Are you sure you want to run this now?

All of PageGate's modules must be stopped in order
to rebuild the database. This can be accomplished
by clicking on the pager icon in the Windows system
tray (next to the clock) and choosing 'Quit' or 'Stop'.
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No part of PageGate can be running when this
rebuild takes place. Please be sure to shut down all
instances of the GUI Client and PageGate Admin.

When you click on Yes, the rebuild will take place.
After the rebuild has finished, you should receive this
prompt:

Rebuild >

Rebuild Successful

After you click on OK, it is safe to run the PageGate
Server, Admin and Client once more.

If PageGate is running as an Application, restart
PageGate by choosing 'PageGate Server' from the
Windows start menu.

If PageGate is running as a Windows Service, click
on the pager icon in the Windows system tray (next to
the clock) and choose 'Start' from the popup menu.

Note: An external rebuild utility is included with
PageGate. It is called 'Jetcomp.exe' and can be
found in the PageGate program directory. This utility
can be used in cases where the PG Admin program
is unable to start due to certain types of database
corruption. After the database is rebuilt, you will have
to restart the PageGate Server module.

Password Protect

The password protect option allows you to set a
password specifically on the database. This does not
have anything to do with the other Security features of
PageGate; Entering a database password will
restrict access to the database from programs like
Microsoft Access.
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receive this prompt:

WARNING

The PageGate Server and all its GUI Clients must be shut down before
the database can be password protected. You should also make a
backup of the database before proceeding. Are you sure you want to
change the database password now?

When you click on Yes, you will be prompted with
this:

D Database Password oo

Pleaze enter a pazsward far the server's database [14
charactersz max].  *Maote: all PageGate GUI Clients will
azk to hawve their databaze paszwords updated, to
match thiz pazsword.

Pazzward ||

DO MOT LOSE this pazsword or elze the databasze
can become PERMAMEMTLY INACCESSIBLE!

Apply Cancel

Enter a password, then click on Apply.

When you receive the following prompt:

Database password updated

Ok |

Click OK for the password to be accepted.

NOTE: Without the password, the database cannot
be opened. If this password is set, the next time each
PageGate GUI Client is started, the you will need to
enter it (you will be prompted for it automatically). The
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password once, and then it will be stored for the
future (unless the password is changed again).

DO NOT LOSE THIS PASSWORD.
If this password is lost, the database may become
permanently inaccessible!
Synchronization

This section allows you to configure multiple PageGate servers to synchronize their data
with each other.

E|D FPageGate
=] Program

B L—:_[_l Database

b Settings

- Bl SOL Server

3 Status

Ci& Tools

-3 Password Protect

El 1__' Synchromization

----- o Export

e Export
This section should be used on the primary PageGate server that is going to push updates
out to the secondary PageGate server(s).

e Import

This section should be used on the secondary PageGate server(s) that should receive
updates from the primary PageGate server.

Export

NOTE: This option should only be configured on the Master PageGate Server.
Do NOT configure the Synchronization Export on Secondary PageGate Servers.
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[ Enable automatic expart

G0 Ewpart interval [minutes)

| Export folder 1
| Export folder 2
| Export folder 3
| Export folder 4
| Export folder &
| Export folder &
| Export folder 7
| Export folder 2
[ Export cariers
[ Export recipients
[ Ewport groups
[ Export zecurity

Option Function

Enable , , ,

automatic This option will export changes made to the master database to
export each of the slave databases.

This field sets the interval at which changes are exported to the
slave databases. It is not recommended to have this set lower
than once per hour.
Export folder 1 - | This field sets the path to the database directory of the

8 secondary servers.
This option will export the carriers from the master database to
the secondary databases. This includes carrier templates.
This option will export the recipients from the master database
to the secondary databases. This includes recipient templates,
mailboxes and ad-hoc settings.
This option will export groups from the master database to the
Export Groups | secondary databases. This includes group members,
mailboxes, ad-hoc settings and on-call schedules.
This option will export the security settings and users from the
master database to the secondary databases.

Export interval
(minutes)

Export Carriers

Export
Recipients

Export Security
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Impo

NOTE: This option should only ever be set on the Slave PageGate Servers.
Do NOT configure the Synchronization Import on the Primary PageGate Server.

[ Enable automatic import

G0 |mpart interval [minutes)

| Impart folder

[ Impaort cariers |ﬂddepdate£Hemnve ﬂ

[includes templatesz)

[ Import recipisnts |ﬂddepdate£Hemnve ﬂ

[includes templates, mailboxes, ad-hoc)

[ Import groups |.-’-'-.-:||:|a"L| pdate/Remove ﬂ

[includes members, maiboxes, ad-hoc, oncall]

[ Impart zecurity |ﬂddepdate£Hemnve ﬂ

Option Function

Enable automatic | Enabling this option will import changes made to the master database
import into each the slave database this copy of the Admin controls.

This field sets the interval at which changes are imported to the slave
database. It is not recommended to have this set lower than once per
hour.

Enabling this option will import the carriers, including their templates)
from the master database.

Enabling this option will import the recipients (including templates,
mailboxes and ad-hoc settings) from the master database.

Enabling this option will import groups (including group members,
Import Groups | mailboxes, ad-hoc settings and on-call schedules) from the master
database.

Enabling this option will import the security settings and users from the
master database.

Import interval
(minutes)

Import Carriers

Import Recipient

Import Security

When enabling the option to import Carriers, Recipients, Groups, or Security Settings, you
will be presented with four options:
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ption Function

This option will allow the imported entries to Add new recipients,
Updated existing recipients, or Remove existing recipients that are not
on the list of recipients to be imported.

Add Only This option will only allow new recipients to be added upon import.

Add/Update/Rem
ove

Update Only | This option will only update existing recipients upon import.

This option will allow new recipients to be created and existing

Add/Update | o iients can be updated upon import.

Scheduler

The PageGate Scheduler is the main, core processing component of the PageGate
server. While there aren't many settings controlled by this section of the PG Admin, it is
incredibly important to run the PageGate Scheduler as all functions for all APls and
Connectors are governed by the Scheduler.

= D Pagelate
#-[=] Program

[% Databaze
e [Z] Settings
----- 3 Status
Z Lag

e Settings
This section controls how often the PageGate Scheduler polls the PageGate
database.

e Status
This section displays the running status of the PageGate Scheduler.

elo
This section contains a log of everything recorded by the PageGate Scheduler.

Right clicking on Scheduler will provide a context menu

o Start -] Program
Selecting this option will start the PageGate Scheduler, if % Database
L

stopped. -4 Interfaces Start

-1=’T Connectors Stop
g m - 28 Carriers
Selecting this option will stop the PageGate Scheduler, if

started.

with two options.
EID PageGate ‘
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Paling Interval [zec] |3

In the Settings of the PageGate Scheduler, you can modify the scheduler's polling interval.
This value represents how often, in seconds, the scheduler should poll the database for
new information but does not affect how often the scheduler updates the database when
processing messages.

Status

Service  |Scheduler
Status  [Rumning

The status subsection of Scheduler will show you if

the PageGate Scheduler is currently running or

stopped. There are three ways to start the scheduler:

1) Restart the PageGate Server application or service.

2) Reboot the computer.

3) To manually stop or start the PageGate Scheduler, right click on the word Scheduler.

When you do, it will come up with the Start and Stop options.

Note: If the PageGate Scheduler is not enabled in the "Run on this server" section of the

PageGate Admin's program settings on the PageGate server, the scheduler will not be

able to run and PageGate will not function properly.
Log

If logging is enabled, this log shows a summary of the events generated by the
PageGate Scheduler.
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Refresh Dpen Clipboard Find | Purge |
Button Function
Refresh Displays the most current entries in the global log.
Print Sends a copy of everything listed in the Scheduler Log to a printer.
Find Allows you to search for a variable (such as a carrier or recipient name).
Purge Deletes the entirety of the Scheduler Log.
Clipboar| Copies the contents of the Scheduler Log to the Windows Clipboard, allowing
d it to be pasted into another application.
Templates

Templates control quite a bit in PageGate. Some template variables control how
messages are formatted while others determine how message negotiations should be
encoded.

PageGate comes preloaded with a set of default templates that you may never need to

modify. However, the Templates section provides administrators easy access to modify
most parts of both the input to and output from PageGate.
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Recipient levels. This means that a template can be configured for all messages that leave
the system or just to a specific interface, connector, carrier or recipient.

The order of importance for the templates is as follows:
1) Recipient

2) Carrier

3) Connector

4) Interface

5) Global

This inter-connected system enables changes to be made for the maximum number of
recipients by making a single change to one of the parent templates.

For example, if a Recipient has a template that has been applied to it, PageGate will
format any messages delivered to this recipient based on its template regardless of
whether Carrier, Connector, Interface or Global templates have been configured.

This allows you to create exceptions for Global rules by creating templates unique to a

given Recipient, Carrier, Connector or Interface while the rest of your traffic remains
formatted to a standard.

Both hard-coded text and PageGate specific macros can be used in each template,
combining both static and dynamic elements into the message text.

Templates are comprised of three sections: Settings, Subject and Text.
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Settings

Subject

Test

All Templates have three sections:

e Settings
Settings

Settings variables (also called parameters) are used to turn settings on and off and are
used to control the behavior of whatever you're interacting with.

The Settings template is unique in that variables specified in this section are cumulative.
So, if you have Settings variables specified in the Global template and have completely
different variables specified in a Carrier level template, all Settings specified are
respected. However, if you have the same variable specified by multiple Settings
templates, the highest order template's value will always be used.

For more information, see the Template Settings section.

e Subject
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NOTE: Methods of delivery (protocols) that do not use subject lines do not reference this
section of the template in any way.

The Subject section of a template controls the behavior of any subject line processed by
this template. Macros can be used to insert information in to the subject line, like the date,
time or other pertinent information. This template cannot use or reference parameters and
will only accept macros.

Subject templates will override templates of a lower order. For example, a Recipient level
subject template will override any Carrier, Connector, Interface or Global subject.

For more information, see the Subject Template section.

e Text
Text

The Message section of the template controls the output and format of the body of any
message controlled by this template and references Macros. A Macro variable is an
inserted value to control, modify and specify the output of a message. The Message
section of a Template should not use or reference any Setting variables and must only use
Macro variables. Text templates will override templates of a lower order. For example, a

Recipient level text template will completely replace the subject line for that recipient and
will override any Carrier, Connector, Interface or Program level Subject template you've
applied.

Settings

Settings variables (also called parameters) are used to turn settings on and off and are
used to control the behavior of whatever you're interacting with.
Settings
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Fﬁ%gﬁ&éﬁ]t)?every APl uses the same language or data structure. So, when you're
configuring

As an example, Airlink and Multitech both produce lines of cellular devices that can be
accessed via COM or TCP but each implements a different AT command set. PageGate
can automatically negotiate most connections with most devices and does automatically
retain which command is best to use but you can decrease the overall amount of time it

takes to deliver a message by specifying the necessary value in the Settings template.

Template values are ranked in this order:
1) Recipient

2
3
4
5

Carrier
Connector
Interface
Global

~— N N N

So, a Settings variable specified on a Carrier level will override any Global value. To use
our earlier example, let's say you have an environment in which you're using multiple
cellular modems; some of them Airlink, some of them Multitech. Since you have two
devices that need to use the same protocol (GSM-AT-IP) but also need it implemented in
different ways, you would specify a carrier level template value that configures the Airlink
device for one AT command set and the Multitech device for the other. Alternately, you

could tie each cellular gateway to a specific Connector, then specify a Connector level

template instead.

Variables that can be specified in the Settings section of a template can be broken down

in to a few categories: Protocol Delivery and Content Modification

Protocol Delivery

These variables modify the behavior of a protocol and specify certain declarations that
must be made during the protocol negotiation sequence.

Parameters for SMTP

Parameters for GSM-AT-IP
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Parameters for HTTPGET
Parameters for HTTPPOST
Parameters for FILE
Parameters for SNPP
Parameters for WCTP

Parameters for TAP

Parameters for RawTCP

Parameters for RawSerial
Parameters for XMPP.
Parameters for TONE

Parameters for UCP

Subject

The Subject section of a template controls the behavior of any Subject Line processed by

this template.
Subject

Since Subject Templates may be applied on a Global, Carrier, Connector or Recipient
level, itis entirely possible to create a standard format for all message subjects using a
Global Template, then specify exceptions to this global rule in the Carrier, Connector or
Recipient templates.

Generally speaking, the SMTP_or Email protocol is the only protocol that actively
references the Subject line during its protocol negotiation sequence. As such, you may
want to format special Subject Templates for each of your SMTP carriers but that is not
required. This can be also accomplished by a single Global Template, if you want to apply
these settings to all messages.

When configuring a Subject template, you can use plain text, macros or a mix and match of
both. Please see the Macros section for a list of variables that can be used in this section.

For example, you could format a subject template like this:
Message from %Sender%

and any message processed by this template would include the text "Message from
TheSenderValue" in the subject.
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You could also use only plain text to configure a static subject. For example:
Message from CAD

Or you could use only Macros. For example:
%Date% %Time%

Text

The Message section of the template controls the output and format of the body of any

message controlled by this template.
Tt

Since Message Templates may be applied on a Global, Carrier, Connector or Recipient
level, itis entirely possible to create a standard format for all Messages using a Global
Template, then specify exceptions to this global rule in the Carrier, Connector or Recipient
templates.

When configuring a Text template, you can use plain text, macros or a mix and match of
both. Please see the Macros section for a list of variables that can be used in this section.

For example, you could format a text template like this:
%Date% %Time% %Messsage%

and any message processed by this template would have the date and time stamp before
the body of the message.

You could also completely override messages processed by this template by using
plaintext and not referencing the %Message% variable. For example:
This is a message from your automated messaging system.

or

You have received a notification on %Date% at % Time%.
Macros

This is the master list of all Macro variables that can be used in a Subject or Text
Template.
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% This variable inserts the setting specified Internet Domain Setting.
InternetDo
main%
%St:/bject This variable inserts the Subject text.
(o]
%
SubjectDel This variable inserts the Subject Delimiter.
imiter%
%
Message This variable inserts the body of the Message.
%
(o)
A)Sg/?der This variable inserts the Sender of the Message.
0,
Send/;rMa If the Sender value is an email address, this variable inserts only
o the portion of the Sender's Address before the @.
ilbox%
0,
Send/ferDo If the Sender value is an email address, this variable inserts only
o the portion of the Sender's Address after the @.
main%
0,
.A’. This variable inserts the Recipient field of a Recipient's record or
Recipient G
%, roup field of a Group record.
0,
/° This variable inserts the Full Name field of a Recipient's record or
Recipientr the Description field of a Group record
ullName% '
% This variable inserts the intended Original Recipient of a message.
OriginalRe For example, if the message was originally addressed to a group,
cipient% this will be the group's name.
o This variable inserts the Last Recipient a message delivery
o attempt was addressed to. this can be used when a message has
LastRecipi e " s . ! e
o failed over" to another recipient, to insert the previous recipient's
ent% name
%
Recipientl This variable inserts the ID/PIN field of a Recipient's record.
d%
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Reci oient If the Recipient of a message is an email address, this variable
Mailbpox% inserts only the portion of the Recipient's Address before the @.
0,
Reci/oient If the Recipient of a message is an email address, this variable
DomZin% inserts only the portion of the Recipient's Address after the @.
0,
Com/:nent This variable inserts the Comment 1 field of a Recipient or Group's
1% Record.
0,
Com/:nent This variable inserts the Comment 2 field of a Recipient or Group's
20, Record.
0,
Com/:nent This variable inserts the Comment 3 field of a Recipient or Group's
39, Record.
0,
Com/:nent This variable inserts the Comment 4 field of a Recipient or Group's
4% Record.
% Date% This variable inserts the Date as specified by the operating
° ° system.
% Time% This variable inserts the Time as specified by the operating
° ° system.
0,
Milita/o Tim This variable inserts the Time as specified by the operating
eor/f system output in a 00:00 - 24:00 format.
0,
Requ/(:,sted This variable inserts the Date on which a request to deliver a
message was requested.
Date%
0,
Re u/;sted This variable inserts the Time on which a request to deliver a
T(iqme% message was requested.
%
Requested This variable inserts the Time on which a request to deliver a
MilitaryTim message was requested outputina 00:00 - 24:00 format.
e%
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Time%one This variable inserts the Time Zone as specified by the operating
% system.
o
Shor‘{el'ime This variable inserts the Time Zone as specified by the operating
Zone% system output in short code.
o .
/OSEZUO” This variable inserts the PageGate Station ID value.
(o)
Lo ir/10Nam This variable inserts the Windows Login Name of the user who
9 o performs a given action (such as sending a message).
e%
(0]
ComA) uter This variable inserts the Windows Computer of the a computer that
Nan?e% performs a given action (such as sending a message).
%Reliapage PageGate will sequentially number each message it sends to
° % Pag recipients. This is useful for detecting if a message has been

missed (a number is missing).

Global Templates

The Global Template controls the behavior of all messages processed by the PageGate
Server. PageGate's Global Template is contained in the Program - Template section of

PG Admin.
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Settings

StipMaonPrintable = Falze
IntermetDomain = yourdomain. com
SMTPHelloHost = ZlnternetDoman®
SMTPSubjectDefault = Text Meszage

Subject

Text

When configuring PageGate to send Email/lSMTP, it is incredibly important to properly
configure certain global variables. There are also some template variables that modify
certain commands and responses to commands in certain protocol negotiations as well.

PageGate is pre-loaded with a default template that provides most base functionality, so
you may not need to modify the Global Template. However, itis very, very important to
make sure that this Template is formatted properly.

To format the Global Template, please review the Template Components section of the
documentation.
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Settings

Subject

Test

Carrier level templates are most often used to apply specific settings or formatting
requirements to your method of delivery and most of the variables you'll apply will be in the
Settings section. For more information, please review the Template Components section
of the documentation. Applying a custom template to a carrier tells PageGate to format
messages delivered via this carrier in a certain way. Most carriers do not require a custom
template but there may be things you want to customize about the look, output or specific
format of your messages.

All delivery protocols have specific variables that can be used in the Settings section of a
corresponding carrier template. These variables can be broken down in to a few
categories: Protocol Delivery and Content Modification

Protocol Delivery

These parameters modify the behavior of a protocol and specify certain declarations that
must be made during the protocol negotiation sequence.
Parameters for SMTP

Parameters for GSM-AT-IP

Parameters for GSM-AT

Parameters for HTTPGET

Parameters for HTTPPOST

Parameters for FILE
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Parameters for WCTP

Parameters for TAP

Parameters for RawTCP

Parameters for RawSerial

Parameters for XMPP

Parameters for TONE

Parameters for UCP

Parameters for SMTP/Email

These variables control how PageGate sends SMTP/Email messages. Variables
specified on a carrier level will override variables specified on a global level.

Variable

BodyMax
Chars

Envelope
From

Envelope
FromAsE
mail

Filter

Click here for more information on how PageGate sends Email.

Possible
Values

Numeric

Email
Address

True

False

File path

Description
Example: BodyMaxChars =200
This parameter limits the length of the % Message % macro and
does not override the carrier "Max Chars" setting.
Example: EnvelopeFrom = your@sender.com

Every email has two sender values, one on the 'outer' envelope
and one on the 'inner' envelope.

This setting will only change the outer envelope sender value.
When this variable is not present, the outer and inner envelope
sender value is the same. This variable provides a way to use a
different outer envelope sender value, if required.

Example: EnvelopeFromAsEmail = True

This variable forces the EnvelopeFrom value to be turned into an
valid email address, if it isn't already.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate

to and file | program directory to use this parameter.

name of
the filter
to run

Example: Filter = c:\PageGateData\Filters\yourfilter.xml
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PageGate . _
It is entirely possible to call on PageGate's filtering system when
delivering an SMTP/Email message, allowing you to reformat
messages that enter the queue to any data structure you need.
As an example, you could have a filter take every message and

putitin an XML payload for delivery.

File path | Example: FilterDebugFile = c:
to and file | \PageGateData\Filters\outboundfilter1.log

FilterDeb
name of

ugFile the log to | When using a filter, you can use this variable to output this
write specific filter's log to the specific location and file name.
Example: From = your@sender.com
This variable overrides any sender information passed in by the
From Email |interfaces and APls.
Address
By specifying this variable, you're telling PageGate to use a
single, standardized sender's name for all traffic controlled by this
template.
Number Example: InterMessageDelay = 1000
Inter[l\)/lelss M.".Of This variable inserts a pause, in milliseconds, in between each
agebelay Vi |::con message that is delivered. This is sometimes required to stay

below messaging thresholds for SMTP servers.
Example: InternetDomain = alternate.domain.org

This variable is used when carrier a should declare that
messages are coming from a domain other than the one
specified in the global template. Generally

speaking, this variable should be set at a global level unless an
exceptionis being made.

Example: ReplyTo = YourEmail@domain.com

InternetD Email
omain domain

Email

Address If the reply email address should be something other than the

'From' value, this variable allows you to specify the necessary
address.

Example: SMTPConnectTimeout = 40

ReplyTo

SmtpCon | Number
nectTime of

This variable specifies the number of seconds PageGate should
out Seconds

wait for a response from an SMTP host.
, Example: SmtpForceAuth = plain
SmtpForc | 109N

eAuth plain This variable forces PageGate to only use the specified

authentication method, rather than selecting from the list of
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md5
ntim
SmtpForc | True
eStartTls | False
SmtpFrie | Tr4e
ndlyName
s False
SmtpHell | Email
oHost domain
SmtpQpE | True
ncode False
SmtpSen | True
dReset False
SmtpTLS oxt
Version

supported authentication styles reported by the mail server.
PageGate currently supports using LOGIN, PLAIN, CRAM-MD5
and NTLM authentication.

Example: SmtpForceStartTls = True

This variable forces a carrier to use STARTTLS for its SMTP
transactions, regardless of the value specified in the 'Port' field of
the carrier settings.

Example: SmtpFriendlyNames = True

Some SMTP hosts use SMTP 'Friendly Names' as a part of anti-
spam monitoring policy. Settings this value to true tells PageGate
to include the SMTP 'Friendly Name' information in this carrier's
transactions.

Examples: SmtpHelloHost = %lInternetDomain%, SmtpHelloHost
= hardcodedvalue.org

During the SMTP negotiation, this value is used during the
EHLO/HELO exchange. Typically speaking, you will want this
value to mirror the InternetDomain value and this should also be
set at a global level.

Implementing this at a carrier level is intended to create
exceptions to the global rule, telling this carrier it should use a
different value.

Example: SMTPQpEncode = False

By default, PageGate uses Quoted Printable encoding for
SMTP/Email. However, some systems can't interpret this format
and require plaintext, so 'QP Encoding' needs to be turned off.

Example: SmtpSendReset = False

By default, PageGate issues the SMTP RSET command, which
reset's the sessions values, between each message. This
parameter provides the ability to turn that behavior off.

Example: SmtpTLSVersion = TLS 1.3 or higher

This parameter configures the version of TLS/SSL that should be
used by this carrier. Valid values are:
e default

e TLS 1.3
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SmtpUse | True
Dkim False

StripAlph | True
a False

See

StripChar |qescriptio

acters
n

StripNon True
Printable = False

SubjectD Text
efault

SubjectD

L Text
elimiter

e TLS 1.2
e TLS 11
e TLS 1.0
e SSL 3.0
e TLS 1.3 or higher
e TLS 1.2 or higher
e TLS 1.1 or higher
e TLS 1.0 or higher

Example: SmtpUseDkim = True

If you have PageGate configured to deliver email as a mail
server and have created a DKIM record, set this value to true to
have PageGate include the DKIM signature in delivered traffic.

Example: StripAlpha = True

Setting this value to true will remove any alphabetical character
from messages delivered through this carrier. For example, if you
tried to send the message 'Alert on node 127.0.0.1', the only
thing delivered would be '127.0.0.1'

Example: StripCharacters = |\~

This parameter will remove all instance of any character(s)
entered. In the above example, that would strip out all pipes (|),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True

Settings this value to true will remove any non-printable ASCII
characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.

Example: SubjectDefault = Dispatch Alert

This parameter is used to set the subject line of all messages
delivered through this carrier to a single, standard value.

Example: SubjectDelimiter =\013\010/|~|:

This parameter tells PageGate to look in the message text for
subject line information. Multiple objects may be searched for
and you'll want to separate each search parameter with a pipe.
ASCIl values may be scanned for but you must prefix any ASCII
code with a backslash (\).
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File path
Subjectril 10 @nd file
ter name of
the filter
to be run
File path

SubjectFil |to and file
terDebug | name of
File the log to
be written

SubjectM

Numeric
axChars

SubjectS
earchLen | Numeric
gth

To Email
address

UseAltern | True

ateDNS False

UseFilter True

DIl False

In the above example, that would scan for a carriage return+line
feed or a tilde (~) or a colon (:) within the specified
SubjectSearchLength.

Subjects parsed by this parameter are overridden by the
SubjectDefault parameter.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: SubjectFilter = c:\PageGateData\Filters\yourfilter.xml

This parameter allows you to specify a filter that will only be run
on the subject line of traffic delivered through this carrier.

Example: FilterDebugFile = c:
\PageGateData\Filters\CarrierSubjectFilterLog.log

When using a filter, you can use this variable to output this
specific filter's log to the specific location and file name.

Example: SubjectMaxChars = 20

This parameter determines the maximum number of characters
the subject line may contain.

Example: SubjectSearchLength =10

This parameter determines how many characters in to the
message PageGate should look for the configured delimiting
character(s).

Example: To = email@address.gov

This parameter forces all traffic to go to a single email address,
overriding any interface or recipient values for the delivery
address.

Example: UseAlternateDNS = True

PageGate has a few methods of performing DNS lookups. If you
are experiencing issues with standard DNS lookups, setting this
parameter to true will tell the program to use an alternate method
for performing them.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: UseFilterDIl = True
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Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.

Parameters for GSM-AT-IP

These variables control how PageGate interacts with cellular routers and gateways
accessed by TCP or SSH. Itis recommended that you configure these variables on either
the Carrier or Connector level.

Click here for more information on how PageGate uses cellular gateways and routers.

Possibl
Variable e Description
Values
Example: BodyMaxChars =200
BodyMaxC Numeric
hars This parameter limits the length of the %Message% macro and
does not override the carrier "Max Chars" setting.
Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
File path program directory to use this parameter.
to and Example: Filter = c:\\PageGateData\Filters\yourcarrierfilter.xml
Filter file name
f“cl): thf This parameter calls on PageGate's filtering system when
liter to sending and receiving SMS through this carrier. This allows for
run the sorting and modification of both outbound messages and
replies and is an integral part of two-way messaging.
File path | Example: FilterDebugFile = c:
FillerDebu toand |\PageGateData\Filters\outboundfilter1.log
File file name
9 of the log | When using a filter, you can use this variable to output this
to write | specific filter's log to the specific location and file name.
Example: From = ALERTS
This parameter overrides any sender information passed in by
From Text the interfaces and APls.
By specifying this variable, you're telling PageGate to use a
single, standardized sender's name for messages delivered
through this carrier.
GsmCmgl | Number | Example: GsmCmglDelay = 1000
Delay of
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GsmCmgl|
String

GsmSetTe
xtModeOn
ce

GsmUseC
mgf

GsmUseC
mgs

GsmUseCp
oint

GsmUseG
T

GsmUseM
mmg

Milliseco

nds

Text

True

False

True

False

True

False

True

False

True

False

True

False

This parameter increases the amount of time PageGate will
wait on a response from cellular hardware when checking for
messages.

Example: GsmCmglIString = AT+CMGL=UREAD

This parameter overrides the normal 'check for messages'
command. PageGate will use whatever AT command is
supplied in this statement instead.

Example: GsmSetTextModeOnce = True

This parameter specifies that PageGate should only send the
command to enter text delivery mode once until Connector is
restarted.

This parameter should not be used with cellular modems that
require the "Enter Text Delivery Mode" command be issued in
each session.

Example: GsmUseCmgf = True

This parameter specifies that the AT+CMGF=1 command
should be used to enter text delivery mode.

if your modem supports AT+CMGF=1, set this variable to true
for the carrier or connector using the IP capable cellular
modem, router or gateway.

Example: GsmUseCmgs = True

This variable specifies that the AT+CMGS command should
be used to deliver text messages.

Example: GsmUseCpoint = True

This parameter tells PageGate to use the CradlePoint
command set to interact with the device.

Example: GsmUseGT = False

This parameter tells PageGate to wait for a ">' character after
using the CMGS command. By default, this is true but to
disable it, set the variable above.

Example: GsmUseMmmg = True

This variable specifies that the AT+MMMGS command should
be used to deliver text messages.
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GsmUseS
msm2m

GsmUseW
scl

InterComm
andDelay

InterMessa
geDelay

ModemHa
ngupCom
mand

ModemWa
keupCom
mand

ReplyFilter

True

False

True

False

Milliseco
nds

Number of
Millisecon
ds

Comman
d Set
String

Comman
d Set
String

File path
to and
file name

6

This variable specifies that the AT*SMSM2M command should
be used to deliver text messages.

Example: GsmUseSmsm2m = True

This is usually used with Sierra Wireless/Airlink hardware.
Example: GsmUseWscl = True

This variable specifies that the AT+WSCL=1,2 command
should be used to enter text delivery mode.

ff your modem uses AT+WSCL=1,2 to enter SMS delivery
mode, set this variable to true.

Example: InterCommandDelay = 500

This variable inserts a pause, in milliseconds, in between each
command used in the protocol negotiation with the hardware.
This is used to make sure PageGate doesn't send commands
faster than the device's command shell can receive them and
is not required for all devices.

Example: InterMessageDelay = 1500

This variable inserts a pause, in milliseconds, in between each
message that is delivered.

It is entirely possible for PageGate to overload the cellular
radio in your device by sending information too quickly. By
default, PageGate inserts a 1.5 second pause between
messages to ensure this doesn't happen but this variable may
need to be adjusted for specific hardware requirements.

Example: ModemHangupCommand = ATO

if your cellular modem, router or gateway requires a special
parameter for disconnect/hang-up, use this cariable to specify
the necessary command. Default if not set: ATHO

Example: ModemWakeupCommand =\013

if your cellular modem, router or gateway requires something
other than AT<CR> to wake up, use this variable to specify the
necessary command.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: Filter = c:\\PageGateData\Filters\replyfilter.xml
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ReplyFilter
DebugFile

StripAlpha

StripChara
cters

StripNonPr
intable

TcpProtoc
ol

UseFilterDI
I

of the
filter to
run

File path
to and
file name
of the log
to write

True

False

See
descriptio

n

True

False

SSH
TCP

A Phone
Number

True

False

This parameter calls on PageGate's filtering system using the
"Check for Messages" routine to retrieve SMS from the device.
This allows for the sorting and modification of both outbound
messages and replies and is an integral part of two-way
messaging.

Example: FilterDebugFile = c:
\PageGateData\Filters\replyfilterlog1.log

When using a filter, you can use this variable to output this
specific filter's log to the specific location and file name.

Example: StripAlpha = True

Setting this value to true will remove any alphabetical character
from messages delivered through this carrier. For example, if
you tried to send the message 'Alert on node 127.0.0.1', the
only thing delivered would be '127.0.0.1'

Example: StripCharacters = |\~

This parameter will remove all instance of any character(s)
entered. In the above example, that would strip out all pipes (|),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True

Settings this value to true will remove any non-printable ASCII
characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.

Example: TcpProtocol = SSH

This parameter configures what protocol negotiation method
should be used. By default, PageGate uses TCP but to
connect with SSH instead, specify the above variable.

Example: To = 7818290500

This parameter forces all traffic to go to the specified phone
number, overriding any interface or recipient values.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: UseFilterDIl = True

Setting this parameter to true tells PageGate to use the filter
dll, which is a more efficient method of running the filter.
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True

False This variable tells PageGate to negotiate telnet terminal
capabilities upon connection

Example: UseTelnet = True

UseTelnet

Parameters for GSM-AT

These variables control how PageGate interacts with modems. We recommend setting
these parameters at either the Carrier or Connector level.

Click here for more information on how PageGate uses cellular modems.

Possi
Variable ble Description
Value
s
Example: BodyMaxChars = 200
BodyMax Numeric
Chars This parameter limits the length of the %Message % macro and
does not override the carrier "Max Chars" setting.
Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
File program directory to use this parameter.
path to
and file | Example: Filter = c:\PageGateData\Filters\yourcarrierfilter.xml
Filter name
ofthe | This parameter calls on PageGate's filtering system when
filter to | sending SMS through this carrier. This allows for the sorting and
run modification of both outbound messages and replies and is an
integral part of two-way messaging.
File
pathto | Example: FilterDebugFile = c:
FilterDebu and file | \PageGateData\Filters\outboundfilter1.log
. name
gFile ofthe | When using a filter, you can use this variable to output this
logto | specific filter's log to the specific location and file name.
write
Example: From = ALERTS
This parameter overrides any sender information passed in by
the interfaces and APls.
From Text

By specifying this variable, you're telling PageGate to use a
single, standardized sender's name for messages delivered
through this carrier.
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Numbe Example: GsmCmglDelay = 1000
GsmCmgl T‘?f This parameter increases the amount of time PageGate will wait

Delay Millise .
q on a response from cellular hardware when checking for
conas messages.
Example: GsmCmgIString = AT+CMGL=UREAD

GsmCmgl|

Text | This parameter overrides the normal 'check for messages'

String command. PageGate will use whatever AT command is supplied
in this statement instead.
Example: GsmSetTextModeOnce = True
This parameter specifies that PageGate should only send the
GsmSetTe | 1, |command to enter text delivery mode once until Connector is
xtModeOn restarted.
ce False

This parameter should not be used with cellular modems that
require the "Enter Text Delivery Mode" command be issued in
each session.

Example: GsmUseCmgf = True

This parameter specifies that the AT+CMGF=1 command should
GsmUseC | True | pe used to enter text delivery mode.

mgf False
If your modem supports AT+CMGF=1, set this variable to true for

the carrier or connector using the IP capable cellular modem,
router or gateway.
Example: GsmUseCmgs = True
GsmUseC | True
mgs False @ This variable specifies that the AT+CMGS command should be
used to deliver text messages.

Example: GsmUseCpoint = True

GsmUseC | True
point False | This parameter tells PageGate to use the CradlePoint command

set to interact with the device.
Example: GsmUseGT = False

GsmUseG | True

This parameter tells PageGate to wait for a ">' character after
T False

using the CMGS command. By default, this is true but to disable
it, set the variable above.

GsmUseM | True | Example: GsmUseMmmg = True
mmg False
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This variable specifies that the AT+MMMGS command should be
used to deliver text messages.

Example: GsmUseSmsm2m = True

This variable specifies that the AT"SMSM2M command should
be used to deliver text messages.

This is usually used with Sierra Wireless/Airlink hardware.
Example: GsmUseWscl = True

This variable specifies that the AT+WSCL=1,2 command should
be used to enter text delivery mode.

If your modem uses AT+WSCL=1,2 to enter SMS delivery mode,
set this variable to true.

Example: InterCommandDelay = 500

This variable inserts a pause, in milliseconds, in between each
command used in the protocol negotiation with the hardware.
This is used to make sure PageGate doesn't send commands
faster than the device's command shell can receive them and is
not required for all devices.

Example: InterMessageDelay = 1500

This variable inserts a pause, in milliseconds, in between each
message that is delivered.

Iltis entirely possible for PageGate to overload the cellular radio
in your device by sending information too quickly. By default,
PageGate inserts a 1.5 second pause between messages to
ensure this doesn't happen but this variable may need to be
adjusted for specific hardware requirements.

Example: ModemHangupCommand = ATO

if your cellular modem, router or gateway requires a special
parameter for disconnect/hang-up, use this cariable to specify
the necessary command. Default if not set: ATHO

Example: ModemWakeupCommand =\013

If your cellular modem, router or gateway requires something
other than AT<CR> to wake up, use this variable to specify the
necessary command.
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J Note: pdfilter.exe and pdfilter.dll must reside in the PageGate

File | Program directory to use this parameter.

g:;hﬁtlz Example: Filter = c:\PageGateData\Filters\replyfilter.xml
ReplyFilter | name This parameter calls on PageGate's filtering system using the
Ofthe | nCheck for Messages" routine to retrieve SMS from the device.
filterto | This allows for the sort ng and modification of both outbound
run messages and replies and is an integral part of two-way
messaging.
File

pathto | Example: FilterDebugFile = c:

and file |\PageGateData\Filters\replyfilterlog1.log
name

ofthe | When using a filter, you can use this variable to output this
logto | specific filter's log to the specific location and file name.
write

ReplyFilter
DebugFile

Example: StripAlpha = True

True | Setting this value to true will remove any alphabetical character

StripAlpha False | from messages delivered through this carrier. For example, if you
tried to send the message 'Alert on node 127.0.0.1", the only
thing delivered would be '127.0.0.1'

See Example: StripCharacters = |\~
Strlggrr;ara descripti | This parameter will remove all instance of any character(s)

on entered. In the above example, that would strip out all pipes (|),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True

StripNonP | True

. Settings this value to true will remove any non-printable ASCII
rintable False

characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.

A Example: To = 7818290500

To Phone
Numbe | This parameter forces all traffic to go to the specified phone
r number, overriding any interface or recipient values.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
UseFilterD | True | Programdirectory to use this parameter.

! False | Example: UseFilterDIl = True
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Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.

Parameters for HTTPGET

These variables control how PageGate uses the HTTP GET method of communication. It
is recommended to set these parameters at the Carrier level.

Click here for more information on how PageGate uses HTTP GET.

Templates for HTTP GET carriers tell PageGate what variables and data to declare in the
URL passed to the API.

All variables are declared in the "Text' section of the template as follows:
|[<name1>|<value1>|

|[<name2>|<value2>|

etc.

Each value you specify will need to correspond to a variable that the receiving APl will
recognize. For example, let's say we wanted to send a message to an API that looked for
to, from, subject and text as variables. We would need to format the text template as
follows:

to]%Recipientld%|
[from|%Sender%|
|subject|%Subject%|
text|%Message%|

NOTE: The default parameter delimiter is a pipe (|) but this may be changed with the
ParameterDelimiter setting below.

Possi
Variable ble Description
Value P

S

Example: BodyMaxChars = 200
BodyMaxCh | Numeri
ars c This parameter limits the length of the % Message% macro and
does not override the carrier "Max Chars" setting.

File | Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
path | program directory to use this parameter.

to and
file Example: Filter = c:\\PageGateData\Filters\yourcarrierfilter.xml

Filter
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name
of the
filter
to run

File

path
to and

FilterDebug | file
File name
of the
log to

write

From Text

Com
mand
HttpErrorRe | String
sponse See
Descr
iption

This parameter calls on PageGate's filtering system when
sending and receiving SMS through this carrier. This allows for
the sorting and modification of both outbound messages and
replies and is an integral part of two-way messaging.

Example: FilterDebugFile = c:
\PageGateData\Filters\outboundfilter1.log

When using a filter, you can use this variable to output this
specific filter's log to the specific location and file name.

Example: From = CAD

This parameter overrides the value passed to PageGate by the
input modules/APIs. By specifying this variable, you're telling
PageGate to use a single, standardized sender's name for all
traffic controlled by this template.

NOTE: This parameter's routine only engages when receiving a
200 class response from the web server.

This variable tells PageGate to scan for the specified keywords
or keyphrases in responses to a GET requests made by this
carrier. If those keywords or keyphrases are found, the message
is treated as failed or rejected, depending on what you specify.

This variable is both case and punctuation sensitive and
PageGate will look for an exact match to what you enter.

Multiple search terms may be used and must be separated by a
pipe.

For example, this would only scan for the word failed:
HttpErrorResponse = failed

This would scan for the word failed in the <Reply> tag:
HttpErrorResponse = <Reply>failed</Reply>

This would scan for the word reject or the word failed in the
<Reply> tag:
HttpErrorResponse = reject|<Reply>failed</Reply>
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phrase object not found:
HttpErrorResponse = failed|reject|object not found

Any response from the web server that includes the search
term(s) will be treated as a failure.

HTTP | Example: HttpProtocol = HTTPS

HitpProtocol| S| g parameter forces the use of HTTPS regardless of the port
HTTP | used to connect.

Example: HitpResponseTimeout = 1000

HttpRespon | Millise

, This variable forces PageGate to wait for the specified number
seTimeout | conds

of milliseconds (1000 = 1 second) for a response to the HTTP
communication request.

NOTE: This parameter's routine only engages when receiving a
200 class response from the web server.

This variable tells PageGate to scan for the specified keywords
or keyphrases in responses to a GET requests made by this
carrier. If those keywords or keyphrases are found, the message
is treated as failed or rejected, depending on what you specify.

This variable is both case and punctuation sensitive and
PageGate will look for an exact match to what you enter.

Com | Multiple search terms may be used and must be separated by a
mand | pipe.
HttpSucces | String
sResponse | See | For example, this would only scan for the word success:
Descr | HttpSuccessResponse = success
iption
This would scan for the word Acknowledged in the <Reply> tag:
HttpSuccessResponse = <Reply>Acknowledged</Reply>

This would scan for the word hijinks or the word Acknowledged
in the <Reply> tag:
HttpSuccessResponse =hijinks|<Reply>Acknowledged</Reply>

This would scan for the word success OR the word hijinks OR

the word actualization:
HttpSuccessResponse = success|hijinks|actualization
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Any response from the web server that includes the search
term(s) will be treated as a success.

Example: InterMessageDelay = 1000

This variable inserts a pause, in milliseconds, in between each
message that is delivered. It could be possible for PageGate to
send a large number of data requests too quickly and this
prevents that from happening.

Example: ParameterDelimiter = !

Message templates for HTTP GET carriers usually involve
parameter + variable pairs that are declared in this format:
|[parameter|variable|

ParameterDelimiter allows you to change the 'wrapping'
character from a pipe (|) to something else, like an exclamation
mark (1).

Example: ResponseincludeRequest = True

Setting this parameter to true tells PageGate to include the
original request sent to the APl when recording responses.

Example: ResponsePath = c:\\PageGateData\APIResponses\

This parameter allows you to specify the folder that responses
should be written to. If APl responses do not need to be tracked,
this parameter is not required.

Example: ResponseRecipient = groupname

When the HTTP GET or POST transaction completes, the
specified recipient or group will receive any responses from the
receiving APllweb host. For more information, please see the

Two Way Messaging section of the documentation.

Example: StripAlpha = True

Setting this value to true will remove any alphabetical character
from messages delivered through this carrier. For example, if
you tried to send the message 'Alert on node 127.0.0.1', the only
thing delivered would be '127.0.0.1"
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J See Example: StripCharacters = |\~
Strlrf[grr;arac descrip | This parameter will remove all instance of any character(s)

tion | entered. In the above example, that would strip out all pipes (|),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True

i i | True
StripNonPi Settings this value to true will remove any non-printable ASCII

ntable False | characters, like carriage retums, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.
To =7818290500
To Text | This variable overrides the ID/PIN or Email values. By specifying

this variable, you're telling PageGate to send all traffic processed
by this template to the specified ID or Email address instead.
Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

True

UseFilterDl Example: UseFilterDIl = True
False

Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.
Parameters for HTTPPOST

These variables control how PageGate uses the HTTP POST method of communication. It
is recommended to set these parameters at the Carrier level.

Click here for more information on how PageGate uses HTTP POST.

Possi
Variable ble Description
Value
s
Example: BodyMaxChars = 200
BodyMaxC Numeric , I
hars This parameter limits the length of the % Message % macro and

does not override the carrier "Max Chars" setting.

File Note: pdfilter.exe and pdfilter.dll must reside in the PageGate

pathto | program directory to use this parameter.
and file

Filter name | Example: Filter = c:\\PageGateData\Filters\yourcarrierfilter.xml

of the
filter to | This parameter calls on PageGate's filtering system when

run sending and receiving SMS through this carrier. This allows for
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the sorting and modification of both outbound messages and
replies and is an integral part of two-way messaging.

Example: FilterDebugFile = c:
\PageGateData\Filters\outboundfilter1.log

When using a filter, you can use this variable to output this
specific filter's log to the specific location and file name.

Example: From = CAD

This parameter overrides the value passed to PageGate by the
input modules/APIs. By specifying this variable, you're telling
PageGate to use a single, standardized sender's name for all
traffic controlled by this template.

NOTE: This parameter's routine only engages when receiving a
200 class response from the web server.

This variable tells PageGate to scan for the specified keywords
or keyphrases in responses to a POST requests made by this
carrier. If those keywords or keyphrases are found, the message
is treated as failed or rejected, depending on what you specify.

This variable is both case and punctuation sensitive and
PageGate will look for an exact match to what you enter.

Multiple search terms may be used and must be separated by a
pipe.

For example, this would only scan for the word failed:
HttpErrorResponse = failed

This would scan for the word failed in the <Reply> tag:
HttpErrorResponse = <Reply>failed</Reply>

This would scan for the word reject or the word failed in the
<Reply> tag:
HttpErrorResponse = reject|<Reply>failed</Reply>

This would scan for the word failed OR the word reject OR the
phrase object not found:
HttpErrorResponse = failed|reject|object not found
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Any response from the web server that includes the search
term(s) will be treated as a failure.

HttpPostType = HeadBody configures an HTTP POST carrier to
HeadB | Provide header information followed by structured data, usually
JSON or XML, in the body.
HttpPostTy ody
pe UrlHea | HitpPostType = UrlHeadBody configures an HTTP POST carrier
dBody to pass parameters in the URL, more like the POST method.
This is not a typical use of HTTP POST but is used/required by

some APlIs.
HTTP | Example: HttpProtocol = HTTPS
HttpProtoc 3
ol This parameter forces the use of HTTPS or HTTP regardless of

HTTP | the port used to connect.
Example: HitpResponseTimeout = 1000

HUPResPO |\ ice
nseTimeou This variable forces PageGate to wait for the specified number
t conds of milliseconds (1000 = 1 second) for a response to the HTTP
communication request.
NOTE: This parameter's routine only engages when receiving a
200 class response from the web server.
This variable tells PageGate to scan for the specified keywords
or keyphrases in responses to a POST requests made by this
carrier. If those keywords or keyphrases are found, the message
is treated as failed or rejected, depending on what you specify.
This variable is both case and punctuation sensitive and
Comm | PageGate will look for an exact match to what you enter.
HttpSucce ar.1d
String | Multiple search terms may be used and must be separated by a
ssRespons .
o See | pipe.
Descri

ption | For example, this would only scan for the word success:
HttpSuccessResponse = success

This would scan for the word Acknowledged in the <Reply> tag:
HttpSuccessResponse = <Reply>Acknowledged</Reply>

This would scan for the word hijinks or the word Acknowledged in

the <Reply> tag:
HttpSuccessResponse =hijinks|<Reply>Acknowledged</Reply>
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6

This would scan for the word success OR the word hijinks OR the
word actualization:
HttpSuccessResponse = success|hijinks|actualization

Any response from the web server that includes the search
term(s) will be treated as a success.

Example: InterMessageDelay = 1000

This variable inserts a pause, in milliseconds, in between each
message that is delivered. It could be possible for PageGate to
send a large number of data requests too quickly and this
prevents that from happening.

Example: ParameterDelimiter = !

Message templates for HTTP POST carriers usually involve
parameter + variable pairs that are declared in this format:
|[parameter|variable|

ParameterDelimiter allows you to change the 'wrapping' character
from a pipe (|) to something else, like an exclamation mark (!).

Example: ResponselncludeRequest = True

Setting this parameter to true tells PageGate to include the
original request sent to the APl when recording responses.

Example: ResponsePath = c:\\PageGateData\APIResponses\

This parameter allows you to specify the folder that responses
should be written to. If APl responses do not need to be tracked,
this parameter is not required.

Example: ResponseRecipient = groupname

When the HTTP POST transaction completes, the specified
recipient or group will receive any responses from the receiving
APliweb host. For more information, please see the Two Way
Messaging section of the documentation.

Example: StripAlpha = True

Setting this value to true will remove any alphabetical character
from messages delivered through this carrier. For example, if you
tried to send the message 'Alert on node 127.0.0.1", the only
thing delivered would be '127.0.0.1'
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See
StripChara | yescri pt
cters

Example: StripCharacters = |\~

This parameter will remove all instance of any character(s)
on entered. In the above example, that would strip out all pipes (|),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True

i True
StripNonPr Settings this value to true will remove any non-printable ASCII

intable False | characters, like carriage retumns, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.
Example: To = 7818290500
To Text | This variable overrides the ID/PIN or Email values. By specifying

this variable, you're telling PageGate to send all traffic processed
by this template to the specified ID or Email address instead.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

UseFilterDI | True

Example: UseFilterDIl = True
| False

Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.

This is how to use the 'Text' section of an HTTP POST carrier:
Each value you specify will need to correspond to a variable that the receiving API will
recognize. For example, let's say we wanted to send a message using Twilio's API. We
know they're looking that looked for to, from and body as variables. We would need to
format the text template as follows:

to|%Recipientld%|
[from|%Sender%|
lbody|%Message%|

NOTE: |is a pipe character and is found on most keyboards above the backslash
character, \.

Some APIs, like MessageBird, require an authentication variable in the body of the POST
and those are declared like any other variable.

Example:
|Authorization|]AccessKey PasteYourAccessKeyHere|

[recipients|%Recipientld%|
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lbody|%Message%|
Parameters for FILE

These variables control how PageGate uses the FILE method of communication. It is
recommended to set these parameters at the Carrier level.

Click here for more information on how PageGate outputs ASClIIfiles with the FILE

protocol.
Possi
Variable ble Description
Value
s
Example: BodyMaxChars = 200
BodyMaxC Numeric , I
hars This parameter limits the length of the %Message% macro and
does not override the carrier "Max Chars" setting.
File Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
path to program directory to use this parameter.
and file . . ,
. Example: Filter = c:\PageGateData\Filters\yourcarrierfilter.xml
Filter name
ofthe This parameter calls on PageGate's filtering system outputting
filter to files with this carrier. This is often an integral part of two-way
fun messaging.
File

pathto | Example: FilterDebugFile = c:
and file | \PageGateData\Filters\outboundfilter1.log

FilterDebu
. name
gFile ofthe | When using a filter, you can use this variable to output this
logto | specific filter's log to the specific location and file name.
write
Example: From = CAD
Erom Text This parameter overrides the value passed to PageGate by the

input modules/APls. By specifying this variable, you're telling
PageGate to use a single, standardized sender's name for all
traffic controlled by this template.

Example: InterMessageDelay = 1000
InterMessa | Millise
geDelay | conds | This variable inserts a pause, in milliseconds, in between each
message thatis delivered. It could be possible for PageGate to
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True
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See
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on

StripNonPr | True
intable False

To Text

UseFilterDI | True
| False

Parameters for SNPP

send a large number of data requests too quickly and this
prevents that from happening.

Example: StripAlpha = True

Setting this value to true will remove any alphabetical character
from messages delivered through this carrier. For example, if you
tried to send the message 'Alert on node 127.0.0.1', the only
thing delivered would be '127.0.0.1'

Example: StripCharacters = |\~

This parameter will remove all instance of any character(s)
entered. In the above example, that would strip out all pipes (|),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True

Settings this value to true will remove any non-printable ASCII
characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.

Example: To = 7818290500

This variable overrides the ID/PIN or Email values. By specifying
this variable, you're telling PageGate to send all traffic processed
by this template to the specified ID.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: UseFilterDIl = True

Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.

These variables control how PageGate uses the SNPP method of communication. ltis
recommended to set these parameters at the Carrier level.

Click here for more information on how PageGate uses SNPP.

Poss
ible
Valu
es

Variable

Description
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Example: BodyMaxChars =200

This parameter limits the length of the %Message% macro and
does not override the carrier "Max Chars" setting.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: Filter = c:\\PageGateData\Filters\yourcarrierfilter.xml

This parameter calls on PageGate's filtering system when using
this carrier.

Example: FilterDebugFile = c:
\PageGateData\Filters\outboundfilter1.log

When using a filter, you can use this variable to output this specific
filter's log to the specific location and file name.

Example: From = CAD

This variable overrides the value passed to PageGate by the input
modules/APIs. By specifying this variable, you're telling PageGate
to use a single, standardized sender's name for all traffic controlled
by this template.

Example: InterCommandDelay = 500

This variable inserts a pause, in milliseconds, in between each
command used in the protocol negotiation with the hardware. This
is used to make sure PageGate doesn't send commands faster
than the device's command shell can receive them and is not
required for all devices.

Example: InterMessageDelay = 1000

This variable forces PageGate to delay for the specified number of
milliseconds (1000 = 1 second) after delivering each message.

Example: SNPPMessOnly = True
This variable tells PageGate to use the MESS command, instead
of the DATA command, during the SNPP delivery sequence.
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True | Setting this value to true will remove any alphabetical character

StripAlpha False | from messages delivered through this carrier. For example, if you
tried to send the message 'Alert on node 127.0.0.1', the only thing
delivered would be '127.0.0.1"

See Example: StripCharacters = |\~

StripChar

descrip | This parameter will remove all instance of any character(s) entered.
tion | Inthe above example, that would strip out all pipes (|), backslashes
(\) and tildes (~).
Example: StripNonPrintable = True

acters

StripNonP | True

) Settings this value to true will remove any non-printable ASCII
rintable | False

characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.

Example: To =7818290500

To Text | This variable overrides the ID/PIN or Email values. By specifying
this variable, you're telling PageGate to send all traffic processed
by this template to the specified ID or Email address instead.
Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

UseFilter | True

Example: UseFilterDIl = True
Dli False

Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.
Parameters for WCTP

These variables control how PageGate uses the WCTP method of communication. ltis
recommended to set these parameters at the Carrier level.

Click here for more information on how PageGate uses WCTP.

Possib
Variable le Description and Possible Values
Values
Example: BodyMaxChars = 200
BodyMax | Numeri
Chars c This parameter limits the length of the %Message% macro and
does not override the carrier "Max Chars" setting.
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Example: EnvelopeFrom = your@sender.com

WCTP has two potential sender values, one on the 'outer’
transaction and one on the 'inner' payload.

This setting will only change the outer sender value. When this
variable is not present, the outer and inner envelope sender value
is the same. This variable provides a way to use a different outer
envelope sender value, if required.

Example: EnvelopeFromAsEmail = True

This variable forces the EnvelopeFrom value to be turned into an
valid email address, if it isn't already.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: Filter = c:\PageGateData\Filters\yourcarrierfilter.xml

This parameter calls on PageGate's filtering system when using
this carrier.

Example: FilterDebugFile = c:
\PageGateData\Filters\outboundfilter1.log

When using a filter, you can use this variable to output this specific
filter's log to the specific location and file name.

Example: From = CAD

This variable overrides the value passed to PageGate by the input
modules/APIs. By specifying this variable, you're telling PageGate
to use a single, standardized sender's name for all traffic
controlled by this template.

Example: InterCommandDelay = 500

This variable inserts a pause, in milliseconds, in between each
command used in the protocol negotiation with the hardware. This
is used to make sure PageGate doesn't send commands faster
than the device's command shell can receive them and is not
required for all devices.
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J Example: InternetDomain = exampledomain.com

This variable determines the domain name PageGate will pass

nternetDo | Email during the WCTP negotiation sequence.

main domain If this variable has already been implemented for SMTP/Email, it

does not need to be specified again at a carrier level unless the
receiving WCTP host requires you to specify a domain name
other than your email domain.

- Example: InterMessageDelay = 1000
InterMessa | Millise

geDelay | conds This variable forces PageGate to delay for the specified number

of milliseconds (1000 = 1 second) after delivering each message.
Example: StripAlpha = True

True | Setting this value to true will remove any alphabetical character

StripAlpha False | from messages delivered through this carrier. For example, if you
tried to send the message 'Alert on node 127.0.0.1', the only thing
delivered would be '127.0.0.1'

See Example: StripCharacters = |\~
Strlci(elrr;ara descrip | This parameter will remove all instance of any character(s)

tion |entered. In the above example, that would strip out all pipes (|),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True

StripNonP | True

. Settings this value to true will remove any non-printable ASCII
rintable False

characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.

Example: To =7818290500

Recipie

To nt ID

This variable overrides the ID/PIN or Email values. By specifying
this variable, you're telling PageGate to send all traffic processed

by this template to the specified ID or Email address instead.
Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.
i True
UseFilterD Example: UseFilterDIl = True
I False

Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.
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Parameters for TAP

Example: WCTPBase64Encode = False

This variable tells PageGate whether or not to use base64
encoding in WCTP transmissions. If this variable is not present,

the value is assumed to be true and baseb64 is used.

Example: WCTPResponsesTo = email@domain.com

This variable tells PageGate to include the sendResponsesTolD
field in the message envelope. A value of 'none' will instead send

an allowResponse field with the value of 'false’.

These variables control how PageGate uses the TAP method of communication. ltis
recommended to set these parameters at the Carrier level.

Click here for more information on how PageGate uses TAP.

Pos
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ars ric
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to

FilterDebug
File

Description

Example: BodyMaxChars =200

This parameter limits the length of the %Message% macro and
does not override the carrier "Max Chars" setting.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: Filter = c:\\PageGateData\Filters\yourcarrierfilter.xml

This parameter calls on PageGate's filtering system when using
this carrier.

Example: FilterDebugFile = c:
\PageGateData\Filters\outboundfilter1.log
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When using a filter, you can use this variable to output this
specific filter's log to the specific location and file name.

This variable overrides the value passed to PageGate by the
input modules/APIs. By specifying this variable, you're telling
PageGate to use a single, standardized sender's name for all
traffic controlled by this template.

Example: IgnoreCD = True

This variable tells PageGate to ignore the Carrier Detect signal
when establishing a connection.

This variable forces PageGate to delay for the specified number
of milliseconds (1000 = 1 second) after delivering each message.

Example: ModemHangupCommand = ATO

If your cellular modem, router or gateway requires a special
parameter for disconnect/hang-up, use this cariable to specify the
necessary command. Default if not set: ATHO

Example: ModemWakeupCommand =\013

If your cellular modem, router or gateway requires something
other than AT<CR> to wake up, use this variable to specify the
necessary command.

Example: StripAlpha = True

Setting this value to true will remove any alphabetical character
from messages delivered through this carrier. For example, if you
tried to send the message 'Alert on node 127.0.0.1', the only thing
delivered would be '127.0.0.1"'

Example: StripCharacters = |\~

This parameter will remove all instance of any character(s)
entered. In the above example, that would strip out all pipes (]),
backslashes (\) and tildes (~).
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J Example: StripNonPrintable = True

StripNonPrin | True

Settings this value to true will remove any non-printable ASCII
table False

characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.

Example: To =7818290500

Recip

ient ID This variable overrides the recipient ID/PIN. By specifying this

variable, you're telling PageGate to send all traffic sent by this
carrier should only go to the specified ID.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

True
UseFilterDlI Example: UseFilterDIl = True
False

Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.
Parameters for RawTCP

These variables control how PageGate uses the RawTCP method of communication. It is
recommended to set these parameters at the Carrier level.

Click here for more information on how PageGate uses RawTCP.
Pos
Variable sible Description
Valu
es
Example: BodyMaxChars = 200
BodyMaxCh |Numer
ars ic | This parameter limits the length of the % Message % macro and
does not override the carrier "Max Chars" setting.
File
path
to Note: pdfilter.exe and pdfilter.dll must reside in the PageGate

and | program directory to use this parameter.
file

Filter nam | Example: Filter = c:\PageGateData\Filters\yourcarrierfilter.xml
e of
the | This parameter calls on PageGate's filtering system when using
filter | this carrier.
to
run
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Example: FilterDebugFile = c:
\PageGateData\Filters\outboundfilter1.log

When using a filter, you can use this variable to output this specific
filter's log to the specific location and file name.

Example: From = CAD

This variable overrides the value passed to PageGate by the input
modules/APIs. By specifying this variable, you're telling PageGate
to use a single, standardized sender's name for all traffic
controlled by this template.

This variable forces PageGate to delay for the specified number
of milliseconds (1000 = 1 second) after delivering each message.

Example: PauseChar = ~

This parameter tells PageGate to pause for the specified
PauseTime before continuing on and should be set to a character
that does not show up in your message text.

As an example, you could use the above example to declare that
a tilde (~) should create a pause. You could then format the
message template of a RawTCP carrier as follows:
~myusername\013~~mypassword\013~%Message%\013

That would tell this carrier that it should connect, wait 1 second,
pass a username value and a carriage return, wait 2 seconds,
pass the password value and a carriage return, wait 1 second,
then pass the message text and a carriage return.

Example: PauseTime = 1000

This parameter tells PageGate how long to pause when the
PauseChar is encountered.

This parameter scans through response packets for the specified
keywords or keyphrases to determine if an error has occurred
during communication.
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J This variable is both case and punctuation sensitive and

PageGate will look for an exact match to what you enter.

Multiple search terms may be used and must be separated by a
pipe. All values are considered to have wildcards.

For example, this will scan for the word reject but will also match
rejecting, rejected, etc:
RawTcpErrorResponse = reject

This would scan for the words fail* or reject*:
RawTcpErrorResponse = faillreject

This would scan for the word failed* OR the word reject* OR the
phrase *object not found*:
RawTcpErrorResponse = failed|reject|object not found

Any response from the TCP host that includes the search term(s)
will be treated as a failure.
Example: RawTcpResponseTimeout = 1000
RawTcpRes | Millis
ponseTime | econ | This variable forces PageGate to wait for the specified number of
out ds | miliseconds (1000 = 1 second) for a response to the TCP
communication request.

This parameter scans through response packets for the specified
keywords or keyphrases to determine if a communication attempt
has been successfully completed.

This variable is both case and punctuation sensitive and
PageGate will look for an exact match to what you enter.

Multiple search terms may be used and must be separated by a

RawTcpSuc g: pipe.
cessnlzeespo cripti | For example, this would only scan for the word success:

on | RawTcpSuccessResponse = success

This would scan for the words Acknowledged or acknowledged
RawTcpSuccessResponse = Acknowledged|acknowledged

This would scan for the word success OR the word hijinks OR the
word actualization:
RawTcpSuccessResponse = success|hijinks|actualization
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Any response from the web server that includes the search
term(s) will be treated as a success.

Example: StripAlpha = True

True
StripAlpha False | Setting this value to true will remove all alphabetical characters
from messages delivered through this carrier.
See Example: StripCharacters = |\~
Strlﬁgrr;arac descri | This parameter will remove all instance of any character(s)

ption | entered. In the above example, that would strip out all pipes (|),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True

StripNonPri | True

Settings this value to true will remove any non-printable ASCII
ntable False

characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.

Example: TcpProtocol = SSH

TcpProtocol SSH This parameter configures what protocol negotiation method
TCP | should be used. By default, PageGate uses TCP but to connect
with SSH instead, specify the above variable.
Example: To = 7818290500
Recipi . , , - . .
To ent ID This variable overrides the recipient ID/PIN. By specifying this

variable, you're telling PageGate to send all traffic sent by this
carrier should only go to the specified ID.

True | Example: UseTelnet = True

UseTelnet | Fals This variable tells PageGate to negotiate telnet terminal

capabilities upon connection

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

True
UseFilterDI Example: UseFilterDIl = True
False

Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.
Parameters for RawSerial

These variables control how PageGate uses the RawSerial method of communication. It is
recommended to set these parameters at the Carrier level.

Click here for more information on how PageGate uses RawSerial.
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Description

Example: BodyMaxChars = 200

This parameter limits the length of the %Message% macro and
does not override the carrier "Max Chars" setting.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: Filter = c:\\PageGateData\Filters\yourcarrierfilter.xml

This parameter calls on PageGate's filtering system when using
this carrier.

Example: FilterDebugFile = c:
\PageGateData\Filters\outboundfilter1.log

When using a filter, you can use this variable to output this specific
filter's log to the specific location and file name.

Example: From = CAD

This variable overrides the value passed to PageGate by the input
modules/APIs. By specifying this variable, you're telling PageGate
to use a single, standardized sender's name for all traffic controlled
by this template.
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InterMessag | ise | This variable forces PageGate to delay for the specified number of
eDelay con | milliseconds (1000 = 1 second) after delivering each message.

ds
Example: PauseChar = ~
This parameter tells PageGate to pause for the specified
PauseTime before continuing on and should be set to a character
Sp that does not show up in your message text.
eci

As an example, you could use the above example to declare that a

PauseChar glh tilde (~) should create a pause. You could then format the message
template of a RawSerial carrier as follows:
St':r ~myusername\013~~mypassword\013~%Message%\013

That would tell this carrier that it should connect, wait 1 second,
pass a username value and a carriage return, wait 2 seconds,

pass the password value and a carriage return, wait 1 second,
then pass the message text and a carriage return.

Mill | Example: PauseTime = 1000

ise

con | This parameter tells PageGate how long to pause when the
ds | PauseCharis encountered.

PauseTime

This parameter scans through response packets for the specified
keywords or keyphrases to determine if an error has occurred
during communication.

This variable is both case and punctuation sensitive and
PageGate will look for an exact match to what you enter.

Se Multiple search terms may be used and must be separated by a

e pipe. All values are considered to have wildcards.

RawSerialEr | De
rorResponse | scri
ptio

n

For example, this will scan for the word reject but will also match
rejecting, rejected, etc:
RawSerialErrorResponse = reject

This would scan for the words fail* or reject*:
RawSerialErrorResponse = fail[reject

This would scan for the word failed* OR the word reject* OR the

phrase *object not found*:
RawSerialErrorResponse = failed|reject|object not found
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. e
RawSerialS
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n
True
StripAlpha | Fals
e
See
StripCharact desc
ers riptio
n
. ~ | True
StripNonPrin
table Fals
e

Any response from the TCP host that includes the search term(s)
will be treated as a failure.

Example: RawTcpResponseTimeout = 1000

This variable forces PageGate to wait for the specified number of
milliseconds (1000 = 1 second) for a response to the TCP
communication request.

This parameter scans through response packets for the specified
keywords or keyphrases to determine if a communication attempt
has been successfully completed.

This variable is both case and punctuation sensitive and
PageGate will look for an exact match to what you enter.

Multiple search terms may be used and must be separated by a
pipe.

For example, this would only scan for the word success:
RawSerialSuccessResponse = success

This would scan for the words Acknowledged or acknowledged
RawSerialSuccessResponse = Acknowledged|acknowledged

This would scan for the word success OR the word hijinks OR the
word actualization:
RawSerialSuccessResponse = success|hijinks|actualization

Any response from the web server that includes the search term(s)
will be treated as a success.

Example: StripAlpha = True

Setting this value to true will remove all alphabetical characters
from messages delivered through this carrier.

Example: StripCharacters = |\~

This parameter will remove all instance of any character(s)

entered. In the above example, that would strip out all pipes (]),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True
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Settings this value to true will remove any non-printable ASCII
characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.
Example: To = 7818290500
Reci
To pient | This variable overrides the recipient ID/PIN. By specifying this

ID |variable, you're telling PageGate to send all traffic sent by this
carrier should only go to the specified ID.
Note: pdfilter.exe and pdfilter.dll must reside in the PageGate

program directory to use this parameter.
True

UseFilterDIl | Fgls | Example: UseFilterDIl = True

e
Setting this parameter to true tells PageGate to use the filter dll,

which is a more efficient method of running the filter.
Parameters for XMPP

These variables control how PageGate interacts with XMPP chat systems. We
recommend setting these parameters at either the Carrier or Connector level.

Click here for more information on how PageGate uses XMPP chat systems.

Possi
Variable ble Description
Value
s
Example: BodyMaxChars =200
BodyMax Numeric
Chars This parameter limits the length of the %Message% macro and
does not override the carrier "Max Chars" setting.
Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
File program directory to use this parameter.
path to
and file | Example: Filter = c:\PageGateData\Filters\yourcarrierfilter.xml
Filter name
ofthe | This parameter calls on PageGate's filtering system when
filter to | sending messages through this carrier. This allows for the sorting
run and modification of both outbound messages and replies and is
an integral part of two-way messaging.
File Example: FilterDebugFile = c:
FilterDebu pathto | \PageGateData\Filters\outboundfilter1.log
. and file
gFile

name | When using a filter, you can use this variable to output this
ofthe | specific filter's log to the specific location and file name.
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From

InterComm
andDelay

InterMessa
geDelay

ReplyFilter

ReplyFilter
DebugFile

StripAlpha

log to
write

Text

Millise
conds

Number
of
Milliseco
nds

File
path to
and file

name

of the

filter to
run

File
path to
and file

name
of the
log to
write

True

False

Example: From = ALERTS

This parameter overrides any sender information passed in by
the interfaces and APls.

By specifying this variable, you're telling PageGate to use a
single, standardized sender's name for messages delivered
through this carrier.

Example: InterCommandDelay = 500

This variable inserts a pause, in milliseconds, in between each
command used in the protocol negotiation with the chat server.
This is used to make sure PageGate doesn't send commands
faster than the chat server's command shell can receive them and
is not required in most cases.

Example: InterMessageDelay = 1500

This variable inserts a pause, in milliseconds, in between each
message delivery attempt.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: Filter = c:\\PageGateData\Filters\replyfilter.xml

This parameter calls on PageGate's filtering system using the
"Check for Messages" routine to retrieve chat messages from
the XMPP server. This allows for the sorting and modification of
both outbound messages and replies and is an integral part of
two-way messaging.

Example: FilterDebugFile = c:
\PageGateData\Filters\replyfilterlog1.log

When using a filter, you can use this variable to output this
specific filter's log to the specific location and file name.

Example: StripAlpha = True

Setting this value to true will remove any alphabetical character
from messages delivered through this carrier. For example, if you
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tried to send the message 'Alert on node 127.0.0.1", the only
thing delivered would be '127.0.0.1'
See Example: StripCharacters = |\~
Strlgtgrf;ara descripti | This parameter will remove all instance of any character(s)

on entered. In the above example, that would strip out all pipes (|),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True

StripNonP | True

. Settings this value to true will remove any non-printable ASCII
rintable False

characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this carrier.

A Example: To = 7818290500

To Phone
Numbe | This parameter forces all traffic to go to the specified ID,
r overriding any interface or recipient values.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.
i True
UseFilterD Example: UseFilterDIl = True
I False

Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.
Parameters for TONE

These variables control how PageGate uses the TONE method of communication. Itis
recommended to set these parameters at the Carrier level.

Click here for more information on how PageGate uses TONE.

Po
ssi
. ble o
Variable Val Description

ue
s

ModemWak Example: ModemWakeupCommand = Custom Variable Here

eupC(;ijman t | This variable is used if a custom initialization string is required to

engage the serial line.
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t
Tru
e
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Fal
se
Mill
InterMessag | ise
eDelay con
ds

Parameters for UCP

6

This variable overrides the value passed to PageGate by the input
modules/APIs. By specifying this variable, you're telling PageGate
to use a single, standardized sender's name for all traffic controlled
by this template.

Example: To = 7818290500

Example: From = CAD

This variable overrides the ID/PIN or Email values. By specifying
this variable, you're telling PageGate to send all traffic processed
by this template to the specified ID or Email address instead.

Example: IgnoreCD = True

This variable tells PageGate to ignore the Carrier Detect signal
when connecting to a serial line.

If this variable is not present, a False value is assumed.
Example: InterMessageDelay = 1000

This variable forces PageGate to delay for the specified number of
milliseconds (1000 = 1 second) after delivering each message.

These variables control how PageGate uses the UCP method of communication. ltis
recommended to set these parameters at the Carrier level.

Click here for more information on how PageGate uses UCP.

Po
Ssi
ble
Variabl
ariable Val
ue
S
ModemWak
Tex
eupComman
t
d
From Tex

Description

Example: ModemWakeupCommand = Custom Variable Here

This variable is used if a custom initialization string is required to
engage the serial line.

Example: From = CAD

This variable overrides the value passed to PageGate by the input
modules/APIs. By specifying this variable, you're telling PageGate
to use a single, standardized sender's name for all traffic controlled
by this template.
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J Example: To = 7818290500

To Tex This variable overrides the ID/PIN or Email values. By specifying

t this variable, you're telling PageGate to send all traffic processed
by this template to the specified ID or Email address instead.

Example: IgnoreCD = True

Tru
€ | This variable tells PageGate to ignore the Carrier Detect signal
IlgnoreCD . o
Fal when connecting to a serial line.
se

If this variable is not present, a False value is assumed.

Mill | Example: InterMessageDelay = 1000
InterMessag | ise
eDelay con | This variable forces PageGate to delay for the specified number of
ds | milliseconds (1000 = 1 second) after delivering each message.

Templates for Faxing
When sending a fax from PageGate, you may want to modify the output so that the
information maintains the look of a facsimile transmission rather than raw text output.

To apply a template to a Fax or FaxSrv carrier, all you have to do is go in to the Template
sub-section of that carrier. In the "Message" section, you can enter the template and all
important variables.

The following is an example of a Faxing Template:

FROM <Your Nane here>

TO YReci pi ent %
Y%Commrent 1%
Y%Conmmrent 2%
%Conmment 3%
Y%Conmment 4%

SENT:  9%Date% %li me%
SUBJECT: %Subj ect %
MESSAGE:

%\Vessage%

After entering the template information, click on Apply.
Interface Templates

Templates applied to a specific interface format, or re-format, all messages processed by
this interface. Interface level variables will override the same variables specified ona
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C!I:g@aggg%ﬁtﬁl be overridden by variables specified at a Connector, Carrier or
Recipient level.
Settingz

Subject

Text

For example, if the Interface Template formats the message to standardize the Sender's
Name to a static value, but a Connector, Carrier or Recipient template specifies a different
value, messages passed through those Carriers or to those Recipients will use the
Sender's Name variable from their own templates and ALL other variables from higher
level templates.

e Parameters for GetAscii

e Parameters for GetMail

e Parameters for GetSerial

e Parameters for GetTAP

e Parameters for Get\Web

Parameters for GetAscii

Variable Description
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InterfaceFilter

InterfaceFilterDe
bugFile

RawiInterfaceFilte
r

RawlinterfaceFilte
rDebugFile

UseFilterDIl
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Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: InterfaceFilter = c:\\PageGateData\Filters\yourfilter.xml

This applies a filter to processed data. This allows the interfaces to
apply the initial layer of data sorting and collection and then applies the
filter to the result.

¢ Standard polling: Filter is applied against temp file with recipient,

sender and message

¢ Advanced polling: Filter is applied against temp file with recipient,
sender and message, and after lookup substitution

Example: InterfaceFilterrDebugFile = c:
\PageGateData\Filters\GetAsciiFilter.log

When using an interface filter, you can use this parameter to output
this specific filter's log to the declared location and file name.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: RawlinterfaceFilter = c:\PageGateData\Filters\yourfilter.xml

This applies a filter to raw, unprocessed data. This applies the filter
before the interface has a chance to read the data.
e Standard polling: Filter is applied against the raw text file before

GetAscii tries to process it

e Advanced polling: Filter is applied against each record that is found,
before it is processed any further (record pattern matching done first)

Example: RawinterfaceFilterDebugFile = c:
\PageGateData\Filters\GetAsciiFilter.log

When using a filter, you can use this variable to output this specific
filter's log to the declared location and file name.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: UseFilterDIl = True

Setting this parameter to true tells PageGate to use the filter dll, which
is a more efficient method of running the filter.
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Parameters for GetMail

These variables control some of the PageGate mail server's basic functions.

Variable

AltParser

AltParserSt
ripTags

ForceAdho
cEmail

InterfaceFilt
er

InterfaceFilt
erDebugFil
e

Rawinterfac
eFilter

Description
Example: AltParser = True
If this value is set to "True', GetMail to examine the attachments of
messages it receives IF the body of the message is completely blank.
If the attachment is in an ASCIl format (HTML, XML, etc), the program will

use the contents of the file as the body of the message.

Example: AltParserStripTags = True

If this value is set to 'True', GetMail will remove formatting tags from the
data parsed from attached files.

This entry's function is contingent on the GetMail_Alt_Parser registry entry

existing and being set to 'True'.

Example: ForceAdhocEmail = True

Enabling this parameter tells GetMail that mailbox value for every incoming
message should be treated as ad-hoc. When this is enabled, PageGate

will not try to match the incoming mailbox name with a recipient or group.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate program
directory to use this parameter.

Example: InterfaceFilter = c:\\PageGateData\Filters\yourfilter.xml

This parameter calls on the filter after messages have been extracted from
the incoming email and decoding has taken place/

Example: InterfaceFilterrDebugFile = c:
\PageGateData\Filters\GetMailFilter.log

When using an interface filter, you can use this parameter to output this
specific filter's log to the declared location and file name.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate program
directory to use this parameter.

Example: RawinterfaceFilter = c:\\PageGateData\Filters\yourfilter.xml

This parameter calls on the filter before messages have been extracted
from the incoming email and decoding has taken place/
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J %xample: RawinterfaceFilterDebugFile = c:
Rawinterfa | \PageGateData\Filters\GetMailFilter.log
ceFilterDe
bugFile | When using a raw interface filter, you can use this parameter to output this
specific filter's log to the declared location and file name.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate program
directory to use this parameter.

SubjectFilt

or Example: SubjectFilter = c:\PageGateData\Filters\YourSubjectFilter.xml

This parameter calls on a filter that will only work with the contents of the
subject line and will not influence the recipient(s) or body of the message.
Example: SubjectFilterDebugFile = c:
SubjectFilt | \PageGateData\Filters\GetMailSubjectFilter.log
erDebugFil
e When using a subject filter, you can use this parameter to output this
specific filter's log to the declared location and file name.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate program
directory to use this parameter.

Example: UseFilterDIl = True
UseFilterDI
I Note: pdfilter.exe and pdfilter.dll must reside in the PageGate program
directory to use this parameter.

Setting this parameter to true tells PageGate to use the filter dll, which is a
more efficient method of running the filter.
Parameters for GetSerial

Variable Description

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

InterfaceFilter | Example: InterfaceFilter = c:\\PageGateData\Filters\yourfilter.xml

This parameter calls on the filter after GetSerial has received and
processed a message trigger, including any lookup substitutions.
Example: InterfaceFilterrDebugFile = c:

nterfaceFilterDe \PageGateData\Filters\GetSerialFilter.log

bugFile When using an interface filter, you can use this parameter to output

this specific filter's log to the declared location and file name.
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Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: InterfaceFilter = c:\\PageGateData\Filters\yourfilter.xml

This parameter calls on the filter before GetSerial has received and
processed a message trigger, including any lookup substitutions.

Example: RawinterfaceFilterDebugFile = c:
\PageGateData\Filters\GetSerialFilter.log

rDebugFile When using a filter, you can use this variable to output this specific
filter's log to the declared location and file name.
Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

UsekFilterDI Example: UseFilterDIl = True
Setting this parameter to true tells PageGate to use the filter dll, which
is a more efficient method of running the filter.

Parameters for GetTAP
Variable Description

InterfaceFilter

InterfaceFilterDe
bugFile

RawinterfaceFilte
r

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: InterfaceFilter = c:\\PageGateData\Filters\yourfilter.xml

This parameter calls on the filter after GetTAP has received and
processed a message trigger, including any lookup substitutions.

Example: InterfaceFilterrDebugFile = c:
\PageGateData\Filters\GetTAPFilter.log

When using an interface filter, you can use this parameter to output
this specific filter's log to the declared location and file name.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: InterfaceFilter = c:\\PageGateData\Filters\yourfilter.xml

This parameter calls on the filter before GetTAP has received and
processed a message trigger, including any lookup substitutions.
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J " Example: RawinterfaceFilterDebugFile = c:

RawlnterfaceFilte \PageGateData\Filters\GetTAPFilter.log

rDebugFile When using a filter, you can use this variable to output this specific

filter's log to the declared location and file name.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

UseFilterDl Example: UseFilterDIl = True

Setting this parameter to true tells PageGate to use the filter dll, which
is a more efficient method of running the filter.
Parameters for GetWeb

Variable Description
Example: GroupLabelAfter = True

GroupLabelAfter| When using the GUI List web paging template, setting this parameter
to true tells the website that the (G) that designates a group should
appear after the group name instead of before.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

InterfaceFilter | Example: InterfaceFilter = c:\PageGateData\Filters\yourfilter.xml

This parameter calls on the filter after a web trigger has been received
by GetWeb and after its' contents have been decoded.

Example: InterfaceFilterrDebugFile = c:

InterfaceFilterDe \PageGateData\Filters\GetWebFilter.log

bugFile When using an interface filter, you can use this parameter to output

this specific filter's log to the declared location and file name.
Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

RawlinterfaceFilte

) Example: RawinterfaceFilter = c:\PageGateData\Filters\yourfilter.xml

This parameter calls on the filter before a web trigger has been
received by GetWeb and after its' contents have been decoded.
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J " Example: RawinterfaceFilterDebugFile = c:

RawlnterfaceFilte \PageGateData\Filters\GetWebFilter.log

rDebugFile When using a filter, you can use this variable to output this specific

filter's log to the declared location and file name.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

UseFilterDl Example: UseFilterDIl = True

Setting this parameter to true tells PageGate to use the filter dll, which
is a more efficient method of running the filter.

Connector Templates

Templates applied to a specific connector format, or re-format, all messages passed
through this connector. Connector level variables will override the same variables
specified on a Global or Interface level but will be overridden by variables specified ata
Carrier or Recipient level.

Typically speaking, you'll set most parameters at the carrier and interface levels but when
PageGate is interacting with multiple endpoints simultaneously, Connector templates can
make logically organizing things a bit easier.

Settings

Subject

Test

For use with Cellular Modems and Gateways
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Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: Filter = c:
\PageGateData\Filters\YourConnectorFilter.xml

This parameter calls on PageGate's filtering system when
sending messages through this connector.

Example: FilterDebugFile = c:
\PageGateData\Filters\connector1filter.log

When using a filter, you can use this variable to output this
specific filter's log to the specific location and file name.

Example: InterMessageDelay = 1500

This variable inserts a pause, in milliseconds, in between each
message that is delivered by this connector.

Example: StripAlpha = True

Setting this value to true will remove any alphabetical character
from messages delivered through this carrier. For example, if
you tried to send the message 'Alert on node 127.0.0.1", the only
thing delivered would be '127.0.0.1'

Example: StripCharacters = |\~

This parameter will remove all instance of any character(s)
entered. In the above example, that would strip out all pipes (]),
backslashes (\) and tildes (~).
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Example: StripNonPrintable = True

Settings this value to true will remove any non-printable ASCI
characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this connector.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: SubjectFilter = c:
\PageGateData\Filters\YourSubjectFilter.xml

This parameter calls on a filter that will only work with the
contents of the subject line and will not influence the recipient(s)
or body of the message.

Example: SubjectFilterDebugFile = c:
\PageGateData\Filters\ConnectorSubject.log

When using a subiject filter, you can use this parameter to output
this specific filter's log to the declared location and file name.

Example: UseCarrierAuth = False

This setting tells the connector whether or not it should use
authentication when connecting to the cellular modem, router or
gateway. This is enabled by defaullt.

This is most often used when multiple makes and models of
cellular modem, router or gateway are being used and some
devices require authentication but others don't.

This allows you to have a single carrier using the GSM-AT or
GSM-AT-IP protocols and specialize each connector for the
different types of devices in your environment.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.
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PageGate
J Example: UseFilterDIl = True

Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.
Recipient Templates

Templates applied to a specific Recipient format, or re-format, all messages passed to

this Recipient. Recipient level variables will override the same variables specified in any
other Template.

Recipient level parameters will not, and can not, be overridden by Global, Interface,
Connector or Carrier templates.
Settings

Subject

Text

For example, if you have From = CAD in Recipient Template, CAD is the only sender's

name that will be used when messaging this recipient, regardless of what values the
interface or carrier might try to use.

Pos
. sible o
Variable Valu Description
es
File Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
path program directory to use this parameter.
Filter to

and Example: Filter=c:
file \PageGateData\Filters\YourRecipientFilter.xml
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This parameter calls on PageGate's filtering system when
sending messages to this recipient.

Example: FilterDebugFile = c:
\PageGateData\Filters\RecipientFilter.log

When using a filter, you can use this variable to output this
specific filter's log to the specific location and file name.

Example: StripAlpha = True

Setting this value to true will remove any alphabetical character
from messages delivered to this recipient. For example, if you
tried to send the message 'Alert on node 127.0.0.1', the only
thing delivered would be '127.0.0.1'

Example: StripCharacters = |\~

This parameter will remove all instance of any character(s)
entered. In the above example, that would strip out all pipes (]),
backslashes (\) and tildes (~).

Example: StripNonPrintable = True

Settings this value to true will remove any non-printable ASCI
characters, like carriage returns, line feeds, horizontal tabs and
similar, from messages delivered through this connector.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: SubjectFilter = c:
\PageGateData\Filters\YourSubjectFilter.xml

This parameter calls on a filter that will only work with the
contents of the subject line and will not influence the recipient(s)
or body of the message.
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Example: SubjectFilterDebugFile = c:
\PageGateData\Filters\ConnectorSubject.log

When using a subiject filter, you can use this parameter to output
this specific filter's log to the declared location and file name.

Example: UseCarrierAuth = False

This setting tells the connector whether or not it should use
authentication when connecting to the cellular modem, router or
gateway. This is enabled by defaullt.

This is most often used when multiple makes and models of
cellular modem, router or gateway are being used and some
devices require authentication but others don't.

This allows you to have a single carrier using the GSM-AT or
GSM-AT-IP protocols and specialize each connector for the
different types of devices in your environment.

Note: pdfilter.exe and pdfilter.dll must reside in the PageGate
program directory to use this parameter.

Example: UseFilterDIl = True

Setting this parameter to true tells PageGate to use the filter dll,
which is a more efficient method of running the filter.

Success and Failure Notification Templates

Note: This feature requires the GetMail Interface to be a part of your

license.

This type of template is completely unlike the other Templates. These
templates trigger a specific behavior within the program and are not
contained within the Administrative GUI.
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when a message succeeds or when a message fails.

When a message is successfully delivered, PageGate looks for a file
named successnotifylist.txt in the PageGate program folder. This file
can contain a list of email addresses that will receive notification that
the message was successful. You can use the special value %Sender
% on one of the lines to have the sender of the message in the list.

In addition you will need to create a file named success.mtp and place
itin the PageGate program directory. This file is used as a template for
what is sent in the success notification message. It uses the same
variables as the Macros.

The same process happens for a failed message, but it uses a
failurenotifylist.txt and a failure.mtp file instead.

Create a successnotifylist.txt file in the PageGate folder with a single
line containing %Sender%

Do the same for a failurenotifylist.txt file.
The success.mtp file should look like this:
Subject: Successful Message To %Recipient%

Message Info:

Recv: %RequestedDate% %RequestedTime%
Sent: %Date% %Time%

To: %Recipient%

From: %Sender%

Msg: %Message%

The failure.mtp file should look like this:
Subject: Failed Message To %Recipient%

Message Info:

Recv: %RequestedDate% %RequestedTime%
Fail: %Date% %Time%

To: %Recipient%

From: %Sender%

Msg: %Message%
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Interfaces

The Interfaces section is where you'll configure your APIs to accept information from
different sources. Each interface controls behavior for that AP], so it's important to
understand which APl you want to implement. Click here for more information on how
PageGate accepts messages.

ElD Pagel ate
=-[=] Program
[% D atabase
3 Scheduler
ER Jinteifaces

- @ Global

-t Gethsci

-=7 Gethai

F-7 GetSerial

% GetTap

-7 Getweb

m-=] GUI Client

The APIs that can be configured in the PageGate Admin are:

o GetASCII

Also known as the Command Line/ASCllinterface, this interface is capable of monitoring
a directory or series of directories on the local hard drive or across the network for ascii
file output and also provides a command line interface for other applications to use. This
module allows many 'off the shelf and custom applications, such as SolarWinds' Network
Performance Monitor, SolarWinds' Orion, Paessler's PRTG and several CAD programs,
among many others, to tell PageGate when a message needs to be sent.

e GetMail

This interface allows you to receive SMTP/Email traffic and translate it in to outbound
messages in a different format. For example, you could email a message to PageGate to
deliver as a message to pagers, cell phones and/or other email addresses.

o GetSerial
This interface allows PageGate to monitor a serial/RS232 port, virtual or physical, for raw
data text strings to be parsed in to outbound messages.

o GetTa

This interface gives PageGate the ability to monitor a serial port or modem to receive TAP
transmitted pages, effectively allowing PageGate to function as a TAP receiver or a TAP
terminal for any devices and systems that can transmit that protocol, such as a Motorola or
Zetron paging terminal.

o GetWeb
This interface provides a CGl executable that can be hosted on a web server and a series
of pre-formatted templates to publish a website messaging interface. Web Developers
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cg%g%gétgerver interface to send messages to PageGate from their webpages
(HTML, ASP, JavaScript, Java, etc.). This means that you can host messaging websites
on your local intranet or, if GetWeb is interfaced with an outward facing web server, on the
internet.

e GUIClient

A Windows based program installed on workstations on the same network as the
PageGate server. This program provides a graphical user interface to send and schedule
messages.

e Additional APIs

PageGate also supports additional APIs that are not controlled by the PageGate Admin.
These include the SNPP Server, TAP IP Server, TAP to ASCIland Serial to ASCII
modules.

Right clicking on Interfaces will provide a context menu with

two options.

e Start All =~ n_g;?oa;a !

Selecting this option will start all configured and enabled %g’;‘;ﬁ;
%

[+

- & Cartiers Stop All
Recipients

[+

Interfaces, if stopped. e ——

)
2,8

e Stop All
Selecting this option will stop the all configured and enabled
Interfaces, if started.

GetAscii

ASCllis, literally, text. What you're reading on the screen right now are ASCII characters.
HTML, XML and JSON are examples of command formatted ascii text, which means that
GetASClIl can be configured to read in and recognize values in those formats as well.
However, this APl is one of PageGate's powerhouse interfaces and is used in a variety of
implementations.

For example, if you use the SNPP Server or TAP over IP Server, these reference the
GetASCII module. This module also powers the Filter Pack and can be implemented with
the 2-way reply system for use with cellular infrastructure to allow you much greater control
over who receives what replies.

On the surface, GetASCllis incredibly easy to implement, especially if you're just having it
read input from network monitoring programs and CAD systems. However, you can
implement incredibly intricate and complex operations to process data from numerous
locations, then format and reformat that data into any configuration want before delivering
it.
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FEr%gﬁpqéQt/gj have a mapping data program that outputs an ascii log file, you can
configure GetASCIl to monitor that log for any mapping data, then feed that data through a
filter pack to turn it in to an alert to your personnel.

It's also important to note that PageGate can use the File protocol to write files that
GetASClIl can process. This allows you to take information from other APIs, whether
PageGate's or a web API, and pass it to the GetASCIl module for message and data
parsing.

L——_lh-jf.; Interfaces
- @@ Global

El A8 Gethscii
- B3| Seftings

e Settings
This section controls the implementation of the GetASCIl module. This is where you

configure all directories and text processing parameters.

o Status
This section displays the running/not running status of the interface.

e Template
This section allows you to configure a custom template for messages processed by this
APL

e Log
This sectionis a record of all activity performed by the interface.

This interface allows PageGate to monitor a directory or series of directories on the local
hard drive or across the network for ascii file. This APl also provides a command line
interface for other applications to use. This module allows many 'off the shelf and custom
applications, such as SolarWinds' Network Performance Monitor, SolarWinds' Orion,
Paessler's PRTG and several CAD programs, among many others, to tell PageGate when
a message needs to be sent.

In addition to the interface presented in the PageGate Admin, the GetASCIlI module
provides two command line interface executables, allowing other programs to pass
parameters to the GetASCIl module directly. For more information, please see the
Command Line Interface section of the documentation.

There are two ways to implement GetASCII: Standard Polling and Advanced Polling
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GetASClIl has a standard file format and file naming convention that it will recognize
without the need to configure specific parsing parameters. You'll need to configure the
basic polling directory to tell PageGate where to look for these files. Once you have that
specified, you can output a file with a .asc extension in the folder and PageGate will read it
in, looking for the standard format. The file should be formatted as follows:

Recipient Value
Sender Value
Message Value

So, for example, we could create a file named test.asc, format it as shown below and drop
itin the basic polling directory:

[TDept

CAD

This is a test

and that would send a message to the recipient or group named [TDept from the sender
CAD and the message would say "This is a test".

Notes:

The basic polling directory must be configured to use Advanced Polling. Typically
speaking, we recommend creating c:\PageGateData\ASCIN as the basic polling folder.
Itis not recommended to have the Standard and Advanced polling locations
pointed at the same folder. This can cause file read errors if an advanced routine

polls for files with the extension .asc

e Advanced Polling

When your data won't follow the standard file format or naming convention, you'll need to
configure the Advanced Polling options to tell GetASCIl how to interpret the ascii data it
needs to handle. The Advanced Polling is used when you want to process free floating,
HTML, XML, JSON or other ascii formatted data.

For more information, please see the Advanced Polling section of the documentation.
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Ri&ﬁﬂc‘fc\{f‘nﬂ o GetASCII will provide a context menu

with two options. - [J PageGate

H-[=] Program
e Start % Database

. . . . - . #-L5 Scheduler

Selecting this option will start the GetAsscii interface, if | 5 g Interfaces
stopped. - @ Global

B

- =1 GetMail Start
hd m Q? GetSeri "
Selecting this option will stop the GetASCIl interface, if | @ ® 2 GeTer =
started.
Settings

This section and its sub-sections contain all configuration settings for the implementation
of the GetASCII API.

Enabled I

Falling Directary | J

Folling Interyal 3

Registy Integration [

The Settings section determines the basic polling directory. When using Standard
Polling, this is the directory that will host the command line executables as well as
the directory to which you should output standard formatted files for processing.
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Setting Function
Enabled When the Enabled checkbox is checked, it tells the PageGate
server to run the GetASCIl module.
This field specifies basic polling location to monitor for ascii files
named something.asc to be processed. This value can be set to
. a local path (c:\\PageGateData\ascii\, for example) or a UNC
Polling \ . .
Directory path (\server\path\). If you're running PageGate as a Windows

Polling Interval

Registry
Integration

Expanding the Se

Service and GetASCIl is referencing a UNC path, you must
provide a service account to the PageGate GetASCIl Windows
service.

This field determines how often the GetASCIl module looks for
new ascii files in the specified Polling Directory.

When enabled, this tells GetAscii to write information to
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Note
Page\PageGate for other applications and platforms to
reference.

ttings menu will display the following menu items:

ElD Pagelate
#-[=] Program
% Datahase
% Scheduler
Elv;fq- Interfaces

- @ Global
= Getsci

CHEA] Settings |

]

Advanced Polling

Click here to go to the Advanced Polling section of the documentation for more

information.

Advanced Polling

This section is where you'll configure PageGate's advanced ascii parsing parameters.
This is most often used when you need to process ascii data that doesn't follow
PageGate's standard format or file naming convention. This allows you to process XML,
HTML, JSON and similarly styled content as well as the ability to process free floating data
within an ascii file.
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= Settings

= "‘_:,. Advanced Polling
[ Files
- & Symbols

----- lfi;[ Recipient

H L
b T Sender

.= ezzage

e Files
This section determines the directory or series of directories that GetASCIl should look for
content within and also specifies style of implementation as well as the naming convention

of the files being worked with.

e Symbols
This section determines certain special characters and their functions.

e Record
This section is where you configure the pattern recognition to determine what represents
the start and end of valid data to process.

¢ Recipient

This section is where you configure the pattern recognition to determine what represents
who the messages should go to. This section can also be set to a static recipient, to
indicate that all traffic processed from the serial line should be sent to the specified
individual or group.

e Sender

This section is where you configure the pattern recognition to determine what represents
who or what sent the messages. This section can also be set to a static sender to indicate
that all traffic processed from the serial line should declare that it is from the specified
value.

e Message
This section is where you configure the pattern recognition to determine what represents

the body of the message to be delivered. This section can also be set to a static message
to provide the message text to be delivered.

e Advanced Polling Example
This section shows an example of how to implement the GetASCII module's Advanced
Polling to process XML, HTML and similar ascii formatted languages.
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This section determines the directory or series of directories that GetASCIl should look for

content within and also specifies style of implementation as well as the naming convention
of the files being worked with.

) Advanced Polling Files X

R ecipient [From [File[=] [File Type  [Path

Add Edit Delete -

Option Function

Add Adds a new Advanced Polling rule.

Edit Edits an existing Advanced Polling rule
Delete Removes an existing Advanced Polling rule.
Cancel | Cancels all recent changes.

Apply Applies new changes and rules.

To add an Advanced Polling Files option, click on the Add button.
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Recipient |- 5]
From |
Filels) |
Path | J
File Type  [Standard ]

Cancel Apply

Setting Function

By default, this field is set to all recipients (*).

If the asterisk(*) option is used, this tells GetASCIl that the recipient
Recipient | information will be contained within the file(s) processed.

If you select a recipient or group from the list, all messages processed
by this rule will be delivered solely to the selected recipient or group.
This field is only used when a specific recipient or group is specified in
the Recipient field, otherwise, leave this field blank.

rom If a specific recipient is used in the Recipient field, the 'From' field
specifies what sender value to use for those messages.
This field determines the naming convention of the file(s) you want
GetASCllIto look for. Wildcard characters (* and ?) may be used.
Flo(s) For example, an entry of *.txt will poll all files that end with .txt
ile(s

An entry of *.?at will collect files like cat, bat, and rat, but not 'flat'.
An entry of custom*xml will collect files like custom1.xml and

custom_naming_scheme.xml or customer1234.xml

This field determines the directory that this Advanced Polling entry will
monitor. This can be set to a local path (example: c:

Path \PageGateData\ASCIN), UNC path (example: \\server\path\) or mapped
drive location (example: S:\CADOutputLocation\).

Wildcard characters are not valid in this field.
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DA
! CIHU\JO'LFyou're running PageGate as a Windows Service and your Advanced

Polling is referencing a UNC path, you will usually need to provide a
service account to the PageGate or PageGate GetASCIl Windows

services.

There are four options for the file type of each Advanced Polling rule:

e Standard

Selecting this option tells GetASClI that text file(s) being referenced are
in the standard ascii format.

This is option is usually used when files are in the standard ascii
format, but aren't named with the standard .asc extension or are written
to a directory other than the basic polling directory. When the Standard
file type is selected, the other Advanced Polling sections (Symbols,
Record, Recipient, Sender, and Message) are not referenced in the
file read process.

e Custom

When the Custom file type is selected, the other Advanced Polling
options (Symbols, Record, Recipient, Sender, and Message) are used.
Each text file must contain a single message, but the message
information is not in the regular format and must be extracted from the
text file using the Advanced Polling configuration.

File Type

e Adding

The ascii file specified by the File(s) field periodically has message
information added to the end of the file. With this file type the GetASCII
Interface will read in any new data added to the file and extract the
message information using the Symbols, Record, Recipient, Sender,
and Message options.

e Changing

The ascii file changes periodically. Each time the file specified in the
File(s) field is changed, the GetASCIl Interface will attempt to extract
message information from it using the Symbols, Record, Recipient,
Sender, and Message options. This option is different from Adding
because the Adding option only looks at the end of the file specified.
The Changing option assumes the entire file will be modified, not
appended to.
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This section determines certain special characters and their functions.

Single Character wildcard |:|_
bultiple Character ‘wildcarnd |T
End OF Record Syrbal |~_

Sz Walue Delimiter |-T
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Wildcard

End of
Record
Symbol

ASCII Value
Delimiter

Apply

Record

Function

When scanning through the ascii data, this character can be used to
stand in for any single character.

For example, let's say you use Fire?

That would tell the GetASCIl module to recognize any word that began
with Fire and had one extra letter on the end. So, it would recognize Fires
or Fired but would not recognize Fire alone.

As another example, let's say you use ??/??/?7?7?7?
That would tell GetSerial to recognize any date stamp in the two digit
month, two digit day, four digit year configuration.

When scanning through the ascii data, this character can be used to
stand in for any character or group of characters.

For example, let's say you use Fire*

That would tell the GetASCIl module to recognize any instance of the word
Fire, regardless of whether there are any characters after the word. So, it
would recognize Fire, Fired, Fires, Firehouse or Fireman and it would
also recognize 'Fire' in phrases like Fire Sale or Fire Department.

As another example, let's say you use *age*

That would tell GetSerial to recognize any reference to the three letters
age close to each other, regardless of whether that was in the word
PageGate or NotePage or ageless or damage. Any instance of the three
characters together will be recognized.

This character stands for the end of record symbol.

This symbol is used to help represent non-printable characters that
normally can't be typed like horizontal tabs, carriage returns and line
feeds. This character is always followed three numbers which represent
the decimal value for a character.

For example, this represents a carriage-return: \013

For a full list of ascii codes, visit http://www.asciitable.com/

Applies all changes made to the Symbols.

This section is where you configure the pattern recognition to determine what represents
the start and end of a message sequence.
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Start Offzet |
End Pattern [~
End Offzet 0

o Start Pattern
This value determines the start of relevant information. For example, let's say this is the
contents of a file you need to process:

SubscriberName=AgencyToDispatch
[MESSAGE]

Line1=Type of call

Line2=Address information.
Line3=Cross-street information.
Line4=Dispatcher notes.

You would want to use * as the Start Pattern as we want GetASCIl to recognize that the
relevant data begins at the very first character of the file.

o Start Offset
This value determines how many characters before or after the identified start pattern to
begin character processing. This field can be set to positive or negative values.

For instance, a value of 5 means that GetSerial will begin the data record 5 characters
after the first character in the Start Pattern. A value of -5 means that GetSerial will begin
the data record 5 characters before the first character the Start Pattern.

Using our example, you would set the Start Offset to O to indicate that the relevant data
begins at the very first character read in.

Note: the value -999 has special meaning, and is typically used in conjunction with the use
of the Multiple Character Wildcard in the search strings.

If -999 is used as a Start Offset, an offset of one character past the string that matches the
start pattern, is used. This will cause the number of characters that were found to match the
Start Pattern to be skipped, even though the actual number of characters in the Start
Pattern matching string aren't known ahead of time.

e End Pattern

Chapter 6 PageGate Admin: How to Configure PageGate



PageGate Admin: How to Configure 6

Tﬁ@&%@@xﬁnes the end of relevant information. For example, let's say this is the
contents of a file you need to process:

SubscriberName=AgencyToDispatch
[MESSAGE]

Line1=Type of call

Line2=Address information.
Line3=Cross-street information.
Line4=Dispatcher notes.

You would want to use ~ as the End Pattern as that tells PageGate that the very last
character in the file is the end of relevant information.

e End Offset
This value determines how many characters before or after the identified end pattern to
end character processing. This field can be set to positive or negative values.

For instance, a value of 5 means that GetSerial will end the data record 5 characters after
the last character in the End Pattern. A value of -5 means that GetSerial will end the data
record 5 characters after the last character the End Pattern. To use our earlier example, if
we don't want the word END to be a part of the record processed, we would set the Start
Offset value to -3. That way, the data record ends three characters before the last
character of END.

Note: the value -999 has special meaning, and is typically used in conjunction with the use
of the Multiple Character Wildcard in the search strings.

If -999 is used as an End Offset, an offset of one character before the string that matches
the end pattern, is used. This will cause the number of characters that were found to match
the End Pattern to be skipped, even though the actual number of characters in the End

Pattern matching string aren't known ahead of time.
Recipient

IMPORTANT
This character, unless specified otherwise in the Symbols section, represents the
character that tells PageGate that the three characters following it represent an
\ ascii decimal value/ascii code. For instance, if you want to tell PageGate to look
for a carriage return, you would use a backslash and the three character ascii
decimal value representing a carriage return. Written out, that would be \013

For a full list of ascii codes, visit http://www.asciitable.com/

This section is where you tell GetASCIl what represents who the messages should go to.
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" Static Recipient
Recipient | J

f* Diynamic Recipient

Start Pattern |«
Start Offset [

End Pattern |~
End Offzet 0

[~ Use Lookup Table

i

There are two possible configurations you can use:
¢ Static Recipient
f* Static Recipient

Recipient | -

s i Red .
Dynamic Reg et

Ctart Pattarn -

Selecting this option tells the GetASCII module that all messages processed from the ascii
file should go to the specified recipient or group.

¢ Dynamic Recipient

Start Pattern |«

Start Offzet |
End Pattern |~
End Offzet 0

[ Usze Lookup Table

i

Selecting this option tells the GetASCII module to look for specific patterns that denote
where the recipient information is located in within the record.

o Start Pattern
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For example, let's say this is the record identified and let's also say that who the message
needs to go to is contained in the SubscriberName= field:
SubscriberName=AgencyToDispatch

[MESSAGE]

Line1=Type of call

Line2=Address information.

Line3=Cross-street information.

Line4=Dispatcher notes.

You would want to use SubscriberName= as the Start Pattern of the recipient information.
Note: Start patterns are included in the recipient processed unless you specify the
otherwise with the Start Offset. See below.

o Start Offset
This value determines how many characters before or after the identified start pattern to
accept as the recipient value. This field can be set to positive or negative values.

For instance, a value of 5 means that GetSerial will begin looking for the recipient value 5
characters after the first character in the Start Pattern. A value of -5 means that GetSerial
will begin looking for the recipient value 5 characters before the first character the Start
Pattern.

To use our earlier example, we would want a Start Offset of 15 because there are 15
characters in SubsciberName= and we don't want that text included as part of the recipient
or group designation.

e End Pattern
This value determines the last character in the recipient value.

Using our earlier example, we've already specified that the recipient value starts with
SubscriberName= but what does it end with?

SubscriberName=AgencyToDispatch
[MESSAGE]

Line1=Type of call

Line2=Address information.
Line3=Cross-street information.
Line4=Dispatcher notes.

This is where things are ultimately up to your preferences. The first thing that technically

follows the recipient name in our example is a carriage return followed by a line feed
(represented visually as a line break but as two ascii codes/characters in the text being

Chapter 6 PageGate Admin: How to Configure PageGate 376



377

PageGate Admin: How to Configure 6

pBéggo@r%ttﬁe text MESSAGE]. However, you could tell PageGate to use either \013
(the ascii value representing a carriage return) or  MESSAGE] as the End Pattern as both
clearly identify the end of recipient information. However, you would use a different End
Offset for each. See below.

e End Offset

This value determines how many characters before or after the identified End Pattern to
stop character recognition. The discovered value is not included in the overall statement.
This field can be set to positive or negative values.

For instance, a value of 5 means GetASCIl will stop looking for the recipient value 5
characters after the first character in the End Pattern. Using our earlier example, if your
End Patternis [MESSAGE] and you specify a value of 5, the data for the recipient will end
with [MESS and you don't want that. If your End Patternis \013 and you specify a value of
5, the data for the recipient will end with <CR><LF>[ME and you don't want that.

On the other side of the coin, a value of -5 means GetASCIl will stop looking for the
recipient value 5 characters before the first character the End Pattern. Using our earlier
example, if your end pattern is either \013 or  MESSAGE] and you specify a value of -5,
the first five characters in the recipient line will be lost and you don't want that.

To use our earlier example, if we have \013 specified as the End Pattern, you would use a
End Offset of -1 thereby telling GetASCII not to include the carriage return as pert of the
recipient or group designation. If we have [MESSAGE] specified as the End Pattern, we
would use an End Offset of 0.

e Lookup Table

The lookup table enables PageGate to perform basic search and replace commands.
This allows you to interchange or translate values as needed. To enable this feature, check
Use Lookup Table and click Edit Table.

Edit T able

This feature enables PageGate to perform basic search and replace commands on values
read in as the Recipient, which allows you to interchange or translate values as needed.
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D Lockup Table >
Dataln Data Out
| | ’
Add | E dit | Diallic | Lotz | Apply
Button Function
Add Adds a new search and replace value.
Edit Edits an existing search and replace value.
Delete Removes an existing search and replace value.
Cancel Closes the table without saving changes.

Apply Applies updates made to the table.

When adding new entries to the table, you'll be presented with this dialog:

[J 4ddtoLockup Table — O X

Drataln |

Data Out |

Cancel | Apply

e Data In
This value represents what you want to search for. Wildcard characters can be used.

e Data Out
This value represents what you want to replace the text with.

For example, if we had a 'Data In' value of oranges and a 'Data Out' value of bananas, the
program would replace any instance of the word oranges with the word bananas.
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To provide a more practical example, let's use the example from the GetASCII - Settings -
Recipient section of the documentation and say that we needed to translate
AgencyToDispatch in to recipient or group name as you've entered it in to the PageGate
Admin. You could use a 'Data In' value of AgencyToDispatch and a 'Data Out' value of
Station14 so any messages that came addressed to the literal text AgencyToDispatch

were routed to the group called Station14 in PageGate.
Sender

IMPORTANT
This character, unless specified otherwise in the Symbols section, represents the
character that tells PageGate that the three characters following it represent an
\ ascii decimal value/ascii code. For instance, if you want to tell PageGate to look
for a carriage return, you would use a backslash and the three character ascii
decimal value representing a carriage return. Written out, that would be \013

For a full list of ascii codes, visit http://www.asciitable.com/

This section is where you tell GetASCIl who or what sent the messages.

(™ Static Sender
Sender |

f* [Dunamic Sender

Start Pattern |«

Start Offzet |
End Pattern [~
End Offzet 0

[ Usze Lookup Table

There are two possible configurations you can use:

e Static Sender
{* Static Sender

Sender |Static5 endert ame

Selecting this option tells the GetASCII module that all messages processed should
identify themselves as having been sent from the specified value. This is the value used in
the maijority of GetASClIlimplementations.
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e Dynamic Sender

Start Pattern [+

Start Qffset |
End Pattern |~
End Offzet 0

Selecting this option tells the GetASCII module to look for specific patterns that denote
where the sender information is located in within the record.

o Start Pattern
This value determines the first character in the sender value.

o Start Offset
This value determines how many characters before or after the identified start pattern to
accept as the sender value. This field can be set to positive or negative values.

For instance, a value of 5 means that GetASCIl will begin looking for the sender value 5
characters after the first character in the Start Pattern. A value of -5 means that GetASCII
will begin looking for the sender value 5 characters before the first character the Start
Pattern.

e End Pattern
This value determines the last character in the sender value.

e End Offset
This value determines how many characters before or after the identified End Pattern to
stop character recognition. This field can be set to positive or negative values.

For instance, a value of 5 means that GetASCIl will stop looking for the sender value 5
characters after the first character in the End Pattern. A value of -5 means that GetASCII
will stop looking for the sender value 5 characters before the first character the End
Pattern.

e Lookup Table

The lookup table enables PageGate to perform basic search and replace commands.
This allows you to interchange or translate values as needed. To enable this feature, check
Use Lookup Table and click Edit Table.

Edit Table
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Tﬁsag@rgeﬁgtﬁes PageGate to perform basic search and replace commands on values
read in as the Sender, which allows you to interchange or translate values as needed.

D Lockup Table >
Dataln Data Out
<« | >
add | Edt | Delete | Cancel | | apob
Button Function
Add Adds a new search and replace value.
Edit Edits an existing search and replace value.
Delete Removes an existing search and replace value.
Cancel Closes the table without saving changes.

Apply Applies updates made to the table.

When adding new entries to the table, you'll be presented with this dialog:

[J addtoLockup Table — O X

Dataln |

Drata Out |

Cancel | Apply

e Data In
This value represents what you want to search for. Wildcard characters can be used.

e Data Out
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For example, if we had a 'Data In' value of oranges and a 'Data Out' value of bananas, the
program would replace any instance of the word oranges with the word bananas.

To provide a more practical example, let's say we wanted to translate A834 in to Dispatch

Center. You would use a 'Data In' value of A834 and a 'Data Out' value of Dispatch Center.
Message

IMPORTANT
This character, unless specified otherwise in the Symbols section, represents the
character that tells PageGate that the three characters following it represent an
\ ascii decimal value/ascii code. For instance, if you want to tell PageGate to look
for a carriage return, you would use a backslash and the three character ascii
decimal value representing a carriage return. Written out, that would be \013

For a full list of ascii codes, visit http://www.asciitable.com/

This section is where you tell GetASCll what represents the message.

" Static Meszage

bezzage |

{* Dipnamic Message

Start Pattern |«

Start Offset |
End Pattern |~
End Offset 0

[~ Use Lookup T able

There are two possible configurations you can use:
e Static Message
f* Static Meszage

Meszage  |Static Message Test

Selecting this option allows you to specify a pre-canned message when a file is read in.
This is useful for configuring a system so that any time a file appears in the folder
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C!g@gﬁ gw%tﬁoring, a pre-canned message is sent to the necessary recipients and
groups.

e Dynamic Message
P

Start Pattern |«
Start Offset |

End Pattern |~
End Offset 0

Selecting this option tells the GetASCII module to look for specific patterns that denote
where the message is located in within the record.

o Start Pattern
This value determines the first character in the message value.

To use the example we've been working with, the record originally started as:
SubscriberName=AgencyToDispatch

[MESSAGE]

Line1=Type of call

Line2=Address information.

Line3=Cross-street information.

Line4=Dispatcher notes.

We then configured GetASCll to treat SubscriberName=<value> as the recipient line,
which removes it from the data string. So, by the time the Message processing happens,
this is the remaining data:

[MESSAGE]

Line1=Type of call

Line2=Address information.

Line3=Cross-street information.

Line4=Dispatcher notes.

As a result, we would want a Start Pattern of Line1= to indicate that the message begins
with that text. This effectively removes the [MESSAGE] line as irrelevant data.

o Start Offset
This value determines how many characters before or after the identified start pattern to
accept as the message. This field can be set to positive or negative values.

For instance, a value of 5 means that GetASCIl will begin looking for the message 5

characters after the first character in the Start Pattern. A value of -5 means that GetASCII
will begin looking for the message 5 characters before the first character the Start Pattern.
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LB%Q@ Qa%%% you would want to set the Start Offset to 6 because there are 6
characters in Line1=

e End Pattern
This value determines the last character in the message.

In our example, you would want to set the End Pattern to the End of Record symbol in the
GetASCII - Settings - Symbols section. This tells PageGate that the last character of the
data line is the termination point for the message. So, by configuring a Start Pattern of
Line1=and ~ for the End Pattern, we're telling PageGate that all of the remaining relevant
data is between Line1= and the end of the file.

e End Offset
This value determines how many characters before or after the identified End Pattern to
stop character recognition. This field can be set to positive or negative values.

For instance, a value of 5 means that GetASCIl will stop looking for the message 5
characters after the first character in the End Pattern. A value of -5 means that GetASCII
will stop looking for the message 5 characters before the first character the End Pattern.

In our example, you would set the End Offset to O to indicate that the last character of the
file was the last relevant character to process.

e Lookup Table

The lookup table enables PageGate to perform basic search and replace commands.
This allows you to interchange or translate values as needed. To enable this feature, check
Use Lookup Table and click Edit Table.

Edit Table

This feature enables PageGate to perform basic search and replace commands on values
in the body of the message, which allows you to interchange or translate values as
needed.

[) addtoLookup Table  — | X

Data ln |

Drata Ot |

Cancel | Apply
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Jalc
PageGate :
Button Function
Add Adds a new search and replace value.
Edit Edits an existing search and replace value.
Delete Removes an existing search and replace value.
Cancel Closes the table without saving changes.

Apply Applies changes made to the table.

When adding new entries to the table, you'll be presented with this dialog:

[) addtoLockup Table — O X

Dataln |

Drata Out |

Cancel | Apply

e Data In
This value represents what you want to search for. Wildcard characters can be used.

e Data Out
This value represents what you want to replace the text with.

For example, if we had a 'Data In' value of oranges and a 'Data Out' value of bananas, the
program would replace any instance of the word oranges with the word bananas.

To provide a more practical example, let's use the example from the GetASCII - Settings -
Message section of the documentation. This is the message being processed:

Type of call

Line2=Address information.

Line3=Cross-street information.

Line4=Dispatcher notes.

Assuming that * is your multiple character wildcard, to remove the text Line2=, Line3=,
Line4=, etc from the body of the message, you would use the following:

Data In: *Line2=*

Data Out: Leave this field completely empty.

Data In: *Line3="
Data Out: Leave this field completely empty.
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and so on.
Advanced Polling Example

PageGate's GetASCIl module can be configured to read any ascii formatted content,
regardless of whether that content is a stream of text or a formatted language like HTML,
XML, Jave, etc. In this example, you'll be going through how to configure PageGate to read
XML content but you can use these steps just as easily for HTML, JSON or another ascii
text formatted language by replacing the XML flags with the appropriate language's
flags/tags/statements/etc.

First, we'll need to create a basic polling directory and get the module online:

1) In Windows, create a sub-directory of your PageGateData folder and name it ASCII
Note: This is arbitrary and you can name the folder whatever you like). For example, if

you're using PageGate's default directories, you would create C:\PageGateData\ASCIN
2) Open the PG Admin.
3) Go to Interfaces - GetASCII - Settings.
4) Set the "Polling Directory" to the ASClIIfolder you created in step 1. By default, C:
\PageGateData\ASCIN
Check Enabled.
Click Apply.

When prompted, you do want to enable this for all existing groups and recipients.

5
6
7
8) Go to Program - Settings.

9) In"Run on this server", check GetASCII
10) Click Apply.

11) When prompted for credentials, please reference the Windows Credentials section of

)
)
)
)

the Run Style documentation.

12) When "Switching Run Styles" goes away, open the Windows Services list

Next, we'll need to configure the GetASCIl module to process your XML content:

1) Go to Interfaces - GetASCII - Settings - Advanced Polling - Files.
2) Click Add.
3) Specify the following:

Recipient: *

Chapter 6 PageGate Admin: How to Configure PageGate 386



387

PageGate Admin: How to Configure 6
P%%Q@l@ender‘s value. CAD, for example.

File(s): If you want the program to read all XML files from the folder, use *.xml

If you want the program to only read for a specific file name, use filename.xml
Combinations of the two are allowed. For example, you could use 2017*.xml and the
program would only look for files that began with 2017 and had an extension of xml.
Path: Enter the directory the .xml files will be in.

File Type: Custom

4) Click Apply.
5) Click Apply.
6) Go to Interfaces - GetASCII - Settings - Advanced Polling - Record
7) Specify the following:

Start Pattern: *
Start Offset: 0

End Pattern: ~
End Offset: 0

General Notes: This effectively tells PageGate that the data to be processed is the first
character in the file until the last character of the file.

8) Click Apply.
9) Go to Interfaces - GetASCII - Settings - Advanced Polling - Recipient.

10) If you want all of the processed content always delivered to the same recipient or
group, select Static Recipient and select the recipient or group to which these
messages should be delivered.

If there is an XML tag that denotes who these messages should go to, select Dynamic
Recipient and specify the following:

Start Pattern: <YourRecipientXMLTag>

Start Offset: Set this to the number of characters contained in your xml tag. For
example, if your XML tag is <Recipient>, you would set Start Offset to 11 as there are
11 characters in <Recipient>.

End Pattern: </YourRecipientXMLTag>
End Offset: 0

11) Click Apply.
12) Go to Interfaces - GetASCII - Settings - Advanced Polling - Sender.
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18@&%t§§it%ender and enter a value in to the Sender's Name field. For example,
you could use CAD.

14) Click Apply.

15) Go to Interfaces - GetASCII - Settings - Advanced Polling - Message.

16) Select Dynamic Message and specify the following:

If the entire message is contained within a single XML tag, you would specify the
following:

Start Pattern: <XMLMessageTag>

Start Offset: 0

End Pattern: </ XMLMessageTag0>
End Offset: 0

For example, let's say that your message is contained in XML content like this:
<Message>The entire body of the message is contained in this field.</Message>

You would use the following:
Start Pattern: <Message>
Start Offset: 0

End Pattern: </Message>
End Offset: 0

As another example, let's say your message is containex in XML content like this:
<Message>

<line1>Relevant data</line1>

<line2>More relevant data</line2>

<irrelevant_data>Value</irrelevant_data>
<irrelevant_data>Value</irrelevant_data>

<line3>More relevant data</line3>

</Message>

You would use this:
Start Pattern: <Message>
Start Offset: 0

End Pattern: </Message>
End Offset: 0

If the message is contained across multiple XML tags with no over-arching header
tag, you would specify the following:
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Start Offset: 0

End Pattern: </LastRelevantTag>
End Offset: 0

For example, let's say your message is contained in XML content like this:
<message_line_1>First line of the message</message_line_1>
<irrelevant_data>Value</irrelevant_data>
<irrelevant_data>Value</irrelevant_data>

<message_line_2>Second line of the message</message_line_2>
<message _line_3>Third line of the message<message line_3>

You would use the following:
Start Pattern: <message_line_1>
Start Offset: 0

End Pattern: </message_line_3>
End Offset: 0

17) Check "Use Lookup Table". This function will allow us to remove the raw text XML tags
from the text to be delivered.

18) Click Edit Table.

19) Click Add.

General Notes: The Data In value represents the data you want either removed or
modified. If you want the data removed, eave the Data Out field completely empty.

For example, if you wanted to change every instance of the word pecans to the word
oranges, you would use this:

Data In: *pecans™

Data Out: oranges

However, if you wanted to remove every instance of the word pecans, you would use
this:

Data In: *pecans®

Data Out:

To make this a bit more relevant for XML content, however, let's say we wanted to
completely remove an entire XML statement as it didn't contain any relevant data. We

would use this:

Data In: *<value>*</value>*
Data Out;
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With that, we're telling PageGate to completely remove the entire XML statement from
the text processed. For example, *<DATE>*</DATE>" tells PageGate that there isn't
any relevant data in the <DATE> tag and to simply remove the entire section from
what needs to be delivered.

As another example, if you want the data in the <ServerName> tag but you don't want
the actual text <ServerName> to appear in the text delivered, you would use this:

Data In: *<ServerName>*
Data Out;

and you would want to add an additional entry to remove the </ServerName> closing
tag:

Data In: *</ServerName>*
Data Out;

Just to note, anything expressed as a \XXX value is an ASCIl code
(http://www.asciitable.com/). For example, \009 is a tab, \013 is a carriage return and
\010 is a line feed.

For example, if you want PageGate to replace all instances of three carriage
return/line feed statements in a row and with a single carriage return/line feed, you
would use this:

Data In: *\013\010\013\010\013\010*

Data Out: \013\010

As another example, if you want to remove all tabs from the data, you would use this:
Data In: *\009*
Data Out:

20) After you've added the necessary entries, click on Apply.
21) Click Apply.
Status

This section displays the current status of the GetASCIl module.

Service  |Gattsci
Status Running

Refrezh
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HR@&%Q%SCII is stopped, it indicates that the module is not running and this can
be caused by a few things.

e GetASCIl will need to be checked in the "Run on this server" section in the Program -

Settings section of the PageGate Admin.

e Enabled must be checked in the settings of the GetASCIl module.

e The PageGate server must be running. If you're running PageGate as an application,
launch the PageGate server from the shortcut in the start menu. If you're running
PageGate as a Windows Service, start the PageGate service. For more information,
see the Run Styles section of the documentation.

Log

This log is a record of information and traffic processed by the GetASCIl module.

Refrezh Open Clipbioard Find i Purge

.......................
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Danal(Catna
1 Ayco'\Jadlo

Butfon Function

Refresh | Displays the most current entries in the log.
Print Sends a copy of everything listed in the log to a printer.
Find Allows you to search for something within the log.

Purge | Deletes the entirety of this log.

Copies the contents of this log to the Windows Clipboard, allowing it to be
pasted into another application.
Command Line Interface

Clipboard

The Command Line Interface function of GetASCIl can be used to send messages
to PageGate from:

Command Line | Messages can be sent from a command prompt.

Windows

. Messages can be sent from the Windows Run menu.
Command Line

Third Party Messages can be sent from any application that can issue a
Applications command line command (shell command).

Custom This is a popular interface for developers who want an easy way to
Applications add messaging to their application.

The most basic components of the Command Line interface are the sendpage.exe
and sendpage32.exe files. By default, these files are hosted in the Polling
Directory specified in the base settings of the GetASCIl module but you can copy
these files to any location to have them function and output at that location.

The difference between the sendpage.exe and sendpage32.exe files is that the
sendpage.exe is intended to be run from a DOS Command Line or by 16-bit
applications and sendpage32.exe is a 32-bit program, which is what most
Windows based applications will use.

To pass a message to sendpage.exe or sendpage32.exe, use this command
structure:

sendpage.exe <recipient> <sender> <message>
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<reciptent> should be replaced with the intended recipient or group's name as it
exists in the PageGate Admin. This value keys specifically off of the Recipient field
for recipients and the Group field for groups. This is a required value.

<sender> should be replaced with who or what is sending the message. This is a
required value.

<message> should be replaced with what you want the body of the message to
say.

Ad-Hoc with the Command Line interface

It's also important to note that you can use Ad-Hoc recipients with the command line
interface. When using the sendpage.exe or sendpage32.exe command line executables
to pass messaging parameters to PageGate, this is how to call on an ad-hoc recipient:
<location of files>\sendpage32.exe <ad-hoc recipient name>;<value>;<value>;<etc>
<sender> <message>

For example, if you have the sendpage32.exe hosted in c:\\PageGateData\ASCIN\ and your
ad-hoc recipient's name is 'ah', then you sent the following command:
c:\PageGateData\ASCI\sendpage32.exe ah;7819999998;8290500234 CAD This is a
test message

That would send a message to the phone numbers specified from the sender 'CAD' and
the message would say 'This is a test message'.
GetMail

PageGate has a fully functional mail server engine as a core part of the program but
without the GetMail module, you only ever access the outbound functions of this mail
server. The GetMail module unlocks the receiving portion of our mail server engine and a
few features associated with the mail server in general. This allows you to receive
SMTP/Email traffic and translate it in to outbound messages in a different format. For
example, you could email a message to PageGate to deliver as a message to pagers, cell
phones and/or other email addresses.

Enabling this interface will allow you to access the Email sub-section of the recipients and
groups in the PageGate Admin. This allows you to have all traffic to a recipient or group
forwarded to the specified email address as well as allowing PageGate to host a POP
accessible mailbox on the PageGate server for this recipient or group.

As mentioned above, GetMail allows you to receive SMTP/Email traffic and translate it in
to outbound messages in a different format and it can receive email/SMTP messages in

one of two ways:

e Sub-domain hosting

Chapter 6 PageGate Admin: How to Configure PageGate



PageGate Admin: How to Configure 6

T@%&@r@lﬁot]eof email integration is to have PageGate host a sub-domain off of your
existing domain. To do this, you'll want to talk to your mail server administrator and ask
them to create this sub-domain for you, then redirect the MX record for that sub-domain to
the internal IP address of the PageGate server. For example, let's say you have an email
domain of example.com. So, you might have something.example.com or
messaging.example.com or pg.example.com created and redirected to the internal IP of
the PageGate server. At that point, PageGate 'owns' the sub-domain and processes all
traffic intended for it.

So, let's say that we have a group called sales_team and we have GetMail configured to
use messaging.example.com. You could send an email to
sales_team@messaging.example.com and that email would be delivered to all members
of the group as it exists in PageGate.

e POP Mailbox

POP is a relatively antiquated method of receiving email and many modern mail servers
don't support it. However, if your mail server does still support POP mailboxes, you can
configure GetMail to periodically check those email addresses, then read in any email
waiting in the mailbox and deliver that traffic to a recipient or group of your specification.

If your POP server requires SSL/TLS authentication, be sure to set the Pop_Delivery Port
Template value to 995. For more information, please see the Parameters for GetMail
section.

With the ubiquity of email, more and more modern applications are integrating the ability
to send email. If your application has the ability to send email, it can easily be integrated
with PageGate by using the GetMail module. It is worth noting that this interface can be
used to integrate applications running on different platforms (Unix, Mac, etc.).

L——_Ir;j;- Interffaces
ﬁ Glabal
-, Getbac

----- 3 Status
H- &% Log

e Settings
This section controls the implementation of the GetMail API.

o Status
This section displays the running/not running status of the interface.

e Template
This section allows you to configure a custom template for messages processed by this
APL
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elo

This section contains a log of all activity recorded by the PageGate Mail Server and
GetMail module.

Right clicking on GetMail will provide a context menu with
two options.

Selecting this option will start the GetMail module and | 3.¢7 GetSeri Start
g

PageGate Mail Server service, if stopped. : GetTap Stop
Getweb

L

1+l

e Sto
Selecting this option will stop the GetMail module and
PageGate Mail Server service, if started.

Settings

Enabled [

Lacal Damain |m_l,u:||:|main.|:l:um

Foztmaster |

Relay Al Mal [

Relay Server |

(o Use systemn's DMNS servers

" Set static DMS servers

DMS Server ||:|.|:|_|:|.|:|

DMS Server 2 ||:|.|:|_|:|.|:|

POP Interval |3 [minutesz)
Setting Function

Enable | When the Enabled checkbox is checked, it tells the PageGate server to run the
d GetMail module.

This is a multi-purpose field. If the GetMail module is only being configured to
send or check email, this field needs to be the sending domain. For example, if
your email address was support@notepage.com, you would put notepage.com
in the Local Domain as that is the domain the messages are being sent from.

Local

Domain If the GetMail module is being configured to function as a POP3 server, the

Local Domain needs to be set to the domain used by PageGate when
receiving email. This is an internet domain name, not a Microsoft networking
domain. Only email with an address in this domain will be accepted by
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Postma
ster

Relay
All Mail

Relay
Server

DNS
Server
1

DNS
Server
2

POP
Interval

m‘er:a-l-e
J “ﬁ'ageéate. This setting must be a valid domain name for to work properly

(Note: an IP address can be used here instead of a domain name, if email is
addressed to match. This is commonly done during testing when a domain
name has not yet been assigned to this machine).

The Postmaster setting needs to be set to a valid email address. This email
address is sent all warnings, alerts, and bad messages generated by the
GetMail module. Leaving this field blank will drop all messages that would
normally go to the postmaster. The Postmaster setting is also used when no
valid Sender's Information is present in an outbound email message.

This option should only be checked if port 25 is not open on your network. To
determine whether port 25 is open or closed on your network, please run a Port
Scan.

This field allows you to specify a relay server for SMTP messages to be routed
through. This option should only be used if port 25 is not open on your network.
To determine whether port 25 is open or closed on your network, please run a
Port Scan.

This field allows you to specify the primary DNS server for SMTP delivery and
is only valid if port 25 is open on your network. To determine whether port 25 is
open or closed on your network, please run a Port Scan.

This field allows you to specify the secondary DNS server for SMTP delivery
and is only valid if port 25 is open on your network. To determine whether port
25 is open or closed on your network, please run a Port Scan.

If any of the GetMail Module's POP functions are used, this setting determines
how often (in minutes) their processes occur.

Expanding Settings will display the following menu:

S-=1 Gethai

..... E
..... 11

Eﬂ&

SR} Settings

otz AdHoo

& Domain POP
2 DUN
Template

Status

Log

e Ad-Hoc

This section configures PageGate's mail server to accept certain values to pass to an Ad-

Hoc recipient.

e Domain POP
A relatively antiquated but still supported method of mail collection for an entire email

domain.
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A relatively antiquated but still supported method of mail collection involving a Dial Up

Network.
AdHoc

This section controls how GetMail implements AdHoc Email. The interface can handle
Ad-Hoc email in two ways, both of which can be used separately or together.

e The first method is to accept email addressed to the ID/PIN number that the

message should use for delivery (i.e. 1234567 @pagingserver.com).

e The second method is to have the Ad-Hoc Email function accept incoming email with the

ID/PIN numbers of the intended destination device on the subject line.

[ Enable Ad-Hoc Map

First 1D | Last ID | Ad-Hoc Recipient
Add Edit Delete
Button Function

Enable Ad-Hoc Mail | Enables the use of Ad-Hoc ranges for email processing.

Add Adds a new Ad-Hoc range.

Edit Edits an existing Ad-Hoc range.
Delete Removes an existing Ad-Hoc range
Apply Applies updates made to the table.

Method 1

To use this method with email, simply address an email message to the PageGate
Server's Local Domain with an ID/PIN number (within the range set in steps 6 and 7 below)
as the part of the email address before the @ (i.e. 1234567 @mypagegateserver.com).
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BEfaggglﬁgtﬁis function, you must first have at least one Ad-Hoc recipientin the
program:

1) Create an Ad-Hoc recipient.

2) Under the 'Enabled Services' section of the recipient, make sure GetMail is checked.
3) Select the carrier that messages should be sent to via the Ad-Hoc function.

Once the Recipient has been configured, check "Enable Ad-Hoc Mail".

[v Enable Ad-Hoc Map

First 1D | Lazt [0 | Ad-Hoc Recipient
Add E dit Delete Apply
1) Click Add.
[J addID/PINRange — O X

Starting 1D /PIM ||:||:||:||:||:||:||:||:|1

Ending ID/PIN - [339339939

Ad-Haoc Recipient |au:|hu:u:_fu:ur_getmail ﬂ

Caricel Apply

2) Enter the Starting ID/PIN.

3) Enter the Ending ID/PIN.

4) Select an Ad-Hoc Recipient from the drop-down menu
5) Click Apply.
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To configure the GetMail module to accept email with the ID/PIN numbers in the subject
line of incoming email:

1) Create an Ad-Hoc recipient.

2) Under the 'Enabled Services' section of the recipient, make sure GetMail is checked.

3) Select the carrier that messages should be sent to via the Ad-Hoc function.

To use this new ad-hoc email, send email addressed to the ad-hoc recipient
(recipientname@getmaildomain.com) and use one or more ID/PIN numbers (separated
by spaces or commas) in the subject line.

PageGate will then use the carrier associated with this ad-hoc recipient to deliver a copy

of the email message to each ID/PIN number in the subject.
Domain POP

PageGate can collect all email for and entire domain from a single mailbox. Most Internet
Service Providers have the ability to put all email addressed to your domain into a single
POP mailbox. This is commonly known as 'Domain POP Mail' or 'Mailbagging'.

It works well with Dial-Up Internet connections or Internet connections that don't have a
static IP address.

PageGate will try to collect mail from the mailbox according to the POP Interval. Once the
messages have been retrieved, PageGate will sort them into local mailboxes that must set

up.

This setup can be used to give the appearance of having a dedicated, in-house mail

server to both the workstations on your local area network and the Internet.
Enabled -

POP Maibax |

POP Pazzward |

POP Server |

[ Remove Collected Mail Fram Server

To configure the Domain POP section of PageGate:
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1P&gﬁ§%ts%red domain name. This can generally be done by contacting your
Internet Service Provider or a Domain Hosting Site.

2) Have the host of your registered domain name set up mailbagging (domain pop mail)

3) If you will be using Dial-Up Networking to connect to the Internet, see the DUN section
of the manual.

4) Check Enabled in the Domain POP section of the GetMail Settings.

5) Enter the name of the mailbox your ISP has configured. Note: Do not include the
@domain.com part in the 'POP Mailbox field.

6) Enter the password to access the mailbox in the POP Password field.

7) Enter the name of the mail server in the POP Server field. Note: The POP Server is the
portion of the address after the @ symbol. Do not include the @ symbol.

8) If you want PageGate to remove collected messages from the Domain POP Email
Account, put a check in "Remove Collected Mail From Server".

9) Click Apply.

10) Set up one or more recipients in PageGate. By default, the recipient's name will be the
name of their email address.

DUN

DUN is an acronym for Dial-Up Networking.

PageGate can use the Dial-Up Networking function of Windows to connect to the
Internet for collecting email. A Dial-Up Networking Connection must first be setup
within the operating system in order for this to work.

When the DUN portion of the GetMail Settings is enabled, the POP Interval setting
will be used to determine how often PageGate will connect to the Internet to collect
email. After PageGate is done receiving messages from the email account(s), it
will automatically disconnect from the Internet and wait for the next POP Interval.

If the Dial-Up Networking account is already connected when the POP Interval
happens, PageGate will use the current connection but will not disconnect when
finished. Basically, PageGate assumes that another application is controlling the
Dial-Up session and will not interfere with it.
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Enable Dial-Up Metworking [

IJze This Accaunt | j

Account Paszward |

Coordinate with Connectarl [

Setting Function
Enable Dial-Up This option enables and disables the Dial-Up Network portion of
Networking PageGate's GetMail module.

An existing Dial-Up networking connection must be configured in
Use This Account | Windows before this setting can be used. Select a Dial-Up
networking connection from the drop-down list.
Enter the password required by the selected Dial-Up Networking
connection.
If you don't have access to multiple modems and require the
primary Connector to function in tandem with the Dial-Up
Networking portion of PageGate, place a check here.

Account Password
Coordinate with
Connector1

Status

This section displays the current status of the GetMail module.
Sermvice |GetMaiI
Statug |F|unning

If the status of GetMail is stopped, it indicates that the module is not running and this can
be caused by a few things.

¢ GetMail will need to be checked in the "Run on this server" section in the Program -

Settings section of the PageGate Admin.

e Enabled must be checked in the settings of the GetMail module.

e The PageGate server must be running. If you're running PageGate as an application,

launch the PageGate server from the shortcut in the start menu. If you're running
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B%@%@Nimows Service, start the PageGate service. For more information,

see the Run Styles section of the documentation.

Log

This section contains a record of all functions performed by GetMail and the PageGate
Mail Server service. As the GetMail module has many functions, it has five separate logs

that correspond to it.
E-F= Gt i
- |5| Settings

3 Status
b %= General
£ SMTP Dutgaing
----- @ SMTPF Incarming
----- @ FOF Clignt
- @ POP Server

e General
This log is a record of information and traffic processed by the GetMail module.

e SMTP Outgoing
This log is a record of all outgoing SMTP transactions negotiated by the PageGate Mail
Server.

e SMTP Incoming
This log is a record of all incoming SMTP transactions negotiated by the PageGate Mail
Server.

e POP Client
This log is a record of all POP mail collection sessions negotiated by the PageGate Mail
Server.

e POP Server
This log is a record of all incoming POP mail collection requests negotiated by the
PageGate Mail Server.
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This log is a record of information and traffic processed by the GetMail module.

.......................

R efrezh Open Clipbioard Firnd { Purge

Button Function

Refresh | Displays the most current entries in the log.
Print Sends a copy of everything listed in the log to a printer.
Find Allows you to search for something within the log.

Purge | Deletes the entirety of this log.

Copies the contents of this log to the Windows Clipboard, allowing it to be

Clipboard pasted into another application.

SMTP Outgoing

This log is a record of all outgoing SMTP transactions negotiated by the PageGate Mail
Server.
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.......................

R efrezh Open Clipbioard Firnd { Purge

Button Function

Refresh | Displays the most current entries in the log.
Print Sends a copy of everything listed in the log to a printer.
Find Allows you to search for something within the log.

Purge | Deletes the entirety of this log.

Copies the contents of this log to the Windows Clipboard, allowing it to be

Clipboard pasted into another application.

SMTP Incoming

This log is a record of all incoming SMTP transactions negotiated by the PageGate Mail
Server.
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.......................

R efrezh Open Clipbioard Firnd { Purge

Button Function

Refresh | Displays the most current entries in the log.
Print Sends a copy of everything listed in the log to a printer.
Find Allows you to search for something within the log.

Purge | Deletes the entirety of this log.

Copies the contents of this log to the Windows Clipboard, allowing it to be

Clipboard pasted into another application.

POP Client

This log is a record of all POP mail collection sessions negotiated by the PageGate Mail
Server.
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.......................

R efrezh Open Clipbioard Firnd { Purge

Button Function

Refresh | Displays the most current entries in the log.
Print Sends a copy of everything listed in the log to a printer.
Find Allows you to search for something within the log.

Purge | Deletes the entirety of this log.

Copies the contents of this log to the Windows Clipboard, allowing it to be

Clipboard pasted into another application.

POP Server

This log is a record of all incoming POP mail collection requests negotiated by the
PageGate Mail Server.
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.......................

R efrezh Open Clipbioard Firnd { Purge

Button Function

Refresh | Displays the most current entries in the log.
Print Sends a copy of everything listed in the log to a printer.
Find Allows you to search for something within the log.

Purge | Deletes the entirety of this log.

Copies the contents of this log to the Windows Clipboard, allowing it to be

Clipboard pasted into another application.

GetSerial

This interface allows PageGate to monitor a serial/RS232 port (virtual or physical) for raw
data ascii strings to be parsed in to outbound messages. When a data string is sent to a
monitored serial port, GetSerial pattern matches sections of the data string to parse
information for messaging.
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e Settings

-5 Interfaces
- Global
F-Y. Getbsci
#-[=7 Gethai
El#? GetSerial

| Settings

----- B Status
o & Laog

This section controls the implementation of the GetSerial API.

e Status

This section displays the running/not running status of the interface.

e Template

This section allows you to configure a custom template for messages processed by this

API.

e Log

This sectionis a record of all activity performed by the interface.

started.

Right clicking on GetSerial will provide a context menu

Selecting this option will stop the GetSerial interface, if

with two options. 58 Interfaces
e Start - @ Global
. . . . L . - Getbaci

Selecting this option will start the GetSerial interface, if B-r= GetMai

stopped. R4 GetSer Start
B 50 GetTap % .
-8 Getweh op

e Stop mlﬁ Rl Clent
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Enabled I
Serial Port m
Baud Rate m
Parity m
Data Bits m
Stop Bits m
Handzhaking m
I kit Skring |
Setting Function
When the Enabled checkbox is checked, it tells the PageGate server to run the
Enabled :
GetSerial module.
Serial | This field determines the Communications (COM) Port the GetSerial module
Port | will monitor for incoming data.
BRZl,:: This setting must match the Baud Rate the sending device uses.
Parity | This setting must match the Parity the sending device uses.
DB?,:: This setting must match the Data Bits the sending device uses.
Stop : . . . ,
Bits This setting must match the Stop Bits the sending device uses.
Handsh If the sending device uses handshaking for flow control, GetSerial must mirror
akin the handshaking method (Xon/Xoff or RTS). If the sending device does not use
9 handshaking, this field must be set to None.
Init | Init strings are not typically used with Serial Connections but may be used if a
String | modem is attached to the same COM port specified in the Serial Port setting.

Expanding the Settings section will provide the following menu items:
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DAanalAata

El-i? Getsenal

B [F] Settings

- & Symbols

-7 Recard

M3 Recipient

et Sender
- Meszage

----- [F| Template

----- 3 Status

..... @ Lag

This is where you'll configure PageGate to recognize the patterns in the stream of data
being read in on the RS232/Serial line.

e Symbols
This section determines certain special characters and their functions.

e Record
This section is where you configure the pattern recognition to determine what represents
the start and end of valid data to process.

¢ Recipient

This section is where you configure the pattern recognition to determine what represents
who the messages should go to. This section can also be set to a static recipient, to
indicate that all traffic processed from the serial line should be sent to the specified
individual or group.

e Sender

This section is where you configure the pattern recognition to determine what represents
who or what sent the messages. This section can also be set to a static sender to indicate
that all traffic processed from the serial line should declare that it is from the specified
value.

e Message
This section is where you configure the pattern recognition to determine what represents

the body of the message to be delivered. This section can also be set to a static message
to provide the message text to be delivered.
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This section determines certain special characters and their functions.

Single Character Wildcard |:-_
bultiple Character ‘wildcard |=<_
End OF Record Syrnbal |~_

Azcii Value Delimiter |-T
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Single Character
Wildcard

Character
Wildcard

End of Record

ASCIl Value
Delimiter

Record

tting

Multiple

Symbol

Apply

Function

When searching for pattern matches in the data strings on the
RS232/Serial line, this character can be used to stand in for any
single character.

For example, let's say you use Fire?

That would tell the GetSerial module to recognize any word that began
with Fire and had one extra letter on the end. So, it would recognize
Fires or Fired.

As another example, let's say you use ??/?7?/?77?7?

That would tell GetSerial to recognize any date stamp in the two digit
month, two digit day, four digit year configuration.

When searching for pattern matches in the data strings on the
RS232/Serial line, this character can be used to stand in for any
character or group of characters.

For example, let's say you use Fire*

That would tell the GetSerial module to recognize any instance of the
word Fire, regardless of whether there are any characters after the
word. So, it would recognize Fire or Fired or Fires but it would also
recognize the Fire in Fire Sale or Fire Department.

As another example, let's say you use *age*
That would tell GetSerial to recognize any reference to the three letters
age close to each other, regardless of whether that was in the word
PageGate or NotePage or ageless or damage. Any instance of the
three characters together will be recognized.

This character stands for the end of record symbol.

This symbol is used to help represent non-printable characters that
normally can't be typed like horizontal tabs, carriage returns and line
feeds. This character is always followed three numbers which
represent the decimal value for a character.

For example, this represents a carriage-return: \013

For a full list of ascii codes, visit http://www.asciitable.com/

Applies all changes made to the Symbols.

This section is where you configure the pattern recognition to determine what represents
the start and end of a message sequence.
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Ctart Patterm Ix—

Start Offset |
End Pattern |~
End Offzet 0

o Start Pattern

This value determines the start of relevant information. For example, let's say this is a data
string read in on the RS232/Serial line:

CODE 17 START A04 Refrigeration Unit 003 Temperature High 84.31 N773 END
A9.3178

You would want to use START as the Start Pattern as that begins the section of
information relevant for your message. Start patterns are included in the record processed
unless you specify the otherwise with the Start Offset.

o Start Offset
This value determines how many characters before or after the identified start pattern to
begin character processing. This field can be set to positive or negative values.

For instance, a value of 5 means that GetSerial will begin the data record 5 characters
after the first character in the Start Pattern. A value of -5 means that GetSerial will begin
the data record 5 characters before the first character the Start Pattern. To use our earlier
example, if we don't want the word START to be a part of the record processed, we would
set the Start Offset value to 5. That way, the data record begins five characters after the
first character in START.

e End Pattern

This value determines the end of relevant information For example, let's say this is a data
string read in on the RS232/Serial line:

CODE 17 START A04 Refrigeration Unit 003 Temperature High 84.31 N773 END
A9.3178

You would want to use END as the End Pattern as that ends the section of information
relevant for your message. End patterns are included in the record processed unless you
specify the otherwise with the End Offset.

e End Offset
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Tﬁsalggggmnes where in the data stream the record of relevant information ends
and does so by determining how many characters before or after the identified End
Pattern to begin. This field can be set to positive or negative values.

For instance, a value of 5 means that GetSerial will end the data record 5 characters after
the last character in the End Pattern. A value of -5 means that GetSerial will end the data
record 5 characters after the last character the End Pattern. To use our earlier example, if
we don't want the word END to be a part of the record processed, we would set the Start
Offset value to -3. That way, the data record ends three characters before the last
character of END.

Recipient

This section is where you configure the pattern recognition to determine what represents
who the messages should go to.

" Static Recipient
Recipient | J

{* Dynamic Recipient

Start Pattern |«

Start Off=et [
End Pattern |~
End Offzet 0

[ Usze Lookup Table

There are two possible configurations you can use:
e Static Recipient
(™ Static Recipient

R ecipignt | J

Selecting this option tells the GetSerial module that all messages processed from the
RS232/Serial line should go to the specified recipient or group.

¢ Dynamic Recipient
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f* Dynamic Recipient

Start Pattern |«

Start Offset [
End Pattern |~
End Offzet 0

[ Use Lookup T able

Selecting this option tells the GetSerial module to look for specific patterns that denote
where the recipient information is located in within the record.

o Start Pattern
This value determines the first character in the recipient value.

For example, let's say this is a data string identified as the record and let's also say that
the first three characters represent the recipient or group this message should go to:
A04 Refrigeration Unit 003 Temperature High 84.31 N773

or another example:
B16 Refrigeration Unit 007 Temperature High 92.74 N712

or another example:
A29 Refrigeration Unit 005 Temperature High 85.93 N798

You would want to use * as the Start Pattern as the recipient information is the first value in
the string of data. Start patterns are included in the recipient processed unless you specify
the otherwise with the Start Offset.

o Start Offset
This value determines how many characters before or after the identified start pattern to
accept as the recipient value. This field can be set to positive or negative values.

For instance, a value of 5 means that GetSerial will begin looking for the recipient value 5
characters after the first character in the Start Pattern. A value of -5 means that GetSerial
will begin looking for the recipient value 5 characters before the first character the Start
Pattern.

To use our earlier example, we would want a Start Offset of 0 because we want everything
from the first character in the data stream.
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e End Pattern
This value determines the last character in the recipient value.

Using our earlier example, we've already specified that the recipient value starts at the
very first character in the stream.
A04 Refrigeration Unit 003 Temperature High 84.31 N773

or another example:
B16 Refrigeration Unit 007 Temperature High 92.74 N712

or another example:
A29 Refrigeration Unit 005 Temperature High 85.93 N798

Assuming ? represents the single character wildcard value assigned in the Symbols
section, you would want to use ??? as the End Pattern as the first three character
sequence in the data represents the recipient value.

e End Offset
This value determines how many characters before or after the identified End Pattern to
stop character recognition. This field can be set to positive or negative values.

For instance, a value of 5 means that GetSerial will stop looking for the recipient value 3
characters after the first character in the End Pattern. A value of -5 means that GetSerial
will stop looking for the recipient value 5 characters before the first character the End
Pattern.

To use our earlier example, since we have ??? specified as the End Pattern and that three
character value represents the recipient value, we would set the Start Offset value to 3.
That way, the data record ends three characters after the first character in the file.

e Lookup Table

The lookup table enables PageGate to perform basic search and replace commands.
This allows you to interchange or translate values as needed. To enable this feature, check
Use Lookup Table and click Edit Table.

[w |z Lookup Table

Edit Table |

Lookup Table

This feature enables PageGate to perform basic search and replace commands on values
read in as the Recipient, which allows you to interchange or translate values as needed.
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Dataln Data Out
| | ’
Add | E dit | Diallic | Lotz | Apply

Button Function

Add Adds a new search and replace value.

Edit Edits an existing search and replace value.
Delete Removes an existing search and replace value.
Cancel Closes the table without saving changes.

Apply Applies updates made to the table.

When adding new entries to the table, you'll be presented with this dialog:

[J 4ddtoLockup Table — O X

Drataln ||

Data Out |

Cancel | Apply

e Data In
This value represents what you want to search for. Wildcard characters can be used.

e Data Out
This value represents what you want to replace the text with.

For example, if we had a 'Data In' value of oranges and a 'Data Out' value of bananas, the
program would replace any instance of the word oranges with the word bananas.
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To provide a more practical example, let's use the example from the GetSerial - Settings -
Recipient section of the documentation and say that we needed to translate A0O4 in to
recipient or group name as you've entered it in to the PageGate Admin. You could use a
'Data In' value of AO4 and a 'Data Out' value of [TDept so any messages that came in for
A04 were routed to the group called [TDept in PageGate.

Sender

This section is where you configure the pattern recognition to determine what value
represents who or what sent the messages read in from the RS232/Serial line.

(™ Static Sender
Sender |

f* [Dunamic Sender

Start Pattern |«

Start Offzet |
End Pattern [~
End Offzet 0

[ Usze Lookup Table

T

There are two possible configurations you can use:
e Static Sender

" Static Sender
Sender |

Selecting this option tells the GetSerial module that all messages processed should
identify themselves as having been sent from the specified value. This is the value that is
used in the majority of GetSerial implementations.

e Dynamic Sender
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DanalAatAa
{» Dipnamic Sender

Start Pattern |«

Start Offset |
End Pattern |~
End Offset 0

[~ Use Lookup T able

Selecting this option tells the GetSerial module to look for specific patterns that denote
where the sender information is located in within the record.

o Start Pattern
This value determines the first character in the sender value.

o Start Offset
This value determines how many characters before or after the identified start pattern to
accept as the sender value. This field can be set to positive or negative values.

For instance, a value of 5 means that GetSerial will begin looking for the sender value 5
characters after the first character in the Start Pattern. A value of -5 means that GetSerial
will begin looking for the sender value 5 characters before the first character the Start
Pattern.

e End Pattern
This value determines the last character in the sender value.

e End Offset
This value determines how many characters before or after the identified End Pattern to
stop character recognition. This field can be set to positive or negative values.

For instance, a value of 5 means that GetSerial will stop looking for the sender value 5
characters after the first character in the End Pattern. A value of -5 means that GetSerial
will stop looking for the sender value 5 characters before the first character the End
Pattern.

e Lookup Table

The lookup table enables PageGate to perform basic search and replace commands.
This allows you to interchange or translate values as needed. To enable this feature, check
Use Lookup Table and click Edit Table.
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[w |z Lookup Table i

Edit Table |

Lookup Table

This feature enables PageGate to perform basic search and replace commands on values
read in as the Sender, which allows you to interchange or translate values as needed.

Dataln Data Out
| | »
Add | E dit | Dallic | Caiisl | Apply
Button Function
Add Adds a new search and replace value.
Edit Edits an existing search and replace value.
Delete Removes an existing search and replace value.
Cancel Closes the table without saving changes.

Apply Applies updates made to the table.

When adding new entries to the table, you'll be presented with this dialog:
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[) addtoLockup Table — O X

Dataln ||

Drata Out |

Cancel | Apply

e Data In
This value represents what you want to search for. Wildcard characters can be used.

e Data Out
This value represents what you want to replace the text with.

For example, if we had a 'Data In' value of oranges and a 'Data Out' value of bananas, the
program would replace any instance of the word oranges with the word bananas.

To provide a more practical example, let's say we wanted to translate A834 in to Dispatch

Center. You would use a 'Data In' value of A834 and a 'Data Out' value of Dispatch Center.
Message

This section is where you configure the pattern recognition to determine what value
represents the messages read in from the RS232/Serial line.

(™ Static Meszzage

hezzage |

(* [ynamic Meszage

Start Pattern |«

Start Offzet |
End Pattern [~
End Offzet 0

[ Usze Lookup Table

There are two possible configurations you can use:
e Static Message
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hezzane |

Selecting this option allows you to specify a pre-canned message to be delivered when
activity is detected on the serial line.
e Dynamic Message

(* [ynamic Meszage

Start Pattern =

Start Offzet |
End Pattern |~
End Offzet 0

[ Usze Lookup Table

Selecting this option tells the GetSerial module to look for specific patterns that denote
where the message is located in within the record.

o Start Pattern
This value determines the first character in the message value.

To use the example we've been working with, the record originally started as:
A04 Refrigeration Unit 003 Temperature High 84.31 N773

We then configured GetSerial to treat AO4 as the recipient value, which removes it from
the data string. So, by the time the Message processing happens, this is the remaining
data:

Refrigeration Unit 003 Temperature High 84.31 N773

As a result, we would want a Start Pattern of * to indicate that the message begins at the
first remaining character.

o Start Offset
This value determines how many characters before or after the identified start pattern to
accept as the message. This field can be set to positive or negative values.
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Flc?r%gggégtlgue of 5 means that GetSerial will begin looking for the message 5
characters after the first character in the Start Pattern. A value of -5 means that GetSerial
will begin looking for the message 5 characters before the first character the Start Pattern.

Using our example, you would want to set the Start Offset to 0.

e End Pattern
This value determines the last character in the message.

In our example, you would want to set the End Pattern to the End of Record symbol in the
GetSerial - Settings - Symbols section. This tells PageGate that the last character of the
data line is the termination point for the message. So, by configuring a * for the Start
Pattern and a ~ for the End Pattern, we're telling PageGate that all of the remaining data is
relevant and needs to be in the body of the message delivered.

e End Offset
This value determines how many characters before or after the identified End Pattern to
stop character recognition. This field can be set to positive or negative values.

For instance, a value of 5 means that GetSerial will stop looking for the message 5
characters after the first character in the End Pattern. A value of -5 means that GetSerial
will stop looking for the message 5 characters before the first character the End Pattern.

e Lookup Table

The lookup table enables PageGate to perform basic search and replace commands.
This allows you to interchange or translate values as needed. To enable this feature, check
Use Lookup Table and click Edit Table.

[w |ze Lookup Table

Edit Table |

Lookup Table

This feature enables PageGate to perform basic search and replace commands on values
in the body of the message, which allows you to interchange or translate values as
needed.
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Dataln Data Out
| | ’
Add | E dit | Diallic | Lotz | Apply

Button Function

Add Adds a new search and replace value.

Edit Edits an existing search and replace value.
Delete Removes an existing search and replace value.
Cancel Closes the table without saving changes.

Apply Applies updates made to the table.

When adding new entries to the table, you'll be presented with this dialog:

[J 4ddtoLockup Table — O X

Drataln ||

Data Out |

Cancel | Apply

e Data In
This value represents what you want to search for. Wildcard characters can be used.

e Data Out
This value represents what you want to replace the text with.

For example, if we had a 'Data In' value of oranges and a 'Data Out' value of bananas, the
program would replace any instance of the word oranges with the word bananas.

Chapter 6 PageGate Admin: How to Configure PageGate 424



425

PageGate Admin: How to Configure 6
PageGate

To provide a more practical example, let's use the example from the GetSerial - Settings -
Message section of the documentation and say that we needed to translate 84.31 in to
Building 14, Floor 3, Room 6. You would use a 'Data In' value of 84.31 and a 'Data Out'
value of Building 14, Floor 3, Room 6. As another example, let's say you wanted to
translate N773 in to Service contract Norwood, Account 773. You would use a 'Data In'
value of N773 and a 'Data Out' value of Service contract Norwood, Account 773.

Status

This section displays the current status of the GetSerial module.

Service lm
Status  [Rurning

If the status of GetSerial is stopped, it indicates that the module is not running and this can

be caused by a few things.

¢ GetSerial will need to be checked in the "Run on this server" section in the Program -

Settings section of the PageGate Admin.

e Enabled must be checked in the settings of the GetSerial module.

e The PageGate server must be running. If you're running PageGate as an application,
launch the PageGate server from the shortcut in the start menu. If you're running
PageGate as a Windows Service, start the PageGate service. For more information,

see the Run Styles section of the documentation.
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Log
This log is a record of information and traffic processed by the GetSerial module.

R efrezh Open Clipbioard Firnd

Button Function

Refresh | Displays the most current entries in the log.
Print Sends a copy of everything listed in the log to a printer.
Find Allows you to search for something within the log.

Purge | Deletes the entirety of this log.

Copies the contents of this log to the Windows Clipboard, allowing it to be

Clipboard pasted into another application.

GetTap

This interface allows PageGate to monitor a serial port or answer a modem call to receive
TAP transmitted pages. This allows PageGate to function as a TAP receiver or a TAP
terminal for any devices and systems that can transmit that protocol, such as a Zetron or
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I\B@ggp%ﬁg%rminal as well as a few CAD systems. This also allows PageGate to
function as a TAP receiver for any installation of NotePager Pro, allowing satellite offices
to submit messages for processing with a centralized, master server.

- Interfaces
- @ Glohal
H-Y,. Getbsci
=7 Gethai
H- GetSerisl
[=B-H GetTap

B |5 Settings

3 Status
{:,4 Lag

e Settings
This section controls the implementation of the GetTap APL.

e Status
This section displays the running/not running status of the interface.

e Template
This section allows you to configure a custom template for messages processed by this
APL.

elo
This sectionis a record of all activity performed by the interface.

Right clicking on GetTap will provide a context menu with
two options. E-dp Interfaces
- Global
o Start - Gethscii
Selecting this option will start the GetTap interface, if B-f=1 GetMail
stopped -G GetSerial
. g GetT N Start
-TH Gt L}
e Sto m-[=] GUI T Stop
Selecting this option will stop the GetTap interface, if | ##T Fannectors
started.
Settings
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Settiitg Function

When the Enabled checkbox is checked, it tells the PageGate server to run the
GetTap module.

This field determines the Communications (COM) Port the GetTap module will
monitor for incoming data. This field can be set to use the COM port of a
modem or a serial port.

Baud | Choose the baud rate at which incoming connections will be established. By
Rate | default, the baud rate is 1200.

Choose the parity with which incoming connections will be established. By
default, the parity is even.
Data | Choose the data bits the incoming connections will be established with. By
Bits | default, the data bits is 7.

Stop | Choose the stop bits the incoming connections will be established with. By
Bits | default, the stop bits is 1.

The init string is a set of commands sent to the modem to configure it for
incoming calls. The init string also turns certain modem connection features on
and off. For example, most systems using the TAP protocol communicate at
1200 baud with no error correction or data compression. By default, the Init

Enabled

Serial
Port

Parity

Sr:ilr: String field is set to ATS0=1 - this init string resets the modem to factory
9 defaults and sets the modem to answer on the first ring.
If you specified a Serial Port connected directly to a serial cable, instead of a
modem, please set the Init String field to the word 'direct’ (without the quotes).
AdHoc

This function configures the GetTap module to accept ID/PIN values within a certain range
and pass them through as the ID/PIN the message should ultimately be delivered to. For
example, if the TAP system sending information in to the GetTap APl uses ten digit phone
number as the ID/PIN value, you could have that passed through in-state to the ad-hoc
recipient without needing to configure a static recipient value to correspond to the ID
passed.
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[ Enable Ad-Hoz Map

First 1D | Lazt IO | A d-Hoc Recipient
Add E dit Delete
Button Function

Enable Ad-Hoc Tap | Enables the use of Ad-Hoc ranges for processing TAP ID's.

Add Adds a new Ad-Hoc range.

Edit Edits an existing Ad-Hoc range.
Delete Removes an existing Ad-Hoc range
Apply Applies updates made to the

Before enabling this function, you must first have at least one Ad-Hoc recipient in the

program:
1) Create a new Ad-Hoc recipient.

2) Under the 'Enabled Services' section of the recipient, make sure GetTap is checked.
3) Select the carrier that messages should be sent to via the Ad-Hoc function.

Once the Recipient has been configured, check "Enable Ad-Hoc Tap".

[+ Enable Ad-Hoc Map

1) Click Add.
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[) 4dd ID/PINRange — O X

Ctarting |DAPIN ||:||:||:|‘|

EndingID/PIN ~ [3359

Ad-Hoc Recipient |a|:|h|:u:_f|:|r_gettap j

Cancel | Apply

2) Enter the Starting ID/PIN.

3) Enter the Ending ID/PIN.

4) Select an Ad-Hoc Recipient from the drop-down menu
5) Click Apply.

Status

This section displays the current status of the GetTap module.

Semvice  |GetTap
Statuz Funning

If the status of GetTap is stopped, it indicates that the module is not running and this can
be caused by a few things.

e GetTap will need to be checked in the "Run on this server" section in the Program -

Settings section of the PageGate Admin.

e Enabled must be checked in the settings of the GetTap module.

e The PageGate server must be running. If you're running PageGate as an application,
launch the PageGate server from the shortcut in the start menu. If you're running
PageGate as a Windows Service, start the PageGate service. For more information,

see the Run Styles section of the documentation.
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Log
This log is a record of information and traffic processed by the GetTap module.

.......................

R efrezh Open Clipbioard Firnd { Purge

Button Function

Refresh | Displays the most current entries in the log.
Print Sends a copy of everything listed in the log to a printer.
Find Allows you to search for something within the log.

Purge | Deletes the entirety of this log.

Copies the contents of this log to the Windows Clipboard, allowing it to be

Clipboard pasted into another application.

GetWeb

This interface provides a CGl executable that can be hosted on a web server and a series
of pre-formatted templates to publish a website messaging interface. This allows you to
host messaging websites on your local intranet or, if GetWeb is interfaced with an outward
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fﬁ%@%@ on the internet. Web Developers can also use this web server interface
to send GET/POST requests to notify PageGate when a message needs to be sent, who
the message should go to, who sent the message and what the message should say. This
interface can also be used to enable PageGate to receive notifications from applications
running on different platforms (Unix, Mac, etc.).

El-4% Interfaces
- @ Global
-, Gethsci
-[=7 Gethai
(}? GetSerial
;L GetTap

E| Template
- @ Status
il Log

e Settings
This section controls the implementation of the GetWeb API.

e Status
This section displays the running/not running status of the interface.

e Template

This section allows you to configure a custom template for messages processed by this
APL.

elo
This sectionis a record of all activity performed by the interface.

Right clicking on GetWeb will provide a context menu

with two options.

o Start

Selecting this option will start the GetWeb interface, if : ﬁ% Start

stopped. 1 Cornectors Stop
- amiers

e Sto

Selecting this option will stop the GetWeb interface, if

started.

The GetWeb module provides a CGl executable that can be implemented in one of two
ways

Hosting messaging websites
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Tﬁsqgt@g‘@\kgyou to host a messaging website or series of messaging websites on
your web server and GetWeb comes pre-loaded with a few stock templates to help you
get started with this process. It should be noted that these templates are completely
customizable and can be edited in any way you see fit.

e GUI List Template Configuration

This template should be tied to a group and provides a messaging website which offers a
list of recipients and groups available to be messaged. Which recipients are groups are
available to message is controlled by the member list of the group that the template is tied
to. If a recipient or group is a member of the group the template is tied to, they show up on
the website. If they aren't, they don't.

e Adhoc Template Configuration

This template should be tied to an Ad-Hoc recipient and provides a messaging website
which offers a field to enter a phone number to message rather than a static list to choose
from.

POST/GET request to GetWeb's CGI Executable
GetWeb's CGl executable can be used with either a POST or GET method.

The POST method can be used by creating a form on your webpage and pointing to the
webgate.exe program in the FORM ACTION statement.

The GET method is more popular with scripting languages such as JavaScript and Java.
It allows the GetWeb CGl to be called with a command similar to one that could be entered
into a browser's URL field.

For more sophisticated webpages that use javascript, java, or another higher-end
language than HTML, the webgate.exe CGI program can be called directly rather than
using it only with an HTML form.

Standard Messaging

The three variables the webgate.exe CGlreceiver is expecting to see are USER, FRM
and MSG. USER specifies who the message should go to, FRM specifies who or what
sent the message and MSG specifies the text to be sent.

Example:
http://www.mydomain.com/scripts/webgate.exe?
USER=pageme&FRM=fromme&MSG=This+is+a+test

This would send a message to the recipient 'pageme’, from 'fromme’, with a message of
"This is a test'

Ad-Hoc Messaging
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T@%’%aq%a@ltgthe webgate.exe CGlreceiver is expecting to see are USER,
SUBJECT, FRM and MSG. USER specifies the ad-hoc recipient, SUBJECT specifies the
phone numbers that should receive the message, FRM specifies who or what sent the
message and MSG specifies the text to be sent.

Example:

http://www.mydomain.com/scripts/webgate.exe?

USER=ADHOCMETHOD &Subject=PhoneNumber,PhoneNumber,PhoneNumber,etc&FR
M=fromme&MSG=This+is+a+test

This would send the message "This is a test" to the phone numbers specified in the
"Subject" parameter.

Using Scripts

You can also find examples of Linux and Powershell scripts that can be used with GetWeb
in this section of the documentation.

Settings

This section is where you tell the GetWeb APl what directory to reference on the web
server to publish your messaging websites and what directory hosts the CGl executable.

Enabled -

“Web Pagesz Path | J
CGl Data Path | J
CGIURL |httpi.-".-"_','Dur-WEb-SEWED"SCriDtSa"WEbgatE.E

Paling Interval |3

Setting Function

When the Enabled checkbox is checked, it tells the PageGate server to run
the GetWeb module.

This field determines the location on the web server where PageGate will

Web publish your messaging website(s). This field should be set to a directory on
the web server where new content should be created.

Enabled

Pages

Path Iif you have IIS installed locally and the Default Website referencing the default

IS location, set this field to: c:\inetpub\wwwroof\

This field determines the location on the web server where PageGate will
CGl Data| host its CGl executable. This field should be set to the web server's scripting
Path | directory.

Chapter 6 PageGate Admin: How to Configure PageGate 434



435

PageGate Admin: How to Configure 6

Danal(Catna
] GHU'\JG <o

For IIS installations on Windows 7, 8, 10, Server 2008, Server 2012 or
Server 2016 please see the Configuring IIS 7.5, 8 and 10 section for steps
on configuring IIS to allow GetWeb's CGl executable to function.

This field determines the URL used in the FORM action and should be set to
the URL and directory of the web server hosting webgate.exe

ff you have IIS installed locally and are using the default configuration
described in the local IS installation section of the documentation, set this to:

| URL
cGlu http://your-web-server/scripts/webgate.exe

Be sure to replace your-web-server with the machine name or IP address of
the PageGate server.

Polling | The setting in this field determines how often the GetWeb module looks for
Interval | new messages in the CGIl Data Path.

The GetWeb module provides a CGl executable that can be implemented in one of two
ways

Hosting messaging websites

This option allows you to host a messaging website or series of messaging websites on
your web server and GetWeb comes pre-loaded with a few stock templates to help you
get started with this process. It should be noted that these templates are completely
customizable and can be edited in any way you see fit.

e GUI List Template Configuration

This template should be tied to a group and provides a messaging website which offers a
list of recipients and groups available to be messaged. Which recipients are groups are
available to message is controlled by the member list of the group that the template is tied
to. If a recipient or group is a member of the group the template is tied to, they show up on
the website. If they aren't, they don't.

e Adhoc Template Configuration

This template should be tied to an Ad-Hoc recipient and provides a messaging website
which offers a field to enter a phone number to message rather than a static list to choose
from.

POST/GET request to GetWeb's CGl Executable
The webgate CGl can be used with either a POST or GET method.

The POST method can be used by creating a form on your webpage and pointing to the
webgate.exe program in the FORM ACTION statement.
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T@%ﬁ?ﬁlﬁo@s more popular with scripting languages such as JavaScript and Java.
It allows the GetWeb CGl to be called with a command similar to one that could be entered
into a browser's URL field.

For more sophisticated webpages that use javascript, java, or another higher-end
language than HTML, the webgate.exe CGI program can be called directly rather than
using it only with an HTML form. Here is a sample calling command that can be used in
the URL field in a browser to call webgate.exe:

http://www.mydomain.com/scripts/webgate.exe?
USER=pageme&FRM=fromme&MSG=This+is+a+test

This would send a message to the recipient 'pageme’, from 'fromme’, with a message of
"This is a test'

Just to note, the three variables the webgate.exe CGl receiver is expecting to see are
USER, FRM and MSG. USER specifies who the message should go to, FRM specifies
who or what sent the message and MSG specifies the text to be sent.

Configuring IIS 7.5, 8 and 10 for GetWeb

GetWeb can be configured to reference either a local installation of IIS or, if the
appropriate directories on the web server are accessible on the network, a web server on
the same network.

Click here for steps on how to configure a local installation of IIS for GetWeb.

Click here for steps on how to configure GetWeb to reference a web server accessible by
UNC path.

Local IS Installation

1) After installing IIS, if the directory does not already exist, create the directory c:
\inetpub\scripts\

2) Open the PageGate Admin.

3) Go to Interfaces - GetWeb - Settings.

4) Set the "Web Pages Path" to: c:\inetpub\wwwroot\

5) Set the "CGIl Data Path" to: c:\inetpub\scripts\

6) Set the "CGI URL" to: http://your-web-server/scripts/webgate.exe but replace your-web-
server with the machine name or IP address of the PageGate server.

7) Check Enabled

8) Click Apply.

9) If prompted, you do want to enable this for all existing groups and recipients.
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18%&@&%%§dmin and select the server object (the first thing in the list in the menu on
the left side).

11) Open Handler Mappings.

12) Right click CGl-exe, left click Edit Feature Permissions

13) Check Execute.

14) Click OK.

15) Select the Server Obiect again.

16) Open ISAPIl and CGI Restrictions.

17) Right click in the box and select Add.

18) Set the ISAPI or CGl path to: c:\inetpub\scripts\webgate.exe

19) Set the Description to: GetWeb CGI API

20) Check "Allow extension path to execute".

21) Click OK.

22) Right click Default Web Site, left click Add Virtual Directory.

23) Set the Alias to: scripts

24) Set the Physical path to: c:\inetpub\scripts\

25) Click OK.

26) Right click on the new scripts virtual directory, left click Edit Permissions.

27) Select the Security tab.

28) Click Edit.

29) Click Add.

30) Type Domain Users, left click Check Names.

31) Click OK.

32) Grant them the Modify permission.

33) Click Add.

34) Type IUSR, left click Check Names.

35) If prompted, select the local IUSR account.

36) Click OK.

37) Grant then the Modify permission.

38) Click Add.

39) Type Domain Admin, left click Check Names.

40) Click OK.
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Netw ork Web Server

1) Open the IS Admin and select the server object.

2) Open Handler Mappings.

3) Right click CGlexe, left click Edit Feature Permissions

4) Check Execute.

5) Click OK.

6) Select the Server object again.

7) Open ISAPIand CGlI Restrictions.

8) Right click in the box and select Add.

9) Setthe ISAPIor CGl path to the directory on the web server where webgate.exe is
being hosted. This should correspond to the folder specified in GetWeb's Settings.

10) Set the Description to: GetWeb CGI API

11) Check "Allow extension path to execute".

12) Click OK.

GUI List Template Configuration

NOTE: You must configure the GetWeb API's settings before you can implement this.

This template will format a messaging website to provide a list of recipients and groups
available to be messaged and the page will look something close to the image shown
below.

Chapter 6 PageGate Admin: How to Configure PageGate

438



PageGate Admin: How to Configure 6

DAanalAatAa

To configure GetWeb to publish this style of messaging website, you'll first need to create
a Group to tie the webpage to as the member list of the group controls who is available in
the Recipient List shown above. Once you have the group created, this is what you'll want
to do:

1) Open the PageGate Admin.
2) Go to Groups - <YourGroupName> - WebPage.
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Template File I ;I

Textl
Tent2
Tent3d
Textd
Texth
Tents
Tent?
Textd
Text3
Text10

Irmagel
Irmage
Irmage3
Irmaged
Irmageh

[~ Custom Page [~ Group List [T Full Hames

Apply

3) In the "Template File' dropdown menu, select: guilist.nhtm
4) In the Image1 field, enter: pagegatewebclient.gif

5) Check Group List.

6) Check Full Names.

Template File Iguilist.htm d

Tenxtl
Text2
Text3
Textd
Texth
Texts
Text?
Textd
Text9
Text10

Imagel
Image2
Image3
Imaged
Imageh

[T Custorm Page v Group List [v Full Marmes

Apply

7) Go to the Members sub-section of your new webpaging group.

8) Add all recipients and groups who should be available to message
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Maon-members b emberz

test]
test10
test?
testd
testd
testh
testh

Copy from | j Apply

9) Click Apply.

As soon as you do, PageGate will publish a directory to the Web Pages path specified in
the GetWeb Settings that matches the name of the group and publish the index.htm and
default.htm files to it. This makes a new messaging website, accessible by going to
http://<yourwebserver>/<yourgroupname>/

For example, let's say that our web server's host name is webhost and that our group's

name was webpaging. You would go to http://webhost/webpaging/
Adhoc Template Configuration

NOTE: You must configure the GetWeb API's settings before you can implement this.

This template should be tied to an Ad-Hoc recipient and provides a messaging website
which offers a field to enter a phone number to message rather than a static list to choose
from.
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P pf:r:‘l'g
ag TO | |

FROM |

MESSAGE

| SEND PAGE | CLEAR FORM |

To configure GetWeb to publish this style of messaging website, you'll first need to create

an ad-hoc recipient to tie the template to. Once you have the ad-hoc recipient created, this

is what you'll want to do:
1) Open the PageGate Admin.
2) Go to Recipients - <YourAdHocRecipient> - WebPage.

PG A - O
- %3 GetTap ~
El }E; tﬁvg:tliingg Template File j
Textl
Teut2
Teut3
&-[=] GUI Client Textd
H-FT Connectors Teuth
B Carriers Texts
B % Recipients Tent?
El f: adhoc_for_gebweb Textd
e [Z] Settings Text9
i - [E] Advanced Text10
- [F] Template
o
~{=1 Emai ImaEEE
o #: WebPage Imaged
% test Imageh
Bl T test1D
i T test2 [~ Custom Page B
Bl T testd
I B F testd
T tests W
< >

3) Inthe "Template File' dropdown menu, select: ad-hoc.htm
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Template File (S j
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Text3
Textd
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Texts
Text?
Textd
Text3
Text10

Irmagel
Irmagez
Irmage3
Irmaged
Irmageh

[ Custom Page [

Apply

4) Click Apply.

As soon as you do, PageGate will publish a directory to the Web Pages path specified in
the GetWeb Settings that matches the name of the ad-hoc recipient and publishes the
index.htm and default.htm files to it. This makes a new messaging website, accessible by
going to http://<yourwebserver>/<youradhocrecipientname>/

For example, let's say that our web server's host name is webhost and that our group's
name was ad-hoc. You would go to http://webhost/ad-hoc/
Status

This section displays the current status of the GetWeb module.

Service  |Gefn'eh
Status Fiunining

If the status of GetWeb is stopped, it indicates that the module is not running and this can

be caused by a few things.

e GetWeb will need to be checked in the "Run on this server" section in the Program -

Settings section of the PageGate Admin.

e Enabled must be checked in the settings of the GetWeb module.
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ol?r%gggg%@tg%erver must be running. If you're running PageGate as an application,
launch the PageGate server from the shortcut in the start menu. If you're running
PageGate as a Windows Service, start the PageGate service. For more information,

see the Run Styles section of the documentation.

Log

This log is a record of information and traffic processed by the GetWeb module.

Refrezh Open Clipbioard Firnd
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Butfon Function

Refresh | Displays the most current entries in the log.
Print Sends a copy of everything listed in the log to a printer.
Find Allows you to search for something within the log.

Purge | Deletes the entirety of this log.

Copies the contents of this log to the Windows Clipboard, allowing it to be
pasted into another application.
Supported Scripts

Clipboard

It's quite easy to use a script to pass information to GetWeb's CGl executable. Below,
you'll find examples of both Linux and Powershell scripts to use as a guide:

Linux Script

#!/bin/bash

# set each part of the URL to send

UrlToCgi=$(printf "http://127.0.0.1/scripts/webgate.exe")
RecipientVar=$(printf "?USER=")

Recipient=$(printf "pageyou")

SenderVar=$(printf "&FRM=")

Sender=$(printf "fromme")

MessageVar=$(printf "&MSG=")

# set message to all the text sent on the command line
Message=$@

# url encode message text

Message=$(php -r "echo urlencode(\"$Message\");")

# build the request URL
FullUrl=$UrlToCgi$RecipientVar$Recipient$SenderVar$Sender§MessageVar$Message
# send the request

wget -O- "$FullUrl"

Powershell Script
# set each part of the URL to send

$UrToCgi="http://127.0.0.1/scripts/webgate.exe"
$RecipientVar="?USER="
$Recipient="pageyou"
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$Sender="fromme"

$MessageVar="&MSG="

# set message to all the text sent on the command line
$Message=%args

# url encode message text
[uri]::EscapeUriString($Message)

# build the request URL

$FullUrl=$UrlToCgi + $RecipientVar + $Recipient + $SenderVar + $Sender +
$MessageVar + $Message

# send the request

Invoke-WebRequest -Uri $FullUrl

GUI Client

The GUI Client APlis a Windows based program installed on workstations on the same
network as the PageGate server. This program provides a graphical user interface to
send and schedule messages. Since the PageGate Client is its own application, the
PageGate Admin's GUI Client section is only used to enable or disable this interface,
modify the template tied to this interface, to check the status of the interface and to review
the log of traffic submitted by the workstation clients.

e Settings
This section controls whether the GUI Client interface is enabled or disabled.

e Status
This section displays the running/not running state of the interface.

e Template
This section allows you to configure a custom template for messages processed by this
APL.

elo
This section displays a record of all messages submitted by the GUI Client.
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Cﬁc@ggg’rantgmation on how to install, configure and implement the PageGate GUI
Client.
Settings

[+ Enabled

The only setting for the GUI Client contained within the PageGate Admin is whether the
GUI Client module is Enabled or Disabled. By default, the GUI Client is set to Enabled.

To disable the GUI Client interface, uncheck Enabled and click Apply.

To enable the GUI Client interface, check Enabled and click Apply.
Status

The status subsection of GUI Client will show you if the GUI Client module is currently
running or stopped.

Service  |GUI Clent
Statuz Furning

Refrezh

If the Status of GUI Client is Stopped, that indicates that either the module is not
enabled or the PageGate server is not active.

e Enabled must be checked in the settings of the GUI Client module.

e The PageGate server must be running. If you're running PageGate as an application,
launch the PageGate server from the shortcut in the start menu. If you're running
PageGate as a Windows Service, start the PageGate service. For more information,
see the Run Styles section of the documentation.

Log

This log is a record of information and traffic submitted by workstations using the GUI
Client.
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R efrezh Open Clipbioard Firnd { Purge

Button Function

Refresh | Displays the most current entries in the log.
Print Sends a copy of everything listed in the log to a printer.
Find Allows you to search for something within the log.

Purge | Deletes the entirety of this log.

Copies the contents of this log to the Windows Clipboard, allowing it to be
pasted into another application.

Additional APIs

e SNPP Server
This APl allows you to host an SNPP server to receive messages in the SNPP protocol.

Clipboard

e TCP Server Module
This module allows PageGate to run a TCP server/listener, enabling it to accept TCP
packets from any source.
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This module allows PageGate to run a UDP server/listener, enabling it to accept UDP
packets from any source.

e TAP to ASCII

This APl allows you to monitor a COM port (physical or virtual) for either modem or serial
messages in the TAP protocol. When a monitored modem or serial port passes a TAP
message, the TAP to ASCIl module records the information and submits it to the GetASCII
APl for processing.

e TAP IP Server
This APl allows you to receive the TAP protocol by TCP/IP instead of the standard modem
or serial/RS232 line.

e Serial to ASCII
This APl allows you to monitor a serial/RS232 port (physical or virtual) for raw data ascii
strings to be parsed in to outbound messages. When a data string is sent to a monitored

serial port, the Serial to ASCIl module records the information and submits it to the
GetASCII APl for processing.

e Filter Pack

The filter pack is a series scripts that allow you to modify any input from any APl based on
nearly any selection criteria of your choosing. These scripts also allows you to read any
plaintext content generated by another application; whether that's another program's log
files, XML or HTML content, delimited text or anything that can be read as plaintext.

SNPP Server

This interface allows PageGate to function as an SNPP server to receive this protocol.
Messages received by this APl are output to a directory as a text file that is then read in by
the GetASCIIAPI.

Step 1: Create a directory for the SNPP Server

1) In Windows, create a new directory for the SNPP Server. This can be any folder
accessible to PageGate, whether on the local hard drive or by UNC path to a network
resource. However, if PageGate will need to reference a network resource, the services
relevant to these processes will need permission to access it. For more information, see
the services section of the documentation. We recommend creating a directory called
SNPP as a sub-directory of PageGate's database directory (By default, c:
\PageGateData\SNPP\).

2) In Windows, browse in to the PageGate program directory.
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BEI\%%%QQE%eNer.exe, pininfo.txt and snpp.ini files to the folder you created in step
1.

Step 2: Configure the SNPP Server's settings

1) The first thing we'll need to do is modify the snpp.ini file. Open the file in notepad.

To give you a little more information, the snpp.ini file controls the behavior of the SNPP
Server. If you are running the evaluation version, it will stop itself every 3-5 days, and/or
after 500 messages, whichever comes first.

2) Change the OutputFolder= value to the directory you created in step 1. By default, C:
\PageGateData\SNPP\

3) Change the LogFolder= value to your logging directory. If you are unsure of what this
folder is, open the PageGate Admin and go to the Program - Settings section. By defaul,
C:\PageGateData\Logs\

4) Save the .ini file and close notepad.
5) Open pininfo.txt in notepad.

This file tells the SNPP server what range of numbers can be passed to the server. The
format of the entries defined in this text file are:
"Starting PIN", "Ending PIN", "recipient type"

if you would like ID numbers in a range to be recognized as the recipient's name (not using
ad-hoc, but using numeric recipient names in PageGate), use the text "PG_Recipient" as
shown below:

"0001","9999", "PG_Recipient"

If you would like ID numbers in a range to be passed through PageGate as intact ID's to
another source in an ad-hoc range, use the name of a Recipient in PageGate whose type
is Ad-Hoc.

"0000001","4999999" "adhoc1"

To have it accept all potential alphanumeric values, use the following statements:
II*II,II*II’IIPG_ReCipientII
ll*ll’ll*ll’lladhocrecipient"

6) After declaring the appropriate ID ranges, save and close the file.

Step 3: Run the SNPP Server
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2) Change directory to the SNPP Server's program directory. By default, c:
\PageGateData\SNPP\

3) Type the following and hit enter:
snppserver /install

4) Exit the command prompt.
5) Open the Services listin Windows.
6) Go in to the Properties of the PageGate SNPP Server service.

7) Change the Startup Type to Automatic and Start the Service.

Step 4: Configure the GetASCII APIto process the SNPP Server's messages

1) Go to Interfaces - GetASCII - Settings.

2) Set the 'Polling Directory' to the output folder. By default, C:\PageGateData\SNPP\

3) Check Enabled.

4) Click Apply.

5) Go to Program - Settings.

6) In the 'Run on this server' section, check GetASCI

7) Click Apply.

8) If prompted for credentials, leave them blank and click Apply again.

Note: If you are already using the GetASCIl module, you can use the Advanced Polling
Files section to specify the SNPP Server's output folder as a secondary polling location.

The File(s) value will need to be setto *.asc and itis a Standard file type.
TCP Server Module

This interface allows PageGate to function as a TCP server to receive TCP packets from
a variety of sources. Messages received by this API are output to a directory as a text file
that is then read in by the GetASCII API.

Step 1: Create a directory for the TCP Server
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1?@%9@?%&@ a new directory for the TCP Server. This can be any folder
accessible to PageGate, whether on the local hard drive or by UNC path to a network
resource. However, if PageGate will need to reference a network resource, the services
relevant to these processes will need permission to access it. For more information, see
the services section of the documentation. We recommend creating a directory called
TCP as a sub-directory of PageGate's database directory (By default, c:
\PageGateData\TCP\).

2) In Windows, browse in to the PageGate program directory.

3) Move the pgtcpserver.exe and pgtcp.ini files to the folder you created in step 1.

Step 2: Configure the TCP Server's settings

1) The first thing we'll need to do is modify the pgtcp.ini file. Open the file in notepad.

To give you a little more information, this INI file controls the behavior of the TCP Server. If
you are running the evaluation version, it will stop itself every 3-5 days, and/or after 500
messages, whichever comes first.

2) Configure the port the TCP server should listen to. By default, the port is set to 5002.

3) Change the OutputFolder= value to the directory you created in step 1. By default, C:
\PageGateData\TCP\

4) Change the LogFolder= value to your logging directory. If you are unsure of what this
folder is, open the PageGate Admin and go to the Program - Settings section. By defaul,
C:\PageGateData\Logs\

5) Next, we'll need to set the end of record delimiter but let's go in to what that means first.
When the TCP Server is receiving information, it doesn't really know what in the data is
important; it's just receiving TCP packets of data. The end of record delimiter tells the TCP
server that the expressed series of characters denotes a break in the data stream.

For example, the TCP server could receive a series of 5 packets:
a) This is

b)a

c) test message #

d) This is a new

€) message

If you set EndOfRecordDelimiter = #, that tells the TCP server that everything before every
# received is a data block to be parsed.

Chapter 6 PageGate Admin: How to Configure PageGate 452



453

PageGate Admin: How to Configure 6

Flaglgﬁee\‘/@!@he end of record delimiter tells the TCP server how to break down the
information it's receiving in to processable chunks.

It's the "over" of a CB radio conversation.

5) Below that, there are RequiredText and RequiredTextOperator values that can be set.

RequiredText specifies text that must appear for a data block to be processed and you
may specify multiple values by separating each with a | (pipe).

The RequiredTextOperator specifies whether you're using OR or AND logic.

For example, let's say you specify the following:
RequiredText=alarm|notification
RequiredTextOperator=AND

That tells the TCP server that both the words alarm AND notification need to appear in a
received data block for that data block to be treated as a message to send.

As another example:
RequiredText=alarm|alert
RequiredTextOperator=OR

That tells the TCP server that either the words alarm or alert need to appear in a received
data block for that data block to be treated as a message to send.

6) Next we have EndOfRecordTimeout, whose value is expressed in milliseconds. This
value tells the TCP server how long to wait before timeout after receiving data, to accept a
data record.

By default, this is set to 3000 milliseconds or 3 seconds.

7) RejectOnTimeout determines whether timeouts should post a rejection notice or not. By
default, this is set to true.

8) AcceptResponse determines what the TCP server will echo to the sending system upon
acceptance of a data block.

9) RejectResponse determines what the TCP server will echo to the sending system upon
rejection of a data block.

10) Last, we have two optional settins: StaticRecipient and StaticSender

StaticRecipient allows you to specify the name of a specific recipient or group in
PageGate that ALL traffic from the TCP server should be passed through.
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StaticSender allows you to hard code a sender's name that should be associated with
ALL traffic from the TCP server.

11) Save the .ini file and close notepad.

Step 3: Run the TCP Server

1) Open a command prompt with elevated permission.

2) Change directory to the TCP Server's program directory. By default, c:
\PageGateData\TCP\

3) Type the following and hit enter:
pgtcpserver /install

4) Exit the command prompt.
5) Open the Services listin Windows.
6) Go in to the Properties of the PageGate TCP Server service.

7) Change the Startup Type to Automatic and Start the Service.

Step 4: Configure the GetASCII API to process the TCP Server's messages
1) Go to Interfaces - GetASCII - Settings.
2) Set the 'Polling Directory' to the output folder. By default, C:\PageGateData\TCP\
3) Check Enabled.
4) Click Apply.
5) Go to Program - Settings.
6) In the 'Run on this server' section, check GetASCI
7) Click Apply.

8) If prompted for credentials, leave them blank and click Apply again.
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I\joatgg%g;aaetgready using the GetASCIl module, you can use the Advanced Polling
Files section to specify the TCP Server's output folder as a secondary polling location. The
File(s) value will need to be set to *.asc and it is a Standard file type.

UDP Server Module

This interface allows PageGate to function as a UDP server to receive UDP packets from
a variety of sources. Messages received by this API are output to a directory as a text file
that is then read in by the GetASCII API.

Step 1: Create a directory for the UDP Server

1) In Windows, create a new directory for the UDP Server. This can be any folder
accessible to PageGate, whether on the local hard drive or by UNC path to a network
resource. However, if PageGate will need to reference a network resource, the services
relevant to these processes will need permission to access it. For more information, see
the services section of the documentation. We recommend creating a directory called
UDP as a sub-directory of PageGate's database directory (By default, c:
\PageGateData\UDP\).

2) In Windows, browse in to the PageGate program directory.

3) Move the pgudpserver.exe and pgudp.ini files to the folder you created in step 1.

Step 2: Configure the UDP Server's settings

1) The first thing we'll need to do is modify the pgudp.ini file. Open the file in notepad.

To give you a little more information, this INI file controls the behavior of the UDP Server. If
you are running the evaluation version, it will stop itself every 3-5 days, and/or after 500
messages, whichever comes first.

2) Configure the port the UDP server should listen to. By default, the portis set to 5002.

3) Change the OutputFolder= value to the directory you created in step 1. By default, C:
\PageGateData\UDP\

4) Change the LogFolder= value to your logging directory. If you are unsure of what this
folder is, open the PageGate Admin and go to the Program - Settings section. By defaul,
C:\PageGateData\Logs\

5) Next, we'll need to set the end of record delimiter but let's go in to what that means first.
When the UDP Server is receiving information, it doesn't really know what in the data is
important; it's just receiving UDP packets of data. The end of record delimiter tells the
UDP server that the expressed series of characters denotes a break in the data stream.
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FB@)gﬁpqé%L%DP server could receive a series of 5 packets:

a) This is

b)a

c) test message #
d) This is a new
€) message

If you set EndOfRecordDelimiter = #, that tells the UDP server that everything before every
# received is a data block to be parsed.

Put another way, the end of record delimiter tells the UDP server how to break down the
information it's receiving in to processable chunks.

It's the "over" of a CB radio conversation.
5) Below that, there are RequiredText and RequiredTextOperator values that can be set.

RequiredText specifies text that must appear for a data block to be processed and you
may specify multiple values by separating each with a | (pipe).

The RequiredTextOperator specifies whether you're using OR or AND logic.
For example, let's say you specify the following:
RequiredText=alarm|notification

RequiredTextOperator=AND

That tells the UDP server that both the words alarm AND notification need to appearin a
received data block for that data block to be treated as a message to send.

As another example:
RequiredText=alarmjalert
RequiredTextOperator=OR

That tells the UDP server that either the words alarm or alert need to appear in a received
data block for that data block to be treated as a message to send.

6) Next we have EndOfRecordTimeout, whose value is expressed in milliseconds. This
value tells the UDP server how long to wait before timeout after receiving data, to accept a
data record.

By default, this is set to 3000 milliseconds or 3 seconds.

7) RejectOnTimeout determines whether timeouts should post a rejection notice or not. By
default, this is set to true.
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8?.@&@1@9;[)@% determines what the UDP server will echo to the sending system
upon acceptance of a data block.

9) RejectResponse determines what the UDP server will echo to the sending system upon
rejection of a data block.

10) Last, we have two optional settins: StaticRecipient and StaticSender

StaticRecipient allows you to specify the name of a specific recipient or group in
PageGate that ALL traffic from the UDP server should be passed through.

StaticSender allows you to hard code a sender's name that should be associated with
ALL traffic from the UDP server.

11) Save the .ini file and close notepad.

Step 3: Run the UDP Server

1) Open a command prompt with elevated permission.

2) Change directory to the UDP Server's program directory. By default, c:
\PageGateData\UDP\

3) Type the following and hit enter:
pgudpserver /install

4) Exit the command prompt.
5) Open the Services listin Windows.
6) Go in to the Properties of the PageGate UDP Server service.

7) Change the Startup Type to Automatic and Start the Service.

Step 4: Configure the GetASCII APIto process the UDP Server's messages

1) Go to Interfaces - GetASCII - Settings.
2) Set the 'Polling Directory' to the output folder. By default, C:\PageGateData\UDP\
3) Check Enabled.

4) Click Apply.
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6) In the 'Run on this server' section, check GetASCII
7) Click Apply.
8) If prompted for credentials, leave them blank and click Apply again.

Note: If you are already using the GetASCIl module, you can use the Advanced Polling
Files section to specify the UDP Server's output folder as a secondary polling location.
The File(s) value will need to be set to *.asc and itis a Standard file type.

TAP to ASCII

This interface is a companion module for GetTAP and unlocks the ability to monitor
additional seriallRS232 ports or modems, up to as many as you need. Messages
received by this API are output to a directory as a text file that is then read in by the
GetASCIIAPI. This APl requires the GetASCII APIto function.

Step 1: Create a directory for the TAP to ASCIl receiver

1) In Windows, create a new directory for the TAP to ASClIreceiver. This can be any folder
accessible to PageGate, whether on the local hard drive or by UNC path to a network
resource. However, if PageGate will need to reference a network resource, the services
relevant to these processes will need permission to access it. For more information, see
the services section of the documentation. We recommend creating a directory called
TAP2ASCIIX where X is the number of the interface running as a sub-directory of
PageGate's database directory (By default, c:\\PageGateData\TAP2ASCII\).

2) Unzip the TAP to ASCII file you were sent upon purchasing the APl in to the folder you
created in step 1.

Step 2: Configure the TAP to ASCllreceiver's settings

1) The first thing we'll need to do is modify the TAP2ASCILini file. Open the file in notepad.

To give you a little more information, the TAP2ASCILini file controls the behavior of the
TAP to ASCllreceiver.

2) Change RunStyle=Application to RunStyle=Service
3) Change SwitchStyle=False to SwitchStyle=True

4) Set DataFolder= to the directory you created in step 1. By default, DataFolder=C:
\PageGateData\TAP2ASCII1\
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6) Set ComSettings= to the communication parameters required. Values must be passed
as baud rate,parity,databits,stopbits

For example, this string would use 9600 baud, no parity, 8 data bits and 1 stop bit:
ComSettings=9600,n,8,1

and this string would use 1200 baud, even parity, 7 data bits and 1 stop bit:
ComSettings=1200,e,7 1

7) Set InitString= to the word 'direct for RS232/serial connections. Example,
InitString=direct

Set InitString= to the appropriate AT command string to initialize your modem in 'answer
mode. For most modems, you can use ATS0=1 to configure the modem to answer after 1
ring. Example, InitString=ATS0=1

8) Save the .ini file and close notepad.

Step 3: Run the TAP to ASCllreceiver

1) Open a command prompt with elevated permission.

2) Change directory to the TAP to ASCIl receiver's program directory. By default, c:
\PageGateData\TAP2ASCII\

3) Type the following and hit enter:
TAP2ASCIN /install

4) Exit the command prompt.
5) Open the Services listin Windows.
6) Find and start the TAP 2 ASCII 1 service.

Step 4: Configure the GetASCII APIto process the TAP to ASCIlreceiver's messages

Note: You must configure a basic polling directory before specifying these advanced
polling settings.

1) Go to Interfaces - GetASCII - Settings - Advanced Polling - Files.

2) Click Add.
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3) Specify the following:

Recipient: *

From: Leave blank or specify a value

File(s): *.t2a

Path: Specify the output path of the TAP to ASCIl receiver. By default, c:
\PageGateData\TAP2ASCII\

File Type: Standard

4) Click Apply, then click Apply again.

TAP IP Server

The TAP IP Server allows PageGate to receive the TAP protocol by TCP request instead
of serial or modem line. Messages received by this APl are output to a directory as a text

file that is then read in by the GetASCIl API. This API requires the GetASCIl API to
function.

Step 1: Create a directory for the TAP IP Server

1) In Windows, create a new directory for the TAP IP receiver. This can be any folder
accessible to PageGate, whether on the local hard drive or by UNC path to a network
resource. However, if PageGate will need to reference a network resource, the services
relevant to these processes will need permission to access it. For more information, see
the services section of the documentation. We recommend creating a directory called
IPTAP as a sub-directory of PageGate's database directory (By default, c:
\PageGateData\lIPTAP\).

2) In Windows, browse in to the PageGate program directory.

3) Move the TaplpServer.exe, pininfo.txt and tapip.ini files to the folder you created in step
1.

Step 2: Configure the TAP IP Server's settings

1) The first thing we'll need to do is modify the tapip.ini file. Open the file in notepad.
To give you a little more information, the tapip.ini file controls the behavior of the TAP IP
Server. If you are running the evaluation version, it will stop itself every 3-5 days, and/or

after 500 messages, whichever comes first.

2) Change the OutputFolder= value to the directory you created in step 1. By default, C:
\PageGateData\IPTAP\
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BEﬁgﬁe%@t_@gFoldeF value to your logging directory. If you are unsure of what this
folder is, open the PageGate Admin and go to the Program - Settings section. By defaul,
C:\PageGateData\Logs\

4) Save the .ini file and close notepad.
5) Open pininfo.txt in notepad.

This file tells the SNPP server what range of numbers can be passed to the server. The
format of the entries defined in this text file are:
"Starting PIN", "Ending PIN", "recipient type"

If you would like ID numbers in a range to be recognized as the recipient's name (not using
ad-hoc, but using numeric recipient names in PageGate), use the text "PG_Recipient" as
shown below:

"0001","9999", "PG_Recipient"

if you would like ID numbers in a range to be passed through PageGate as intact ID's to
another source in an ad-hoc range, use the name of a Recipient in PageGate whose type
is Ad-Hoc.

"0000001","4999999" "adhoc1"

To have it accept all potential alphanumeric values, use the following statements:
"*","*"’"PG_ReCipient"

Wk mwikn n

;" "adhocrecipient”

6) After declaring the appropriate ID ranges, save and close the file.

Step 3: Regqister the TAP IP Server
Without its registration, the TAP IP Server can be run in a demo mode where it will stop
the service/shut itself off every 3 to 5 days or every 100 messages, whichever happens
first.

To register the TAP IP Server:
1) Open the tapip.ini file in notepad.

2) Add the following line to the bottom of the file:
Registration= Your PageGate version 10 registration key number

3) Save and close the tapini.ini file.

Step 4: Run the TAP IP Server

1) Open a command prompt with elevated permission.
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2) Change directory to the TAP IP Server's program directory. By default, c:
\PageGateData\IPTAP\

3) Type the following and hit enter:
tapipserver /install

4) Exit the command prompt.
5) Open the Services listin Windows.
6) Go in to the Properties of the PageGate TAP IP Server service.

7) Change the Startup Type to Automatic and Start the Service.

Step 5: Configure the GetASCII APIto process the TAP IP Server's messages

1) Go to Interfaces - GetASCII - Settings.

2) Set the 'Polling Directory' to the output folder. By default, C:\PageGateData\IPTAP\

3) Check Enabled.

4) Click Apply.

5) Go to Program - Settings.

6) In the 'Run on this server' section, check GetASCII

7) Click Apply.

8) If prompted for credentials, leave them blank and click Apply again.

Note: If you are already using the GetASCIl module, you can use the Advanced Polling
Files section to specify the TAP IP Server's output folder as a secondary polling location.

The File(s) value will need to be set to *.asc and itis a Standard file type.
Serial to ASCII

This interface is a companion module for GetSerial and unlocks the ability to monitor
additional serial/RS232 ports (physical or virtual), up to as many as you need. Messages
received by this API are output to a directory as a text file that is then read in by the
GetASCIIAPIL This APl requires the GetASCII API to function.

Step 1: Create a directory for the Serial to ASCll receiver
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1R@Qiﬁd§@,t§eate a new directory for the Serial to ASCIl receiver. This can be any
folder accessible to PageGate, whether on the local hard drive or by UNC path to a
network resource. However, if PageGate will need to reference a network resource, the
services relevant to these processes will need permission to access it. For more
information, see the services section of the documentation. We recommend creating a
directory called S2ASCIIX where X is the number of the interface running as a sub-
directory of PageGate's database directory (By default, c:\PageGateData\S2ASCII\).

2) Unzip the Serial to ASCIIfile you were sent upon purchasing the APl in to the folder you
created in step 1.

Step 2: Configure the Serial to ASCIl receiver's settings

1) The first thing we'll need to do is modify the Serial2ASCILini file. Open the file in
notepad.

To give you a little more information, the Serial2ASCILini file controls the behavior of the
Serial to ASCllreceiver.

2) Change RunStyle=Application to RunStyle=Service
3) Change SwitchStyle=False to SwitchStyle=True

4) Set DataFolder= to the directory you created in step 1. By default, DataFolder=C:
\PageGateData\S2ASCII\

5) Set ComPort= to the serial/RS232 port that should be monitored.

6) Set ComSettings= to the communication parameters required. Values must be passed
as baud rate,parity,databits,stopbits

For example, this string would use 9600 baud, no parity, 8 data bits and 1 stop bit:
ComSettings=9600,n,8,1

and this string would use 1200 baud, even parity, 7 data bits and 1 stop bit:
ComSettings=1200,e,7 1

7) The behavior of the Symbols, Record, Recipient, Sender and Message sections follows
that of the GetSerial module. Click here for more information.

8) After configuring all appropriate input parameters, save and close the .ini file.

Step 3: Run the Serial to ASCll receiver
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2) Change directory to the Serial to ASCII receiver's program directory. By default, c:
\PageGateData\S2ASCIIN\

3) Type the following and hit enter:
Serial2ASCIN /install

4) Exit the command prompt.
5) Open the Services listin Windows.

6) Find and start the Serial 2 ASCII 1 service.

Step 4: Configure the GetASCII APIto process the TAP to ASCllreceiver's messages

Note: You must configure a basic polling directory before specifying these advanced
polling settings.

1) Go to Interfaces - GetASCII - Settings - Advanced Polling - Files.
2) Click Add.

3) Specify the following:

Recipient: *

From: Leave blank or specify a value

File(s): *.s2a

Path: Specify the output path of the TAP to ASCIl receiver. By default, c:
\PageGateData\Serial2ASCII1\

File Type: Standard

4) Click Apply, then click Apply again.
Filter Pack

The filter pack is a scripting system that allows you to modify any input in to or output from
any of PageGate's interfaces based on nearly any criteria of your choosing.

Things you can do with the filtering system:
e Conditionally modify who a messaqge is intended to go to based on key words or key

phrases.
e Allfire, rescue and accident calls should be dispatched but non-emergency calls

Exam should not be.
Ples: o Only alarms with "CRITICAL" in them should be delivered.
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Pag?gﬁegsta%es with the keyphrase "HAZARD" should go to a high priority group
instead of the normal distribution list.
¢ Replies with the word 'subscribe' should perform one action but replies with the

word 'unsubscribe' should perform another.

¢ Modify the contents or structure of data to turn it in to something more user-friendly and
readable.
¢ Pull content from an API (like the National Weather Service, a Ticket Tracking

Exam  System like Jira or ServiceNow, etc)

ples: e Parse XML, HTML, JSON or any other form of delimited text in to readable

message content

e Trigger a Powershell or other script.

¢ This allows you to have PageGate trigger other applications or processes by
tying them to a conditional filter in PageGate. Powershell is incredibly powerful
and with the right script, you could have PageGate execute functions that would
modify another application's database, perform network or domain lookup
functions or anything else made available by Powershell.

Descr
iption:

This is certainly not a comprehensive list of things you could do and, effectively, this filter
allows you to modify any input fed in to or output delivered from PageGate based on nearly
any selection criteria of your choosing.

Over the course of this documentation, we'll be going over how to configure, code and
implement PageGate's filtering system.

First, the filter scripts require the file 'pdfilter.exe’ to reside in the PageGate program
directory and will need to reference an XML file containing the script, which can reside in
any directory the PageGate server has access to (whether that's on the local hard drive or
on a network share via UNC path). You should receive all necessary files for the filtering
system upon purchase but if you do not have them, please contact our sales and
registration department at 781-829-0500 x 1 or by email at sales@notepage.com.

Second, it's important to understand the chain of events that triggers the script to run.

For more detailed information, please see: How to Implement the Script

As an important note, due to the way this script is programmed, certain characters are
treated as command characters instead of literal text characters. The following characters
represent certain command functions in the script:
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Function
cter

~ as first character means start of sectionffile, ~ as last character means end of
sectionffile. For example, ~123~ would only find 123 and not 01234 or 1237, etc.
~123 would find 12340 but would not find 01234. 123~ would find 0123 but would
not find 01234.

? | Single character wildcard.

* | Multiple character wildcard.

IMPORTANT
ASClIvalue prefix (Ex: \013 for a carriage return, \010 for a line feed). The \ must
be followed by a three digit code to indicate the character to be output.

This character is used when you want to represent a character as represented by
its ASCII Decimal value. For example, since the filter directly references the
character ~ in its function, if you want to use the ~ character in your text, you'll need
to represent it with its ASCIl value. The ASCIl value of ~ is: \126

Note: PageGate's filter script supports RegEx expressions, which can allow you to
implement an incredibly intricate system.

How to Implement the Script

Step 1: Copy the filter's executable in to the PageGate program directory
The file 'pdfilter.exe’ must reside in the PageGate program folder. If you do not have a
copy of this file, please contact our sales and registration department at
sales@notepage.com or by phone at 781-829-0500.

Step 2: Determine what you want filtered
Filter scripts are called through PageGate's template system and can be broken downin
to two categories: Inbound and Outbound

Inbound filters can trigger on and modify content passed to the program. These filters are
applied to the program's input interfaces and on a global level to effect all input interfaces.

Outbound filters can trigger on and modify messages delivered by the program. These
filters can be applied to a recipient, carrier, connector and on a global level.

You can have a system reference multiple filters for different purposes at the same time.

For example, you could configure an inbound filter to strip XML and JSON formatting from
received data as well as a global outbound filter that inserted a custom header before
every message. You could then make exceptions to that global rule by configuring unique
filters for a carrier, recipient or connector.
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ﬁﬁ&@%@i&ﬁgum an SMS reply processing system that filtered reply messages
containing certain keywords to specific recipients and groups while also implementing an
outbound filter to customize the contents or formatting of messages delivered to them.

You could do everything described all at once. It really is just a matter of determining what
you want to do, then implementing an appropriate solution.

Step 3: Write the filter
Each filter exists as an XML file in a directory of your choosing; this directory just needs to
be accessible to the PageGate server, whether that's on the local hard drive or via UNC to
a network path. The XML file containing your filter may also be called anything you like, you
can give the file any name as long as its extension is .xml

Steps for writing filters can be found here.

Step 4: Reference the filter
After writing a filter, you'll need to add reference it in the 'Settings' section of a template in
PG Admin.

Inbound/Interface Filters

Value Description Example

This applies a filter to processed data. This
allows the interfaces to apply the initial layer
of data sorting and collection and then
applies the filter to the result.

GetAscii
Standard polling: Filter is applied against

temp file with recipient, sender and message

Advanced polling: Filter is applied against
temp file with recipient, sender and message,| InterfaceFilter = c:
and after lookup substitution \PageGateData\Filters\yourfilter
xml

InterfaceFil
ter

GetMail

Filter is applied against temp file with
recipient, sender and message, after they
have been extracted from the email, and
decoding has taken place

GetSerial
Filter is applied against temp file with
recipient, sender and message, and after

lookup substitution
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Filter is applied against each message that is
received. The file processed by PGFilter will
have Id as first line, second line blank, and
message on remaining lines.

GetWeb
Filter is applied against temp file with
recipient, sender and message

This can be used on an interface or global
level. If used in aninterface, it applies the filter
to that interface. If used on a global level, it
applies the filter to all input from all interfaces.

This applies a filter to raw, unprocessed data.
This applies the filter before the interface has
a chance to read the data. The specific
behavior varies depending on the interface in
question.

GetAscii
Standard polling: Filter is applied against the

raw text file before GetAscii tries to process if

Advanced polling: Filter is applied against
each record that is found, before it is
processed any further (record pattern

matching done first) RawInterfaceFilter = c:
Rawinterfa ;
Eilt \PageGateData\Filters\yourfilter
ceriiier | GetMail xml

Filter is applied against the raw file received
from the PageGate mail server process. Al
headers are intact and no decoding has
taken place yet. Envelope values for recipient
and sender are not available for modification
in the raw mail file (because they are read
from the envelope).

GetSerial

Filter is applied against each record found
before it is processed any further (record
pattern matching is done first)
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GetTEp

Filter is applied against each message that is
received.

GetWeb
Filter is applied against raw text file created
by webgate.exe CGl program

This can be used on an interface or global
level. If used in an interface, it applies the filter
to that interface. If used on a global level, it

applies the filter to all input from all interfaces.

Outbound Filters

Value

Description

Example

Filter

This applies a filter to outbound messages.
This can be applied on a recipient, carrier,
connector or global level.

If used in a recipient template, all messages
delivered to that recipient will be processed
through the filter.

If used in a carrier template, all messages
delivered through that carrier will be
processed through the filter.

If used in the program template, it applies to

all output from the program.

ConnectorFilter = c:
\PageGateData\Filters\yourfilter
xml

Connector
Filter

This applies a filter to the messages
delivered by a connector. This filter can only
modify the contents of a message and cannot
modify the recipient or sender information.

This can be applied on a connector or global
level.
If used in the program template, it applies to

all connectors in the program.

Filter = c:
\PageGateData\Filters\yourfilten
xml
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T AY S Hoplies a filter to the subject line of any
outbound email. This value is only referenced
by the SMTP protocol and is not referenced
by other protocols.

This can be applied on a recipient, carrier,
connector or global level.

If used in a recipient template, all
SMTP/email messages delivered to that
SubjectFilt| recipient will have their subject lines

er processed through the filter.

SubjectFilter = c:
\PageGateData\Filters\yourfilter
xml

If used in a recipient template, all
SMTP/email messages delivered to through
that SMTP/email carrier will have their subject]
lines processed through the filter.

If used in the program template, all
SMTP/email traffic sent from the system will
have its subject line processed through the
filter.

Hierarchy
An Interface (and Global) template can have both a RawlnterfaceFilter and an

InterfaceFilter. Both filters will run in that order if they are both set.

Connectors will run any outbound filter according to which template has the highest priority.
In order, they are:

1) Recipient
2) Carrier

3) Connector
4) Global

After implementing a filter script, it is highly recommend that you go through a debugging

process to verify what you've configured. See Debugging the Script for more information.
Debugging the Script

To debug the filter script, you'll first need to set the Debug tag to true.

By setting Debug to True, that puts the script in to debugging mode. When in debugging
mode, the script will display a window that shows the result of every component of your
filter. It will display whether the filter performed its functions successfully or if there was an
error and, if there was an error, what the error was related to. For example, "Match not
found" in the event that your search criteria couldn't be found.
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This makes tracking down errors in the script much easier than it otherwise would be.
If you're using preproc.bat, rename it to preprocv.bat
If you're using pstproc.bat, rename it to pstprocv.bat

The vin the file name stands for Verbose, so you're effectively putting the scriptinto a

mode that will display far more information on the screen.
The Filter Script

Filters can be simple or complex depending on what you want to do. The most basic filters
are search and replace functions, where you remove specific patterns like XML tags from
text or replace short-codes with more verbose information. The more advanced filters can
conditionally modify who receives a message, what the message says and execute
functions via batch file or Powershell script, among other things.

The filters themselves are written in XML and, to start, you may want to look at the
complete filter script template. That will give you a general overview of each section and all
of the possible values you could use in them.

To break things down, there is one major section, Filter, that determines what each section
of the script will do. Additionally, there are two conditional sections, InputFile and
OutputFile, plus an optional debugging mode:

o Filter

The Filter section determines what you want to do with the data read as input. A single
filter script may reference multiple individual <Filter> sections to perform multiple tasks
within the same data set. It's also important to note that the filter system supports the use
of Regex, allowing for a high level of customization and control.

e InputFile

Most scripts will not need this parameter. When using the filter system in conjunction with
the GetAscii interface or a FILE protocol carrier, the InputFile section determines which
file(s) you want the filter to scan.

e OutputFile

Most scripts will not need this parameter. When using the filter system in conjunction with
the GetAscii interface or a FILE protocol carrier, the OutputFile section determines what
you want to name the files output by the filter's modifications.

e Debug
The Debug section determines whether you want a debug level review of the filter to

appear before the filter completes its actions. This is incredibly useful when first
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ca%grﬁgcé @ct%t and we recommend that this flag be enabled until the filter is ready to
put in to production.

For most scripts, you'll want to start with the Filter section.
The Complete Filter Script Template

Note: The InputFile and OutputFile sections are not required for most scripts. For more
information, please see The Filter Script.

<InputFile>
<Name>
(Parameter), static input filename
</Name>
<Delete>
True, (False) - deletes the Input File, even if <Abort> is used
</Delete>
</InputFile>
<OutputFile> - not used if the .dll version of the filter is running the script
<Name>
(InputFile), static output filename
</Name>
</OutputFile>
<Debug>
<Console>
<Active>
True, (False)
</Active>
</Console>
<File>
<Active>
True, (False)
</Active>
<Name>
debug log filename
</Name>
<Append>
True, (False) - appends to existing file instead of recreating it
</Append>
</File>
<LogInputFile>
True, (False)
</LoglnputFile>
<LogOutputFile>
True, (False)
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</Debug>
<Filter>*
<Comment>
optional comment text that will be shown in debug output
</Comment>
<FilterName>
If you are using the <Goto> tag for looping, then the filter you want
to jump back to must have a name
</FilterName>
<Lookup> - if the Lookup section is included, no other sections are processed (i.e.
<MatchFound> and <MatchNotFound> are not run
<Variable>
(All), Recipient, Sender, Message, Temp1-10
</Variable>
<CaseSensitive>
True, (False)
</CaseSensitive>
<SpaceSensitive>
True, (False) - If False, leading and trailing spaces are ignored
(otherwise they need to match exactly)
</SpaceSensitive>
<List>
A list of comma separated values - one per line
or a filename that contains the list
If the text in the <Variable> text matches the first value of a pair in the
list,
the second value in the pair is substituted for it
Multiple values can be included in the first value by separating them
with | symbols
Values can be quoted - if so use two quotes in a row ("") to include
a single quote in the value's text
If no match is found, and the last pair in the list have a * for it's first
value, then this will be used as a default value
Comments: any line of text with a pound sign (#) as the very first
character
(no leading spaces or tabs) will be considered a comment,
and ignored.
</List>
</Lookup>
<Search>
<Type>
(Literal), RegEx, GreaterThan, LessThan - for GreaterThan and
LessThan, <Variable> is GreatherThan/LessThan <Text> </Type>

Chapter 6 PageGate Admin: How to Configure PageGate



PageGate Admin: How to Configure 6
PageGa@riabI@

(All), Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Text>*
search text, True, False
must be quoted to retain beginning and/or ending whitespace
</Text>
</Search>
<MatchFound> - if you don't include a <Search> section,
<Replace> - multiple Replace sections are allowed
<Type>
(Literal), RegEx, And, Or - And/Or sets Flag equal to Flag
And/Or <Text>
</Type>
<Variable>
(All), Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Scope>
(Match), Entire - replace only the matched text, or the entire
variable's contents
</Scope>
<ReplaceAll>
True, (False) - replaces all matches in the variable
</ReplaceAll>
<Text>*
replacement text, True, False
must be quoted to retain beginning and/or ending whitespace
</Text>
</Replace>
<WriteFile>
<Name>*
if match found, filename to save to - most macros are valid
</Name>
<Variable>
(All), Recipient, Sender, Message, Temp1-10
</Variable>
</WriteFile>
<Run>
<Command>*
run this command (no spaces in folders or filenames)
</Command>
<Async>
(True), False - if true, the filter continues immediately, if false it
waits for
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</Async>
<Show> - true give the program a window to run in, false hides the
program
True, (False)
</Show>
</Run>
<RunFilter>
<SettingsFile>*
path and name of new filter settings file
</SettingsFile>
<Variable>
(), All, Recipient, Sender, Message, Temp1-10
name of the variable that holds the text to be sent to the filter
*if Variable is used (and not empty), the InputFile value is
ignored
</Variable>
<InputFile>
path and name of input file - ignored if Variable section is set
</InputFile>
<DebugFile>
path and name of debug file
</DebugFile>
<AppendDebug>
True, (False)
</AppendDebug>
<UseDII>
True, False - if pdfilter.dll is running, then default value is True,
otherwise itis False
</UseDlII>
</RunFilter>
<ReadFile>
<Name>*
if match found, filename to read - most macros are valid
</Name>
<Variable>
(All), Recipient, Sender, Message, Temp1-10
</Variable>
<Delete>
True, (False) - delete the file after reading it
</Delete>
</ReadFile>
<Goto>
Name of filter to jump to - *** be careful not to make infinite loops
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<Abort>
True, (False) - exit without writing to the Output File (which is the Input
File by default)
</Abort>
<Continue>
(True), False - whether or not to continue processing the next filter
block
</Continue>
<MatchFound>
<MatchNotFound> - this section is always run if there is no <Search> section
<Replace> - multiple Replace sections are allowed
<Type>
(Literal), And, Or - And/Or sets Flag to Flag And/Or
replacement Text
</Type>
<Variable>
(All), Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Text>*
replacement text, True, False
must be quoted to retain beginning and/or ending whitespace

</Text>
</Replace>
<WriteFile>
<Name>*
if match found, filename to save to - most macros are valid
</Name>
<Variable>
(All), Recipient, Sender, Message, Temp1-10
</Variable>
</WriteFile>
<Run>
<Command>*
run this command (no spaces in folders or filenames)
</Command>
<Async>
(True), False - if true, the filter continues immediately, if false it
waits for
the program it started to finish
</Async>
<Show> - true give the program a window to run in, false hides the
program

True, (False)
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</Show>

</Run>
<RunFilter>

ignored

otherwise itis False

<SettingsFile>*
path and name of new filter settings file
</SettingsFile>
<Variable>
(), All, Recipient, Sender, Message, Temp1-10
name of the variable that holds the text to be sent to the filter
* if Variable is used (and not empty), the InputFile value is

</Variable>
<InputFile>
path and name of input file - ignored if Variable section is set
</InputFile>
<DebugFile>
path and name of debug file
</DebugFile>
<AppendDebug>
True, (False)
</AppendDebug>
<UseDII>
True, False - if pdfilter.dll is running, then default value is True,

</UseDlII>

</RunFilter>
<ReadFile>

<Name>*

if match found, filename to read - most macros are valid
</Name>
<Variable>

(All), Recipient, Sender, Message, Temp1-10
</Variable>
<Delete>

True, (False) - delete the file after reading it
</Delete>

</ReadFile>
<Goto>

Name of filter to jump back to - be careful not to make infinite loops

</Goto>
<Abort>

File by default)

True, (False) - exit without writing to the Output File (which is the Input

</Abort>
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(True), False - whether or not to continue processing the next filter

block
</Continue>
<MatchNotFound>
</Filter>
<Filter>...
Notes:

Sections with * are required
Values in () are default values if section is not present

The first commandline parameter is the name of the InputFile to be processed
If an <InputFile><Name> section is used, its value overrides the commandline
parameter value

The default settings file name is pdfilter.xml
The settings file name can be set by using settingsfile= as a parameter on
the commandline. The input file name would then be the next parameter

The debug file name can be set by using debugfile= as a parameter on
the commandline. The input file name would then be the next parameter

By default, when writing debug info to a file, the file is recreated each time

Using the commandline parameter debugappend=true will append to the file
instead

* WARNING *** don't leave debugappend set for long periods, because the file

will keep growing forever

OutputFile, ReadFile, WriteFile support variables (in addition to the normal ones):
Y%InputFilePathAndName%
%InputFilePath%
Y%lnputFileName%
%InputFileNameBase %
Y%InputFileNameExtension%
%Filterindex%

Section values for Recipient, Sender, Message, and All really just mean:
Recipient: first line of text,
Sender: second line of text,
Message: third and remaining lines of text
All: the entire contents of the file
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~ as first character means the start of the variable's contents

~ as last character means the end of variable's contents

? matches a single character

* matches anything (including nothing)

\ following 3 digits are a decimal character value

the ~, ?, *, and \ characters must use \ with decimal equivalent to be used
literally

RegEx replacement:
Backreferences are allowed in replacement text (i.e.\1\2\3 ...)
\r, \n, and \### (3 digits) literals are supported for inserting CR, LF, and
ASCI

Literal search text variables
%Recipient% - the current value for Recipient
%Sender% - the current value for Sender
%Message% - the current value for Message
%All% - the current value for All of the text
%Temp1-10% - the current value for that Temp variable
\ following 3 digits are a decimal character value

Literal replacement text variables:

%Recipient% - the current value for Recipient

%Sender% - the current value for Sender

%Message% - the current value for Message

%All% - the current value for All of the text

%Match% - the actual text that matched the search text (Literal or RegEx
match types)

%Group1-10% - RegEx group backreferences obtained from a RegEx
search

%Temp1-10% - the current value for that Temp variable

Y%InputFileName% - the name of the input file being processed

%Year%, %Month%, %Day%, %eMHour%, %Hour%, %Minute%, %Second
%, %MSecond%, %AMPM%

%Unique % - unique number - guaranteed unique to the computer - pretty
unique otherwise

\ following 3 digits are a decimal character value

Functions:
Format is %FunctionName(input-value)% - it will be replaced with the
function's output value
Y%DateTimeToUnixTime()%
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Pag[ﬁecégatﬁvalue of the Temp1-10 variables are an empty string
The default value of the Flag variable is false

Comments: The <Comment> section can be used in each <Filter> and it will b
output
in the debug log, or any line of text with a pound sign (#) as the very first
character (no leading spaces or tabs) will be considered a comment, and
ignored,
and also not logged

The Recipient, Sender, Message and ALL variables are dynamically linked
together. So, for
example, if you change the Sender, the first line of All will also be updated.
Changing
All will update the Recipient, Sender and Message parts

When the order of things matter:
<Filter> block are executed in the order they appear (unless <Goto> is used)
In a <Filter> block:
<Search> (if it exists) runs first and determines if the <MatchFound>
or <MatchNotFound> block is run
<Replace> <WriteFile> <Run> <RunFilter> <ReadFile> <GoTo>
<Abort> <Continue> run in that order
There can be multiple <Replace> <WriteFile> <Run> <RunFilter>
<ReadFile> blocks and they will run
in the order they appear - i.e. all <Replace> blocks will run,
then all <WriteFile> blocks, etc.

RegEx uses a Pearl compatible implementation syntax
good reference: http://www.regular-expressions.info/tutorialcnt.html

Breaking changes

<Section></Section> is renamed to <Variable></Variable>

In the <Replace> section the <All></All> tag has been renamed to
<ReplaceAll></ReplaceAll>

In the <Replace> <Scope> section the value: 'Section' is renamed to 'Entire’

All exiting <Replace> section have to be surrounded with <MatchFound></MatchFound>
tags

Recipient, Sender, Message and All are new dynamically linked together

Bare Filter Template - for easier cuttting/pasting
* in sections with multiple value options, the first in the list is the default value

Chapter 6 PageGate Admin: How to Configure PageGate 480



481

PageGate Admin: How to Configure
fageGate

<Name>
Parameter
</Name>
<Delete>
False, True
</Delete>
</InputFile>
<OutputFile>
<Name>
InputFile
</Name>
</OutputFile>
<Debug>
<Console>
<Active>
False, True
</Active>
</Console>
<File>
<Active>
False, True
</Active>
<Name>

</Name>
<Append>
False, True
</Append>
</File>
<LogInputFile>
False, True
</LoglnputFile>
<LogOutputFile>
False, True
</LogOutputFile>
</Debug>
<Filter>
<Comment>

</Comment>
<FilterName>

</FilterName>
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<Variable>
All, Recipient, Sender, Message, Temp1-10
</Variable>
<CaseSensitive>
False, True
</CaseSensitive>
<SpaceSensitive>
False, True
</SpaceSensitive>
<List>

</List>
</Lookup>
<Search>
<Type>
Literal, RegEx, GreaterThan, LessThan
</Type>
<Variable>
All, Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Text>

</Text>
</Search>
<MatchFound>
<Replace>
<Type>
Literal, RegEx, And, Or
</Type>
<Variable>
All, Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Scope>
Match, Entire
</Scope>
<ReplaceAll>
False, True
</ReplaceAll>
<Text>

</Text>

</Replace>
<WriteFile>
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<Name>

</Name>
<Variable>
All, Recipient, Sender, Message, Temp1-10, Flag
</Variable>
</WriteFile>
<Run>
<Command>

</Command>
<Async>
True, False
</Async>
<Show>
False, True
</Show>
</Run>
<RunFilter>
<SettingsFile>

</SettingsFile>
<Variable>
, All, Recipient, Sender, Message, Temp1-10
</Variable>
<InputFile>

</InputFile>
<DebugFile>

</DebugFile>
<AppendDebug>
False, True
</AppendDebug>
<UseDII>
True, False
</UseDlII>
</RunFilter>
<ReadFile>
<Name>

</Name>
<Variable>

All, Recipient, Sender, Message, Temp1-10, Flag
</Variable>
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<Delete>
False, True
</Delete>
</ReadFile>
<Goto>
</Goto>
<Abort>
False, True
</Abort>
<Continue>
True, False
</Continue>
<MatchFound>
<MatchNotFound>
<Replace>
<Type>
Literal, And, Or
</Type>
<Variable>
All, Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Text>
</Text>
</Replace>
<WriteFile>
<Name>
</Name>
<Variable>
All
</Variable>
</WriteFile>
<Run>
<Command>
</Command>
<Async>
True, False
</Async>
<Show>
False, True
</Show>
</Run>
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<SettingsFile>

</SettingsFile>
<Variable>
, All, Recipient, Sender, Message, Temp1-10
</Variable>
<InputFile>

</InputFile>
<DebugFile>

</DebugFile>
<AppendDebug>
False, True
</AppendDebug>
<UseDlI>
True, False
</UseDII>
</RunFilter>
<ReadFile>
<Name>

</Name>
<Variable>
All, Recipient, Sender, Message, Temp1-10, Flag
</Variable>
<Delete>
False, True
</Delete>
</ReadFile>
<Goto>

</Goto>
<Abort>
False, True
</Abort>
<Continue>
True, False
</Continue>
<MatchNotFound>
</Filter>
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The Filter section determines what you want to do with the data read as input. A single
filter script may reference multiple individual <Filter> sections to perform multiple tasks
within the same data set. You can also find filter statement examples here and complete
script examples here.

<Filter>

<Search>

See Search section
</Search>
<Replace>

See Replace section.
</Replace>
<Continue>

See Values and Description
</Continue>

<Abort>
See Values and Description
</Abort>
</Filter>
Flag Values and Description
Search Please review the Search section for a detailed explanation of this tag and
its components.
Replace Please review the Replace section for a detailed explanation of this tag and

its components.

This tag determines whether or not you want the script to continue to the
next action if it finds a match. This tag can be set to a value of True or
False.

Continue | For example, let's say we're searching for the text 345 within the input file's
data. Let's also say that no match for 345 can be found in the input data.

If Continue is set to True, the filter will move to the next specified <Filter>
section. If Continue is set to False, the script willimmediately terminate
upon not finding a match.

If the search section finds a match and Abort has a value of True, the script
is aborted. Basically, the input data is left unchanged and no more filter
blocks are processed. It just abruptly ends the filter processing and quits
out without saving anything.

Abort
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AEQ%QQI%@, due to the way this script is programmed, certain characters are
treated as command characters instead of literal text characters. The following characters
represent certain command functions in the script:
Chara Function

cter

~ as first character means start of sectionf/file, ~ as last character means end of
sectionffile. For example, ~123~ would only find 123 and not 01234 or 1237, etc.
~123 would find 12340 but would not find 01234. 123~ would find 0123 but would
not find 01234.

? | Single character wildcard.

* | Multiple character wildcard.

IMPORTANT
ASCll value prefix (Ex: \013 for a carriage return, \010 for a line feed). The \ must
be followed by a three digit code to indicate the character to be output.

This character is used when you want to represent a character as represented by
its ASCII Decimal value. For example, since the filter directly references the
character ~ in its function, if you want to use the ~ character in your text, you'll need
to represent it with its ascii value. The ascii value of ~ is \126.

The Search section determines what you want the filter to look for.

<Search>
<Section>
See Values and Description
</Section>
<Type>
See Values and Description
</Type>
<Text>
See Values and Description
</Text>
</Search>
Flag Values and Description

This tag determines where the filter should look for the data specified in thel
Text tag (see below).

Value Explanation
Section s

All | Alltells the filter to search the entire data set read from the input file.
Recipi
ent

Recipient tells the filter to search only in the first line of the file.
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Messa| Message tells the filter to search only in the third and following lines of
ge | thefile.
Temp is a string variable that can be passed strings of characters to
hold, then use its value to search on later. Temp does not support
Temp| boolean operators. For example, you can have certain information
stored in the Temp value, then both search on and output that Temp
value in successive Filter tags. See Example 1 and Example 3.
Flag is a boolean value that can only hold a true or false statement,
Flag | However, you can run "And" or "Or" statements against it for
advanced logic chains. See Example 1 and Example 3.

Sender tells the filter to search only in the second line of the file.

Values: Literal or RegEx

Type This tag determines whether you want to use literal text or a RegEx statement
in the Text tag.
If the Type tag is set to Literal, this tells the filter to search on the text entered in
to the Text tag. For example, you could enter the literal text Fire Department if
you wanted the filter to key off of the literal text "Fire Department" (without the}
quotes).
This tag supports the following boolean parameters:
* - Multiple Character Wildcard
For example, fire* would find fire, firewood, fireplace, fireman and similar.
? - Single Character Wildcard
For example, fire? would fine fires, fired but would not find fire.

Text

(Literal)| ~ as first character means start of section/file

~ as last character means end of section/file

For example, ~12345~ would only read 12345. Without the ~ before and after
the string, the filter would recognize 12345 in 0123456.

This tag also supports the following variables:

%Recipient% - the current value for Recipient

%Sender% - the current value for Sender

%Message% - the current value for Message

%All% - the current value for All of the text

%Temp% - the current value for the Temp variable

\ - following 3 digits are a decimal character value. See Below.

The PageGate Filter script supports RegEx expressions. RegEx uses a Pear

compatible implementation syntax and a good reference guide for the
language can be found here:

Text
(Regex)
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As an important note, due to the way this script is programmed, certain characters are
treated as command characters instead of literal text characters. The following characters
represent certain command functions in the script:
Chara Function

cter

~ as first character means start of sectionf/file, ~ as last character means end of
sectionffile. For example, ~123~ would only find 123 and not 01234 or 1237, etc.
~123 would find 12340 but would not find 01234. 123~ would find 0123 but would
not find 01234.

? | Single character wildcard.

* | Multiple character wildcard.

IMPORTANT
ASCll value prefix (Ex: \013 for a carriage return, \010 for a line feed). The \ must
be followed by a three digit code to indicate the character to be output.

This character is used when you want to represent a character as represented by
its ASCII Decimal value. For example, since the filter directly references the
character ~ in its function, if you want to use the ~ character in your text, you'll need
to represent it with its ascii value. The ascii value of ~ is \126.

The Replace section determines what you want to do with the data found in the Search
section.

<Replace>
<Section>
See Values and Description
</Section>
<Type>
See Values and Description
</Type>
<Scope>
See Values and Description
</Scope>
<All>
See Values and Description
</All>
<Text>
replacement text goes here
must be quoted to retain beginning and/or ending whitespace
See Values and Description
</Text>
</Replace>
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Flag

Values and Description

Secti
on

Values: All, Recipient, Sender, Message, Temp, Flag

This tag determines which section the filter perform the replacement within.

Value Explanation

All tells the filter to replace any instance of the searched text within the
All . .
entire data set read from the input file.

Recipi

ent Recipient tells the filter to replace values only in the first line of the file.

Sende

; Sender tells the filter to replace values only in the second line of the file.

Mess| Message tells the filter to replace values only in the third and following
age | lines of the file.

Temp is a string variable that can be passed strings of characters to
hold, then use its value to search on later. Temp does not support

in the Temp value, then both search on and output that Temp value in
successive Filter tags.

Temp| boolean operators. For example, you can have certain information storedj

Flag is a boolean value that can only hold a true or false statement.
Flag | However, you canrun"And" or "Or" statements against it for advanced
logic chains.

Type

Values: Literal, RegEx, And, Or

This tag determines whether you want to use literal text or a RegEx statement in
the Text tag. This tag can also be used as a situational boolean operator to
determine how to proceed.

The boolean values (Or & And) modify the Flag value. So, for example, you could
have the filter search for a value and set it as the Flag, then have the replace filter
use "Or" to indicate that the Flag value may be more than one thing. You could
also use the And operator to tell the filter that the Flag value must contain multiple
variables to be matched. See Example 1 and Example 3.

Scop

Values: Match or Section

All

Values: True or False

Text
(Liter
al)

If the Type tag is set to Literal, this tells the filter to search on the text entered in to
the Text tag. For example, you could enter the literal text Fire Department if you

wanted the filter to key off of the literal text "Fire Department" (without the quotes).

This tag supports the following boolean parameters:
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For example, fire* would find fire, firewood, fireplace, fireman and similar.

? - Single Character Wildcard
For example, fire? would fine fires, fired but would not find fire.

~ as first character means start of sectionffile

~ as last character means end of sectionffile

For example, ~12345~ would only read 12345. Without the ~ before and after the
string, the filter would recognize 12345 in 0123456.

Text| The PageGate Filter script supports RegEx expressions. RegEx uses a Pearl
(Reg| compatible implementation syntax and a good reference guide for the language
ex) | canbe found here: http://www.regular-expressions.info/tutorialcnt.html

As an important note, due to the way this script is programmed, certain characters are
treated as command characters instead of literal text characters. The following characters
represent certain command functions in the script:

Chara
cter

Function

~ as first character means start of sectionffile, ~ as last character means end of
sectionffile. For example, ~123~ would only find 123 and not 01234 or 1237, etc.
~123 would find 12340 but would not find 01234. 123~ would find 0123 but would
not find 01234.

Single character wildcard.

Multiple character wildcard.

IMPORTANT
ASClIvalue prefix (Ex: \013 for a carriage return, \010 for a line feed). The \ must
be followed by a three digit code to indicate the character to be output.

This character is used when you want to represent a character as represented by
its ASCIl Decimal value. For example, since the filter directly references the
character ~ in its function, if you want to use the ~ character in your text, you'll need
to represent it with its ascii value. The ascii value of ~ is \126.

To better demonstrate how some of the flags function, here are a few examples of
complete filter statements and an explanation of what they do.

Here is an example of a Literal Text Replacement Command.

Here is an example of an Abort Command.
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Tﬁ@ﬂ@%@ﬁ%m tells the script to terminate if the Flag variable is set to False:

<Filter>

<Search>

<Section>

Flag
</Section>
<Type>

Literal
</Type>
<Text>

False
</Text>

</Search>
<Replace>

<Section>

Flag
</Section>
<Scope>

Section
</Scope>
<Type>

And
</Type>
<Text>

False
</Text>
<All>

False
</All>

</Replace>

<Continue>
False

</Continue>

</Filter>

6

This Filter statement tells the script to replace one piece of literal text with another. More

specifically, this statement tells the script to search for the literal text Boiler Room and
replace it with boiler_tech_group.

<Filter>
<Search>
<Section>
All
</Section>
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Literal
</Type>
<Text>

Boiler Room
</Text>

</Search>
<Replace>
<Section>

Temp
</Section>
<Scope>

Section
</Scope>
<Type>

Literal
</Type>
<Text>

boiler_tech_group
</Text>
<All>

False
</All>

</Replace>

</Filter>
InputFile

The InputFile section determines which file(s) you want the filter to scan.

<InputFile>
<Name>
See Values and Description
</Name>
<Delete>
See Values and Description
</Delete>
</InputFile>
Flag Values and Description

Values: Parameter or Static Input File Name

This tag determines the name(s) of the file(s) that you want the filter to modify.
Just to note, the value Parameter is literal and not figurative. To use this value,
you'll want to use the text Parameter, including the capital P. When the filter is

Name
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T LYY eifdaded by the pstproc.bat file, itis fed the file name being used by the filter.
The Parameter value tells the filter that it should simply accept the file name as
it was passed by the batch file.
Alternatively, you can specify a static file for input. For example, c:
\PageGateData\Filter\winsck9000.log would tell the filter to only read from a
specific file named winsck9000.log. As another example, you could specify c:
\PageGateData\Filter\*.log and that would tell the filter to read all log files
placed in the directory.
Values: True or False

D This tag determines whether you want the filter to delete the input file when it

elete ; o

has finished processing it.
If you do, set this tag to True. If you do not, set this tag to False.

As an important note, due to the way this script is programmed, certain characters are
treated as command characters instead of literal text characters. The following characters

represe

nt certain command functions in the script:

Chara
cter

Function

~ as first character means start of section/file, ~ as last character means end of
sectionffile. For example, ~123~ would only find 123 and not 01234 or 1237, etc.
~123 would find 12340 but would not find 01234. 123~ would find 0123 but would
not find 01234.

Single character wildcard.

Multiple character wildcard.

IMPORTANT
ASClIvalue prefix (Ex: \013 for a carriage return, \010 for a line feed). The \ must
be followed by a three digit code to indicate the character to be output.

This character is used when you want to represent a character as represented by
its ASCII Decimal value. For example, since the filter directly references the
character ~ in its function, if you want to use the ~ character in your text, you'll need
to represent it with its ascii value. The ascii value of ~is \126.

OutputFile

The Out

putFile section determines what you want to name the files output by the filter's

modifications. This section is defined as follows:

<Output

File>

<Name>
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</Name>
</OutputFile>

Flag

Values and Description

Name

Values: InputFile or Static Input File Name

This tag determines the names of the files that you want the filter to output after
it has modified the data read from the input file.

The value InputFile (this is case sensitive) tells the filter that the file output
should mirror the original input file's name. So, for example, if the file read was
named example.txt, then the file output would also be called example.txt

Alternatively, you can specify a static naming convention for the output files.
This value also supports the following variables:

%InputFileName%

%InputFileNameBase%

%InputFileNameExtension%

%InputFilePathAndName %

%InputFilePath%

So, for example, you could specify this as the value: c:\PageGateData\ASCI\%
InputFileNameBase%.asc

That would tell the filter that it should use the original name of the file read but
the output file should have the extension .asc instead of the extension on the
original file.

As an important note, due to the way this script is programmed, certain characters are
treated as command characters instead of literal text characters. The following characters
represent certain command functions in the script:

Chara
cter

Function

~ as first character means start of sectionffile, ~ as last character means end of
section/file. For example, ~123~ would only find 123 and not 01234 or 1237, etc.
~123 would find 12340 but would not find 01234. 123~ would find 0123 but would
not find 01234.

? | Single character wildcard.
* | Multiple character wildcard.
IMPORTANT
\ ASClIvalue prefix (Ex: \013 for a carriage return, \010 for a line feed). The \ must
be followed by a three digit code to indicate the character to be output.
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ThiS Character is used when you want to represent a character as represented by
its ASCII Decimal value. For example, since the filter directly references the
character ~ in its function, if you want to use the ~ character in your text, you'll need
to represent it with its ascii value. The ascii value of ~ is \126.

Debug

The Debug section determines whether you want a debug level review of the filter to
appear before the filter completes its actions. This is incredibly useful when first
configuring a script and we recommend that this flag be enabled until the filter is ready to
put in to production. This section is defined as follows:

<Debug>
See Values and Description
</Debug>

Flag Values and Description
Values: True or False

Debug | This tag determines whether you want to review the debug level information for
the filter before it completes its actions. Set this flag to True to review the
debugging information, set this flag to False if you do not.

Please see Debugging the Script for more information.
Complete Script Examples

Due to the complex nature of the Filter script, we've created a few examples of how scripts
can be implemented. This is by no means a complete list of everything that the script can
do and is intended to be a set of examples to guide you through the possibilities the script
offers.

Example 1
In this example, we've configured the filter script to search the message read from the

input file for the text BIOHAZARD and replace it with bio_hazard. We're then inserting the
static text WARNING! EXTREME HAZARD DETECTED: before the matched search
string.

Example 2
In this example, we've configured the filter to scan through XML tags for the text Technical

or Network in the <AlertType> tag, then pull in information from the <Incident> and
<Description> tags. This collated data is then being passed to a statically named group in
PageGate: techsupervisors.

Example 3
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Irﬁt%g)g%@,t%'ve configured the filter to scan for certain keywords and key phrases. If
it finds them, messages containing that text should not be allowed to go through and
should instead be filtered.

Example 4
In this example, we've configured the filter script for a dispatching agency that needs all

fire, rescue and accident calls dispatched but does not want non-emergency calls
dispatched. To do this, the script reads in the entire input file and looks for certain flags
like FIRE,DISPATCHED or RESCUE,DISPATCHED or ACCID,DISPATCHED.

If it finds any of those three strings, the script then begins massaging and reformatting the
data to remove unwanted information and to determine who the message should go to and
what the message should say.

In this particular example, all fire and rescue calls need to be delineated from each other
so that the fire calls go to the fire department and the rescue calls go to the rescue
department but all accident calls should go to both fire and rescue departments.

Example 5
In this example, we're using an HTTPGET carrier to poll data from the National Weather

service to have it delivered as an SMS.

Example 6
This example is designed to work with an SMS Replies system and is configured to look

for the words 'subscribe' and 'unsubscribe' in the body of reply messages. If it finds
'subscribe’, it reconfigures the message to go to the recipient or group in PageGate
named 'subscribe’'. f it finds 'unsubscribe', it reconfigures the message to go to the
recipient or group named 'unsubscribe’.

Example 7
This example is designed to work with an SMS Replies system and is configured so that

any time someone replies to a message with 'unsubscribe' or 'subscribe’, those replies
execute a batch file or script contained within a batch file. This can be especially useful if
you're using an SQL environment and have PageGate's database linked to it with ODBC
expressions. In theory, you could code a script to be executed that would automatically
remove an entry from the users table of the database any time the 'unsubscribe' script was
executed.

Example 8
This example is designed to work with an SMS Replies system. This script is configured

with a list of 'allowed' phone numbers and is also configured to scan the sender value of all
replies. If the sender's phone number isn't in the 'allowed' list, the message is filtered as
spam.
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Example 1

In this example, we've configured the filter script to search the message read from the
input file for the text 'BIOHAZARD'. fit is found then the script will replace the current
Recipient with 'bio_hazard' to indicate that all messages containing the word BIOHAZARD
should go to the bio_hazard group. We're then inserting the static text WWARNING!
EXTREME HAZARD DETECTED:' before the matched search string.

Note: Lines prefaced with # are comment lines for description purposes. The filter ignore
any lines that begin with #

This section of the filter configures the script to look for a static file named Example.txt in
the same directory as the script and, when the script completes, it will not delete the
original file and will output to a static file named Output.txt to the directory in which the
script resides.

<InputFile>
<Name>
Example.txt
</Name>
<Delete>
False
</Delete>
</InputFile>

<OutputFile>
<Name>
Output.txt
</Name>
</OutputFile>

<Debug>
False
</Debug>

# This section of the filter configures the script to search
# for BIOHAZARD and if found, replaces the Recipient
# with bio_hazard.

<Filter>
<Search>
<Section>
Message
</Section>
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Literal
</Type>
<Text>
BIOHAZARD
</Text>
</Search>
<Replace>
<Section>
Recipient
</Section>
<Type>
Literal
</Type>
<Scope>
Section
</Scope>
<Text>
bio_hazard
</Text>
</Replace>
<Continue>
True
</Continue>
</Filter>

# This section of the filter configures the script to insert
# WARNING! EXTREME HAZARD DETECTED: before the BIOHAZARD text
<Filter>
<Search>
<Section>
Message
</Section>
<Type>
Literal
</Type>
<Text>
BIOHAZARD
</Text>
</Search>
<Replace>
<Section>
Message
</Section>
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Literal
</Type>
<Scope>
Match
</Scope>
<Text>
WARNING! EXTREME HAZARD DETECTED: %Match%
</Text>
</Replace>
</Filter>
This is an example of the input file for filter example 1. This is what it looks like before the

filter engages.

supervisors
AlarmMonitor
BIOHAZARD ROOM 354

Another example:

it_alerts
AlarmMonitor
BIOHAZARD RULES IN EFFECT FOR WING 2

When the data from example 1 is put through the example 1 filter, this is the output:

bio_hazard
AlarmMonitor
WARNING! EXTREME HAZARD DETECTED: BIOHAZARD ROOM 354

or like this:

bio_hazard

AlarmMonitor

WARNING! EXTREME HAZARD DETECTED: BIOHAZARD RULES IN EFFECT FOR
WING 2

Example 2

Example 2

In this example, we've configured the filter to scan through an XML file for the text
"Technical' or 'Network' in the <AlertType> tag. It will then temporarily store the information
from the <Incident> and <Description> tags in the Temp variable. This collected data is
then being passed to a statically named group in PageGate: techsupervisors.

Note: Lines prefaced with # are comment lines for description purposes. The filter ignore
any lines that begin with #

<InputFile>
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Parameter
</Name>
<Delete>

True
</Delete>

</InputFile>

<Debug>
False
</Debug>

<OutputFile>
<Name>
c:\PageGateData\ASCI\%InputFileNameBase%.asc
</Name>
</OutputFile>

# This section of the Filters tells the script to look for
# any lines that have<AlertType>Technical</AlertType> and
# set the Flag variable to True if it is found
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
<AlertType>Technical</AlertType>
</Text>
</Search>
<Replace>
<Section>
Flag
</Section>
<Scope>
Section
</Scope>
<Type>
Or
</Type>
<Text>
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</Text>
</Replace>
</Filter>

# This section of the Filters tells the script to look for any
# lines that have the<AlertType>Network</AlertType> and
# set the Flag variable to True if it is found
<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
<AlertType>Network</AlertType>
</Text>
</Search>
<Replace>
<Section>
Flag
</Section>
<Scope>
Section
</Scope>
<Type>
Or
</Type>
<Text>
True
</Text>
</Replace>
</Filter>

# This Filter section tells the script to abort if no instances of
# the two search strings can be found:

<Filter>
<Search>
<Section>
Flag
</Section>
<Type>
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</Type>
<Text>
False
</Text>
</Search>
<Replace>
<Section>
Flag
</Section>
<Scope>
Section
</Scope>
<Type>
And
</Type>
<Text>
False
</Text>
</Replace>
<Continue>
False
</Continue>
</Filter>

# This section of the filter tells the script to grab data
# contained in the <Incident> tag.

<Filter>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
<Incident>*</Incident>
</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
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Section
</Scope>
<Type>

Literal
</Type>
<Text>

%Match%
</Text>

</Replace>

</Filter>

# This section of the filter tells the script to grab data from

# the <Description> tag

<Filter>

<Search>

<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
<Description>*</Description>
<[Text>

</Search>
<Replace>

<Section>
Temp
</Section>
<Scope>
Section
</Scope>
<Type>
Literal
</Type>
<Text>
%Temp% %Match%
</Text>

</Replace>

</Filter>

# This section of the filter removes the tag
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<Filter>
<Search>

<Section>
Temp

</Section>

<Type>
Literal

</Type>

<Text>

<Incident>

</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
<Scope>
Match
</Scope>
<Type>
Literal
</Type>
<Text>

<[Text>
</Replace>
</Filter>

# This section of the filter removes the tag
# </Incident> from the message.

<Filter>
<Search>

<Section>
Temp

</Section>

<Type>
Literal

</Type>

<Text>

</Incident>

</Text>
</Search>
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Temp
</Section>
<Scope>
Match
</Scope>
<Type>
Literal
</Type>
<Text>

</Text>
</Replace>
</Filter>

# This section of the filter removes the tag

# <Description> from the message.

<Filter>
<Search>
<Section>
Temp
</Section>
<Type>
Literal
</Type>
<Text>
<Description>
</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
<Scope>
Match
</Scope>
<Type>
Literal
</Type>
<Text>

</Text>
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</Filter>

# This section of the filter removes the tag
# </Description> from the message.

<Filter>
<Search>
<Section>
Temp
</Section>
<Type>
Literal
</Type>
<Text>
<Incident>
</Text>
</Search>
<Replace>
<Section>
Temp
</Section>
<Scope>
Match
</Scope>
<Type>
Literal
</Type>
<Text>

</Text>
</Replace>
</Filter>

# This Filter tells the script to output the file in the standard
# PageGate GetASClI file format for direct processing:

<Filter>
<Search>
<Section>
Flag
</Section>
<Type>
Literal
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<Text>
True
</Text>
</Search>
<Replace>
<Section>
All
</Section>
<Scope>
Section
</Scope>
<Type>
Literal
</Type>
<Text>
TechSupervisors\013\010CAD\013\010%Temp%
</Text>
</Replace>
</Filter>

This is example XML content to be processed by filter example 2. This is what it looks like

before the filter engages.

<XML>

<AlertType>Technical</AlertType>

<Requester>Station 3</Requester>

<Assets>PC01, PC02</Assets>

<Category>Desktop Support</Category>

<Incident>Replace Computers</Incident>

<Description>Workstations 01 and 02 should be replaced on Thursday</Description>
</XML>

Another example:

<XML>

<AlertType>Network</AlertType>

<Requester>Admin Group</Requester>

<Assets>Router</Assets>

<Category>Network Support</Category>

<Incident>DNS Failure</Incident>

<Description>DNS failures detected in node 2</Description>

</XML>

When the data from filter example 2 is processed by filter example 2, this is the output
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techsupervisors
CAD
Replace Computers, Workstations 01 and 02 should be replaced on Thursday

Another example:

techsupervisors
CAD

DNS Failure, DNS failures detected in node 2
Example 3

In this example, we're scanning for keywords and keyphrases that indicate a message
shouldn't be sent. If the filter finds any of the keywords or keyphrases, it will filter those
messages from going through. For this example, we've configured the filter to look for the
key phrases "Return from Alarm" and "Alarm Acknowledged" as well as potential partial
matches.

<InputFile>
<Name>

Parameter
</Name>
<Delete>

True
</Delete>
</InputFile>

<Debug>
True
</Debug>

<OutputFile>

<Name>
c:\PageGateData\output\%InputFileNameBase%.asc

</Name>

</OutputFile>

<Filter>
<Comment>look for Return From Alarm</Comment>
<Search>
<Section>
All
</Section>
<Type>
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</Type>
<Text>
Return From Alarm

</Text>
</Search>
<Replace>
<Text>
</Text>
</Replace>
<Abort>
True
</Abort>
</Filter>

<Filter>
<Comment>look for Partial Phrases of Return From Alarm</Comment>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
Retu*
</Text>
</Search>
<Replace>
<Text>
</Text>
</Replace>
<Abort>
True
</Abort>
</Filter>

<Filter>
<Comment>look for Alarm Block Acknowledged</Comment>
<Search>
<Section>
All
</Section>
<Type>
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</Type>
<Text>
Alarm Block Acknowledged

</Text>
</Search>
<Replace>
<Text>
</Text>
</Replace>
<Abort>
True
</Abort>
</Filter>

<Filter>
<Comment>look for Partial "Alarm Block Acknowledged" phrases</Comment>
<Search>
<Section>
All
</Section>
<Type>
Literal
</Type>
<Text>
Block
</Text>
</Search>
<Replace>
<Text>
</Text>
</Replace>
<Abort>
True
</Abort>

</Filter>
Example 4

Example 3
In this example, we've configured the filter script for a dispatching agency that needs all
fire, rescue and accident calls dispatched but does not want non-emergency calls

dispatched. To do this, the script reads in the entire input file and looks for certain
keywords like FIRE,DISPATCHED or RESCUE,DISPATCHED or ACCID,DISPATCHED.
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information, and determines who the message should be sent to.

In this particular example, all fire and rescue calls need to be separated from each other
so that the fire calls go to the fire department and the rescue calls go to the rescue
department, but all accident calls should go to both fire and rescue departments.

Note: Lines prefaced with # are comment lines for description purposes. The filter ignore
any lines that begin with #

This section of the filter configures the script to accept whatever file name is passed by the
preproc.bat file, to delete the input file when it's finished and to output the reformatted d